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Chapitre 1 : Bienvenue dans Adobe® 
Contribute® CS3

Adobe® Contribute® CS3 permet aux utilisateurs de créer de nouvelles pages pour des sites Web existants et de modifier 
leurs anciennes pages. Que vous utilisiez Contribute pour mettre à jour des pages Web ou pour gérer votre site, ce logiciel 
constitue un outil précieux pour la consultation, la modification et la publication de contenu sur Internet. 

Contribute est livré avec d'autres produits Adobe Create Suite 3 ; Contribute est également incorporé aux produits Create 
Suite 3. Bien que Contribute puisse interagir avec d'autres produits Creative Suite 3, des menus, des options et des boutons 
de boîtes de dialogue ont été nouvellement rajoutés dans toutes les applications Creative Suite 3 pour aider ces produits de 
la suite à interagir avec Contribute.

Ce chapitre contient les sections suivantes :

• « Installation », page 1

• « Aide Adobe », page 2

• « Ressources », page 4

• « Nouveautés », page 8

• « Présentation du service de développement et de maintenance d'un site Web », page 9

Installation

Conditions d'utilisation
Pour connaître la configuration requise et prendre connaissance des recommandations relatives à votre logiciel Adobe, 
consultez le fichier html Lisez-moi présent sur le DVD d'installation.

Installation du logiciel
1 Fermez toutes les autres application Adobe sur votre ordinateur.

2 Insérez le disque d'installation dans le lecteur DVD et suivez les instructions qui s'affichent à l'écran.

Remarque : Pour plus d'informations, consultez le fichier Lisez-moi.html sur le DVD d'installation.

Activation du logiciel
Si vous disposez d'une licence mono-utilisateur, il vous sera demandé de procéder à l'activation de votre logiciel Adobe : 
c'est une démarche simple et anonyme que vous devez effectuer dans les 30 jours suivant l'installation. 

Pour plus d'informations, consultez le fichier Lisez-moi présent sur le disque DVD d'installation ou visitez le site Web 
d'Adobe à l'adresse www.adobe.com/go/activation_fr.

1 Si la boîte de dialogue Activer n'est pas déjà ouverte, choisissez Aide > Activation.

2 Suivez les instructions affichées à l'écran.

Remarque : Si vous souhaitez installer le logiciel sur un ordinateur différent, vous devez d'abord le désactiver du vôtre. 
Choisissez Aide > Désactivation

http://www.adobe.com/go/activation_fr
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Enregistrement
Enregistrez votre produit pour bénéficier de divers avantages, notamment une assistance gratuite lors de l'installation, des 
annonces de mises à jour et d'autres services.

• Pour procéder à un enregistrement, suivez les instructions affichées dans la boîte de dialogue Enregistrement qui 
apparaît après l'installation et l'activation du logiciel. 

Si vous reportez l'enregistrement, vous pouvez le faire à tout moment en choisissant Aide > Enregistrement.

Lisez-moi
Vous pouvez trouver le fichier Lisez-moi.html pour votre produit sur le DVD d'installation (il est également copié dans le 
dossier de l'application durant l'installation du produit). Ce fichier contient des informations précieuses sur les sujets 
suivants :

• Configuration requise

• Installation et désinstallation

• Activation et enregistrement

• Installation des polices

• Dépannage

• Assistance clientèle

• Informations juridiques

Aide Adobe

Ressources de l'aide Adobe
La documentation relative à votre logiciel Adobe est disponible dans différents formats.

Aide intégrée au produit  et dans LiveDocs
L'aide intégrée au produit donne accès à l'ensemble de la documentation et à des instructions détaillées disponibles au 
moment de la mise sur le marché du produit. Elle est disponible par le biais du menu Aide de votre produit Adobe.

L'aide LiveDocs reprend l'ensemble de l'aide intégrée au produit assorti d'actualisations et de liens vers des instructions 
supplémentaires et détaillées disponibles sur le Web. Pour certains produits, LiveDocs se prête à l'insertion de commen-
taires. Trouvez l'aide LiveDocs correspondant à votre produit dans le Centre de ressources d'aide Adobe à l'adresse 
www.adobe.com/go/documentation_fr.

La plupart des versions d'aide intégrée ou LiveDocs vous permettent d'entreprendre des recherches parmi les aides de bon 
nombre de produits. Les rubriques contiennent égalemement des liens à des contenus sur le Web ou à des rubriques dans 
les aides d'autres produits. 

Vous pouvez considérer l'aide, que ce soit celle du produit ou du Web, comme une plaque tournante qui donne accès à des 
compléments d'informations et à des communautés d'utilisateurs. La version de l'aide la plus complète et la plus à jour se 
trouve toujours sur le Web.

PDF, documentation
L'aide intégrée au produit est aussi disponible sous forme de PDF optimisé pour l'impression. D'autres documents, tels que 
les guides d'installation et les livres blancs sont disponibles également sous forme de PDF. 

L'intégralité de la documentation PDF est disponible dans le centre de ressources d'aide Adobe à l'adresse 
www.adobe.com/go/documentation_fr. Vous pouvez trouver la documentation PDF incluse avec votre produit dans le 
dossier Documentation de votre produit installé ou sur le DVD du produit. 

http://www.adobe.com/go/documentation_fr
http://www.adobe.com/go/documentation_fr
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Documentation imprimée
Vous pouvez acheter les versions papier de l'aide complète intégrée au produit dans la boutique Adobe Store, à l'adresse 
www.adobe.com/go/store_fr. Vous pouvez également y trouver des ouvrages publiés par les partenaires d'édition d'Adobe.

Tous les produits Adobe Creative Suite 3 contiennent un guide de flux de travaux en version papier. Certains produits 
individuels d'Adobe peuvent contenir, quant à eux, un guide de prise en main en version papier.

Utilisation de l'aide dans le produit
L'aide intégrée au produit est disponible par le biais du menu Aide. Après avoir démarré le visualiseur d'aide d'Adobe, 
cliquez sur Parcourir pour voir les aides correspondant à d'autres produits Adobe installés sur votre ordinateur. 

Pour vouis aider à approfondir vos connaissances dans plusieurs produits Adobe, les fonctions suivantes sont disponibles :

• Vous pouvez entreprendre des recherches dans les aides de plusieurs produits.

• Les rubriques peuvent contenir des liens vers des rubriques de l'aide concernant d'autres produits Adobe ou vers des 
compléments d'informations sur le Web.

• Certaines rubriques sont partagées entre plusieurs produits. Si vous apercevez une rubrique d'aide avec une icône 
Photoshop et une icône Contribute, vous savez que la rubrique décrit des fonctionnalités semblables dans les deux 
produits ou bien documente des flux de travaux recouvrant plusieurs produits.

Remarque : Si vous recherchez une expression telle que « outil de forme », mettez-la entre guillemets simples pour ne voir que 
les rubriques qui contiennent tous les mots de l'expression.

Fonctions d'accessibilité
Le contenu de l'aide d'Adobe est accessible aux personnes souffrant de handicaps (mobilité réduite, malvoyance). L'aide 
intégrée au produit prend en charge les fonctions d'accessibilité standard, y compris les suivantes :

• La taille du texte peut être changée à l'aide de commandes de menu de contexte standard.

• Les liens sont soulignés pour être reconnaissables aisément.

• Si le texte d'un lien ne correspond pas au titre de la cible, ce dernier est référencé dans l'attribut de titre de la balise d'ancre. 
Par exemple, les liens Précédent et Suivant incluent les titres des rubriques précédentes et suivantes.

• Le contenu prend en charge le mode contenu élevé.

• Les graphiques sans légendes incluent un texte de remplacement.

• Chaque cadre dispose d'un titre pour indiquer son objet.

• Des balises HTML standard définissent la structure du contenu pour la lecture d'écran ou les convertisseurs de texte en 
paroles.

• Les feuilles de style contrôlent le la mise en forme de sorte qu'il n'y a pas de polices intégrées.

Raccourcis clavier des commandes de barre d'outils (Windows)
Chaque contrôle de la barre d'utils pour l'aide du produit est associé à un raccourci clavier.

Bouton Retour Alt+flèche gauche 

Bouton Avant Alt+flèche droite

Imprimer Ctrl+P

A propos de Ctrl+I

Menu Parcourir Alt+flèche vers le bas ou Alt+flèche vers le haut pour visualiser l'aide d'une autre application

Champ Recherche (Windows) Ctrl+S pour placer le curseur dans la case Recherche

http://www.adobe.com/go/store_fr
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Raccourcis clavier pour la navigation (Windows)
Vous pouvez utiliser les raccourcis clavier suivants pour naviguer dans l'aide intégrée au produit et visualiser des rubriques :

• Pour vous déplacer entre des panneaux, appuyez sur Ctrl+touche de tabulation (en avant) et Maj.+Ctrl+touche de 
tabulation (en arrière).

• Pour vous déplacer dans un panneau et souligner des liens au sein d'un panneau, appuyez sur la touche de tabulation (en 
avant) ou sur Maj.+touche de tabulation (en arrière).

• Pour activer un lien souligné, appuyez sur Entrée.

• Pour agrandir le texte, appuyez sur Ctrl+=.

• Pour réduire le texte, appuyez sur Ctrl+-.

Choix des documents d'aides appropriés
Après avoir installé, activé et enregistré votre logiciel, découvrez l'éventail considérable de ressources d'apprentissage et de 
services à la clientèle mis à votre disposition : systèmes d'aide en ligne et intégrés aux produits, vidéos et didacticiels, publi-
cations imprimées, séminaires, plug-ins et processus automatisés en accès libre, assistance clientèle, communautés d'utili-
sateurs et blogs, flux RSS, etc. Parcourez les rubriques dans la section Ressources pour un aperçu des aides et des services 
et, au fur et à mesure que vous avancez dans votre travail, n'oubliez pas de vous y référer. Elles peuvent faciliter la résolution 
des problèmes, offrir des outils puissants et vous faire gagner du temps.

Votre rôle au sein de l'équipe du site Web détermine les ressources Contribute dont vous aurez besoin au départ et celles 
que vous utiliserez régulièrement.

Les administrateurs Contribute devraient commencer par consulter l'aide des guides de démarrage rapide pour installer 
Contribute et assister les utilisateurs dans leur procédure de connexion. Lors de l'utilisation de Contribute, reportez-vous 
au panneau Comment... pour effectuer rapidement les tâches d'administration courantes et utilisez l'aide en ligne pour 
obtenir des informations détaillées sur les tâches et fonctions d'administration de Contribute.

Les utilisateurs de Contribute devraient commencer par lire les guides de démarrage rapide pour savoir comment effectuer 
les tâches essentielles. Suivez ensuite l'intégralité du didacticiel pour mettre à jour les exemples de pages Web et découvrir 
les arcanes de Contribute. Lors de l'utilisation de Contribute, reportez-vous au panneau Comment... pour effectuer 
rapidement les tâches courantes et utilisez l'aide en ligne pour approfondir les autres fonctionnalités de Contribute.

Pour plus d'informations sur toutes les ressources disponibles, voir la section « Ressources », page 4.

Ressources

Atelier vidéo Adobe
L'atelier vidéo d'Adobe Creative Suite 3 vous permet de découvrir et de mieux connaître votre produit Adobe. Il existe plus 
de 200 vidéos de formation sur Adobe Creative Suite 3 qui englobent un grand choix de sujets pour les professionnels de 
l'impression, du Web et de la vidéo. 

Vous pouvez utiliser l'atelier vidéo pour apprendre à connaître le produit Adobe Creative Suite 3 qui vous intéresse. De 
nombreuses vidéos vous décrivent comment utiliser les applications Adobe simultanément.

Lorsque vous démarrez l'atelier vidéo, vous choisissez exactement les produits et les sujets que vous souhaitez aborder. Vous 
pouvez voir des détails sur chaque vidéo pour vous aider à mettre au point votre plan d'apprentissage. 

Communauté de présentateurs
Avec cette version, nous avons invité la communauté Adobe à partager leurs compétences et leurs perspectives. Adobe et 
Lynda.com présentent des didacticiels, des conseils et des astuces provenant de concepteurs et de développeurs de premier 
plan tels que Joe Lowery, Katrin Eismann et Chris Georgenes. Vous pouvez voir et écouter des experts Adobe tels que Lynn 
Grillo, Greg Rewis et Russell Brown. En tout, plus de 30 experts sur les produits partagent leurs connaissances.
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Didacticiels et fichiers source
L'atelier vidéo comprend la formation d'utilisateurs novices et expérimentés. Vous trouverez également des vidéos sur de 
nouvelles fonctionnalités et des techniques fondamentales. Chaque vidéo aborde un seul sujet et dure généralement de 
3-à-5-minutes. La plupart des vidéos sont accompagnées d'un didacticiel illustré et de fichiers source de sorte que vous 
pouvez imprimer des étapes détaillées et suivre le didacticiel tout seul. 

Utilisation de l'atelier vidéo Adobe
Vous pouvez accéder à l'atelier vidéo Adobe à l'aide du DVD qui accompagne votre produit Creative Suite 3. Vous pouvez 
également le consulter en ligne à l'adresse www.adobe.com/go/learn_videotutorials_fr. Adobe ajoute régulièrement de 
nouvelles vidéos à l'atelier vidéo en ligne de sorte que vous devriez aller voir quelles sont les nouveautés.

Vidéos Contribute CS3
L'atelier vidéo Adobe propose de nombreux sujets pour Adobe® Contribute® CS3, entre autres :

• Publication sur un site Web

• Administration d'un site Web

• Modification et enregistrement d'entrées de blog

• Utilisation de modèles Dreamweaver avec Contribute

Pour obtenir les didacticiels vidéo d'Adobe Creative Suite 3, visitez l'atelier vidéo Adobe à l'adresse 
www.adobe.com/go/learn_videotutorials_fr.

Ressources supplémentaires
Vous disposez d'un large éventail de ressources qui vous permet d'exploiter toutes les possibilités de vos logiciels Adobe. 
Certaines de ces ressources sont placées sur votre ordinateur au cours de l'installation ; une documentation supplémentaire 
et des exemples utiles sont également disponibles sur le disque DVD de contenu ou d'installation du produit. Des supplé-
ments inédits sont proposées en ligne par la communauté Exchange d'Adobe, à l'adresse www.adobe.com/go/exchange_fr.

Ressources installées
Durant la mise en place du logiciel, un certain nombre de ressources est placé dans votre dossier d'application. Pour visua-
liser ces fichiers, vous pouvez naviguer jusqu'à l'application spécifique sur votre ordinateur.

• Windows : [disque de démarrage]/Program files/Adobe/Adobe Contribute

• Mac OS : [disque de démarrage]/Applications/Adobe Contribute

Selon le produit Adobe installé, le dossier de l'application peut contenir les éléments suivants :

Modules externes Les modules externes sont de petits logiciels qui améliorent ou ajoutent des fonctions à votre logiciel. 
Une fois installés, les modules externes apparaissent comme des options dans le menu Importer ou Exporter, comme des 
formats de fichier dans les boîtes de dialogue Ouvrir, Enregistrer sous et Exporter l'original ou comme des filtres dans les 
sous-menus de Filtre.

Présélections Les présélections comprennent une grande variété d'outils utiles, de préférences, d'effets et d'images. Les 
préslections de produit comprennent des pinceaux, des nuanciers, des groupes de couleurs, des symboles, des formes 
personnalisées, des styles de graphiques et de calques, des motifs, des structures, des actions, des espaces de travail, etc. Le 
contenu de présélections est disponible dans toute l'interface. Certaines présélections deviennent disponibles lorsque vous 
sélectionnez l'outil correspondant. Si vous ne souhaitez pas créer un effet ou une image à partir de zéro, vous pouvez lire 
les bibliothèques de présélections attentivement pour trouver l'inspiration.

Modèles Les fichiers de modèles peuvent être ouverts et visualisés depuis Adobe Bridge, ouverts depuis l'écran de 
bienvenue ou ouverts directement depuis le menu Fichier. Suivant le produit, les fichiers de modèles vont d'en-têtes de 
lettres, de bulletins et de sites Web à des menus pour DVD et des boutons pour vidéos. Chaque fichier modèle est monté 
professionnellement et représente un exemple de meilleure utilisation parmi les fonctions du produit. Les modèles peuvent 
être une ressource précieuse lorsque vous devez démarrer un projet en trombe. 

http://www.adobe.com/go/learn_videotutorials_fr
http://www.adobe.com/go/learn_videotutorials_fr
http://www.adobe.com/go/exchange_fr
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Exemples Les fichiers d'exemples contiennent des réalisations plus complexes et constituent un très bon moyen de 
découvrir diverses applications concrètes des nouvelles fonctionnalités. Ces fichiers montrent l'étendue des possibilités de 
création que vous offre votre application.

Polices Plusieurs polices OpenType® et des familles de polices sont contenues dans votre produit Creative Suite. Les polices 
sont copiées dans votre ordinateur durant l'installation :

• Windows : [disque de démarrage]/Program Files/Common Files/Adobe/Fonts

• Mac OS X : [disque de démarrage]/Library/Application Support/Adobe/Fonts

Pour des informations sur l'installation de polices, consultez le fichier Lisez-moi.html sur le DVD d'installation.

Contenu du DVD
L'installation ou le contenu du DVD qui accompagne votre produit comprend des ressources supplémentaires utilisables 
avec votre logiciel. Le dossier En prime contient des fichiers spécifiques au produit tels que des modèles, des images, des 
présélections, des actions, des modules externes et des effets ainsi que des sous-dossiers pour des polices et des images de 
photothèque. Le dossier Documentation contient une version PDF de l'aide, des informations techniques et d'autres 
documents tels que des feuilles-modèles, des guides de référence et des informations sur des fonctions spécialisées.

Adobe Exchange
Pour obtenir d'autres ressources gratuites, consultez le site www.adobe.com/go/exchange_fr, une communauté en ligne où 
les utilisateurs téléchargent et partagent des milliers de réalisations gratuites, des compléments, des modules externes et 
d'autre contenu utilisables avec les produits Adobe.

Bridge Home
Bridge Home, une nouvelle destination dans Adobe Bridge CS3, regroupe dans un seul et même emplacement pratique les 
informations récentes qui sont disponibles sur tous les logiciels Adobe Creative Suite 3. Démarrez Adobe Bridge, puis 
cliquez sur l'icône Bridge Home dans la partie supérieure du panneau Favoris pour accéder aux nouvelles, aux ressources 
et aux conseils les plus récents pour vos outils Creative Suite.

Remarque : Bridge Home peut ne pas être disponible dans toutes les langues.

Pôle de création Adobe (Adobe Design Center)
Le pôle de création Adobe (Adobe Design Center en anglais) propose des articles, des instructions, mais aussi des idées, des 
modèles et des exemples qui sont mis à votre disposition par des experts de votre secteur d'activité, des concepteurs de haut 
niveau et des partenaires d'Adobe en matière d'édition. Le contenu est mis à jour tous les mois.

Vous pouvez trouver des centaines de didacticiels pour des produits de design et apprendre des astuces et des techniques 
par des vidéos ; vous y trouverez également des didacticiels au format HTML et des exemples de chapitres de livre.

De nouvelles idées sont au coeur des « Think Tank » (ou Groupe de réflexion), « Dialog Box » (ou Boîte de dialogue) et 
« Gallery » (ou Galerie) :

• Les articles de « Think Tank » étudient sous tous les angles comment les designers d'aujourd'hui utilisent la technologie 
et ce que leurs expériences signifient pour le design, les outils de design et la société. 

• Dans « Dialog Box », les experts échangent de nouvelles idées sur les graphiques de mouvements et le design numérique.

• La « Gallery » présente comment les artistes introduisent le design dans le mouvement.

Visitez le site Web du pôle de création Adobe à l'adresse www.adobe.com/go/designcenter_fr.

http://www.adobe.com/go/exchange_fr
http://www.adobe.com/go/designcenter_fr
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Pôle de développement d'Adobe
Adobe Developer Center propose des exemples, des didacticiels, des articles et des ressources de la communauté pour des 
développeurs qui construisent de riches applications pour Internet, des sites Web, du contenu mobile et d'autres projets 
faisant appel à des produits Adobe. Le Centre des développeurs contient aussi des ressources pour les développeurs qui 
développent des modules externes pour les produits Adobe. 

Outre des exemples de code et des didacticiels, vous y trouverez des flux RSS, des séminaires en ligne, des SDK, des guides 
des scripts ainsi que d'autres ressources techniques. 

Visitez le pôle de développement à l'adresse  www.adobe.com/go/devcenter_fr.

Assistance clientèle
Visitez le site Web de l'assistance Adobe à l'adresse www.adobe.com/go/support_fr pour trouver des informations de 
dépannage pour votre produit et vous renseigner sur les options d'assistance technique gratuite ou payante. Suivez le lien 
Formation pour accéder aux ouvrages d'Adobe Press, à un grand nombre de ressources pour la formation, à des 
programmes de certification pour les logiciels Adobe et davantage encore.

Téléchargements
Visitez le site www.adobe.com/go/updates_fr pour bénéficier de mises à jour gratuites, de versions d'essai et d'autres 
logiciels utiles. En outre, Adobe Store (à l'adresse www.adobe.com/go/store_fr), met à votre disposition des milliers de 
modules externes, créés par des développeurs tiers, qui vous permettent d'automatiser vos tâches, de personnaliser vos flux 
de travaux et de créer des effets dignes de professionnels spécialisés, et davantage encore.

Adobe Labs
Adobe Labs vous donne l'occasion d'être confronté à des innovations, des technologies et des produits d'Adobe nouveaux 
et naissants et de pouvoir les évaluer. 

Sur Adobe Labs, vous avez accès à des ressources telles que les suivantes :

• Logiciels en version bêta et technologies

• Exemples de code et meilleures pratiques pour vous aider à accélérer votre apprentissage.

• Versions précoces des produits et documentation technique

• Forums, contenu basé sur wiki et autres ressources de collaboration pour vous aider à interagir avec des développeurs 
dans le même état d'esprit que vous.

Adobe Labs encourage un processus de développement de logiciel axé sur la collaboration. L'environnement permet aux 
clients de devenir productifs plus rapidement avec les nouveaux produits et technologies et aux équipes de développement 
Adobe de répondre et de réagir aux premières informations en retour pour remodeler le logiciel afin qu'il corresponde au 
mieux aux besoins et aux attentes de la communauté. 

Visitez Adobe Labs à l'adresse www.adobe.com/go/labs_fr.

Communautés d'utilisateurs
Des forums, des blogs et autres moyens d'échange sont mis à la disposition des utilisateurs pour leur permettre de partager 
des technologies, des outils et des informations, de poser des questions et de découvrir comment tirer pleinement parti de 
leurs logiciels. Les forums entre utilisateurs sont disponibles en anglais, français, allemand et japonais ; les blogs sont 
publiés dans un grand choix de langues.

Pour participer à des forums ou à des blogs, consultez le site www.adobe.com/go/communities_fr.

http://www.adobe.com/go/devcenter_fr
http://www.adobe.com/go/ctcs3_support
http://www.adobe.com/go/updates_fr
http://www.adobe.com/go/store_fr
http://www.adobe.com/go/labs_fr
http://www.adobe.com/go/communities_fr
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Nouveautés
Intégration d'Adobe Bridge CS3 à Adobe Contribute CS3  Comme prévu dans le cadre du processus d'intégration à Adobe 
Creative Suite 3, Adobe Contribute CS3 peut maintenant fonctionner avec Adobe Bridge. Cette intégration facilite les 
interactions entre Adobe Contribute et Adobe Bridge, ainsi que d'autres applications de la suite. Il en résulte que vous 
pouvez naviguer dans les ressources d'Adobe Bridge depuis Adobe Contribute et insérer des fichiers dans Contribute. De 
même, en conséquence de l'intégration d'Adobe Contribute avec les produits de la suite, le script de démarrage dans les 
divers programmes d'installation rendra Adobe Contribute CS3 disponible à toutes les applications Creative Suite 3.  (Voir 
la section « Intégration d'Adobe Bridge CS3 à Adobe Contribute CS3 », page 16).

Insertion de documents MS Office sous forme de PDF dans des pages Adobe Contribute Vous pouvez insérer des 
documents MS Word et MS Excel sous forme de PDF dans les pages Adobe Contribute (Windows uniquement). Au 
préalable, vous devez définir les paramètres de conversion et de sécurité pour convertir les documents au format PDF. 
L'installation d'Acrobat Elements et Acrobat Reader 8 est la seule condition requise pour l'utilisation de cette fonctionnalité. 
(Voir la section « Insertion de documents MS Office au format PDF dans des pages Contribute (Windows uniquement) », 
page 74).

Prise en charge de l'insertion de PDF dans des pages Adobe Contribute Vous pouvez insérer des fichiers PDF dans une 
page Adobe Contribute. (Voir la section « Insertion de documents PDF dans des pages Contribute », page 83).

Intégration d'Adobe Help Viewer 1.1 et Adobe Contribute CS3 AdobeContribute CS3 a été intégré à Adobe Help Viewer 1.1 
et, par conséquent, l'aide en ligne est très proche du format d'Adobe Help Viewer. Adobe Help Viewer est une application 
commune qui sert à ouvrir des fenêtres d'aide dans tous les produits Creative Suite 3.

Prise en charge améliorée du service de blogs (Blogger) Adobe Contribute CS3 intègre une prise en charge améliorée du 
service de blogs. Vous avez accès aux connexions de vos blogs grâce à l'authentification Gmail ou à vos détails de compte 
existants. 

Gestion améliorée des entrées de blog L'interface utilisateur améliorée d'Adobe Contribute CS3 vous permet de naviguer 
jusqu'à la page d'accueil d'un blog spécifique et de modifier les entrées de blog à l'aide de la case Liste des entrées en regard 
du champ Adresse. Pour actualiser la liste d'entrées, il vous suffit de cliquer sur l'icône prévue à cet effet en regard de cette 
liste. (Voir la section « Actualisation de la liste des entrées », page 56).

Sélection de modèles pour des documents MS Office lors de leur publication sur un site Web ou de leur ouverture dans Con-
tribute Vous pouvez utiliser Adobe Contribute CS3 pour placer du contenu statique depuis des documents MS Office (MS 
Word et MS Excel) dans des modèles avant de les publier au format HTML (Windows uniquement). En conséquence, 
lorsque vous exécutez Publier sur le site Web ou Ouvrir dans les opérations Contribute, vous pouvez sélectionner un 
modèle pour la page, ce qui affichera votre document sur le site visé. (Voir la section « Définition de modèles lors de 
l'ouverture de documents MS Office dans Contribute (Windows uniquement) », page 82).

Utilisation de fragments de code HTML dans des pages Adobe Contribute Les utilisateurs avancés de Contribute peuvent 
utiliser Adobe Contribute CS3 pour ajouter des fragments de code HTML personnalisés lors de l'édition d'un site Web ou 
d'un blog à l'aide de ce logiciel. Par exemple, vous pouvez utiliser des fragments de code pour lire des séquences vidéo ou 
audio sur votre blog ou site Web. (Voir la section « Insertion de fragments de code HTML dans des pages Contribute », 
page 85).

Prise en charge de l'insertion de fichiers multimédia enrichis à partir d'Internet Adobe Contribute CS3 vous permet 
d'insérer des fichiers image, Flash ou vidéo depuis Internet dans une page Web ou un blog.

Prise en charge d'Internet Protocol (IP) version 6 dans Contribute CS3  Adobe Contribute CS3 prend en charge le protocole 
IPv6. Les URL utilisant l'adressage IPv6 sont prises en charge uniquement avec le navigateur Internet Explorer 7 ou version 
ultérieure sous Windows. Bien que les versions antérieures de Contribute prennent en charge IPv4 uniquement, vous 
pouvez procéder à l'installation ou à la mise à niveau de Contribute CS3 sur des ordinateurs exécutant IPv6.

Connexion à des serveurs de blog à l'aide d'URL Dans Contribute CS3, vous pouvez créer une connexion à un serveur de 
blog en fournissant l'URL de la page d'accueil de votre blog ainsi que vos nom d'utilisateur et mot de passe. (Voir la section 
« Création d'une connexion à un site Web », page 179).

Prise en charge du serveur de blog Roller dans Contribute CS3 Adobe Contribute CS3 prend en charge le serveur de blog 
Roller. Lorsque vous créez une connexion à un serveur de blog Roller, vous devez définir le nom d'utilisateur, le mot de 
passe et le point d'accès.
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Aperçu d'un brouillon d'entrée de blog dans le navigateur Dans Adobe Contribute CS3, vous pouvez afficher un aperçu 
d'un brouillon d'entrée de blog dans un navigateur Web avant sa publication.

Sélection de plusieurs catégories et rétroliens Vous pouvez désormais sélectionner plusieurs catégories pour grouper des 
entrées de blog apparentées et insérer plusieurs retroliens dans un brouillon d'entrée de blog. 

Présentation du service de développement et de 
maintenance d'un site Web
Contribute fonctionne avec votre site Web existant, qu'il s'agisse d'un site public ou privé (intranet). Une équipe est souvent 
nécessaire pour assurer le bon fonctionnement d'un site et actualiser son contenu. 

L'équipe peut être composée des membres suivants : 

Les développeurs Web créent le site Web. Le développeur (ou l'équipe de création) construit le site à l'aide d'une application 
de création Web, Adobe Dreamweaver par exemple. Cette personne est responsable de la planification, de la conception, du 
développement, des tests et de la publication du site Web. Elle peut utiliser des modèles afin d'harmoniser l'aspect global du 
site.

Les développeurs Web utilisant Dreamweaver doivent consulter l'Aide de Dreamweaver pour plus d'informations.

Les utilisateurs de Contribute assurent la maintenance du site Web. Ces personnes sont des commerçants, cadres, ensei-
gnants, étudiants, gérants de petites entreprises, assistants administratifs ou chefs de projet qui utilisent Contribute pour 
maintenir leur site à jour. Aucune expérience de la conception Web ou HTML n'est nécessaire. L'environnement de travail 
est familier et intuitif pour l'utilisateur car Contribute fonctionne comme un traitement de texte. Les utilisateurs peuvent 
ajouter ou modifier du texte, des images, des tableaux, des liens, ainsi que des documents Microsoft Word et Excel.

Ce guide est conçu pour les utilisateurs de Contribute.

Les administrateurs Contribute définissent les utilisateurs de Contribute et les assistent dans l'utilisation de Contribute 
pour gérer le site Web. Les administrateurs Contribute sont également chargés de définir les différentes autorisations, afin 
de désigner les utilisateurs habilités à modifier le contenu du site Web et les dossiers que ces utilisateurs peuvent gérer. 
Contribute n'admet qu'un seul administrateur Contribute par site Web. Cependant, plusieurs personnes peuvent gérer le 
même site si l'administrateur Contribute partage son mot de passe d'administration.
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Chapitre 2 : Prise en main

Si Adobe® Contribute® CS3 ne se trouve pas sur votre ordinateur, installez-le à présent en suivant les instructions de 
« Installation », page 1. Avant de procéder à l'installation, assurez-vous que votre ordinateur dispose de la configuration 
minimale requise. Pour plus d'informations, voir « Conditions d'utilisation », page 1.

Avant d'utiliser Adobe® Contribute® CS3 pour modifier et mettre à jour le contenu de votre site Web ou de votre blog, vous 
devez établir une connexion au serveur Web sur lequel est stocké le site ou le blog. L'établissement d'une connexion permet 
à Contribute d'accéder aux pages de votre site Web et aux entrées de votre blog, ce qui vous donne la possibilité de modifier 
des pages ou des entrées de blog et de publier ces modifications.

Dans la plupart des cas, votre administrateur Contribute configure Contribute à votre place ou vous fournit les informa-
tions nécessaires pour vous connecter au site Web ou au serveur de blog.

Ce chapitre contient les sections suivantes :

• « Flux des travaux dans Contribute », page 11

• « Connexion à un site Web ou à un blog », page 12

• « Démarrage de Contribute sans connexion réseau », page 14

• « Intégration de Contribute aux applications Adobe Creative Suite 3 », page 15

• « Intégration d'Adobe Bridge CS3 à Adobe Contribute CS3 », page 16

Flux des travaux dans Contribute
Contribute utilise trois phases, accès à la page Web ou à l'entrée de blog, modification et publication, qui permettent de 
trouver facilement la page ou l'entrée de blog désirée, d'y effectuer des modifications et de la mettre à jour sur votre site Web 
ou sur le serveur de blog.

Remarque : Vous devez vous connecter à un site Web avant de pouvoir modifier et publier des pages sur ce site. De même, il est 
nécessaire d'établir une connexion avec un serveur de blog préalablement à l'ajout de modifications et à la publication d'entrées 
dans ce blog. Pour plus d'informations, voir la section « Connexion à un site Web ou à un blog », page 12.

La procédure générale suivante décrit le flux des travaux dans Contribute :

1. Naviguez jusqu'à la page ou l'entrée de blog voulue. Faites appel au navigateur de Contribute pour identifier la page 
Web ou l'entrée de blog à modifier. L'aspect de ce navigateur ne surprendra pas les utilisateurs de Microsoft Internet 
Explorer et d'autres outils de navigation courants. La barre d'outils du navigateur contient les boutons de navigation 
habituels et un bouton Choisir permettant d'atteindre les fichiers non liés à votre site Web. Vous pouvez créer des signets 
dans Contribute et afficher ceux définis dans Internet Explorer. Vous avez également la possibilité d'utiliser des raccourcis 
pour afficher rapidement les brouillons en cours.

2. Modifiez le contenu. Une fois que vous avez atteint la page ou l'entrée de blog voulue, cliquez sur le bouton Modifier 
la page ou Modifier l'entrée de la barre d'outils afin d'ouvrir la page Web ou l'entrée de blog dans l'éditeur de Contribute. 
Contribute copie le fichier à partir du serveur Web ou du serveur de blog et le verrouille sur le serveur de manière à 
empêcher toute autre personne de modifier cette page ou cette entrée de blog pendant que vous y apportez des change-
ments. 

Le fonctionnement de l'éditeur de Contribute s'apparente à celui d'une application de traitement de texte. Vous pouvez 
modifier le texte, les images, les tableaux, les liens de la page ou l'entrée de blog et même ajouter des documents Microsoft 
Word ou Excel au site Web ou à l'entrée de blog. La barre d'outils contient les boutons de modification habituels de même 
que des boutons permettant d'enregistrer, d'annuler ou de publier les changements que vous effectuez.
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3. Publiez les modifications apportées. Une fois la page ou l'entrée de blog modifiée, vous pouvez la publier sur votre site 
Web ou votre serveur de blog. Cliquez sur le bouton Publier. Contribute remplace alors la page ou l'entrée de blog existante 
sur le serveur Web ou le serveur de blog par la version modifiée. Contribute déverrouille ensuite le fichier sur le serveur de 
sorte que les autres utilisateurs sont à nouveau en mesure d'accéder à la page ou à l'entrée de blog à des fins de modification.

Remarque : Dans Contribute, les autorisations relatives au rôle qui vous a été attribué indiquent si vous êtes habilité à publier 
des pages Web. Si vous n'êtes pas autorisé à publier des pages Web, servez-vous de l'option Envoyer pour la révision afin de 
transférer le brouillon à un autre utilisateur. Selon les protocoles pris en charge par votre serveur de blog, il est possible que vous 
soyez limité dans le type de contenu que vous pouvez publier dans vos entrées de blog.

Connexion à un site Web ou à un blog
Contribute vous permet de vous connecter rapidement et facilement à votre site Web ou votre blog.

Connexion à un site Web
Votre administrateur de Contribute procédera de l'une des manières suivantes pour vous aider à établir une connexion à 
votre site Web :

• Il vous enverra un message électronique contenant un fichier de clé de connexion au site Web (voir la section « Utilisation 
d'une clé de connexion à un site Web », page 12).

La clé de connexion contient toutes les informations réseau dont Contribute a besoin pour se connecter à votre site Web. 

Remarque : Les clés de connexion sont réservées aux connexions établies avec des sites Web ; elles ne s'utilisent pas pour des 
connexions à un blog.

• Il vous fournira les informations de connexion nécessaires que vous pourrez ensuite indiquer dans l'assistant de 
connexion (voir la section « Création d'une connexion à un site Web », page 179)

Si vous utilisez un Macintosh et que vous disposez d'un compte .Mac, Contribute le détecte et vous demande si vous 
souhaitez vous y connecter. 

Si votre site Web est géré par Contribute Publishing Server, l'administrateur vous envoie une clé de connexion ou des infor-
mations de connexion à saisir sur la barre d'adresses du navigateur de Contribute. 

Connexion à un blog
Pour vous connecter à un blog, vous avez besoin des informations de connexion nécessaires pour le blog pour que puissiez 
saisir les informations dans l'assistant de connexion. Vous avez la possibilité d'utiliser l'API MetaWeblog pour vous 
connecter à un compte de blog hébergé par un service de publication de blogs tel que Blogger, WordPress, Roller ou 
TypePad, ou un serveur interne. Si vous utilisez un ordinateur Macintosh et que vous disposez d'un compte .Mac, 
Contribute détecte ce compte et vous demande s'il doit établir une connexion avec lui.

Remarque : Les clés de connexion ne s'utilisent pas pour des connexions à un blog ; elles sont réservées aux connexions établies 
avec des sites Web.

Pour plus d'informations sur la connexion à un blog, voir « Création d'une connexion à un serveur de blog », page 180.

Utilisation d'une clé de connexion à un site Web 
L'administrateur Contribute peut vous fournir une clé de connexion à utiliser pour établir une connexion à votre site Web. 
La clé de connexion contient toutes les informations réseau dont Contribute a besoin pour se connecter à votre site Web. 

L'administrateur Contribute vous envoie un message électronique contenant la clé. Cette clé de connexion se présente sous 
forme de fichier ou d'adresse URL. 

Remarque : Au lieu de vous l'envoyer dans un message électronique, l'administrateur Contribute peut également vous indiquer 
l'emplacement réseau à partir duquel vous pouvez télécharger la clé de connexion. 
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Pour importer la clé de connexion à un site Web :
1 Ouvrez le message contenant la clé de connexion. 

La clé se présente sous forme de fichier joint.

2 Double-cliquez sur la clé de connexion. 

3 Procédez de l'une des manières suivantes :

• Si la boîte de dialogue Importer la clé de connexion s'ouvre, saisissez votre nom, votre adresse électronique et le mot de 
passe de la clé de connexion, puis cliquez sur OK.

• Si la boîte de dialogue Se connecter à Publishing Server s'ouvre, tapez votre nom d'utilisateur et votre mot de passe, puis 
cliquez sur OK.

Remarque : Si vous ignorez le mot de passe, contactez l'administrateur Contribute qui vous a fourni la clé de connexion.

4 Si le système vous demande d'autres informations de connexion (telles que le site FTP), fournissez-les, puis cliquez 
sur OK.

Dès que la connexion est établie, la page d'accueil du site Web s'ouvre dans le navigateur de Contribute. 

Saisie d'un mot de passe de démarrage de Contribute. 
Si l'option Exiger un mot de passe au démarrage de Contribute est activée dans la catégorie Sécurité de la boîte de dialogue 
Préférences, le logiciel vous demande ce mot de passe au démarrage de Contribute. 

Un mot de passe de démarrage permet d'empêcher des utilisateurs non autorisés de modifier ou de publier des pages sur 
votre site Web et des entrées de votre blog. Si le mot de passe requis n'est pas saisi au démarrage de Contribute, les pages 
Web et les blogs sont désactivés et impossibles à activer. Vous avez seulement la possibilité de parcourir et de créer des pages 
Web ou des entrées de blog. Après avoir saisi le mot de passe correct, vous pouvez effectuer des mises à jour et publier vos 
modifications ou vos nouvelles entrées sur les sites Web et les blogs connectés tant que vous laissez Contribute ouvert.

Dans Contribute, lorsque l'option Demander un mot de passe au démarrage est activée, Contribute fournit non seulement 
un accès sécurisé, mais il applique également une méthode de chiffrement plus sophistiquée lors de l'enregistrement de vos 
informations de connexion sur l'ordinateur.

Remarque : Si vous recevez une clé de connexion exigeant un mot de passe au démarrage de Contribute, vous devez créer ce 
mot de passe avant de pouvoir importer la clé de connexion.

Pour saisir un mot de passe au démarrage de Contribute :
1 Dans la boîte de dialogue de saisie du mot de passe, tapez le mot de passe de démarrage de Contribute.

Trois essais seulement sont autorisés pour la saisie du mot de passe. A la troisième erreur, Contribute se verrouille et vous 
ne pouvez plus y accéder. Vous devez alors redémarrer Contribute afin de pouvoir ressaisir le mot de passe. 

Si vous avez oublié ce mot de passe, vous devez supprimer toutes les connexions à votre site Web, puis les ajouter à nouveau.

2 Cliquez sur OK.

Remarque : Si vous cliquez sur Ignorer, l'invite se ferme et Contribute démarre. Dans ce cas, vous ne pouvez que modifier ou 
annuler les brouillons existants. Pour modifier les autres pages ou publier les modifications que vous avez apportées aux 
brouillons, vous devez redémarrer Contribute et saisir le mot de passe approprié.
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Démarrage de Contribute sans connexion réseau 
Lorsque vous démarrez Contribute, il vérifie que votre connexion réseau vous permet d'accéder à votre site Web ou blog. 
Contribute vous avertit s'il ne détecte aucune connexion.

Si vous démarrez Contribute sans être connecté et qu'un message d'échec de connexion s'affiche, deux choix s'offrent à 
vous :

• Si vous souhaitez travailler hors connexion, choisissez Travailler hors connexion. Pour plus d'informations, voir la 
section « Utilisation de Contribute hors connexion », page 51. 

• Sélectionnez Essayer de se connecter malgré tout si vous n'êtes pas sûr de l'origine du problème et que vous souhaitez 
que Contribute tente de se connecter à nouveau. Si Contribute ne parvient toujours pas à se connecter, vous pouvez 
désactiver le site Web ou le blog et continuer à vérifier vos connexions à d'autres sites Web ou blogs, le cas échéant. Pour 
plus d'informations, voir la section « Désactivation de votre site Web ou blog au démarrage », page 14.

Pour plus d'informations sur la résolution des problèmes de connexion, voir « Dépannage », page 225. 

Désactivation de votre site Web ou blog au démarrage
Contribute vous prévient s'il détecte une anomalie de connexion à l'un de vos sites Web ou blog au démarrage. Contribute 
affiche un avertissement dès qu'il décèle la première anomalie de connexion.

Vous pouvez demander à Contribute de tenter de se connecter à nouveau. Si Contribute ne parvient toujours pas à se 
connecter, désactivez la connexion à ce site Web ou ce serveur de blog et essayez de vous connecter à d'autres sites Web et 
blogs. Si vous désactivez un site Web ou un serveur de blog, vous pouvez le réactiver après avoir résolu votre problème de 
connexion.

Remarque : Vous pouvez désactiver un site Web ou un blog non seulement au démarrage mais à tout moment, dès qu'un 
problème se présente. Si vous disposez de plusieurs sites et blogs, vous pouvez désactiver ceux sur lesquels vous ne travaillez pas 
actuellement. Ainsi, Contribute n'est pas obligé de maintenir la connexion à ces sites sur de longues périodes. Pour plus d'infor-
mations, voir la section « Désactivation de connexions à des sites Web et à des blogs », page 203.

Pour désactiver un site Web ou un serveur de blog en cas d'échec de la connexion :
1 Lancez Contribute.

La boîte de dialogue Echec de la connexion s’ouvre.

2 Choisissez Essayer de se connecter malgré tout afin d'obliger Contribute à poursuivre les tentatives de connexion réseau.

3 Si Contribute ne parvient toujours pas à se connecter, Contribute affiche un message d'erreur présentant deux options :

• Cliquez sur Oui afin de poursuivre les tentatives de connexion à d'autres sites Web et serveurs de blog.

• Cliquez sur Non pour désactiver vos autres sites Web et serveurs de blog.

4 Cliquez sur OK.

Activation d'un site Web ou d'un blog désactivé
1 Naviguez jusqu'à une page de votre site Web ou une entrée du blog, puis cliquez sur Connecter dans la barre d'outils.

2 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

3 Procédez de l'une des manières suivantes :

• Pour activer un site Web, sélectionnez son nom dans la liste, puis cliquez sur Activer.

• Pour activer un blog, sélectionnez le serveur de blog sous lequel le blog est répertorié, puis cliquez sur Activer. Tous les 
blogs figurant dans la liste de ce serveur sont activés. Il est impossible d'activer des blogs spécifiques.

4 Cliquez sur Fermer.
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Intégration de Contribute aux applications Adobe 
Creative Suite 3
Vous avez la possibilité d'exécuter des scripts de démarrage personnalisés au cours de l'installation d'autres applications 
d'Adobe Creative Suite 3 en vue d'activer l'accès à Adobe Contribute à partir du produit approprié de la suite. Lors de 
l'exécution de ces scripts, les menus, options et icônes de barres d'outils d'Adobe Contribute sont créés dans les applications 
de Creative Suite 3. Parallèlement, les menus, options et icônes de barres d'outils pertinents des applications de Creative 
Suite 3 sont insérés dans Adobe Contribute.

Exécution d'opérations Adobe Contribute dans des applications de Creative Suite 3
Le Cross DOM est un petit API qui propose un jeu de fonctions communes à toutes les applications Adobe Creative Suite 
3. Il s'agit notamment des fonctions d'ouverture de fichiers, d'exécution de scripts et d'impression de documents. Faites 
appel à l'API Cross DOM dans vos scripts de démarrage afin d'effectuer une ou plusieurs des opérations suivantes dans 
toutes les applications d'Adobe Creative Suite 3 :

• Ouvrez une nouvelle page Web ou une nouvelle entrée de blog dans Adobe Contribute à partir d'une autre application 
Creative Suite 3 à l'aide de la fonction d'ouverture de l'API Cross-DOM. Vous pouvez également ouvrir des fichiers dans 
Adobe Contribute à partir d'une autre application Creative Suite 3 à l'aide de l'API Cross-DOM incluse dans un script de 
démarrage.

• Ouvrez des fichiers à partir des applications de Creative Suite 3 suivantes dans Adobe Contribute à l'aide de la fonction 
d'ouverture de l'API Cross-DOM : Adobe Bridge, Adobe Photoshop, Adobe Illustrator, Adobe InDesign, Adobe Acrobat, 
Adobe Flash, Adobe Dreamweaver et Adobe Fireworks.

• Ouvrez des fichiers audio et vidéo à partir des applications de Creative Suite 3 suivantes à l'aide de la fonction d'ouverture 
de l'API Cross-DOM : Adobe After Effects, Adobe Premiere Pro, Adobe Audition et Adobe Encore. S'il est possible 
d'afficher le fichier dans le navigateur incorporé, il s'ouvre dans ce dernier.

• Modifiez les fichiers dans l'une des applications suivantes de Creative Suite 3 et appelez la fonction Afficher pour passer 
à Adobe Contribute : Adobe Bridge, Adobe Photoshop, Adobe Illustrator, Adobe InDesign, Adobe Acrobat, Adobe Flash, 
Adobe Dreamweaver, Adobe Fireworks, Adobe After Effects, Adobe Premiere Pro, Adobe Audition et Adobe Encore. 

• Imprimez des fichiers à partir des applications de Creative Suite 3 suivantes dans Adobe Contribute à l'aide de l'impri-
mante PDF et de la fonction d'impression de l'API Cross-DOM : Adobe Bridge, Adobe Photoshop, Adobe Illustrator, 
Adobe InDesign, Adobe Acrobat, Adobe Flash, Adobe Dreamweaver et Adobe Fireworks.

• Imprimez des fichiers à partir des applications de Creative Suite 3 suivantes à l'aide de la fonction d'impression de l'API 
Cross-DOM : Adobe After Effects, Adobe Premiere Pro, Adobe Audition et Adobe Encore. (Bien que les fichiers vidéo 
soient rarement imprimés, cette opération vous permet de vérifier si les applications associées réagissent aux messages 
de BridgeTalk.)

• Fermez Adobe Contribute à partir d'autres applications de Creative Suite 3 à l'aide de la fonction de fermeture de l'API 
Cross-DOM.

• Quittez Adobe Contribute à partir des applications de Creative Suite 3 suivantes à l'aide de la fonction Quitter de l'API 
Cross-DOM : Adobe Bridge, Adobe Photoshop, Adobe Illustrator, Adobe InDesign, Adobe Acrobat, Adobe Flash, Adobe 
Dreamweaver, Adobe Fireworks, Adobe After Effects, Adobe Premiere Pro, Adobe Audition et Adobe Encore. 

Remarque : Les scripts d'Adobe Bridge faisant appel au protocole BridgeTalk rendent possible la communication entre Adobe 
Contribute et les applications d'Adobe Creative Suite 3. L'objet message BridgeTalk permet d'envoyer des paquets de messages 
entre les applications.
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Intégration d'Adobe Bridge CS3 à Adobe Contribute CS3
Le logiciel Adobe Bridge CS3 est le nouveau centre de contrôle de navigation conçu pour les applications Adobe Creative 
Suite 3 et leurs composants. Adobe Bridge CS3 propose un accès centralisé à vos fichiers de projets, applications et 
paramètres Creative Suite 3.

Adobe Contribute CS3 a été intégré à l'application Adobe Bridge dans la version 3 d'Adobe Creative Suite. Cette intégration 
vous permet d'effectuer les tâches suivantes :

• Organisation des actifs

• Insertion de fichiers

• Communication entre applications à l'aide du protocole BridgeTalk

• Accès aux galeries de photos Adobe

Insertion de fichiers à partir d'Adobe Bridge dans Adobe Contribute
Avec Adobe Bridge, vous pouvez insérer des fichiers ou des dossiers dans des pages Web ou des brouillons d'entrées de blog 
dans Adobe Contribute. Si le brouillon Contribute prend en charge le type de fichier sélectionné, le fichier est placé dans le 
brouillon ou un lien y renvoyant s'affiche dans le brouillon. Les fichiers dont le type n'est pas pris en charge ne sont pas 
insérés dans le brouillon.

Pour insérer des fichiers d'Adobe Bridge dans Adobe Contribute :
1 Lancez Adobe Contribute.

2 Ouvrez un brouillon d'une page Web ou d'une entrée de blog.

Remarque : Si vous tentez de placer un fichier dans Adobe Contribute alors que l'application n'est pas en cours d'exécution ou 
qu'un brouillon de page Web ou d'entrée de blog n'est pas ouvert, un message vous informe qu'aucun brouillon n'est ouvert pour 
y placer un fichier.

3 Sélectionnez Fichier > Parcourir ou cliquez sur l'icône de la barre d'outils Bridge . 

Remarque : Vous pouvez sélectionner plusieurs fichiers ou dossiers à placer dans un brouillon Contribute.

Adobe Bridge s'ouvre dans une fenêtre distincte.

4 Dans Adobe Bridge, sélectionnez le fichier à insérer.

5 Choisissez Fichier > Ouvrir avec > Contribute.

Le fichier ou un lien renvoyant à celui-ci est inséré dans le brouillon Contribute. Si vous sélectionnez un fichier dont le type 
n'est pas pris en charge, il ne sera pas inséré dans le brouillon.

Remarque : Une autre solution pour insérer un fichier dans un brouillon de page Web ou d'entrée de blog Contribute consiste 
à faire glisser le fichier depuis l'Explorateur Windows ou le Finder de Macintosh et à le déposer sur le brouillon Contribute.

Ouverture de fichiers depuis Adobe Bridge dans Adobe Contribute (Windows uniquement)
Vous pouvez sélectionner un fichier dans Adobe Bridge et l'ouvrir dans Adobe Contribute.

Pour ouvrir un fichier à partir d'Adobe Bridge dans Adobe Contribute :
1 Démarrez Adobe Bridge.

2 Sélectionnez le fichier à ouvrir dans Contribute.

Remarque : Vous pouvez ouvrir des documents Microsoft Word avec l'extension .doc ou .docx, et des documents Excel avec .xls, 
xlsm ou .xlsx.

3 Sélectionnez Outils > Contribute > Ouvrir dans Contribute.

Remarque : Le menu Outils > Contribute > Ouvrir dans Contribute est disponible pour la plate-forme Windows uniquement.

Contribute est lancé et le contenu du document Word ou Excel est inséré dans le brouillon de page Web en fonction de 
l'option d'insertion que vous avez choisie.
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Publication de fichiers d'Adobe Bridge dans Adobe Contribute (Windows uniquement)
Vous pouvez sélectionner les types de fichiers suivants dans Adobe Bridge et les publier dans Adobe Contribute : .doc, .xls, 
.docx, .xlsm et .xlsx. Lors de la publication d'un document MS Office contenant d'autres fichiers, ces fichiers supplémen-
taires sont automatiquement copiés dans votre brouillon de page Web. 

Pour publier un fichier à partir d'Adobe Bridge dans Adobe Contribute :
1 Démarrez Adobe Bridge.

2 Sélectionnez le fichier à publier dans Adobe Contribute.

3 Choisissez Outils > Contribute > Publier sur le site Web.

Remarque : Le menu Outils > Contribute > Publier sur le site Web est disponible pour la plateforme Windows uniquement.

La boîte de dialogue Contribute - Publier sur le site Web s'affiche.

4 Pour sélectionner les paramètres de publication du document, procédez de la manière suivante : 

a Sélectionnez le site Web sur lequel vous souhaitez publier le fichier. 

Remarque : Si vous ne disposez pas d'une connexion à votre site Web avant la publication d'un document, vous pouvez toujours 
en créer une en sélectionnant Créer une connexion dans le menu contextuel Sélectionner de la boîte de dialogue Publier sur le 
site Web. Pour plus d'informations sur la création d'une connexion à un site Web, voir la section « Création d'une connexion à 
un site Web », page 179.

b Sélectionnez l'emplacement de stockage du fichier. 

Remarque : Vous pouvez sélectionner plusieurs fichiers ou dossiers à partir d'Adobe Bridge en vue de les publier dans 
Contribute.

c Saisissez un nom de fichier. Le nom de fichier ne doit pas contenir d'espaces, de tabulations et de caractères alphanumé-
riques.

d Sélectionnez un format. 

e (Facultatif) Désactivez la case à cocher Publier la sélection actuelle uniquement afin de publier la totalité du document 
et pas simplement la sélection. 

Vous pouvez aussi définir ces préférences dans l'onglet Documents Microsoft du menu Modifier dans Contribute. Pour ce 
faire, choisissez Edition > Préférences > Documents Microsoft et effectuez votre choix. Pour plus d'informations sur la 

définition de ces préférences, consultez la section« Définition des préférences dans Contribute », page 27.

5 Cliquez sur Publier. 

Contribute publie le document sur votre page Web et une boîte de dialogue de confirmation apparaît.

Remarque : Si Contribute n'est pas en cours d'exécution lorsque vous publiez un fichier d'Adobe Bridge vers Contribute, Adobe 
Contribute démarre, puis la boîte de dialogue Contribute - Publier sur le site Web s'ouvre.

6 Cliquez sur OK.
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Chapitre 3 : Exploration de l'espace de 
travail de Contribute

Vous pouvez utiliser Adobe® Contribute® CS3 comme navigateur et éditeur de pages Web. Vous pouvez aisément passer de 
la navigation à la modification des pages Web. L'espace de travail de Contribute facilite l'accès aux pages, que vous soyez en 
train de naviguer ou d'effectuer des modifications. 

Vous pouvez naviguer au sein des boîtes de dialogue et de l'espace de travail de Contribute sans utiliser votre souris. Vous 
pouvez également définir des préférences pour personnaliser Contribute.

 Ce chapitre contient les sections suivantes :

• « Espace de travail de Contribute », page 19

• « Basculement entre les modes navigation et modification », page 23

• « Accès aux pages Web et aux entrées de blog », page 23

• « Ouverture des pages Web et des entrées de blog sans passer par le mode navigation », page 24

• « Configuration de l'accès aux pages couramment utilisées », page 26

• « Définition des préférences dans Contribute », page 27

• « Modification ou désactivation du mot de passe de démarrage de Contribute », page 28

• « Configuration du codage du navigateur », page 29

• « Utilisation des fonctions d'accessibilité de Contribute », page 29

Espace de travail de Contribute
L'espace de travail de Contribute se compose de trois zones principales : le navigateur et l'éditeur de Contribute, la barre 
d'outils et le panneau de navigation. 

A. Barre d'outils B. Page d'accueil du navigateur et de l'éditeur C. Panneau de navigation



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

20

Navigateur et éditeur de Contribute
La fenêtre principale de Contribute sert à naviguer et à insérer des modifications. Si vous ignorez dans quel mode vous êtes, 
navigation ou modification, reportez-vous à la barre d'outils. Son contenu diffère selon le mode actif (voir la section 
« Barres d'outils de Contribute », page 20).

Le navigateur de Contribute permet de consulter n'importe quelle page Web, pas seulement celles de votre site. Son 
fonctionnement est le même que celui d'un navigateur Web classique : il suffit de cliquer sur les liens des pages Web pour 
atteindre celle que vous souhaitez modifier. Vous pouvez également créer des signets pour les pages que vous consultez 
fréquemment.

L'éditeur de Contribute permet de modifier les pages des sites Web auxquels vous vous êtes connecté (voir la section 
« Connexion à un site Web ou à un blog », page 12). Vous pouvez modifier le texte, les images, les tableaux, les liens et les 
pages contenant des cadres. Vous pouvez publier vos modifications pour que la version mise à jour soit effective sur votre 
site.

Vous pouvez aisément naviguer et modifier des pages Web dans Contribute, et passer d'un mode à l'autre sans aucune diffi-
culté. Pour plus d'informations, voir la section « Basculement entre les modes navigation et modification », page 23.

Barres d'outils de Contribute
Selon le mode actif, navigation ou modification d'une page Web ou d'une entrée de blog, le contenu de la barre d'outils de 
Contribute change. En mode modification, la barre d'outils de l'éditeur permet de modifier le texte ou les images, selon le 
contenu sélectionné. Lorsque vous modifiez un brouillon pour votre blog, les métadonnées du blog et les barres d'outils de 
métadonnées secondaires sont également disponibles.

Selon le rôle qui vous a été affecté par l'administrateur Contribute, certains boutons peuvent ne pas être disponibles.

Les boutons de la barre d'outils du navigateur permettent de parcourir votre site Web ou de créer une page ou une entrée 
de blog. La barre d'outils du navigateur contient les mêmes options qu'il s'agisse d'un site Web ou d'un blog.

Les boutons de la barre d'outils de l'éditeur permettent d'effectuer les opérations courantes à partir des menus Fichier, 
Insertion, Format et Tableau. Les options de la barre d'outils de l'éditeur varient selon que vous soyez en train de modifier 
un brouillon pour un site Web ou un blog.

A. Boutons d'action B. Insérer du contenu C. Ajouter une ligne ou une colonne D. Propriétés de la page E. Atteindre Adobe Bridge CS3

La barre d'outils de métadonnées du blog contient des informations sur le brouillon, y compris le titre du blog, le titre de 
publication du blog et les balises qui leur sont associées. Cette barre d'outils n'est disponible que pour les brouillons de blog.

La barre d'outils de métadonnées secondaires contient des options supplémentaires permettant d'associer des 
métadonnées à une entrée de blog. Cette barre d'outils n'est disponible que pour les brouillons de blog.
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Les boutons de la barre d'outils de mise en forme du texte permettent de mettre le texte en forme. Les options de la barre 
d'outils de mise en forme du texte varient également selon que vous travaillez sur un brouillon pour un site Web ou un blog.

A. Menu Style B. Menu Police C. Menu Taille de police D. Gras E. Italique F. Boutons d'alignement G. Boutons de liste H. Boutons Retrait 
négatif/Retrait I. Couleur du texte J. Couleur de mise en surbrillance

Remarque : Si l'administrateur Contribute a limité la modification au texte seul, certaines options de mise en page ne sont pas 
disponibles. En outre, certaines options peuvent être désactivées lorsque des styles CSS ont été appliqués à une sélection de texte.

Les outils de la barre d'outils de retouche d'image contiennent des boutons pour retoucher les images.

A. Redimensionner B. Boutons de rotation C. Recadrer D. Accentuer E. Luminosité/Contraste F. Style G. Redimensionner H. Alignement I. 
Propriétés de l'image

Panneau de navigation de Contribute
Ce panneau de Contribute facilite le passage entre les modes navigation et modification et vous permet d'accéder 
rapidement à vos brouillons. Vous pouvez également l'utiliser pour accéder rapidement aux instructions afin d'exécuter des 
tâches dans Contribute.

Le panneau de navigation est composé de deux parties :

Le panneau Pages permet d'accéder au navigateur Web et à tous les brouillons que vous êtes en train de modifier. Un lien 
vers la Console de brouillons, où est indiqué l'état des brouillons, est également présent.

Remarque : La Console de brouillons n'est pas disponible lorsqu'aucun administrateur n'est affecté à votre site Web.

Le panneau Comment fournit les procédures à suivre pour effectuer certaines tâches courantes de Contribute. Il affiche la 
liste des tâches liées à la navigation lorsque vous êtes en train de naviguer et la liste des tâches liées à la modification lorsque 
vous effectuez des modifications. 

Cliquez sur un lien dans le panneau Comment du panneau de navigation pour obtenir plus d'informations sur cette tâche. 
Si la tâche que vous recherchez ne se trouve pas dans la liste, reportez-vous à l'aide de Contribute (Aide > Aide d'Adobe 
Contribute) pour obtenir des informations détaillées.

Remarque : Pour plus d'informations sur l'utilisation des ressources de Contribute et obtenir de l'aide, voir la section 
« Ressources », page 4.
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A. Panneau Comment B. Panneau Pages C. Barre de séparation

Vous pouvez agrandir, réduire ou redimensionner les différentes parties du panneau de navigation.

Pour agrandir ou réduire le panneau de navigation, procédez de l'une des manières suivantes :
• Choisissez Affichage > Panneau de navigation.

• Sous Windows, cliquez sur la flèche de la barre de séparation située entre le panneau de navigation et le 
navigateur/éditeur de Contribute. 

• Sur un système Macintosh, double-cliquez sur l'outil main de la barre de séparation située entre le panneau de navigation 
et le navigateur/éditeur de Contribute. 

Pour redimensionner le panneau de navigation :
• Faites glisser la barre de séparation entre le panneau de navigation et le navigateur/éditeur de Contribute.

Pour agrandir ou réduire une partie du panneau de navigation :
• Double-cliquez sur la barre de titre du panneau. 

Pour redimensionner verticalement les différentes parties du panneau de navigation :
• Faites glisser la barre de titre du panneau Comment.
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Basculement entre les modes navigation et modification
Dans Contribute, vous pouvez parcourir ou modifier des pages Web ou des entrées de blog. A tout moment, vous pouvez 
basculer entre la navigation et la modification. Lorsque vous fermez un brouillon que vous êtes en train de modifier, 
Contribute enregistre vos modifications. Ainsi, lorsque vous retournez dans le brouillon ultérieurement, vous pouvez 
continuer vos modifications là où vous les avez laissées.

Si vous basculez en mode de navigation, Contribute ne publie pas votre brouillon. Pendant que vous parcourez la page ou 
l'entrée de blog, la zone de message vous informe de l'existence d'un brouillon non publié pour cette page ou entrée de blog. 

Si vous n'êtes pas sûr d'être en mode navigation ou modification dans Contribute, reportez-vous à la barre d'outils. En mode 
navigation, la barre d'outils comporte un bouton Modifier la page (ou Créer une connexion). En mode modification, la 
barre d'outils de l'éditeur est affichée (voir la section « Barres d'outils de Contribute », page 20).

Pour passer du mode de navigation à celui de modification, procédez de l'une des manières suivantes :
• Cliquez sur le bouton Modifier la page de la barre d'outils pour modifier une page Web ou sur le bouton Modifier l'entrée 

pour modifier une entrée de blog.

Remarque : Ces boutons ne sont activés que sur les pages des sites Web ou les entrées de blogs auxquels vous êtes connecté et 
que vous êtes autorisé à modifier.

• Dans le panneau Pages du panneau de navigation, cliquez sur le titre d'un brouillon.

Pour passer du mode de modification à celui de navigation, procédez de l'une des manières suivantes :
• Dans le panneau Pages du panneau de navigation, cliquez sur Navigateur.

• Cliquez sur le bouton Enregistrer pour plus tard de la barre d'outils.

• Choisissez Affichage > Navigateur.

Accès aux pages Web et aux entrées de blog
Le moyen le plus simple pour localiser une page Web ou une entrée de blog à modifier consiste à la rechercher dans 
Contribute, comme vous le feriez pour y accéder à l'aide d'un navigateur Web classique.  

Pour apprendre à utiliser d'autres moyens permettant de retrouver vos pages Web ou vos entrées de blog, consultez 
« Ouverture des pages Web et des entrées de blog sans passer par le mode navigation », page 24.

Remarque : (Windows uniquement) Si vous utilisez Microsoft Internet Explorer en tant que navigateur Web principal, le 
navigateur de Contribute utilise les mêmes préférences que celles d'Internet Explorer. Pour modifier les paramètres de base, tels 
que la police, les cookies ou les modules externes, modifiez vos préférences dans Internet Explorer, puis redémarrez Contribute.

Vous pouvez naviguer jusqu'à un site Web ou une entrée de blog quelconque avec Contribute, mais vous ne pouvez modifier 
que les pages Web et les entrées de blog qui se trouvent dans vos sites Web et blogs, autrement dit les sites Web et les blogs 
pour lesquels vous avez créé des connexions (pour plus d'informations, voir « Connexion à un site Web ou à un blog », 
page 12). Lorsque vous parcourez une page qui se trouve dans votre site Web ou une entrée de blog et que vous disposez 
des autorisations de modification, le bouton Modifier la page de la barre d'outils est actif.
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Pour accéder à une page Web ou une entrée de blog dans Contribute, procédez de l'une des manières suivantes :
• Cliquez sur les liens dans les pages Web ou les entrées de blog pour naviguer vers d'autres pages.

• Saisissez l'adresse Web (URL) de la page dans le champ Adresse, puis cliquez sur Atteindre. Vous pouvez également 
appuyer sur la touche Entrée ou Retour.

• Choisissez Affichage > Atteindre l'adresse Web, saisissez l'adresse Web (URL), puis cliquez sur OK.

Ouverture des pages Web et des entrées de blog sans 
passer par le mode navigation
Dans Contribute, vous pouvez ouvrir des pages Web ou des entrées de blog sans passer par le mode de navigation. Pour 
plus d'informations, voir les sections suivantes :

• « Affichage de brouillons et de nouvelles pages ou entrées de blog », page 25

• « Affichage des pages d'accueil de vos sites Web et blogs », page 25 

• « Affichage des pages Web et des entrées de blog publiées récemment », page 25

• « Affichage de pages et de fichiers vers lesquels vous ne pouvez pas naviguer », page 25

• « Affichage de pages dans votre liste de signets », page 26

A. Brouillons en cours B. Signets C. Pages d'accueil D. Pages qui ne comportent pas de lien
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Affichage de brouillons et de nouvelles pages ou entrées de blog
Le panneau Pages présente les titres des brouillons en cours de modification. Ces brouillons sont également accessibles à 
partir du menu Fichier.

Pour afficher un brouillon, procédez de l'une des manières suivantes :
• Dans le panneau Pages du panneau de navigation, cliquez sur le titre du brouillon.

• Choisissez Fichier > Brouillons, puis sélectionnez un brouillon dans le menu déroulant.

Affichage des pages d'accueil de vos sites Web et blogs
La barre d'outils permet d'accéder aux pages d'accueil de tous vos sites Web et blogs. Le menu Affichage permet également 
d'accéder aux pages Web et entrées de blog.

Pour afficher la page d'accueil d'un site Web ou d'un blog auquel vous êtes connecté, procédez de l'une des manières 
suivantes :
• Cliquez sur le bouton Pages d'accueil de la barre d'outils, puis sélectionnez-en une.

• Choisissez Affichage > Pages d'accueil, puis sélectionnez-en une dans le menu déroulant.

Affichage des pages Web et des entrées de blog publiées récemment
Le menu Fichier permet d'accéder rapidement aux pages Web et aux entrées de blog publiées récemment.

Pour afficher une page Web ou une entrée de blog publiée récemment :
• Choisissez Fichier > Pages récentes et entrées de blog, puis sélectionnez-en une dans le menu déroulant.

Affichage des entrées de blog
Le menu contextuel Entrées propose un accès rapide à une entrée de blog à partir de votre page d'accueil de blog.

Pour afficher une entrée de blog :
1 Accédez à la page d'acceuil de votre blog.

2 Dans le menu déroulant Entrées, sélectionnez l'entrée de blog à gérer. Vous pouvez également sélectionner une entrée 
de blog en utilisant Affichage > Sélectionner une entrée de blog > Titre d'entrée de blog.

L'entrée de blog sélectionnée apparaît dans le navigateur intégré et le titre de l'entrée de blog sélectionnée est affiché dans 
le menu contextuel Entrées. 

Remarque : Si une entrée de blog ne comporte pas de titre, le titre de l'entrée de blog apparaît en tant que <Entrée de blog sans 
titre> dans le menu contextuel Entrées.

Affichage de pages et de fichiers vers lesquels vous ne pouvez pas naviguer
Contribute permet d'accéder aux pages et aux fichiers associés à votre site Web ou blog, mais vers lesquels vous ne pouvez 
pas naviguer. Le bouton Choisir de la barre d'outils permet d'accéder aux pages et aux fichiers enregistrés dans un dossier 
du site Web, mais qui ne sont liés à aucune page de votre site ou blog.

Pour afficher une page ou un fichier non lié à une autre page Web ou entrée de blog :
1 Dans le navigateur ou l'éditeur de Contribute, choisissez Affichage > Choisir un fichier ou une entrée de blog ou cliquez 
sur le bouton Choisir de la barre d'outils du navigateur.

La boîte de dialogue Choisir un fichier ou une entrée de blog s'ouvre.
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2 Sélectionnez un fichier ou une entrée de blog de l'une des manières suivantes :

• Si le fichier se trouve dans un dossier du site Web ou du blog que vous parcourez actuellement, sélectionnez le fichier.

• Si le fichier ne se trouve pas dans un dossier du site Web ou du blog vous parcourez actuellement, recherchez le dossier 
du site Web ou du dossier approprié via le menu déroulant Regarder dans, puis sélectionnez un fichier.

Selon le type de fichier sélectionné, un aperçu peut s'afficher ; il permet de vérifier que vous avez sélectionné le fichier 
approprié.

3 Cliquez sur OK.

La page Web ou le fichier s'affiche dans le navigateur de Contribute.

Remarque : Si vous sélectionnez un type de fichier que le navigateur de Contribute ne peut pas afficher, la page Espace réservé 
pour le fichier s'affiche.

Configuration de l'accès aux pages couramment utilisées
Contribute permet de conserver la liste des signets des pages fréquemment visitées. Vous pouvez ajouter un signet pour les 
pages des sites Web ou les entrées des blogs auxquels vous êtes connecté mais aussi pour toutes les pages du Web et les 
entrées des blogs. 

Affichage de pages dans votre liste de signets
Vous pouvez sélectionner des pages dans votre liste de signets pour y accéder aisément. 

Sous Windows, Contribute répertorie également vos signets Internet Explorer (jusqu'à 2 000 adresses) dans la liste Autres 
signets du menu Signets de Contribute.

Pour afficher une page de votre liste de signets, procédez de l'une des manières suivantes :
• Pour afficher un signet de Contribute, choisissez le menu Signets et sélectionnez un élément dans la liste.

• (Windows uniquement) Pour afficher un signet Internet Explorer, choisissez Signets > Autres signets, puis sélectionnez 
un élément dans la liste.

Ajout d'une page à vos signets
Vous pouvez ajouter à votre liste de signets une page Web quelconque, et non pas uniquement les pages des sites Web ou 
des entrées de blogs auxquels vous êtes connecté.  Vous pouvez créer jusqu'à 1 000 signets. 

Pour ajouter une page à votre liste de signets :
1 Recherchez la page à ajouter à votre liste de signets.

2 Choisissez Signets > Ajouter un signet.

La boîte de dialogue Ajouter un signet s'ouvre.

3 Pour changer le titre d'un signet, saisissez un nouveau titre dans le champ de texte Nom.

Ce nom figure ensuite dans votre liste de signets.

4 Pour ajouter cette page à un dossier, cliquez sur un nom de dossier existant ou sur Nouveau dossier pour en créer un.

5 Cliquez sur OK.

Contribute ajoute la page à votre liste de signets dans le menu Signets.
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Suppression d'une page de vos signets
Vous pouvez supprimer une ou plusieurs pages, voire un dossier entier, de la liste des signets.

Pour supprimer un signet :
1 Choisissez Signets > Supprimer un signet.

La boîte de dialogue Supprimer un signet s'ouvre.

2 Sélectionnez le nom du signet ou du dossier à supprimer.

3 Cliquez sur Supprimer.

Contribute retire la page de votre liste de signets dans le menu Signets.

4 Pour supprimer un autre signet ou un dossier, sélectionnez-le, puis cliquez de nouveau sur Supprimer.

5 Lorsque la suppression des signets est terminée, cliquez sur Fermer.

Définition des préférences dans Contribute
La boîte de dialogue Préférences permet de définir vos préférences d'utilisateur dans Contribute. Vous pouvez définir des 
préférences pour des blogs par défaut, des modifications en général, des éditeurs de fichiers, des paramètres de proxy, des 
éléments invisibles, l'insertion de documents Microsoft Office, des documents PDF, l'émission d'un tintement par les 
serveurs lorsqu'une entrée de blog est publiée, la sécurité par mot de passe et des balises pour entrées de blog. 

Pour modifier les préférences d'utilisateur :
1 Choisissez Edition > Préférences (Windows) ou Contribute > Préférences (Macintosh).

La boîte de dialogue Préférences s'ouvre.

2 Sélectionnez une option dans la liste à gauche :

• Sélectionnez Options par défaut d'un blog pour définir des options pour le blog par défaut dans lequel une entrée de blog 
est créée, auquel il faut se connecter, s'il y a lieu de créer une entrée de blog lorsque vous cliquez sur le bouton Nouveau 
et si des commentaires et des rétroliens sont autorisés par défaut pour des entrées de blog

• Choisissez Edition pour définir les options générales, telles que le traitement appliqué par Contribute à la modification 
des tableaux ou le choix d'un dictionnaire orthographique.
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• Choisissez Editeurs de fichiers pour sélectionner les principaux logiciels de modification par type de fichier.

• Choisissez Proxy FTP pour modifier les paramètres de votre serveur proxy FTP.

• Choisissez Eléments invisibles pour masquer ou afficher des éléments invisibles.

• (Windows uniquement), choisissez Documents Microsoft Office pour définir le traitement des documents Office par 
Contribute

• Choisissez Documents PDF pour configurer comment Contribute gère l'insertion de documents PDF dans des 
brouillons de pages Web ou d'entrées de blog 

• Choisissez Serveurs ping pour ajouter ou supprimer des URL de serveur ping que Contribute doit informer lors de la 
publication d'une entrée de blog dans Contribute. Vous pouvez également afficher la liste des entrées du journal des 
serveurs ping ayant échoué et définir le nombre d'entrées à afficher 

• Choisissez Sécurité si vous voulez configurer un mot de passe pour le démarrage de Contribute

• Sélectionnez Balisage pour ajouter ou supprimer les serveurs de balisage, déterminer où Contribute ajoute des balises à 
des entrées de blog et fournir des détails sur le référentiel des balises .

Modification ou désactivation du mot de passe de 
démarrage de Contribute 
Vous pouvez changer le mot de passe de démarrage de Contribute aussi souvent que nécessaire. Pour ce faire, vous devez 
d'abord saisir l'actuel mot de passe et démarrer Contribute.

Si l'option Demander un mot de passe au démarrage de Contribute est sélectionnée dans la boîte de dialogue Préférences 
de Contribute, vous devez saisir le mot de passe exact pour lancer Contribute et modifier les pages d'un site Web. Si vous 
avez l'avez oublié ou que vous ne le connaissez pas, vous ne pouvez pas utiliser Contribute pour modifier des pages tant que 
la demande de mot de passe au démarrage de Contribute est activée. Pour modifier cette préférence, vous devez au préalable 
supprimer toutes vos connexions aux sites Web.

Pour modifier le mot de passe demandé au démarrage de Contribute :
1 Choisissez Edition > Préférences (Windows) ou Contribute > Préférences (Macintosh).

La boîte de dialogue Préférences s'ouvre.

2 Dans la liste des options à gauche, sélectionnez Sécurité.

3 Tapez le nouveau mot de passe à deux reprises.

4 Cliquez sur OK. 

Pour désactiver le mot de passe demandé au démarrage de Contribute :
1 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

2 Sous Nom du site Web, sélectionnez une connexion à un site Web, puis cliquez sur Supprimer.

Remarque : Il peut-être nécessaire d'annuler tous les brouillons non publiés avant de supprimer les connexions.

3 Répétez l'étape 2 jusqu'à ce que toutes les connexions soient supprimées.

4 Cliquez sur Fermer.

5 Choisissez Edition > Préférences (Windows) ou Contribute > Préférences (Macintosh).

6 Dans la boîte de dialogue Préférences, choisissez Sécurité.

7 Désactivez l'option Demander un mot de passe au démarrage de Contribute.

8 Cliquez sur OK.
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Configuration du codage du navigateur
Pour spécifier la manière dont une page doit apparaître dans le navigateur de Contribute, vous pouvez définir son codage. 
Il peut être souhaitable de définir le codage si les caractères ne s'affichent pas correctement dans le navigateur de 
Contribute.

Pour modifier le codage du navigateur :
1 Dans le navigateur de Contribute, cliquez du bouton droit (Windows) ou en maintenant la touche contrôle enfoncée 
(Macintosh) sur la page.

2 Choisissez Codage, puis sélectionnez une option dans le menu déroulant.

Utilisation des fonctions d'accessibilité de Contribute
L'accessibilité consiste à faire en sorte que les sites ou les produits Web que vous créez puissent être utilisés par des 
personnes souffrant d'un handicap visuel, auditif, moteur ou autre. Contribute inclut des fonctions qui le rendent accessible 
à ces utilisateurs.

Utilisation de lecteurs avec Contribute
Un lecteur récite le texte qui s'affiche sur l'écran de l'ordinateur. Il lit également les informations non textuelles, comme les 
noms des boutons ou les descriptions d'images.

Vous pouvez utiliser un lecteur d'écran lorsque vous modifiez vos pages Web. Le lecteur commence sa lecture par l'angle 
supérieur gauche de l'application.

Contribute prend en charge les lecteurs suivants :

• JAWS pour Windows, conçu par Freedom Scientific (www.freedomscientific.com)

• Window Eyes, conçu par GW Micro (www.gwmicro.com)

Utilisation des fonctions d'accessibilité du système d'exploitation
Contribute prend en charge le paramètre de contraste élevé du système d'exploitation Windows. Vous pouvez activer cette 
option dans le Panneau de configuration de Windows. 

Un contraste élevé affecte Contribute de la façon suivante :

• Les boîtes de dialogue et les panneaux utilisent les paramètres de couleurs du système.

Par exemple, si vous définissez les couleurs comme blanc sur noir, toutes les boîtes de dialogue et tous les panneaux de 
Contribute utilisent le blanc comme couleur de premier plan et le noir en arrière-plan.

• L'éditeur de Contribute utilise les couleurs d'arrière-plan et de texte définies dans Format > Propriétés de la page. Ainsi, 
les pages que vous concevez affichent les couleurs telles qu'elles s'affichent dans le navigateur de l'internaute.

Utilisation du clavier pour naviguer Contribute
Lorsque vous apportez des modifications, vous pouvez utiliser votre clavier pour parcourir les tableaux, les boîtes de 
dialogue et l'espace de travail de Contribute, sans recourir à votre souris.

Vous pouvez également utiliser les raccourcis clavier pour ouvrir certaines boîtes de dialogue et exécuter des commandes 
spécifiques. Pour obtenir la liste des raccourcis, voir la section « Raccourcis clavier pour Windows », page 239.

Navigation dans l'espace de travail
Vous pouvez utiliser les raccourcis clavier pour parcourir l'espace de travail de Contribute, c'est-à-dire pour choisir des 
commandes dans les menus et basculer du navigateur à l'éditeur. Pour connaître la liste complète des raccourcis clavier dans 
Contribute, voir la section « Raccourcis clavier pour Windows », page 239.

http://www.freedomscientific.com
http://www.gwmicro.com
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Tous les éléments du panneau Pages et de la barre d'outils sont accessibles dans les menus. Utilisez l'Aide de Contribute 
(Aide > Aide d'Adobe Contribute) pour accéder aux informations relatives aux tâches du panneau Comment.

Pour passer du navigateur à l'éditeur de Contribute à l'aide du clavier, procédez de l'une des manières suivantes :
• Appuyez sur les touches Ctrl+Maj+E (Windows) ou Commande+Maj+E (Macintosh) pour modifier la page en cours.

Remarque : Cette opération équivaut à cliquer sur le bouton Modifier la page de la barre d'outils.

• (Windows uniquement) Appuyez sur les touches Alt+F à deux reprises avant de sélectionner, à l'aide des touches 
fléchées, un brouillon en cours ou une nouvelle page dans le menu déroulant.

Les brouillons et les nouvelles pages répertoriés dans le panneau Pages figurent dans cette liste.

Pour passer de l'éditeur au navigateur de Contribute à l'aide du clavier :
• Appuyez sur Ctrl+Maj+B (Windows) ou sur Commande+Maj+B (Macintosh).

Remarque : Cette opération équivaut à cliquer sur le navigateur dans le panneau Pages.

Navigation dans les boîtes de dialogue
Vous pouvez utiliser le clavier pour naviguer dans les boîtes de dialogue.

Pour ce faire :
• Pour passer d'une option à une autre dans les boîtes de dialogue, appuyez sur la touche de tabulation.

Sur un système Macintosh, la touche de tabulation permet de déplacer le point d'insertion d'un champ de texte à un autre.

• Pour accepter une sélection et fermer la boîte de dialogue, appuyez sur la touche Entrée ou Retour.

• Pour fermer la boîte de dialogue sans apporter de modification, appuyez sur la touche Echap ou sur Alt+F4 (Windows).

• (Windows uniquement) Pour sélectionner l'un des choix proposés pour une option, utilisez les touches fléchées.

Par exemple, si une option dispose d'un menu déroulant, sélectionnez le menu, puis utilisez la touche Flèche Bas pour faire 
défiler le contenu du menu.

• (Windows uniquement) Pour faire défiler une liste de d'options, appuyez sur les touches Ctrl+Tab (touche de 
tabulation) ; faites défiler la liste vers le haut ou le bas à l'aide des touches fléchées.

Pour voir un exemple d'une liste de d'options, choisissez Edition > Préférences. 

• (Windows uniquement) Pour accéder aux options d'une liste, appuyez sur les touches Ctrl+Tab.

Navigation dans les tableaux
Après avoir sélectionné un tableau, vous pouvez utiliser le clavier pour vous y déplacer.

Pour vous déplacer dans un tableau :
1 Dans l'éditeur de Contribute, procédez de l'une des manières suivantes pour sélectionner le tableau :

• Si le point d'insertion est situé à gauche de la cellule, appuyez sur Maj+Flèche Droite.

• Si le point d'insertion est situé à droite de la cellule, appuyez sur Maj+Flèche Gauche.

2 Appuyez sur la touche Flèche Bas pour positionner le point d'insertion dans la première cellule.

3 Utilisez les touches fléchées ou appuyez sur la touche de tabulation pour vous déplacer vers d'autres cellules. 

Si vous appuyez sur la touche de tabulation lorsque vous êtes dans la cellule la plus à droite d'une ligne, vous ajoutez une 
ligne au tableau.

4 Pour sélectionner une cellule, appuyez sur Ctrl+A (Windows) ou sur Commande+A (Macintosh) lorsque le point 
d'insertion est dans la cellule.

5 Pour sortir du tableau, utilisez la commande Sélectionner une cellule de tableau (Ctrl+A, Windows ou Commande+A, 
Macintosh), puis appuyez sur la touche Flèche haut, Flèche gauche ou Flèche droite.
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Création de pages Web accessibles
Il est important que vos pages Web soient accessibles à tous les internautes. 

Le gouvernement américain et d'autres organisations ont établi une législation et des instructions concernant l'accessibilité. 
Pour plus d'informations sur ces deux initiatives importantes, consultez le document relatif aux directives pour l'accessi-
bilité aux contenus Web (www.w3.org/wai) et à la Section 508 de l'Acte Fédéral de Réhabilitation (www.section508.gov).

N'oubliez pas non plus lorsque vous modifiez vos pages que certains internautes utilisent un lecteur d'écran. Contribute 
vous aide à rendre vos images et tableaux plus accessibles à l'aide des méthodes suivantes :

• Vous pouvez ajouter une description pour que le lecteur d'écran décrive également les images sur vos pages. L'adminis-
trateur Contribute peut paramétrer le logiciel pour qu'il vous demande une description à chaque insertion d'une image. 
Pour plus d'informations, contactez l'administrateur Contribute ou reportez-vous à la section « Définition des 
paramètres de modification de pages et de paragraphes », page 215.

• Vous pouvez ajouter des en-têtes aux tableaux qui seront lus par les lecteurs d'écran. Pour insérer des tableaux avec des 
en-têtes, voir la section « Insertion d'un tableau dans une page », page 122.

Remarque : Les lecteurs ne lisent pas les en-têtes dont le texte dans une ligne ou une colonne est en gras et centré.

http://www.w3.org/wai
http://www.section508.gov
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Chapitre 4 : Utilisation des pages et des 
entrées de blog

Adobe® Contribute® CS3 vous permet de modifier, sur votre site Web, des pages Web existantes avec leur contenu et, dans 
vos blogs, des entrées de blog avec leur contenu. Vous pouvez ensuite annuler les modifications que vous venez d'apporter 
ou annuler une nouvelle page Web ou une nouvelle entrée de blog. Vous avez la possibilité de supprimer des entrées de blog 
et, sous réserve de disposer des autorisations appropriées, des pages Web et d'autres fichiers stockés sur un site Web. Vous 
pouvez également exporter une page vers un fichier HTML.

Remarque : Pour plus d'informations sur la création de pages, voir la section « Création ou copie d'une page sur un site Web », 
page 60.

Avant de publier vos modifications sur une page Web, vous pouvez en envoyer une version brouillon à un autre utilisateur 
à des fins de révision. Lorsque vous publiez le brouillon de la page Web, Contribute met à jour la page Web existante en y 
intégrant les modifications que vous avez apportées. La publication de brouillons d'entrées de blog suit la même procédure, 
à l'exception de l'envoi d'un brouillon d'entrée de blog à d'autres personnes (voir la section « Utilisation des pages et des 
entrées de blog », page 33).

Vous avez désormais la possibilité de profiter des atouts de Contribute dans des navigateurs tels que Microsoft Internet 
Explorer et Mozilla Firefox. En vous servant de la barre d'outils de Contribute intégrée à ces navigateurs, vous pouvez direc-
tement ajouter et modifier des pages Web, en publier sur votre site ou sur un blog.

Ce chapitre contient les sections suivantes :

• « A propos de l'utilisation de pages Web et d'entrées de blog », page 34

• « Modification de pages Web et d'entrées de blog existantes », page 37

• « Enregistrement des brouillons », page 41

• « Révision de brouillons de pages Web et de fichiers par des tiers », page 42

• « Utilisation de pages Web créées à partir de modèles Dreamweaver », page 48

• « Utilisation de Contribute hors connexion », page 51

• « Modification du contenu d'une page Web dans un logiciel externe », page 52

• « Ajout de la fonctionnalité de recherche Google à votre page Web », page 53

• « Modification de la source d'une page Web dans une application externe », page 53

• « Annulation d'un brouillon, d'une nouvelle page ou d'une nouvelle entrée de blog », page 54

• « Suppression d'une page Web », page 55

• « Exportation d'une page Web ou d'une entrée de blog (Windows uniquement) », page 56

• « Impression d'une page Web ou d'une entrée de blog », page 57
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A propos de l'utilisation de pages Web et d'entrées de blog
Contribute vous permet de modifier des entrées de blog existantes et des pages de votre site Web, y compris les pages créées 
à partir de modèles. Pour que les modifications apportées à des pages Web soient revues par un autre utilisateur avant leur 
publication, vous pouvez utiliser le processus de révision des brouillons ou le processus de révision par courriel.

Modification de pages Web et d'entrées de blog
Vous pouvez modifier les pages Web et les entrées de blogs de sites et de blogs auxquels vous êtes connecté et pour lesquels 
vous disposez des autorisations de modification adéquates (voir la section « Connexion à un site Web ou à un blog », 
page 12). Il est impossible de modifier une page Web ou une entrée de blog verrouillée, autrement dit une page ou une entrée 
en cours de modification par un autre utilisateur. Lorsque vous accédez à une page ou une entrée de blog, la zone de message 
figurant sous la barre d'outils indique si la page ou l'entrée est disponible pour des modifications.

A. Bouton Actualiser B. liste des entrées

Lorsque vous modifiez une page ou une entrée de blog, Contribute l'enregistre en tant que brouillon et le titre de ce dernier 
figure dans le panneau Pages du panneau de navigation. 

Pour plus d'informations, voir la section « Ouverture d'une page de site Web à des fins de modification », page 37. Pour plus 
d'informations sur l'utilisation des brouillons, voir la section « Enregistrement des brouillons », page 41. 
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Remarque : Si vous souhaitez modifier un document Microsoft relié à votre site Web, voir la section « Modification du contenu 
d'une page Web dans un logiciel externe », page 52.

Il est possible que vous ne puissiez pas modifier toutes les parties d'un brouillon de page Web. Le concepteur peut créer des 
modèles comportant des zones verrouillées. L'administrateur Contribute a également la possibilité de définir des 
contraintes interdisant aux utilisateurs de modifier autre chose que le texte. 

Remarque : Si vous n'êtes pas autorisé à modifier une page ou la partie d'une page que vous avez besoin de remanier, contactez 
l'administrateur Contribute ou reportez-vous à la section « Gestion des utilisateurs et des rôles », page 207.

Description du processus de révision des brouillons
Le processus de révision des brouillons de Contribute vous permet de collaborer avec d'autres utilisateurs de Contribute ou 
de leur demander leur avis sur un brouillon avant sa publication. De même, lorsque votre rôle ne vous permet de publier 
directement sur un site Web, vous pouvez envoyer le brouillon à une personne autorisée à le réviser et à le publier.

Vous pouvez envoyer un brouillon en révision à toute personne connectée au site Web ; lorsque les utilisateurs se connectent 
au site Web, Contribute enregistre leurs noms. Vous pouvez envoyer le brouillon à plusieurs réviseurs en même temps, mais 
une seule personne à la fois peut modifier le document. Lors de l'envoi d'un brouillon en révision, vous transférez sa 
propriété au réviseur. Cela signifie que le réviseur doit prendre des mesures concernant le brouillon. Après l'envoi d'un 
brouillon en révision, vous pouvez suivre son évolution afin de connaître les mesures prises par le réviseur.

Lorsque vous recevez un brouillon à réviser, il s'affiche dans le panneau Pages de Contribute. L'expéditeur peut également 
vous envoyer un message électronique pour vous informer du brouillon à réviser. En tant que réviseur, vous pouvez choisir 
de modifier le brouillon, de l'envoyer à un autre utilisateur ou d'ignorer toutes les modifications apportées en annulant le 
brouillon. Selon le rôle qui vous a été attribué, il est possible que vous ne puissiez pas publier le brouillon.

Processus de révision des brouillons
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Description du processus de révision par courriel
Le processus de révision par courriel Contribute fait appel à votre application de messagerie par défaut afin de créer un 
message contenant l'adresse Web où les réviseurs peuvent visualiser une copie temporaire de votre brouillon. Contribute 
crée automatiquement la copie temporaire sur le serveur sur lequel vous avez publié le site Web. Pour afficher votre 
brouillon, le destinataire clique sur le lien de l'adresse Web (URL) figurant dans le message reçu.

Remarque : Si votre rôle ne vous permet pas de publier, vous ne pouvez pas utiliser le processus de révision par courriel. Dans 
ce cas, servez-vous du processus de révision des brouillons (voir la section « Description du processus de révision des 
brouillons », page 35).

Lorsque vous envoyez une demande de révision par courriel, Contribute affiche un message sous la barre d'outils afin de 
vous signaler l'envoi du brouillon pour révision. Le message contient la date d'envoi de la demande. Vous pouvez alors 
enregistrer le brouillon en vue d'une utilisation ultérieure, jusqu'à réception des commentaires du réviseur ou poursuivre 
la modification du brouillon.

Après examen de votre brouillon, le réviseur vous renvoie ses commentaires par courriel, car il ne peut pas modifier le 
brouillon lui-même. Vous pouvez alors intégrer les modifications du réviseur, puis publier le brouillon ou demander une 
autre révision. Lorsque le brouillon est annulé ou publié, Contribute supprime sa copie temporaire stockée sur le serveur à 
l'intention du réviseur.

Processus de révision par courriel

A propos des modèles
Un modèle Dreamweaver contient une mise en page prédéfinie et des éléments tels que du texte et des images. Un modèle 
peut servir de point de départ à la création d'une page Web ou d'un blog. Il permet de donner un aspect homogène aux 
pages de votre site ou de votre blog. 

Par exemple, sur le site Web interne d'une entreprise, le modèle utilisé pour le profil de chaque employé peut contenir des 
éléments de base et des sections à remplir avec les informations relatives à l'employé. Le modèle peut ainsi comprendre le 
logo et l'adresse de l'entreprise, ainsi que des sections vides dans lesquelles vous pouvez indiquer le nom, le service, le 
numéro de téléphone de l'employé et insérer sa photo. Chaque nouvelle page d'employé créée à partir de ce modèle hérite 
alors de la même mise en page.

Dans un modèle, le concepteur crée des zones destinées à contrôler les éléments de page modifiables. Un modèle contient 
des zones modifiables auxquelles vous pouvez apporter des changements et des zones verrouillées que vous ne pouvez pas 
toucher. Dans l'exemple du modèle d'employé, le logo et l'adresse de l'entreprise peuvent être insérés dans une zone 
verrouillée. En revanche, les sections contenant les informations relatives à l'employé sont des zones modifiables.
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A. Zone verrouillée B. Onglet Modèle C. Zone modifiable

Modification de pages Web et d'entrées de blog existantes
Vous pouvez modifier n'importe quelle page d'un site Web ou n'importe quelle entrée de votre blog du moment que vous 
disposez de l'autorisation appropriée et que la page ou l'entrée en question n'est pas déjà en cours de modification par un 
autre utilisateur.

Pour plus d'informations sur la modification de pages Web et d'entrées de blog, voir la section « Modification de pages Web 
et d'entrées de blog », page 34.

Une autre possibilité pour modifier des pages ou des entrées de blog consiste à utiliser les plug-ins de Contribute à partir 
de votre navigateur (Internet Explorer ou Mozilla Firefox, par exemple).

Pour plus d'informations sur la modification de pages Web et d'entrées de blog avec des modules externes Contribute, voir 
la section « Ouverture d'une page Web ou d'une entrée de blog à des fins de modification dans un navigateur », page 39.

Ouverture d'une page de site Web à des fins de modification
Lorsque vous êtes connecté à un site Web, vous pouvez aisément ouvrir et modifier ses pages. Pour ouvrir une page à des 
fins de modification, il vous suffit de naviguer jusqu'à son emplacement. 

Pour modifier une page de votre site Web :
1 Repérez la page à modifier (voir la section « Accès aux pages Web et aux entrées de blog », page 23).

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Modifier la page  de la barre d'outils.

• Choisissez Fichier > Actions > Modifier la page.

La page s'affiche dans l'éditeur de Contribute en tant que brouillon et le titre de ce dernier s'affiche dans le panneau Pages.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

38

Ouverture d'une entrée de blog à des fins de modification dans Contribute
Vous pouvez modifier une entrée de blog de deux façons différentes. Vous pouvez modifier une entrée directement dans 
Contribute. Autrement, si vous avez une entrée dans une fenêtre de navigateur, vous pouvez cliquer sur le bouton Modifier 
dans Contribute pour démarrer Contribute qui vous permettra de procéder à ces changements dans l'entrée. Pour plus 
d'informations, voir la section « Ouverture d'une page Web ou d'une entrée de blog à des fins de modification dans un 
navigateur », page 39.

Remarque :  Si le bouton Modifier la page ou Modifier l'entrée n'est pas visible sur la barre d'outils de l'application Contribute, 
cela signifie que vous n'êtes pas connecté au serveur de blog hébergeant ce blog. Cliquez sur le bouton Créer une connexion de 
la barre d'outils afin de vous connecter au serveur de blog.

Pour modifier une entrée de blog dans Contribute :
1 Naviguez jusqu'à votre page d'accueil de blog.

2 Dans le menu contextuel Entrées, sélectionnez l'entrée de blog sur laquelle vous voulez travailler ou bien sélectionnez 
Affichage > Sélectionner une entrée de blog > titre de l'entrée de blog et choisissez l'entrée de blog recherchée. Une autre 
solution consiste à choisir Affichage > Choisir un fichier ou une entrée de blog. Dans la boîte de dialogue du même nom, 
cliquez sur le bouton Modifier.

L'entrée de blog sélectionnée apparaît dans le navigateur intégré et le titre de l'entrée de blog sélectionnée est affiché dans 
le menu contextuel Entrées. 

3 Cliquez sur le bouton Modifier l'entrée ou choisissez Fichier > Actions > Modifier l'entrée.

L'entrée de blog s'ouvre sous forme de brouillon dans Contribute. Le cas échéant, modifiez le contenu, puis publiez l'entrée.

Remarque : Vous avez la possibilité de lier cette entrée de blog à une entrée de blog vide et de publier ces entrées. Pour plus 
d'informations, voir la section « Création d'un lien vers une nouvelle entrée de blog vide », page 138.

Ouverture d'une page stockée dans votre ordinateur à des fins de modification
Contribute vous permet de modifier des pages non stockées sur l'un de vos sites Web ; ouvrez alors une page HTML 
enregistrée sur votre ordinateur et apportez-y les modifications voulues. Cette opération est équivalente à l'utilisation du 
Bloc-notes ou de TextEdit, mais elle présente en plus la convivialité et les fonctionnalités de Contribute.

Supposons par exemple que vous receviez dans un message électronique une page HTML à modifier pour un collègue. 
Même si la page n'est pas associée à un site Web auquel vous êtes connecté, vous pouvez l'enregistrer sur votre ordinateur, 
l'ouvrir et la modifier dans Contribute, puis la renvoyer à son expéditeur.

Remarque : Il est préférable de ne pas créer de connexion à votre disque local. Dans le cas contraire, Contribute traite les fichiers 
enregistrés sur votre ordinateur comme des fichiers de site Web et la fonction Direct Edit (Modification directe) ne fonctionne 
pas correctement.

Pour modifier une page Web stockée dans votre ordinateur :
1 Dans le navigateur ou l'éditeur de Contribute, choisissez Fichier > Ouvrir.

La boîte de dialogue Ouvrir s'ouvre.

Remarque : Cette fonction ne vous permet pas d'ouvrir et de modifier des fichiers TXT enregistrés sur votre ordinateur.

2 Localisez et sélectionnez le fichier à modifier, puis cliquez sur Ouvrir.

La page s'ouvre sous forme de brouillon dans l'éditeur de Contribute ; la barre d'outils contient les boutons Enregistrer et 
Fermer au lieu des boutons Publier et Annuler le brouillon. 

Remarque : Les préférences administrateur ne s'appliquent pas, car cette page ne fait pas partie d'un site Web. Pour appliquer 
les préférences aux pages modifiées de cette manière, consultez le Centre d'assistance de Contribute à l'adresse 
http://www.adobe.com/support/contribute/.

http://www.adobe.com/support/contribute/
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Ouverture d'une page Web ou d'une entrée de blog à des fins de modification dans un 
navigateur
Vous pouvez à présent utiliser des modules externes Contribute pour modifier aisément les pages Web et les entrées de blog 
directement depuis un navigateur tel que Microsoft Internet Explorer et Mozilla Firefox. Vous pouvez alors apporter des 
modifications au contenu à partir de la page Web ou de l'entrée de blog proprement dite au lieu d'ouvrir l'application 
Contribute.

Navigateurs et systèmes d'exploitation pris en charge
Cette fonction est disponible dans les navigateurs et systèmes d'exploitation suivants :

• Internet Explorer versions 5.5 et 6.0 sous Windows 2000 (SP 4) et Windows XP (SP 2)

• Mozilla Firefox versions 1.5 et 2.0 sous Windows 2000 (SP 4) et Windows XP (SP 2)

• Mozilla Firefox versions 1.5 et 2.0 sous Mac OS X® (10.3.9) et Mac OS X (10.4.x)

Installation des modules externes (plug-ins) du navigateur sous Windows

Le module externe, ou plug-in, du navigateur Internet Explorer est automatiquement installé sur votre ordinateur en même 
temps que Contribute CS3.

Lorsque vous ouvrez Contribute CS3 pour la première fois sur un ordinateur exécutant Windows, vous êtes invité à installer 
le module externe d'extension de Firefox. Si vous cliquez sur Annuler, vous pouvez installer ce composant à partir du 
chemin d'accès suivant :

<chemin d'accès Contribute>/SupportFiles/FirefoxExtension/FirefoxExtensionSetup

Une fois l'installation de Contribute CS3 terminée, les modules externes Modifier dans Contribute et Publier dans le blog 
s'affichent sous forme de boutons sur une barre d'outils distincte dans la fenêtre du navigateur.

Remarque : Si Contribute est bien installé et que vous ne pouvez toujours pas voir les barres d'outils, sélectionnez Affichage > 
Barres d'outils > Barre d'outils Contribute dans votre navigateur Web.

Installation des plug-ins de navigateur sur un Macintosh
Lorsque vous ouvrez Contribute CS3 pour la première fois sur votre ordinateur Macintosh, vous êtes invité à installer le 
module externe d'extension de Firefox.

Lorsque vous ouvrez Contribute CS3 pour la première fois sur un ordinateur Macintosh, vous êtes invité à installer le 
module externe d'extension de Firefox. Si vous cliquez sur Annuler, vous pouvez installer ce composant à partir du chemin 
d'accès suivant :

<chemin d'accès Contribute>/FFExtnForContributeCS3.app

Une fois l'installation de Contribute CS3 terminée, les modules externes Modifier dans Contribute et Publier dans le blog 
s'affichent sous forme de boutons sur une barre d'outils distincte dans la fenêtre du navigateur.

Informations essentielles relatives à l'utilisation de Contribute sous Windows et sur un Macintosh
Cette section présente des informations importantes à ne pas oublier lors de l'utilisation de Contribute à partir des naviga-
teurs Internet Explorer et Mozilla Firefox sous Windows et sur un Macintosh.
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Utilisation de Contribute sur un Macintosh
Cette sections présente les informations essentielles relatives à l'utilisation de Contribute sur un Macintosh :

• Si vous souhaitez supprimer les plug-ins de navigateur de Contribute pour Mozilla Firefox sur un Macintosh 
uniquement, servez-vous du gestionnaire des extensions de Firefox.

• Il est impossible de réparer l'application Contribute sur un Macintosh ; en cas de problème, réinstallez l'application.

Modification d'une page Web ou d'une entrée de blog dans Contribute à partir d'un navigateur

Pour modifier une page Web ou une entrée de blog dans Contribute à partir d'un navigateur :
1 Ouvrez ou localisez la page Web, le blog ou l'entrée de blog voulu(e) dans votre navigateur.

Remarque : Assurez-vous qu'une connexion a été établie avec le site Web ou le blog avant que vous ne commenciez à modifier 
une page Web ou une entrée de blog depuis votre navigateur. Consultez les références « Création d'une connexion à un site 
Web », page 179 et « Création d'une connexion à un serveur de blog », page 180.

2 Cliquez sur Modifier dans Contribute.

3 Si vous avez localisé la page d'accueil d'un blog, sélectionnez l'entrée de blog à modifier dans le menu déroulant Entrées.

La page Web ou l'entrée de blog s'ouvre en tant que brouillon dans l'éditeur de Contribute et est disponible à des fins de 
modification.

Remarque : Si le bouton Créer une connexion est visible à l'ouverture de la page ou de l'entrée dans Contribute, cela signifie 
qu'aucune connexion n'est établie avec le site ou le blog que vous parcouriez ; les modifications ne sont pas possibles. 

Annulation des erreurs
Comme la plupart des applications, Contribute permet d'annuler les erreurs ponctuelles au fur et à mesure. Vous pouvez 
également rétablir une modification si vous ne souhaitez plus l'annuler. 

Remarque : Contribute vous permet d'annuler les modifications effectuées, même après la publication d'un brouillon, en 
restaurant une ancienne version publiée de la page. Pour plus d'informations, voir la section « Restauration d'une version précé-
dente d'une page », page 163.

Pour annuler une modification :
• Choisissez Edition > Annuler.

Pour rétablir une modification :
• Choisissez Edition > Répéter.
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Enregistrement des brouillons
Vous pouvez enregistrer un brouillon pendant que vous travaillez (voir la section « Enregistrement d'un brouillon en 
travaillant », page 41) ou l'enregistrer et passer à un autre brouillon ou au navigateur (voir la section « Enregistrement d'un 
brouillon », page 41). 

Enregistrement d'un brouillon en travaillant
Contribute enregistre automatiquement une copie de votre brouillon lorsque vous basculez vers le navigateur, affichez un 
autre brouillon, publiez le brouillon ou quittez Contribute. Au besoin, vous pouvez également enregistrer votre travail 
régulièrement. 

Lorsque vous modifiez une page ou une entrée de blog (voir la section « Modification de pages Web et d'entrées de blog 
existantes », page 37), Contribute l'enregistre automatiquement comme brouillon tandis que le titre de celui-ci s'affiche 
dans le panneau Pages du panneau de navigation. 

Pour enregistrer un brouillon et poursuivre votre travail :
1 Choisissez Fichier > Enregistrer.

Remarque : Lorsqu'une page est enregistrée pour la première fois, aucun nom de fichier n'est spécifié avant sa publication. Pour 
plus d'informations, voir la section « Publication d'une nouvelle page sur votre site Web », page 157.

Pour enregistrer un brouillon stocké sur votre ordinateur et poursuivre votre travail, procédez de l'une des manières 
suivantes :
1 Cliquez sur le bouton Enregistrer de la barre d'outils.

Remarque : Cette option est uniquement disponible pour les brouillons stockés sur votre ordinateur, pas pour les brouillons 
associés à un site Web ou un blog.

2 Choisissez Fichier > Enregistrer. 

Enregistrement d'un brouillon 
Vous pouvez enregistrer un brouillon en cours de modification, puis travailler sur un autre, passer à la navigation ou quitter 
Contribute. 

Votre brouillon est enregistré dès que vous quittez Contribute et il demeure dans le panneau Pages jusqu'à sa publication 
(voir la section « Publication de pages Web et d'entrées de blog », page 155), son annulation (voir la section « Annulation 
d'un brouillon, d'une nouvelle page ou d'une nouvelle entrée de blog », page 54) ou son envoi pour révision (voir la section 
« Utilisation du processus de révision des brouillons », page 42).

Pour enregistrer un brouillon en vue d'une utilisation ultérieure :
1 Procédez de l'une des manières suivantes :

• Dans le panneau Pages, cliquez sur Navigateur pour passer en mode navigation.

• Choisissez Affichage > Navigateur pour passer en mode de navigation.

• Dans la barre d'outils, cliquez sur le bouton Enregistrer pour plus tard afin de fermer le brouillon et de passer au 
navigateur.

• Dans le panneau Pages, cliquez sur le titre d'un autre brouillon pour y apporter des modifications.

• Fermez Contribute.

2 Si vous avez fermé Contribute, redémarrez l'application.

3 Cliquez sur le titre du brouillon dans le panneau Pages pour revenir au brouillon que vous modifiiez précédemment.

Le brouillon s'affiche dans l'éditeur de Contribute, lequel vous permet de poursuivre vos modifications.
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Révision de brouillons de pages Web et de fichiers par 
des tiers
Pour ce faire, utilisez le processus de révision des brouillons afin de les faire contrôler avant leur publication. Vous pouvez 
également utiliser le processus de révision par courriel afin d'envoyer les brouillons à réviser.

Remarque : Le processus de révision des brouillons s'applique uniquement à des brouillons de pages Web. Il ne concerne pas les 
brouillons d'entrées de blog.

Utilisation du processus de révision des brouillons
Le processus de révision des brouillons de Contribute simplifie l'envoi des brouillons à réviser à d'autres utilisateurs de 
Contribute. Une autre méthode consiste à envoyer directement les fichiers à réviser à partir de votre ordinateur.

Remarque : Le processus de révision des brouillons s'applique uniquement à des brouillons de pages Web. Il ne concerne pas les 
brouillons d'entrées de blog.

Ce processus de révision vous permet de recevoir les commentaires des destinataires et de collaborer avec d'autres utilisa-
teurs à la modification d'un brouillon de page ou d'un fichier. Les réviseurs peuvent alors examiner votre brouillon, puis le 
modifier, le publier et le transmettre à un autre réviseur ou le supprimer. Pour plus d'informations, voir la section 
« Description du processus de révision des brouillons », page 35.

Remarque : Cette fonction n'est disponible que si votre site Web dispose d'un administrateur. Ce dernier peut définir les autori-
sations de publication et de suppression de chaque rôle d'utilisateur dans le cadre du processus de révision des brouillons. Pour 
plus d'informations, voir la section « Définition des paramètres de rôle généraux », page 212.

Envoi d'un brouillon de page Web pour révision
Le processus de révision de Contribute vous permet de consulter d'autres utilisateurs de Contribute en leur envoyant un 
brouillon avant de le publier. De même, lorsque votre rôle ne vous permet pas de publier directement sur le site Web, vous 
pouvez envoyer le brouillon à une personne autorisée à le réviser et à le publier.

Pour plus d'informations sur le processus de révision des brouillons, voir la section « Description du processus de révision 
des brouillons », page 35.

Remarque : Le processus de révision de brouillon ne s'applique qu'aux brouillons de page Web. Il ne s'applique pas aux 
brouillons d'entrée de blog.
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Pour envoyer un brouillon à des fins de révision :
1 Cliquez sur le bouton Envoi pour la révision de la barre d'outils ou choisissez Fichier > Actions > Envoi pour la révision.

La boîte de dialogue Envoyer pour la révision s'affiche.

2 Activez l'option Envoyer le brouillon à un autre utilisateur de Contribute, puis renseignez la boîte de dialogue.

Vous pouvez envoyer le brouillon à tout utilisateur connecté à ce site Web.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

3 Cliquez sur Envoyer.

4 Si la boîte de dialogue Envoyer une nouvelle page s'affiche, vous pouvez changer le nom de fichier du brouillon ou cliquer 
sur Choisir un dossier pour sélectionner le dossier à partir duquel vous souhaitez publier le fichier. Cliquez ensuite sur 
Envoyer.

Remarque : L'emplacement du dossier actif s'affiche dans l'adresse Web, sous le nom du fichier.

5 Si la boîte de dialogue d'envoi des nouvelles pages liées s'affiche, vous pouvez cliquer sur les noms des pages liées et non 
publiées, puis modifier les noms et l'emplacement des dossiers. Cliquez ensuite sur Envoyer tout.

Contribute envoie alors le brouillon au réviseur.

Pour annuler l'envoi d'un brouillon :
1 Dans le panneau Pages, cliquez sur le lien Console de brouillons.

La Console de brouillons s'affiche. 

Si vous venez juste d'envoyer le brouillon et qu'il est encore présent dans la fenêtre de Contribute, vous pouvez cliquer sur 
le bouton Annuler l'envoi afin d'interrompre cette procédure.

2 Dans la section des brouillons envoyés, sélectionnez un brouillon.

Contribute affiche le brouillon.

3 Dans la barre d'outils, cliquez sur le bouton Annuler l'envoi.

Vous pouvez utiliser cette option si vous êtes la dernière personne à avoir envoyé le brouillon en révision. Si vous avez 
envoyé le brouillon à quelqu'un qui l'a à son tour transmis à un autre réviseur, vous ne pouvez plus le récupérer puisque 
vous n'êtes plus la dernière personne à l'avoir envoyé en révision.

Le brouillon disparaît du panneau Pages du réviseur pour s'afficher dans le vôtre.
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Envoi d'un fichier en révision à partir de votre ordinateur
Vous pouvez envoyer un fichier sur votre ordinateur à une autre personne pour qu'elle le révise ou le publie à votre place.

Vous pouvez aussi publier un fichier directement à partir de votre ordinateur en fonction du rôle que l'administrateur 
Contribute vous a attribué. Pour plus d'informations, voir la section « Publication d'un fichier depuis votre ordinateur 

sur votre site Web », page 160.

Pour envoyer directement un fichier en révision à partir de votre ordinateur :
1 Sélectionnez Fichier > Envoyer un fichier depuis Poste de travail.

La boîte de dialogue Sélectionner un fichier s'affiche.

2 Sélectionnez le fichier à ajouter au site Web, puis cliquez sur Sélectionner.

Remarque : Les fichiers HTML ou de type dynamique (tels que le type JSP) ne sont pas pris en charge. Si vous sélectionnez un 
fichier de type incorrect, Contribute vous en avertit et affiche une liste complète des types de fichiers incorrects.

Si vous disposez de connexions à plus d'un site, la boîte de dialogue Sélectionner un site Web s'affiche.

3 Si la boîte de dialogue Sélectionner un site Web s'affiche, sélectionnez le site sur lequel vous souhaitez ajouter le brouillon 
du fichier à réviser, puis cliquez sur OK.

La liste des sites Web comprend tous les sites auxquels vous êtes connecté. Le réviseur auquel vous souhaitez envoyer le 
fichier doit également être connecté au site que vous avez sélectionné.

La boîte de dialogue Envoyer pour la révision s'affiche.

4 Sélectionnez le nom de la personne devant réviser le fichier envoyé à partir de votre ordinateur, saisissez des commen-
taires destinés au réviseur, puis cliquez sur Envoyer.

La boîte de dialogue Envoyer une nouvelle page s'affiche.

5 Vous pouvez modifier le nom du fichier ou cliquer sur le bouton Choisir un dossier afin d'enregistrer ce brouillon 
ailleurs, puis cliquer sur Envoyer.

Remarque : L'emplacement du dossier actif s'affiche dans l'adresse Web, sous le nom du fichier.

Contribute envoie alors le fichier au réviseur.

Suivi des brouillons de pages Web
Après l'envoi du brouillon d'une page Web pour révision, vous pouvez suivre son évolution afin de connaître les mesures 
prises par le réviseur. 

Remarque : Le processus de révision des brouillons s'applique uniquement à des brouillons de pages Web. Il ne concerne pas les 
brouillons d'entrées de blog.

Pour suivre l'évolution de vos brouillons :
1 Dans le panneau Pages, cliquez sur le lien Console de brouillons.

Remarque : La Console de brouillons n'est pas disponible si aucun administrateur n'est affecté à une connexion du site Web.

Cette console présente des liens pointant vers tous les brouillons que vous avez envoyés, modifiés ou révisés. Chaque 
brouillon envoyé est également accompagné d'informations sur son état. 

Contribute retire les brouillons publiés et supprimés de la Console de brouillons tous les 30 jours. Pour supprimer manuel-
lement les brouillons périmés, appuyez sur Contrôle+Maj et choisissez Affichage > Actualiser les brouillons.

2 Pour afficher un brouillon, sélectionnez son titre.

Le brouillon s'affiche dans Contribute ; vous pouvez cliquer sur le lien Console de brouillons afin de revenir à la console.
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3 Pour actualiser l'affichage à tout moment, procédez de l'une des manières suivantes :

• Cliquez sur l'icône Actualiser les brouillons  située au bas du panneau Pages.

• Cliquez sur le bouton Actualiser de la Console de brouillons.

• Choisissez Affichage > Actualiser les brouillons.

4 Pour fermer la Console de brouillons ou le brouillon sélectionné, sélectionnez le navigateur ou un autre brouillon dans 
le panneau Pages.

Révision d'un brouillon de page Web
Lorsqu'une personne vous envoie un brouillon de page Web à réviser, ce dernier apparaît dans votre panneau Pages de 
Contribute. Pour vérifier la présence de brouillons à réviser, actualisez manuellement le panneau Pages.

Lorsque vous révisez un brouillon de page Web, vous pouvez le modifier, le publier, l'envoyer en révision ou le supprimer, 
selon votre rôle d'utilisateur. Vous pouvez également consulter tous les commentaires joints au brouillon par les réviseurs 
précédents.

Remarque : Le processus de révision des brouillons s'applique uniquement à des brouillons de pages Web. Il ne concerne pas les 
brouillons d'entrées de blog.

Pour récupérer manuellement les brouillons qui vous ont été envoyés pour révision, procédez de l'une des manières 
suivantes :
• Cliquez sur l'icône Actualiser les brouillons  située au bas du panneau Pages.

• Choisissez Affichage > Actualiser les brouillons.

Tous les brouillons qui vous ont été envoyés pour révision s'affichent dans le panneau Pages.

Pour réviser un brouillon :
1 Dans le panneau Pages, sélectionnez un brouillon à réviser.

Il figure dans la fenêtre de Contribute. Le panneau d'état du brouillon situé au bas de la fenêtre présente des informations 
sur le brouillon.

Remarque : Si le panneau d'état n'est pas visible, cliquez sur la flèche de développement située dans le coin inférieur droit de 
la fenêtre de Contribute pour l'afficher.

2 Procédez de l'une des manières suivantes :

• Dans la barre d'outils, cliquez sur le bouton Publier pour que les modifications soient appliquées au site Web.

Remarque : Selon le rôle que l'administrateur Contribute vous a assigné, il est possible que vous ne soyez pas autorisé à publier 
les brouillons.

• Dans la barre d'outils, cliquez sur le bouton Envoyer pour la révision afin de transmettre le brouillon à un autre réviseur. 

Remarque : Utilisez ce bouton pour envoyer un brouillon à un réviseur, quel qu'il soit, y compris à l'expéditeur d'origine.

Renseignez la boîte de dialogue Envoyer pour la révision, puis cliquez sur Envoyer.

• Dans la barre d'outils, cliquez sur le bouton Modifier le brouillon.

Le brouillon s'affiche dans l'éditeur de Contribute. Lorsque vos modifications sont terminées, cliquez sur le bouton Envoyer 
pour la révision, Publier ou Supprimer le brouillon. 

Remarque : Selon le rôle que l'administrateur Contribute vous a assigné, il est possible que vous ne soyez pas autorisé à publier 
les brouillons.

• Cliquez sur le bouton Supprimer le brouillon de la barre d'outils pour annuler ce brouillon.

Remarque : Selon le rôle que l'administrateur Contribute vous a assigné, il est possible que vous ne puissiez pas supprimer de 
brouillon.
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Pour consulter les commentaires du brouillon de page Web que vous révisez :
1 Pendant la révision d'un brouillon de page Web, cliquez sur la flèche de développement située dans le coin inférieur droit 
de la fenêtre de Contribute pour afficher le panneau d'état du brouillon s'il n'est pas visible.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Historique du brouillon du panneau d'état du brouillon.

• Choisissez Affichage > Historique du brouillon.

La boîte de dialogue Historique du brouillon s'ouvre. 

3 Pour afficher les commentaires d'un expéditeur, sélectionnez le nom de cette personne.

4 Pour fermer les commentaires, cliquez sur Fermer.

Envoi d'un brouillon de page Web pour révision par courriel
Vous pouvez mettre un brouillon de page Web à la disposition d'autres personnes en vue d'une révision, même si elles ne 
possèdent pas Contribute. 

Remarque : Si la page à réviser s'affiche dans un jeu de cadres, l'adresse Web correspond uniquement à la page que vous avez 
modifiée et non à l'ensemble du jeu de cadres.

Pour plus d'informations sur le processus de révision par courriel, voir la section « Description du processus de révision par 
courriel », page 36. Si votre rôle ne vous permet pas de publier, vous ne pouvez pas utiliser le processus de révision par 
courriel. Dans ce cas, servez-vous du processus de révision des brouillons (voir la section « Description du processus de 
révision des brouillons », page 35).

Remarque : Le processus de révision des brouillons s'applique uniquement à des brouillons de pages Web. Il ne concerne pas les 
brouillons d'entrées de blog.

Pour utiliser le processus de révision par courriel :
1 Dans votre brouillon, cliquez sur le bouton Envoyer pour la révision de la barre d'outils ou choisissez Fichier > Actions 
> Envoyer pour la révision.

La boîte de dialogue Envoi pour la révision apparaît.

2 Activez l'option Envoyer un courriel avec un lien vers un aperçu du brouillon, puis cliquez sur Envoyer.

3 Si la boîte de dialogue Envoyer une nouvelle page s'ouvre, vous pouvez modifier le nom du fichier ou cliquer sur Choisir 
un dossier pour enregistrer le brouillon ailleurs. Cliquez ensuite sur Envoyer ou sur Suivant.

Remarque : L'emplacement du dossier actif s'affiche dans l'adresse Web (URL), sous le nom du fichier.
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4 Si la boîte de dialogue d'envoi des nouvelles pages liées s'affiche, sélectionnez chaque page liée non publiée afin de 
modifier le nom et l'emplacement du dossier selon vos besoins. Cliquez ensuite sur Envoyer tout.

Contribute crée un nouveau message électronique dans votre application de messagerie par défaut.

Sur Macintosh, Contribute fonctionne avec les applications de messagerie par défaut suivantes : Mail, Eudora et Entourage. 

Remarque : Si Contribute ne détecte pas d'application de messagerie par défaut ou ne parvient pas à la démarrer, créez le 
message électronique en cliquant sur le lien Cliquez ici figurant dans la zone de message située sous la barre d'outils. Copiez 
l'adresse Web (URL) du brouillon figurant dans la fenêtre du navigateur, puis collez-la dans le message à envoyer aux réviseurs.

5 Indiquez le nom du réviseur et tapez un texte, puis envoyez le message.

Dans Contribute, vous pouvez alors modifier un autre brouillon ou passer au navigateur de Contribute en attendant que le 
réviseur vous envoie ses commentaires. Lorsque vous recevez les commentaires du réviseur, cliquez sur le titre du brouillon 
dans le panneau Pages pour le rouvrir et le mettre à jour. 

Remarque : Lorsque vous supprimez ou publiez le brouillon, Contribute supprime sa copie temporaire stockée sur le serveur à 
l'intention du réviseur.

Accès aux nouveaux brouillons de révision
Adobe Contribute CS3 est configuré pour vérifier la présence de nouveaux brouillons de révision et de les synchroniser avec 
les brouillons disponibles pour les sites Web connectés et les blogs en arrière-plan. La prochaine fois que vous modifierez 
un brouillon à réviser existant, Contribute vérifiera automatiquement la présence de nouveaux brouillons, les téléchargera 
le cas échéant et les affichera dans le panneau Pages, accompagnés dans la barre d'état d'une notification indiquant leur 
présence. Une autre solution pour vérifier manuellement la présence de nouveaux brouillons consiste à cliquer sur l'icône 
Actualiser. Le nouveau brouillon envoyé en révision est répertorié dans une zone prévue à cet effet, dans la page de la 
console de brouillons. En conséquence, le démarrage de Contribute n'est pas retardé.

Pour télécharger les nouveaux brouillons à réviser :
1 Dans le panneau Pages, cliquez sur le lien Console de brouillons. 

Remarque : La Console de brouillons n'est pas disponible si aucun administrateur n'est affecté à une connexion du site Web.

La console présente des liens pointant vers tous les brouillons que vous avez envoyés, modifiés ou révisés. A chaque 
brouillon envoyé sont associées des informations d'état. 

Remarque : Contribute retire les brouillons publiés et supprimés de la Console de brouillons tous les 30 jours. Pour supprimer 
manuellement les brouillons périmés, appuyez sur Contrôle+Maj et choisissez Affichage > Actualiser les brouillons.

2 Pour afficher un brouillon, sélectionnez son titre. 

Le brouillon s'affiche dans Contribute ; vous pouvez cliquer sur le lien Console de brouillons afin de revenir à la console.

3 Pour actualiser l'affichage à tout moment, procédez de l'une des manières suivantes : 

• Cliquez sur le bouton Actualiser les brouillons de la Console de brouillons. 

• Choisissez Affichage > Actualiser les brouillons. 

S'il détecte de nouveaux brouillons, Contribute les télécharge et les affiche dans le panneau Pages, accompagnés d'une 
notification indiquant leur présence dans la barre d'état.

Si, au cours de la modification d'un brouillon, Contribute présente une version actualisée d'une révision antérieure, vous 
pouvez supprimer cette ancienne version. Cette opération de suppression n'oblige pas Contribute à vérifier la présence de 
nouveaux brouillons à réviser et, par conséquent, améliore les performances de l'application Contribute.
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Utilisation de pages Web créées à partir de modèles 
Dreamweaver
Un modèle Dreamweaver est un type de page Web spécifique contenant une mise en page prédéfinie et des éléments tels 
que du texte et des images. Contribute vous permet de créer une page Web ou une entrée de blog à partir d'un modèle. Vous 
pouvez également modifier une page créée à partir d'un modèle pour un site ou un blog, modifier les propriétés d'un 
modèle de page de site Web et personnaliser des modèles de blogs. 

Remarque : Si votre site Web comporte de nombreux modèles, le démarrage de Contribute peut prendre un peu plus de temps. 
Pour accélérer le lancement de Contribute, pensez à vous déconnecter de certains sites et blogs ou à désactiver certaines 
connexions au démarrage de l'application. Pour plus d'informations, voir la section « Activation de la connexion à un site Web 
ou à un serveur de blog », page 204.

Modification d'une page Web créée à partir d'un modèle
Toute page issue d'un modèle Dreamweaver contient des zones modifiables dans lesquelles vous pouvez ajouter ou modifier 
du contenu, et des zones verrouillées dans lesquelles toute modification ou ajout est impossible.

Remarque : Si vous essayez de modifier une zone verrouillée dans un document basé sur un modèle, le pointeur change d'aspect 
pour indiquer que vous ne pouvez pas cliquer dans cette zone. 

Lorsque vous ouvrez une page issue d'un modèle, les zones modifiables sont entourées d'un cadre. Elles disposent chacune 
d'un onglet, dans la partie supérieure gauche, affichant leur nom. Dans la page, les onglets indiquent les zones dont vous 
pouvez ajouter ou actualiser le contenu.

Par exemple, une page relative à un produit et issue d'un modèle peut contenir une zone Titre et une zone Description, 
contenant respectivement le nom et le descriptif du produit. Vous ajoutez du contenu dans les sections appropriées.

Comme pour toute autre page Web, vous pouvez éditer les zones modifiables d'une page issue d'un modèle.

Pour modifier une page créée à partir d'un modèle :
1 Recherchez la page à modifier.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Modifier la page de la barre d'outils.

• Choisissez Fichier > Actions > Modifier la page.

La page Web s'ouvre en tant que brouillon dans l'éditeur de Contribute. Vous pouvez éditer les zones modifiables.

Utilisation de modèles de pages Web et de blogs
Vous avez la possibilité de modifier les propriétés d'un modèle et de personnaliser des modèles lorsque vous manipulez des 
pages Web ou des blogs dans Contribute. Parmi les propriétés de modèle modifiables, citons la couleur d'arrière-plan de la 
page. Vous pouvez personnaliser les modèles de blogs en insérant des champs supplémentaires dans le fichier de modèle 
Dreamweaver, lequel est créé automatiquement dès que vous commencez à travailler dans un blog à partir de Contribute.

Configuration des propriétés de modèle de page Web
Le concepteur de modèle Dreamweaver peut vous permettre d'afficher ou de masquer des parties de la page. Pour contrôler 
le contenu de cette page, utilisez la boîte de dialogue Propriétés du modèle. Les pages créées à partir d'un modèle peuvent 
également contenir des attributs modifiables, tels que la couleur d'arrière-plan, que vous pouvez changer dans les propriétés 
du modèle.

Pour modifier les propriétés d'un modèle :
1 Localisez une page créée à partir d'un modèle, puis cliquez sur le bouton Modifier la page de la barre d'outils.

2 Choisissez Format > Propriétés du modèle.
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La boîte de dialogue Propriétés du modèle s'affiche.

3 Dans la liste Nom, sélectionnez une propriété.

Contribute actualise la partie inférieure de la boîte de dialogue et affiche le nom et la valeur de la propriété sélectionnée.

4 Pour modifier la valeur de la propriété, saisissez une autre valeur dans le champ situé à droite du nom de la propriété.

5 Cliquez sur Appliquer pour appliquer les modifications sans fermer la boîte de dialogue ou sur OK pour appliquer les 
modifications et fermer la boîte de dialogue.

Personnalisation des fichiers de modèle Dreamweaver pour les blogs
Lorsque vous créez une connexion à un blog dans Contribute, un fichier de modèle Dreamweaver (DWT) est créé automa-
tiquement. Vous pouvez personnaliser les fichiers DWT de manière à inclure des champs supplémentaires dans le blog sous 
réserve que le service de publication de votre blog prenne en charge cette fonction. Ces champs supplémentaires vous 
permettent ensuite d'ajouter des informations à votre blog. 

Remarque : Certains services de publication de blogs ne prennent pas en charge l'ajout de champs supplémentaires.

Vous pouvez saisir des champs supplémentaires sous forme de balises XML dans le fichier de modèle Dreamweaver. Une 
fois ces balises insérées, les champs ajoutés sont visibles dans la prochaine entrée de blog que vous créez. Pour plus d'infor-
mations sur la création d'entrées de blog, consultez le « Création d'une entrée dans votre blog », page 65.

Remarque : Cette procédure facilite la personnalisation des modèles de fichiers Dreamweaver. Il est également pratique d'avoir 
des connaissances en matière de balises XML pour publier des entrées de blog sur un service de publication de blog tel que 
Movable Type.

Vous pouvez également publier cette entrée de blog personnalisée sur un autre blog si le serveur de celui-ci prend en charge 
des champs supplémentaires ; sinon, les champs supplémentaires demeurent invisibles dans le blog. Une fois que vous avez 
modifié l'entrée de blog selon le blog initial, tous les champs supplémentaires deviennent visibles. Pour plus d'informations 
sur la création d'entrées de blog, consultez le « Sélection du blog dans lequel une entrée doit être publiée », page 70.

Pour personnaliser un fichier de modèle de blog :
1 Ouvrez le fichier DefaultTemplate.dwt dans n'importe quel éditeur de texte. Pour ce faire, procédez de la manière 
suivante :

• Sous Windows, le fichier DefaultTemplate.dwt se trouve à l'emplacement suivant : C:\Documents and 
Settings\votrenom\Local Settings\Application Data\Adobe\Contribute CS3\Sites\Sitex\Templates.

Remarque : Si le dossier Local Settings est masqué, ouvrez l'Explorateur Windows et choisissez Outils > Options des dossiers > 
Affichage. Sous Fichiers et dossiers cachés, activez l'option Afficher les fichiers et dossiers cachés. 

• Sur Macintosh, le fichier DefaultTemplate.dwt se trouve à l'emplacement suivant : /disque dur Macintosh/Application 
Support/Adobe/Contribute CS3/Sites/Sitex/Templates
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2 Indiquez les balises XML relatives aux champs souhaités. L'exemple suivant illustre la procédure d'ajout des balises 
Extended Content, Excerpt et Keyword :
<<begintranslate>> <!-- TemplateBeginEditable name="mt_text_more" --> <<endtranslate>><!-- 

TemplateEndEditable -->

<<begintranslate>> <!-- TemplateBeginEditable name="mt_excerpt" --> <<endtranslate>><!-- 

TemplateEndEditable -->

<<begintranslate>> <!-- TemplateBeginEditable name="mt_keywords" --> <<endtranslate>><!-- 

TemplateEndEditable -->

Ajoutez toujours les balises après les lignes suivantes :

<div class="entry-content">

<<begintranslate>> <!-- TemplateBeginEditable name="adobe_main_content" --> <<endtranslate>><!-- 

TemplateEndEditable --></div>

3 Enregistrez et fermez le fichier.

Les champs supplémentaires seront disponibles lors de la création de votre prochain blog. Pour plus d'informations, voir la 
section « Création d'une entrée dans votre blog », page 65.

Actualisation des modèles
Si votre site Web comporte de nombreux modèles, le démarrage de Contribute peut être un peu plus long. Pour accélérer 
le lancement d'Adobe Contribute CS3, configurez l'application de manière à démarrer sans télécharger les modèles du 
serveur sur votre ordinateur client. Vous avez la possibilité de télécharger des modèles actualisés dès que cela s'avère néces-
saire ou lorsque Contribute affiche un message indiquant qu'un modèle sélectionné n'est pas synchronisé avec le modèle 
disponible sur le serveur.

Pour actualiser des modèles lors de la création de pages Web ou d'entrées de blog :
1 Dans le navigateur de Contribute, cliquez sur le bouton Nouveau de la barre d'outils ou sélectionnez la commande de 
menu Fichier > Nouveau. 

La boîte de dialogue Nouvelle page Web ou entrée de blog s'ouvre.

2 Dans le panneau Créer une page Web ou une entrée de blog pour, sélectionnez et développez le cas échéant la connexion 
au site Web ou au blog dans lequel vous souhaitez créer la page ou l'entrée.

3 Sous le panneau Aperçu, affichez les informations relatives au modèle associé au site Web sélectionné. Si Contribute 
indique que le modèle est périmé, cliquez sur le bouton Actualiser les modèles, puis sélectionnez l'une des options suivantes 
dans le menu déroulant :

• Pour tous les sites Web actualise les modèles relatifs à tous les sites Web et tous les blogs de manière globale.

• Pour le site Web/blog sélectionné met à jour les modèles relatifs au site Web ou au blog sélectionné uniquement.

• Pour le modèle sélectionné met à jour le modèle sélectionné uniquement.

Le modèle est actualisé.

4 Cliquez sur OK.

Lors de la création d'une page, si vous sélectionnez un modèle ne correspondant pas à celui stocké sur le serveur, Contribute 
vous invite à confirmer la création de la page à partir d'un ancien modèle. Si vous cliquez sur Oui, la page est créée à partir 
de l'ancien modèle. Si, au contraire, vous cliquez sur Non, le modèle sélectionné est mis à jour, puis la page est créée.

Remarque : Si un modèle n'est pas disponible, l'option Pour le modèle sélectionné est désactivée.
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Utilisation de Contribute hors connexion
Contribute vous permet de modifier des pages Web et des entrées de blog sans être connecté au réseau. La fonction 
Travailler hors connexion de Contribute vous permet de travailler où que vous soyez (dans un avion, chez vous, etc.). 

Lorsque vous travaillez hors connexion, vous pouvez modifier les brouillons, mais pas utiliser le navigateur de Contribute, 
car Contribute demeure hors ligne. Même si vous établissez une connexion réseau, vous devez activer le travail en ligne. 

Pour utiliser Contribute hors connexion :
• Si Contribute est exécuté et est connecté au réseau, choisissez Fichier > Travailler hors connexion (Windows) ou 

Contribute > Travailler hors connexion (Macintosh).

• Si Contribute n'est pas exécuté, lancez Contribute sans connexion réseau ; choisissez Travailler hors connexion dans la 
boîte de dialogue Echec de la connexion, puis cliquez sur OK.

Le navigateur de Contribute affiche la page Travailler hors connexion. Dans le panneau Pages, cliquez sur le titre d'un 
brouillon pour commencer à le modifier.

Passage du travail en ligne au travail hors connexion
Si vous démarrez Contribute sans être connecté ou que vous passez à une utilisation hors connexion au cours d'une session 
Contribute, vous pouvez revenir en ligne en établissant une connexion avec le serveur.

Remarque : Contribute ne rétablit pas la connexion avec le serveur Web. Vous devez vous connecter avant de pouvoir passer à 
une utilisation en ligne dans Contribute.

Pour passer du travail en ligne au travail hors connexion :
1 Choisissez Fichier > Travailler hors connexion (Windows) ou Contribute > Travailler hors connexion (Macintosh).

Lorsque vous passez en mode hors connexion, votre liaison au réseau n'est pas interrompue. 

Pour basculer du mode hors connexion au mode en ligne :
1 Le cas échéant, rétablissez la connexion réseau.

2 Procédez de l'une des manières suivantes :

• Choisissez Fichier > Travailler hors connexion (Windows) ou Contribute > Travailler hors connexion (Macintosh). 

La coche située en regard de cette option de menu disparaît.

• Cliquez sur le bouton Travail en ligne de la barre d'outils.

Travailler hors connexion dans l'éditeur de Contribute
Lorsque vous travaillez hors connexion, l'éditeur de Contribute affiche des informations sur les opérations possibles dans 
ce mode de travail. Il vous est alors impossible de naviguer vers d'autres pages Web, entrées de blog ou blogs. 

Lorsque vous travaillez hors connexion, vous pouvez modifier les brouillons actifs affichés dans le panneau Pages ou créer 
des pages et des entrées de blog. Certaines fonctions de l'éditeur de Contribute ne sont pas disponibles hors connexion. Par 
exemple, vous ne pouvez pas publier de pages ni d'entrées de blog tant que vous ne travaillez pas à nouveau en ligne.

Avant de passer en mode hors connexion, n'oubliez pas de cliquer sur Modifier la page afin de créer des brouillons pour 
toutes les pages ou entrées de blog que vous souhaitez modifier hors connexion. Lorsque vous êtes hors connexion, vous 

ne pouvez accéder ni aux pages d'accueil, ni aux pages ou entéres de blog récemment publiées. 

Pour modifier un brouillon hors connexion :
• Cliquez sur le titre d'un brouillon dans le panneau Pages du panneau de navigation. 

Le brouillon s'ouvre dans l'éditeur de Contribute.
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Pour créer une page Web ou une entrée de blog hors connexion :
• Choisissez Fichier > Nouveau. La boîte de dialogue Nouvelle page Web ou entrée de blog s'ouvre. Vous pouvez alors créer 

une page Web ou une entrée de blog vide.

La nouvelle page Web ou entrée de blog s'ouvre en tant que brouillon dans l'éditeur de Contribute et son titre figure dans 
le panneau Pages.

Pour supprimer une nouvelle page Web ou une entrée de blog hors connexion :
1 Ouvrez la page Web ou l'entrée de blog créée hors connexion.

Remarque : Vous ne pouvez supprimer que les pages Web et entrées de blog créées hors connexion. Lorsque vous travaillez hors 
connexion, vous ne pouvez pas annuler les modifications apportées à un brouillon.

2 Cliquez sur le bouton Annuler le brouillon de la barre d'outils ou choisissez Fichier > Actions > Annuler le brouillon.

Contribute supprime la nouvelle page Web ou la nouvelle entrée de blog du panneau Pages et ouvre la page Travailler hors 
connexion de Contribute.

Modification du contenu d'une page Web dans un logiciel 
externe
Pour modifier des images, des documents Microsoft Word, du contenu Adobe Fireworks ou d'autres types de fichiers de 
votre site Web, vous devez utiliser l'application dans laquelle ils ont été créés. Vous pouvez ouvrir l'application appropriée 
à partir de Contribute. 

Remarque : Servez-vous de Contribute pour modifier le fichier dans une application externe. Les modifications apportées au 
fichier source local initial ne figurent pas sur le site Web.

Pour pouvoir lancer l'éditeur externe depuis Contribute, il vous faudra peut-être préalablement l'associer au type de fichier 
à modifier. Contribute contient des éditeurs préattribués aux types de fichiers courants.

Pour modifier du contenu dans une application externe :
1 Pour localiser le contenu à modifier, procédez de l'une des manières suivantes :

• Accédez à la page ou au fichier dans lequel se trouve le contenu à modifier, puis cliquez sur Modifier la page.

• Cliquez sur le bouton Choisir de la barre d'outils, accédez au fichier à modifier, puis cliquez sur OK.

Remarque : Si le navigateur de Contribute ne peut pas afficher la page ou le fichier sélectionné, la page Espace réservé pour le 
fichier s'affiche.

2 Procédez de l'une des manières suivantes :

• Si vous localisez puis ouvrez une page en tant que brouillon, cliquez du bouton droit (Windows) ou en maintenant la 
touche Contrôle enfoncée (Macintosh) sur l'élément à modifier et choisissez Modifier dans une application externe.

Contribute affiche la page Modification du brouillon dans une autre application et démarre l'application externe. 

3 Si vous modifiez une image dans Fireworks, cliquez sur Non dans la boîte de dialogue Recherche la source pour indiquer 
que vous ne souhaitez pas modifier le fichier source de cette image, mais uniquement l'image dans le site Web.

4 Apportez les modifications nécessaires dans l'application externe, enregistrez-les, puis fermez l'application.

Remarque : Si vous utilisez Fireworks, cliquez sur le bouton Terminé dans la fenêtre de modification.

5 Dans Contribute, cliquez sur l'un des boutons d'action de la barre d'outils.

Si vous devez apporter d'autres modifications, cliquez sur le lien Lancer de la page Modification du brouillon dans une 
autre application pour rouvrir le contenu dans l'éditeur externe.
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Ajout de la fonctionnalité de recherche Google à votre 
page Web
Vous pouvez ajouter un champ de recherche Google™ dans votre page Web pour que vos internautes puissent lancer des 
recherches sur Internet ou uniquement dans votre site.

Pour insérer un champ de recherche Google :
1 Dans votre brouillon, placez le point d'insertion à l'emplacement où le champ de recherche doit figurer.

2 Choisissez Insertion > Champ de recherche Google.

La boîte de dialogue Insérer un champ de recherche Google s'affiche.

3 Définissez les options de chaque écran, puis cliquez sur Suivant.

Pour plus d'informations sur les options d'un écran, cliquez sur le bouton Aide.

4 Examinez le récapitulatif, puis cliquez sur Terminé.

Le champ de recherche Google apparaît dans votre brouillon.

Pour modifier les propriétés d'un champ de recherche Google :
1 Dans votre brouillon, sélectionnez le champ de recherche Google.

2 Choisissez Format > Propriétés du champ de recherche Google.

La boîte de dialogue Propriétés du champ de recherche Google s'affiche.

3 Cliquez sur l'un des onglets situés en haut de la boîte de dialogue et modifiez les options selon vos besoins.

Pour plus d'informations sur les options de l'onglet, cliquez sur le bouton Aide.

4 Lorsque vous avez terminé, cliquez sur OK.

Modification de la source d'une page Web dans une 
application externe
Pour effectuer des modifications rapides ou réaliser certains tests, par exemple vérifier des liens ou l'accessibilité, vous 
pouvez modifier la source d'une page Web dans une application externe. Contribute ouvre alors la source dans une appli-
cation de modification externe. 

Remarque : Si l'administrateur Contribute n'a pas activé la modification de la source, vous ne pouvez pas la modifier dans une 
application externe. Pour plus d'informations, contactez votre administrateur Contribute.

Important : La modification de la source d'une page Web dans une application externe est une procédure radicalement diffé-
rente de la modification dans Contribute. Si vous n'êtes pas certain de la procédure de modification directe de la source, 
contactez votre administrateur Contribute.

Pour modifier la source d'une page Web dans une application externe :
1 Dans le navigateur ou l'éditeur de Contribute, affichez la page dont vous souhaitez modifier la source.

2 Choisissez Fichier > Actions > Modifier la source de la page dans une application externe.

Contribute affiche la page Modification du brouillon dans une autre application et démarre l'application externe. 

3 Apportez les modifications nécessaires dans l'éditeur externe, enregistrez-les, puis fermez le fichier ou l'application.

Important : Lorsque vous modifiez la source d'une page Web, n'oubliez pas que le style et la mise en forme s'altèrent facilement 
et que vous risquez d'obtenir des résultats inattendus. Si vous n'êtes pas certain de la procédure de modification directe de la 
source, contactez votre administrateur Contribute.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

54

4 Dans Contribute, procédez de l'une des manières suivantes :

• Cliquez sur le lien Modifier dans Contribute de la page Modification du brouillon dans une autre application pour 
recharger le brouillon dans Contribute.

Cette option vous permet de vérifier les modifications apportées et de les poursuivre.

Remarque : Si Contribute vous invite à enregistrer et à fermer le fichier dans l'application externe, cliquez sur OK.

• Cliquez sur le lien Lancer de la page Modification du brouillon dans une autre application pour rouvrir le contenu dans 
l'éditeur externe.

Cette option vous permet d'apporter d'autres modifications et de basculer aisément entre Contribute et l'application 
externe.

• Dans la barre d'outils, cliquez sur le bouton Publier pour que les modifications apportées soient appliquées au site Web.

• Cliquez sur le bouton Envoyer pour la révision pour transmettre le brouillon à un autre utilisateur afin qu'il puisse 
contrôler vos modifications.

• Cliquez sur le bouton Annuler le brouillon si vous souhaitez annuler les changements que vous avez entrepris dans une 
application externe.

Cette option annule tous les changements apportés dans Contribute ou dans l'application externe depuis que vous avez 
commencé l'opération de modification.

Annulation d'un brouillon, d'une nouvelle page ou d'une 
nouvelle entrée de blog
Lorsque vous modifiez le brouillon d'une page Web ou d'une entrée de blog existante, vous pouvez annuler toutes les 
modifications apportées et conserver la version publiée de la page ou de l'entrée de blog. Vous avez la possibilité d'annuler 
une page Web ou une entrée de blog que vous venez de créer.

En outre, selon votre rôle, vous êtes peut-être autorisé à supprimer les pages publiées sur votre site Web. Pour plus d'infor-
mations, voir la section « Suppression d'une page Web », page 55.

Pour annuler les modifications apportées à un brouillon de page Web ou d'entrée de blog publiée :
• Dans le brouillon, cliquez sur le bouton Annuler le brouillon de la barre d'outils.

La version publiée de la page Web ou de l'entrée de blog s'affiche dans le navigateur de Contribute, sans les modifications.

Pour annuler une nouvelle page Web ou entrée de blog :
• Dans le nouveau brouillon, cliquez sur le bouton Annuler le brouillon de la barre d'outils.

Contribute annule la nouvelle page Web ou entrée de blog.
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Suppression d'une page Web ou d'une entrée de blog
Vous pouvez supprimer des pages et des entrées définitivement de votre site Web ou de votre blog. 

Si vous souhaitez supprimer un brouillon et ne pas retirer la page ou l'entrée existante de votre site Web ou de votre blog, 
consultez « Annulation d'un brouillon, d'une nouvelle page ou d'une nouvelle entrée de blog », page 54.

Cette section contient les rubriques suivantes :

• « Suppression d'une page Web », page 55

• « Suppression d'une entrée de blog », page 55

Suppression d'une page Web
Selon votre rôle, vous êtes peut-être autorisé à supprimer les pages publiées dans votre site Web. Dans ce cas, vous pouvez 
supprimer tout type de fichier de votre site Web, y compris les images.

Remarque : Si vous n'êtes pas autorisé à supprimer une page mais que cette opération est nécessaire, contactez votre adminis-
trateur Contribute ou reportez-vous à la section « Définition des paramètres d'accès aux dossiers et fichiers », page 213.

Vous n'avez pas besoin d'autorisation particulière pour supprimer une page que vous venez de créer et que vous n'avez pas 
encore publiée. Pour plus d'informations, voir la section « Annulation d'un brouillon, d'une nouvelle page ou d'une nouvelle 
entrée de blog », page 54.

Pour supprimer une page ou un fichier :
1 Procédez de l'une des manières suivantes pour rechercher la page ou le fichier :

• Naviguez jusqu'à la page ou le fichier à supprimer.

• Cliquez sur le bouton Choisir de la barre d'outils, sélectionnez un fichier, puis cliquez sur OK.

Remarque : Si Contribute ne peut pas afficher la page ou le fichier sélectionné, la page Espace réservé pour le fichier apparaît. 
Bien que vous ne puissiez pas l'afficher, vous pouvez supprimer la page ou le fichier.

2 Choisissez Fichier > Actions > Supprimer la page.

Remarque : Cette commande est désactivée si vous n'êtes pas autorisé à supprimer des pages de votre site Web.

Un message d'alerte s'affiche.

3 Cliquez sur Oui pour confirmer la suppression du fichier.

Contribute supprime la page et affiche la dernière page ouverte dans le navigateur.

Suppression d'une entrée de blog
Vous pouvez alors supprimer les entrées existantes de votre blog. 

Si vous souhaitez supprimer un brouillon, consultez la section « Annulation d'un brouillon, d'une nouvelle page ou d'une 
nouvelle entrée de blog », page 54.

Pour supprimer une entrée de blog :
1 Dans le navigateur de Contribute, localisez la page d'accueil du blog contenant l'entrée à supprimer.

2 Dans le menu déroulant Entrées, sélectionnez l'entrée de blog à supprimer ou choisissez Affichage > Sélectionner l'entrée 
de blog, puis choisissez l'entrée de blog pertinente.

3 Une fois l'entrée de blog affichée dans le navigateur incorporé, cliquez sur le bouton Supprimer l'entrée ou choisissez 
Fichier > Actions > Supprimer l'entrée.

Remarque : Vous pouvez également supprimer une entrée de blog en choisissant l'option Choisir un fichier ou Entrée de blog 
dans le menu Affichage. Dans la boîte de dialogue qui s'affiche, sélectionnez l'entrée de blog requise, puis cliquez sur le bouton 
Supprimer.
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4 Dans la boîte de dialogue de confirmation, cliquez sur Oui pour confirmer la suppression de l'entrée.

Contribute supprime l'entrée de votre blog et affiche la page d'accueil du blog.

Remarque :  La liste des entrées de blog figurant dans le menu déroulant Entrées est mise à jour après la suppression d'une 
entrée.

Actualisation de la liste des entrées
Vous pouvez mettre à jour la liste des entrées de blog de votre page d'accueil en actualisant la liste manuellement.

Pour actualiser la liste des entrées :
• Cliquez sur le bouton Actualiser la liste des entrées de blog  pour actualiser la liste des entrées de blog affichée dans 

le menu déroulant Entrées ou sélectionnez Affichage > Actualiser la liste des entrées de blog.

Les entrées de blog figurant dans le menu déroulant Entrées sont mises à jour.

Exportation d'une page Web ou d'une entrée de blog 
(Windows uniquement) 
Contribute vous permet d'exporter une page Web ou une entrée de blog de Contribute vers un fichier HTML externe. Vous 
pouvez alors enregistrer le fichier sur votre ordinateur ou sur le réseau.

Si vous exportez une page Web contenant des images qui n'a pas encore été publiée, celles-ci s'affichent dans la page Web 
exportée. Si vous modifiez une page Web existante (déjà publiée), il se peut que certaines images ne s'affichent pas dans la 
page exportée, car les nouvelles pages Web désignent les versions locales des images alors que les pages publiées renvoient 
aux images enregistrées sur le site Web.

Pour exporter une page Web ou une entrée de blog :
1 Localisez la page Web ou l'entrée de blog à exporter.

2 Procédez de l'une des manières suivantes :

• Si vous exportez une page Web, cliquez sur le bouton Modifier la page de la barre d'outils.

• Si vous exportez une entrée de blog, cliquez sur le bouton Modifier l'entrée de la barre d'outils.

3 Choisissez Fichier > Exporter.

La boîte de dialogue Exporter s'affiche.

4 Sélectionnez l'emplacement d'enregistrement du fichier exporté.

5 Saisissez un nom de fichier.

6 Cliquez sur Enregistrer. 

Le fichier exporté apparaît dans le dossier sélectionné.
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Impression d'une page Web ou d'une entrée de blog
Vous pouvez accéder à une page Web ou une entrée de blog et l'imprimer, ou encore imprimer une page Web ou une entrée 
de blog en cours de modification, afin de mieux l'examiner. 

Pour afficher un aperçu avant impression d'une page Web ou d'une entrée de blog :
1 Effectuez l'une des opérations suivantes :

• Choisissez Fichier > Aperçu avant impression (Windows).

• Choisissez Fichier > Imprimer, puis cliquez sur le bouton Aperçu (Macintosh).

La page Web ou l'entrée de blog s'affiche dans une fenêtre de navigateur. 

2 Pour imprimer la page ou l'entrée de blog, cliquez sur Imprimer ou sur OK.

3 Cliquez ensuite sur Fermer pour quitter l'aperçu.

Pour avoir un aperçu d'une page Web ou d'une entrée de blog dans un navigateur, reportez-vous à la section « Aperçu 
d'une page dans le navigateur par défaut », page 156.

Pour imprimer une page :
1 Choisissez Fichier > Imprimer.

Remarque : (Windows uniquement) Dans le navigateur de Contribute, vous pouvez également cliquer du bouton droit sur la 
page et choisir Imprimer.

La boîte de dialogue Imprimer s'ouvre.

2 Cliquez sur Imprimer ou sur OK.

L'imprimante par défaut imprime la page.
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Chapitre 5 : Ajout de pages, d'entrées de 
blog et de documents

Adobe® Contribute ® CS3 vous permet d'ajouter des pages à votre site Web. Pour ce faire, vous pouvez créer une page Web 
vierge, utiliser une copie d'une page Web ou une copie d'un exemple de page Web ou encore définir une page à partir d'un 
modèle. Outre la création de pages Web, vous avez la possibilité d'ajouter à un site Web un contenu existant à partir de 
documents Microsoft Office (fichiers Word ou Excel, par exemple) et d'insérer dans une page Web des vidéos Adobe Flash 
à partir de fichiers Adobe.

Vous pouvez également utiliser Contribute pour créer une nouvelle page autonome, non associée à l'un de vos sites Web, 
en l'enregistrant sur votre ordinateur. Enfin, vous pouvez ajouter un document imprimable à votre site Web en le conver-
tissant au format Adobe® Flash® Player 9.

Contribute vous offre la possibilité de créer et de publier des entrées dans votre blog. Vous pouvez également créer une 
entrée de blog vide, créer une entrée de blog en citant la partie sélectionnée d'une page Web affichée ou encore créer une 
entrée de blog à partir d'informations existantes sélectionnées dans le navigateur ou dans des documents Microsoft Office 
tels que des fichiers Word ou Excel. 

Outre la création d'entrées de blog, les fonctionnalités suivantes sont disponibles :

• Ajout de fichiers MP3 et d'autres contenus à une entrée de blog en créant un supplément multimédia 

• Ajout de catégories permettant de regrouper des entrées de blog apparentées

• Sélection du blog dans lequel publier l'entrée

• Configuration des préférences des opérations suivantes s'appliquant aux entrées de blog :

- Autorisation d'ajouter des commentaires pour les utilisateurs

- Autorisation d'ajouter un lien pointant vers une entrée de blog à l'aide de son URL de rétrolien pour les utilisateurs

- Indication des URL de serveur ping que Contribute doit informer lors de la publication d'une entrée de blog

- Affichage d'une liste des échecs de ping vers les serveurs ping

- Indication de l'emplacement où Contribute insère des balises dans les entrées de blog et spécification des informations sur 
le référentiel de balises

Après avoir créé une page Web, vous pouvez modifier ses propriétés et même ajouter des mots-clés ou une description de 
la page Web afin que les internautes puissent la localiser à l'aide d'un moteur de recherche.

Vous avez également la possibilité d'utiliser la barre d'outils de Contribute disponible dans les applications Microsoft telles 
que Word, Excel et Outlook afin d'insérer les documents dans Contribute, d'y apporter des modifications et de les publier 
sur les sites Web auxquels vous êtes connecté.

 Ce chapitre contient les sections suivantes :

• « A propos de la conversion de documents au format PDF (Windows uniquement) », page 60

• « Création ou copie d'une page sur un site Web », page 60

• « Création d'une page Web autonome », page 65

• « Création d'une entrée dans votre blog », page 65

• « Configuration des propriétés d'une page Web », page 67

• « Ajout de mots-clés et d'une description à une page Web », page 68

• « Configuration des préférences des entrées de blog », page 69

• « Association de métadonnées à une entrée de blog », page 69

• « Insertion de documents MS Office au format PDF dans des pages Contribute (Windows uniquement) », page 74
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• « Ajout de documents Microsoft Word et Excel à un site Web », page 75

• « Ouverture de documents dans Contribute à partir d'applications Microsoft Office (Windows uniquement) », page 77

• « Insertion de documents PDF dans des pages Contribute », page 83

• « Insertion de fragments de code HTML dans des pages Contribute », page 85

A propos de la conversion de documents au format PDF 
(Windows uniquement)
Contribute permet de convertir des documents MS Office tels que des documents Word, des présentations PowerPoint et 
des feuilles de calcul Excel en documents PDF, et de les insérer dans des pages Web ou des brouillons d'entrées de blog 
Adobe Contribute. Le processus d'insertion d'un document MS Office sous forme de fichier PDF implique la conversion 
du document au format PDF préalablement à son insertion. 

Les fichiers PDF sont téléchargés vers un dossier d'après les paramètres administrateur pertinents.

Création ou copie d'une page sur un site Web
Vous pouvez créer ou copier tous les types de pages suivants sur votre site Web :

• Copie de la page en cours  

• Page Web vierge  

• Page d'accueil Web  

• Modèle

Remarque : Si l'administrateur Contribute a limité les types de pages qu'il est possible de créer, il se peut que toutes les options 
ne s'affichent pas lors de la création ou de la copie d'une page. Pour plus d'informations, consultez votre administrateur 
Contribute ou la section « Définition des paramètres pour les nouvelles pages Web », page 219.

Copie d'une page sur votre site Web
Vous pouvez créer une copie de la page actuellement affichée sur votre site Web. Cette page doit être affichée dans le 
navigateur de Contribute. Il n'est pas possible de créer une copie d'une page à l'état de brouillon dans l'espace de travail de 
Contribute. De même, vous ne pouvez pas copier une page d'un site Web vers un autre.

N'oubliez pas d'ajouter le lien pointant vers la page avant de la publier, sans quoi les internautes ne pourront pas y accéder. 
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Pour créer une copie d'une page Web :
1 Accédez à la page à copier, puis cliquez sur le bouton Nouveau de la barre d'outils ou choisissez Fichier > Nouveau.

Remarque : Vous ne pouvez pas copier une page qui contient des cadres.

La boîte de dialogue Nouvelle page Web ou entrée de blog s'affiche. 

2 Dans le panneau Créer une page Web ou une entrée de blog pour, sélectionnez Copie de la page en cours. 

Remarque : Si vous ne pouvez pas activer cette option, cela signifie que la page que vous visualisez dans le navigateur ne peut 
pas être copiée. Cette option n'est pas disponible si l'administrateur Contribute a limité les types de page qu'il est possible de 
créer. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres pour les 
nouvelles pages Web », page 219.

Un aperçu de la page s'affiche dans le panneau Aperçu situé dans la partie droite de la boîte de dialogue.

3 Nommez la page dans la zone de texte Titre de la page. 

Ce titre s'affiche dans la barre de titre du navigateur lorsqu'un internaute consulte la page. Il n'apparaît pas sur la page elle-
même.

4 Cliquez sur OK. 

La page s'affiche sous forme de brouillon dans Contribute. Assurez-vous d'ajouter un lien pointant vers la nouvelle page 
avant de la publier (voir la section « Création de liens texte ou image », page 135).

Remarque : Contribute crée la nouvelle page dans le même dossier que la page copiée. Vous pouvez changer l'emplacement du 
dossier au moment de la publication de la page. 
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Création d'une page Web vierge
Vous pouvez créer une page vierge et l'ajouter à votre site Web. N'oubliez pas d'ajouter le lien pointant vers la page avant de 
la publier, sans quoi les internautes ne pourront pas y accéder. 

Remarque : Il est recommandé de créer la page et le lien y renvoyant simultanément. Pour ce faire, consultez la section 
« Création d'un lien vers une nouvelle page », page 136.

Pour créer une page Web vierge :
1 Dans le navigateur de Contribute, cliquez sur le bouton Nouveau de la barre d'outils ou sélectionnez la commande de 
menu Fichier > Nouveau. 

La boîte de dialogue Nouvelle page Web ou entrée de blog s'ouvre.

2 Dans le panneau Créer une page Web ou une entrée de blog pour, développez le cas échéant le site Web sur lequel vous 
souhaitez créer la page, puis sélectionnez Page Web vierge.

Remarque : Cette option n'est pas disponible si l'administrateur Contribute a limité les types de page qu'il est possible de créer. 
Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres pour les 
nouvelles pages Web », page 219.

3 Nommez la page dans la zone de texte Titre de la page. 

Ce titre s'affiche dans la barre de titre du navigateur lorsqu'un internaute consulte la page. Il n'apparaît pas sur la page elle-
même.

4 Cliquez sur OK. 

La page s'affiche sous forme de brouillon dans Contribute. Assurez-vous d'ajouter un lien pointant vers la nouvelle page 
avant de la publier (voir la section « Création de liens texte ou image », page 135).

Remarque : A moins que vous n'ayez sélectionné un site Web différent à l'étape 2, Contribute crée la nouvelle page dans le 
même dossier que celle que vous consultiez au moment de sa création. Vous pouvez changer l'emplacement du dossier au 
moment de la publication de la page. 

Copie d'une page d'accueil Web
Contribute est livré avec des pages d'accueil Web prédéfinies que vous pouvez copier et utiliser pour votre site Web. 
Choisissez l'une d'elles comme point de départ de votre page Web. 

N'oubliez pas d'ajouter un lien pointant vers la page avant de la publier. Sans ce lien, les internautes ne pourront pas y 
accéder. 

Remarque : Il est recommandé de créer la page et le lien y renvoyant simultanément. Pour ce faire, consultez la section 
« Création d'un lien vers une nouvelle page », page 136.

Pour copier une page d'accueil Web :
1 Dans le navigateur de Contribute, cliquez sur le bouton Nouveau de la barre d'outils ou sélectionnez la commande de 
menu Fichier > Nouveau. 

La boîte de dialogue Nouvelle page Web ou entrée de blog s'ouvre.

2 Dans le panneau Créer une page Web ou une entrée de blog pour, procédez de l'une des manières suivantes :

a Le cas échéant, développez le site Web sur lequel vous souhaitez créer la page. 

b Développez le dossier Pages d'accueil Web, puis sélectionnez la page voulue. 

Remarque : Le dossier Pages d'accueil Web n'est pas disponible si l'administrateur Contribute a limité les types de page qu'il est 
possible de créer. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres 
pour les nouvelles pages Web », page 219.

Un aperçu de la page sélectionnée s'affiche dans le panneau Aperçu situé dans la partie droite de la boîte de dialogue.
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3 Nommez la page dans le champ de texte Titre de la page. 

Ce titre s'affiche dans la barre de titre du navigateur lorsqu'un internaute consulte la page. Il n'apparaît pas sur la page elle-
même.

4 Cliquez sur OK. 

La page s'affiche sous forme de brouillon dans Contribute. Pour plus d'informations sur la modification d'une page d'accueil 
Web, voir la section « Modification d'une page d'accueil Web », page 63. Assurez-vous également d'ajouter un lien pointant 
vers la nouvelle page avant de publier celle-ci (voir la section « Création de liens texte ou image », page 135).

Remarque : A moins que vous n'ayez sélectionné un site Web différent à l'étape 2, Contribute crée la nouvelle page dans le 
même dossier que celle que vous consultiez au moment de sa création. Vous pouvez changer l'emplacement du dossier au 
moment de la publication de la page. 

Modification d'une page d'accueil Web 
Les exemples de pages d'accueil de Contribute ont été conçus par une société spécialisée. Vous êtes libre de les copier et de 
les utiliser dans votre site Web. Vous pouvez utiliser l'une de ces pages comme point de départ ou simplement remplacer 
son contenu par vos propres informations.

Après avoir créé une page à partir d'une page d'accueil Web, vous pouvez la modifier. Il ne s'agit pas d'un modèle dont 
certaines parties sont modifiables et d'autres pas, mais d'un simple point de départ à la création de votre propre page. Vous 
pouvez y apporter toutes les modifications nécessaires.

Remarque : Les liens hypertextes de la page ne fonctionnent pas automatiquement. Vous devez modifier chacun d'eux de sorte 
qu'il fasse référence à une page de votre site. 

Les sections suivantes vous guideront dans votre travail avec le texte, les images et les liens des pages d'accueil. Il s'agit là de 
simples conseils de démarrage, car les possibilités de modification de ces pages sont innombrables. 

Pour modifier le texte d'un brouillon créé à partir d'une page d'accueil :
• Pour remplacer le texte existant, sélectionnez le passage concerné et tapez votre propre texte à la place.

Lorsque vous remplacez un texte existant, Contribute conserve la mise en forme définie lors de la conception de la page 
d'accueil. Vous pouvez cependant la remplacer par la mise en forme de votre choix. 

• Pour ajouter du texte à un brouillon, copiez le texte à partir du brouillon ou d'une autre source (un document Microsoft 
Word par exemple), placez le point d'insertion à l'endroit désiré ou sélectionnez le texte à remplacer, puis choisissez 
Edition > Coller du texte uniquement.

Remarque : Pour supprimer l'objet Date de votre page, désactivez l'option Protéger les scripts et les formulaires dans les 
paramètres d'administration. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition 
des paramètres de modification de pages et de paragraphes », page 215.

Pour plus d'informations sur l'utilisation de texte, voir la section « Utilisation de texte », page 87.

Pour remplacer une image ou un élément graphique dans un brouillon créé à partir d'une page d'accueil :
• Sélectionnez l'image, appuyez sur la touche Suppr, puis faites glisser la nouvelle image sur le brouillon.

La plupart des images et des illustrations des pages d'accueil ont des dimensions définies. Lors de leur remplacement, 
essayez d'utiliser une image de taille similaire afin de conserver la même mise en page.

Remarque : Si une icône en forme de bouclier jaune apparaît, il s'agit probablement de l'espace réservé à la date du jour. Lors 
de la publication de la page, la date du jour apparaît.

Pour plus d'informations sur l'utilisation des images, voir la section « Utilisation d'images et d'éléments graphiques », 
page 101.
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Pour activer les liens d'un brouillon créé à partir d'une page d'accueil :
• Pour remplacer le texte d'un lien existant, sélectionnez le lien et tapez votre propre texte. 

Remarque : Tous les liens des pages d'accueil Web ne présentent pas l'aspect par défaut d'un texte souligné en bleu. Ils peuvent 
ne pas être soulignés et avoir été conçus différemment. Lorsque vous cliquez sur un élément destiné à devenir un lien dans un 
brouillon issu d'une page d'accueil, la barre d'état située au bas de l'éditeur de Contribute indique qu'il s'agit d'un lien. 

• Pour activer un lien, sélectionnez-le, cliquez sur le bouton Lien de la barre d'outils, puis choisissez Rechercher une page 
Web. Cliquez sur le bouton Parcourir ou Choisir de la boîte de dialogue Insérer un lien pour localiser et sélectionner une 
page, puis sur OK pour fermer cette boîte de dialogue.

Vous devrez ensuite activer les liens ou supprimer ceux que vous ne souhaitez pas conserver.

Vous pouvez également créer un lien pointant vers une nouvelle page Web, par exemple une autre page d'accueil, et 
modifier celle-ci ultérieurement. Pour plus d'informations, voir la section « Création d'un lien vers une nouvelle page », 

page 136.

• Pour ajouter un lien pointant vers une barre de navigation verticale, sélectionnez la ligne contenant le dernier lien de la 
série, puis choisissez Edition > Copier. La ligne toujours sélectionnée, cliquez sur le bouton Insérer une ligne en dessous 
de la barre d'outils. Sélectionnez la nouvelle ligne, puis choisissez Edition > Coller.

Pour plus d'informations sur l'utilisation des liens, voir la section « Utilisation des liens », page 135.

Création d'une page Web à partir d'un modèle
Vous pouvez créer une page à partir d'un modèle. L'utilisation de modèles permet d'homogénéiser l'aspect des pages de 
votre site Web. Contribute propose deux types de modèles :

• Modèle créé dans Dreamweaver® (voir Aide de Dreamweaver > Utilisation de Dreamweaver). Un modèle Dreamweaver 
est un modèle créé à votre intention par un concepteur, avec des zones modifiables et d'autres verrouillées.

• Page désignée comme modèle par l'administrateur Contribute. L'administrateur Contribute peut choisir n'importe 
quelle page de votre site Web et la désigner comme modèle.

Vous pouvez créer des copies de ces deux types de modèles et les utiliser comme point de départ d'une nouvelle page. La 
seule différence réside dans les modèles Dreamweaver qui contiennent des zones modifiables et verrouillées (voir la section 
« Utilisation de pages Web créées à partir de modèles Dreamweaver », page 48) contrairement aux pages choisies comme 
modèles par l'administrateur Contribute.

Vous avez la possibilité de créer une entrée de blog à partir d'un modèle si le service de publication de blog génère des 
modèles Dreamweaver pour votre blog. Pour en savoir plus sur la création d'entrées de blog, voir la section « Création d'une 
entrée dans votre blog », page 65.

N'oubliez pas d'ajouter un lien pointant vers la nouvelle page avant de publier celle-ci. Sans ce lien, les internautes ne 
pourront pas y accéder. 

Remarque : Il est recommandé de créer la page de site Web ou d'entrée de blog et le lien y renvoyant simultanément. Pour plus 
d'informations, voir les sections « Création d'un lien vers une nouvelle page », page 136 et « Création d'un lien vers une nouvelle 
entrée de blog vide », page 138.

Pour créer une page à partir d'un modèle :
1 Dans le navigateur de Contribute, cliquez sur le bouton Nouveau de la barre d'outils ou sélectionnez la commande de 
menu Fichier > Nouveau. 

La boîte de dialogue Nouvelle page Web ou entrée de blog s'ouvre.

2 Dans le panneau Créer une page Web ou une entrée de blog pour, procédez de l'une des manières suivantes :

a Le cas échéant, développez le site Web sur lequel vous souhaitez créer la page. 

b Développez le dossier Templates, puis sélectionnez un modèle.

Remarque : Le dossier Templates n'est pas disponible si l'administrateur Contribute a limité les types de pages qu'il est possible 
de créer. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres pour 
les nouvelles pages Web », page 219.
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Un aperçu de la page sélectionnée s'affiche dans le panneau Aperçu situé dans la partie droite de la boîte de dialogue.

3 Nommez la page dans la zone de texte Titre de la page. 

Ce titre s'affiche dans la barre de titre du navigateur lorsqu'un internaute consulte la page. Il n'apparaît pas sur la page elle-
même.

4 Cliquez sur OK. 

La page s'affiche sous forme de brouillon dans Contribute. Assurez-vous d'ajouter un lien pointant vers la nouvelle page 
avant de la publier (voir la section « Création de liens texte ou image », page 135).

Remarque : A moins que vous n'ayez sélectionné un site Web différent lors de l'étape 2, Contribute crée la nouvelle page dans 
le même dossier que celle que vous consultiez au moment de sa création. Vous pouvez changer l'emplacement du dossier au 
moment de la publication de la page. 

Création d'une page Web autonome
Contribute vous permet de créer des pages non stockées sur un site Web auquel vous êtes connecté. Vous pouvez alors 
enregistrer la page sur votre ordinateur ou sur le réseau.

Pour créer un brouillon non associé à un site Web Contribute :
1 Dans le navigateur de Contribute, cliquez sur le bouton Nouveau de la barre d'outils ou sélectionnez la commande de 
menu Fichier > Nouveau. 

La boîte de dialogue Nouvelle page Web ou entrée de blog s'affiche. 

2 Dans le panneau Créer une page Web ou une entrée de blog pour, développez le dossier Poste de travail (Windows) ou 
Ce Mac (Macintosh), puis sélectionnez Page Web vierge.

Remarque : Assurez-vous d'activer cette option sous Poste de travail (Windows) ou sous Ce Mac (Macintosh) et non pour un 
site Web auquel vous êtes connecté.

3 Saisissez le titre de la nouvelle page.

4 Cliquez sur OK, puis de nouveau sur OK lorsque vous y êtes invité.

La boîte de dialogue Enregistrer sous s'affiche.

5 Naviguez jusqu'à l'emplacement désiré pour l'enregistrement du fichier, puis cliquez sur OK.

La page s'affiche sous forme de brouillon dans l'éditeur de Contribute.

Création d'une entrée dans votre blog
Les types d'entrées de blog suivants sont disponibles :

• Entrée vide de blog

• Entrée de blog citant la partie sélectionnée d'une page Web

Création d'une entrée de blog vide
Vous pouvez créer une entrée de blog vide et l'ajouter à votre blog. Une entrée de blog vide est une page vierge pouvant 
reprendre le modèle (mise en page et éléments tels que le texte et les images) de votre modèle de blog, selon que votre service 
de publication de blog génère ou pas des modèles Dreamweaver pour votre blog. Si, par exemple, vous créez une entrée de 
blog vide pour un blog hébergé par TypePad, elle reprend la mise en page et les éléments du modèle de blog.

Vous avez la possibilité d'insérer de nouvelles informations dans une entrée de blog vide.
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Pour créer une entrée de blog vide :
1 Dans le navigateur de Contribute, cliquez sur le bouton Nouveau de la barre d'outils ou sélectionnez la commande de 
menu Fichier > Nouveau. 

La boîte de dialogue Nouvelle page Web ou entrée de blog s'ouvre. 

2 Sélectionnez le blog désiré et choisissez l'option Entrée de blog vide.

3 Dans le champ de texte Titre de la page, donnez un nom à l'entrée de blog.

4 Cliquez sur OK. 

La nouvelle entrée de blog s'ouvre sous forme de brouillon dans Contribute.

5 (Facultatif) Insérez une balise à l'aide du champ Balises.

6 Dans la zone Date, cliquez sur l'icône de définition de la date et choisissez la date et l'heure auxquelles votre brouillon 
d'entrée de blog doit êre publié.

7 (Facultatif) Sélectionnez une ou plusieurs catégories dans la liste Catégories.

8 Cliquez sur l'icône Autoriser les rétroliens pour conserver la liste des autres blogs comprenant des liens pointant vers 
votre entrée de blog.

9 Cliquez sur l'icône Autoriser les commentaires pour permettre aux utilisateurs de saisir des commentaires concernant 
votre entrée de blog.

Remarque : Avant de publier l'entrée de blog, dans le menu Fichier, choisissez Aperçu dans le navigateur afin d'afficher l'entrée 
de blog dans un navigateur Web et de tester tous les liens de l'entrée.

10 Tapez le contenu de l'entrée de blog et publiez celle-ci.

Remarque : Vous avez la possibilité de lier une entrée de blog vide à une autre entrée de blog vide et de publier ces entrées. Pour 
plus d'informations, voir la section « Création d'un lien vers une nouvelle entrée de blog vide », page 138.

Création d'une entrée de blog à partir d'une sélection citée
Vous pouvez créer une nouvelle entrée de blog à partir d'informations sélectionnées sur une page Web depuis le navigateur 
de Contribute. Une sélection de ce type est appelée citation.

Vous avez également la possibilité de créer une entrée de blog à partir d'une sélection citée dans un navigateur externe tel 
que Microsoft Internet Explorer (voir la section « Publication de contenu sur un blog à partir d'un navigateur », page 166) 
ou dans des applications Microsoft Office telles que Word, Excel et Outlook (voir la section « Publication d'un contenu de 
blog depuis des applications Microsoft Word (Windows unqiuement) », page 167). Il ne vous reste plus ensuite qu'à publier 
l'entrée dans votre blog. 

Pour créer une nouvelle entrée de blog à partir d'une sélection citée sur une page Web dans Contribute :
1 Dans le navigateur de Contribute, localisez la page Web contenant la partie sélectionnée que vous souhaitez citer.

2 Sélectionnez la partie voulue sur la page Web.

3 Procédez de l'une des manières suivantes :

• Si vous disposez d'une connexion au site Web qui est affiché, cliquez sur le bouton Nouveau de la barre d'outils.

• En l'absence de connexion établie avec le site Web affiché, choisissez Fichier > Nouveau.

La boîte de dialogue Nouvelle page Web ou entrée de blog s'affiche.

4 Développez le dossier du blog dans lequel vous souhaitez publier la nouvelle entrée.

5 Sélectionnez l'option Citer à partir de la page actuelle.

Remarque : Cette option n'est pas disponible dans un autre navigateur que celui de Contribute.

6 Dans la zone de texte Titre des entrées de blog, donnez un nom à l'entrée de blog.

7 Cliquez sur OK.
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Modification d'une entrée de blog
Adobe Contribute CS3 a simplifié la tâche de gestion des entrées de blog. Vous pouvez accéder à une entrée de blog à partir 
de la page d'accueil de votre blog en sélectionnant son nom dans le menu contextuel Entrées. Cette liste affiche toutes les 
entrées du blog auquel vous êtes connecté par ordre chronologique inverse. Lorsque vous sélectionnez une entrée de blog 
dans le menu déroulant Entrées, elle est chargée dans le navigateur incorporé.

Plusieurs méthodes s'offrent à vous pour apporter des modifications à une entrée de blog :

• Vous pouvez modifier une entrée de blog directement dans Contribute. Pour plus d'informations, voir la section 
« Ouverture d'une entrée de blog à des fins de modification dans Contribute », page 38. 

• Si la fenêtre de votre navigateur affiche la page d'accueil d'un blog ou une entrée individuelle, cliquez sur le bouton 
Modifier dans Contribute afin de lancer Contribute à des fins de modification. Pour plus d'informations, voir la section 
« Ouverture d'une page Web ou d'une entrée de blog à des fins de modification dans un navigateur », page 39.

Remarque : Assurez-vous qu'une connexion a été établie avec le site Web ou le blog avant que vous ne commenciez à modifier 
une page Web ou une entrée de blog depuis votre navigateur.

Fixation de la date et de l'heure pour une entrée de blog
Vous pouvez fixer la date et l'heure de la publication de votre brouillon d'entrée de blog.

Si vous sélectionnez une date passée et que vous publiez l'entrée de blog, elle est publiée immédiatement à la date indiquée. 
Si vous sélectionnez une date dans le futur et que vous publiez l'entrée de blog, celle-ci sera publiée aux date et heure 
indiquées à la condition que le serveur de blog prenne en charge l'API de contrôle de la date. A défaut, l'entrée de blog est 
publiée sur le champ avec la date ultérieure indiquée.

Remarque : Les paramètres de date et d'heure de publication sont exclusivement acceptés par des serveurs de blog compatibles.

Configuration des propriétés d'une page Web
Pour chaque page Web, vous pouvez définir des propriétés de mise en page et de mise en forme : la taille et la famille de la 
police par défaut, la couleur d'arrière-plan, les marges, le style des liens et bien d'autres aspects de la présentation.

Remarque : Seules les propriétés des pages Web sont configurables. En effet, vous ne pouvez pas définir les propriétés des entrées 
de blog.

Les propriétés de page sélectionnées ne s'appliquent qu'à la page Web active. Lorsqu'une page utilise une feuille de style CSS 
externe, Contribute ne modifie pas cette dernière, car cette opération aurait un impact sur toutes les autres pages utilisant 
la feuille de style.

Remarque : Si vous modifiez un brouillon créé à partir d'un modèle ou si l'administrateur Contribute ne vous autorise qu'à 
modifier du texte, il est possible que vous ne puissiez changer que le titre de la page. Pour plus d'informations, contactez 
l'administrateur Contribute ou consultez la section « Définition des paramètres de modification de pages et de paragraphes », 
page 215.
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Pour définir les propriétés d'une page :
1 Dans le brouillon, cliquez sur le bouton Propriétés de la page de la barre d'outils ou choisissez Format > Propriétés de la 
page.

La boîte de dialogue Propriétés de la page s'affiche.

2 Sélectionnez des catégories dans la liste de gauche, puis apportez les modifications nécessaires.

Par défaut, Contribute affecte les propriétés des pages à l'aide de feuilles de style CSS. Si l'administrateur Contribute a défini 
l'utilisation de balises HTML au lieu des feuilles de style CSS, seules les catégories Titre/codage et Aspect figurent dans la 
partie gauche de la boîte de dialogue. Pour plus d'informations sur ce paramètre, contactez l'administrateur Contribute ou 
consultez la section « Définition des paramètres pour les styles et les polices », page 217.

Remarque : Si vous ne pouvez pas sélectionner les catégories Liens ou En-têtes, cela signifie que l'administrateur Contribute a 
défini des options interdisant la modification de ces propriétés de la page. De même, si vous ne pouvez modifier que les marges 
des pages dans la catégorie Aspect, c'est que l'administrateur a limité l'accès aux autres propriétés de cette catégorie. Pour plus 
d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres pour les styles et les 
polices », page 217.

Pour plus d'informations sur les options des catégories, cliquez sur le bouton Aide.

3 Cliquez sur Appliquer pour appliquer les modifications sans fermer la boîte de dialogue ou sur OK pour appliquer les 
modifications et fermer la boîte de dialogue.

Ajout de mots-clés et d'une description à une page Web
Vous pouvez associer des mots-clés et une description à votre page Web. Les internautes peuvent alors la localiser en tapant 
ces mots-clés dans un moteur de recherche.

Remarque : Vous ne pouvez ajouter de mots-clés et de descriptions que dans des pages Web. En effet, vous ne pouvez pas en 
insérer dans les entrées de blog.

Pour ajouter des mots-clés et une description à une page ou les modifier :
1 Localisez la page concernée, puis cliquez sur le bouton Modifier la page de la barre d'outils.

Un brouillon s'ouvre dans l'éditeur de Contribute.

2 Choisissez Format > Mots-clés et description.
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La boîte de dialogue Mots-clés et description de la page s'affiche.

3 Saisissez ou modifiez les mots-clés dans la zone Mots-clés.

Séparez les mots-clés par un seul espace (par exemple, compte-rendu réunion planification comité vacances soirée).

4 Saisissez ou modifiez la description de la page dans la zone Description.

5 Cliquez sur OK. 

Configuration des préférences des entrées de blog
Vous pouvez définir d'autres préférences s'appliquant aux entrées de blog. Dans la boîte de dialogue Préférences, vous 
pouvez effectuer les tâches suivantes :

• Définir les options du blog par défaut auquel se connecter : créer (ou non) une entrée de blog lorsque vous cliquez sur le 
bouton Nouvelle page, spécifier si l'ajout (ou non) de commentaires aux entrées de blog est permis et autoriser les autres 
utilisateurs à créer un lien pointant vers une entrée de blog par le biais de ses URL de rétrolien (voir la section 
« Définition des préférences dans Contribute », page 27) ;

Remarque : Certains hôtes de blog ne prennent pas en charge les commentaires ou exigent que vous définissiez une préférence 
à cet effet. Pour en savoir plus à ce sujet, consultez la documentation de votre hôte de blog.

Pour plus d'informations sur l'ajout d'URL de rétrolien à des entrées de blog, voir la section « Ajout d'URL de rétrolien à 
une entrée de blog », page 72. Pour plus d'informations sur l'ajout de balises à des entrées de blog, voir la section « Ajout de 
balises à une entrée de blog », page 71.

• indiquer les URL de serveur ping que Contribute doit informer lors de la publication d'une entrée de blog ;

• afficher la liste des échecs de ping vers les serveurs ping.

Association de métadonnées à une entrée de blog
Lors de la création ou de la modification d'une entrée de blog, vous pouvez saisir des informations supplémentaires sur 
l'entrée à l'aide des fonctions de métadonnées de blog. Les tâches suivantes sont disponibles pour les entrées de blog :

• Sélection du blog sur lequel l'entrée doit être publiée

• Saisie ou modification du titre

• Ajout de balises

• Attribution de catégories

• Ajout d'URL de rétrolien

• Autorisation ou non d'ajout de commentaires



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

70

Les fonctions des métadonnées principales associées aux blogs (blog dans lequel publier une entrée, titre de l'entrée de blog 
et balises à insérer dans l'entrée de blog) sont disponibles à partir de la barre d'outils d'entrée de blog principale dans le 
navigateur de Contribute. Les fonctions des métadonnées secondaires associées aux blogs (catégories, autorisation ou inter-
diction d'utiliser des URL de rétrolien et autorisation ou interdiction d'insérer des commentaires) sont disponibles lorsque 
vous cliquez sur le bouton d'affichage/de masquage des métadonnées secondaires  dans la barre d'outils de l'entrée de 
blog (en regard du champ Balises) ou que vous sélectionnez la commande Autres Options dans le menu Affichage.

Outre les barres d'outils d'entrée de blog, vous pouvez également faire appel au menu Format > Métadonnées de blog pour 
spécifier les fonctions de métadonnées associées à une entrée de blog.

Sélection du blog dans lequel une entrée doit être publiée
Vous pouvez sélectionner le blog dans lequel vous souhaitez publier une entrée en cours de création ou de modification. 
Tous les blogs avec lesquels vous avez établi une connexion via Contribute sont disponibles pour la sélection. 

Pour sélectionner le blog dans lequel vous souhaitez publier une entrée :
1 Créez ou modifiez l'entrée de blog à publier.

Remarque : Pour plus d'informations sur la création d'une entrée de blog, voir la section « Création d'une entrée dans votre 
blog », page 65. Pour plus d'informations sur la modification d'une entrée de blog, voir la section « Modification d'une entrée 
de blog », page 67.

2 Procédez de l'une des manières suivantes :

• Sélectionnez le blog cible dans le menu déroulant Blog de la barre d'outils. 

• Choisissez Format > Métadonnées de blog > Blog, puis sélectionnez le blog voulu dans le menu déroulant.

Remarque : Un avertissement s'affiche lorsque vous publiez une entrée de blog existante en cours de modification dans un blog 
cible autre que le blog initial. Si vous publiez l'entrée de blog modifiée dans un blog différent, une partie des métadonnées 
associées à l'entrée peut être supprimée et les liens pointant vers d'autres brouillons d'entrées de blog définis dans le blog initial 
sont supprimés.

3 (Facultatif) Cliquez sur OK pour fermer la boîte de dialogue d'avertissement.

L'entrée de blog est publiée dans le blog cible. 

Lorsque vous publiez une entrée de blog modifiée existante dans un nouveau blog, tous les liens contenus dans l'entrée du 
blog initial et pointant vers des brouillons d'autres entrées de blog sont rompus. Vous devez résoudre les liens rompus dans 
l'entrée de blog déplacée et dans les brouillons cibles. 

Remarque : Pour plus d'informations sur la définition de liens pointant vers une entrée de blog, voir la section « Création d'un 
lien vers une nouvelle page », page 136. Pour plus d'informations sur la publication d'une entrée de blog, voir la section 
« Publication de contenu sur un blog », page 166.

Définition ou modification du titre d'une entrée de blog
Vous pouvez définir ou modifier le titre d'une entrée de blog. Il est possible de nommer une entrée de blog lors de sa 
création ou de changer son titre par la suite, une fois qu'elle est enregistrée en tant que brouillon ou qu'elle est publiée dans 
votre blog.

Pour saisir le titre d'une nouvelle entrée de blog :
• Lors de la création d'une entrée, renseignez le champ Titre des entrées de blog dans la boîte de dialogue Nouvelle page 

Web ou entrée de blog.

Pour définir ou modifier le titre d'une entrée de blog existante ou d'un brouillon d'entrée de blog :
Procédez de l'une des manières suivantes :

• Renseignez le champ Titre de la barre d'outils.

• Choisissez Format > Métadonnées de blog > Titre, puis renseignez le champ Titre de la barre d'outils.
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Ajout de balises à une entrée de blog
Les balises vous permettent de saisir une ou plusieurs descriptions succinctes d'entrées de blog. Les autres utilisateurs 
peuvent alors rechercher les entrées de blog utilisant ces balises. Par exemple, dans le cas d'une entrée de blog relative au 
plus grand nombre de corners dans un match de football international, vous pouvez saisir les balises « football », « corner 
», « records de corner » et ainsi de suite. Les référentiels de balises suivants sont mis à votre disposition :

• www.technorati.com/tag 

• http://blogs.icerocket.com/search?q=

Lorsque l'utilisateur saisit une balise dans le champ de balise pour une entrée de blog, Contribute crée un lien de type balise. 
Une fois que l'utilisateur a publié l'entrée et activé ce lien, le navigateur incorporé affiche une liste présentant toutes les 
entrées de blog indexées par le référentiel de balises utilisant la même balise.

Lorsque vous créez ou modifiez une entrée de blog dans le panneau Pages, vous pouvez définir autant de balises que vous 
le souhaitez pour cette entrée à condition de les séparer par des virgules.

Remarque : Vous pouvez configurer des préférences en vue de déterminer, entre autres, l'emplacement des balises par rapport 
aux entrées de blog et le préfixe devant précéder les balises dans une entrée de blog. Pour plus d'informations sur la définition 
des balises, voir la section « Définition des préférences dans Contribute », page 27.

Pour ajouter des balises à une entrée de blog :
1 Dans le panneau Pages, sélectionnez l'entrée de blog souhaitée.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le champ Balises de la barre d'outils afin de placer le pointeur dedans.

• Choisissez Format > Métadonnées de blog > Balises pour placer le pointeur dans le champ Balises de la barre d'outils.

3 Dans le champ Balises, spécifiez une ou plusieurs balises à associer à l'entrée de blog. 

Vous pouvez saisir autant de balises que vous le souhaitez pour une entrée à condition de les séparer par des virgules.

Selon la configuration des préférences définie pour l'option Balisage dans la boîte de dialogue Préférences, Contribute 
insère les balises en haut ou en bas de l'entrée de blog, précédées par le préfixe spécifié.

4 Une fois les balises ajoutées à l'entrée de blog, vous pouvez modifier celle-ci, la publier ou l'enregistrer sous forme de 
brouillon.

Remarque : Vous avez la possibilité d'effacer des balises d'une entrée de blog en les supprimant du champ Balises ou, si vous 
modifiez l'entrée de blog, en supprimant la balise de l'entrée. Une fois l'entrée de blog actualisée publiée, la balise n'apparaît 
plus avec elle dans le blog.

Attribution de catégories à une entrée de blog
Vous avez la possibilité d'attribuer des catégories à des entrées de blog afin de regrouper des entrées similaires. Par exemple, 
vous pouvez classer ensemble les entrées de blog liées aux affaires en cours ou aux sports. 

Une entrée de blog peut très bien appartenir à plusieurs catégories. De même, vous pouvez modifier ou supprimer une 
catégorie sélectionnée à tout moment.

La prise en charge des catégories varie d'un hôte de blog à l'autre. Certains hôtes fournissent des catégories prédéfinies 
tandis que d'autres vous permettent de créer vos propres catégories. Enfin, d'autres hôtes encore ne prennent pas du tout 
en charge les catégories. Pour plus d'informations à ce sujet, consultez la documentation de l'hôte hébergeant votre blog.

Pour attribuer une catégorie à une entrée de blog :
1 Dans le panneau Pages, sélectionnez l'entrée de blog souhaitée.

2 Procédez de l'une des manières suivantes : 

• Sélectionnez la catégorie souhaitée dans le menu déroulant Catégories de la barre d'outils. 

Une coche apparaît en regard de la catégorie sélectionnée. 
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• Choisissez Format > Métadonnées de blog > Catégories, puis sélectionnez la catégorie voulue dans le menu déroulant.

Une coche apparaît en regard de la catégorie sélectionnée. 

Remarque : Vous pouvez attribuer plusieurs catégories à une entrée de blog.

Pour attribuer une autre catégorie à une entrée de blog :
1 Le cas échéant, dans le panneau Pages, sélectionnez l'entrée de blog souhaitée.

2 Procédez de l'une des manières suivantes :

• Sélectionnez la nouvelle catégorie dans le menu déroulant Catégories de la barre d'outils.

Une coche apparaît en regard de la catégorie spécifiée.

• Choisissez Format > Métadonnées de blog > Catégories, puis sélectionnez la nouvelle catégorie dans le menu déroulant.

Une coche apparaît en regard de la catégorie spécifiée.

Pour supprimer une catégorie d'une entrée de blog :
1 Le cas échéant, dans le panneau Pages, sélectionnez l'entrée de blog voulue.

2 Procédez de l'une des manières suivantes :

• Désélectionnez les catégories dans le menu déroulant Catégories de la barre d'outils.

• Choisissez Format > Métadonnées de blog > Catégories, puis désélectionnez toutes les catégories sélectionnées dans le 
menu déroulant.

Actualisation de la liste des catégories disponibles
Certains hôtes de blog vous permettent d'ajouter, de modifier ou de supprimer les catégories pouvant être attribuées à des 
entrées de blog. Après avoir apporté les modifications voulues aux catégories disponibles sur l'hôte du blog, actualisez la 
liste des catégories disponibles dans Contribute pour refléter ces changements.

Remarque : Seules les catégories disponibles sur l'hôte du blog sont modifiables. Il est impossible de modifier les catégories 
faisant partie de Contribute.

Pour actualiser la liste des catégories disponibles :
1 Sélectionnez le blog souhaité dans le panneau Pages.

2 Cliquez sur le bouton Actualiser  de la barre d'outils des métadonnées de blog.

Les catégories révisées figurent dans le menu déroulant Catégories de la barre d'outils. Elles sont également disponibles via 
le menu Format > Métadonnées de blog > Catégories. Les entrées de blog intégrant une catégorie que vous venez de créer, 
de modifier ou de supprimer sont mises à jour.

Ajout d'URL de rétrolien à une entrée de blog
Lorsque vous créez une entrée de blog, vous pouvez lui ajouter une ou plusieurs URL de rétrolien. Utilisez les URL de 
rétrolien pour conserver une liste des blogs comprenant des liens pointant vers votre entrée de blog. Pour créer un lien 
pointant vers l'une de vos entrées de blog, les auteurs des autres blogs ajoutent les URL de rétrolien de cette entrée à leur 
propre entrée de blog. Votre blog enregistre ces entrées de blog liées pour chacune de vos entrées. Vous pouvez cliquer sur 
ces liens pour afficher les entrées correspondantes. Vous avez également la possibilité d'empêcher des utilisateurs tiers 
d'insérer l'URL de rétrolien de votre blog dans les entrées de leur propre blog. Pour ce faire, désactivez l'option Autoriser 
les rétroliens.

Remarque : Une préférence permet de déterminer si la fonction de rétrolien est activée ou non pour les entrées de blog. Certains 
blogs ne prennent pas en charge la fonction de rétrolien ou exigent que vous définissiez une préférence à cet effet. Pour plus 
d'informations, consultez la documentation de votre blog. Pour plus d'informations sur l'activation d'URL de rétrolien pour les 
entrées de blog, voir la section « Définition des préférences dans Contribute », page 27.
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Pour ajouter une URL de rétrolien à une entrée de blog :
1 Sélectionnez l'entrée de blog souhaitée dans le panneau Pages.

Remarque : Contribute ne valide pas les URL que vous tapez dans la boîte de dialogue Rétroliens ou le champ URL de rétrolien. 
Si vous spécifiez une URL non valide ou si vous souhaitez modifier l'URL de rétrolien par la suite, modifiez l'entrée de blog et 
ajoutez-y une nouvelle URL de rétrolien. Cependant, vous ne pouvez ni modifier ni supprimer les URL de rétrolien indiqués 
initialement.

2 Procédez de l'une des manières suivantes : 

• Cliquez sur le bouton Rétroliens de la barre d'outils. 

• Choisissez Insertion > Rétroliens. 

3 Saisissez l'URL de rétrolien associée à l'entrée de blog dans le champ URL de rétrolien, puis cliquez sur OK.

Contribute ajoute les URL à l'entrée de blog et le champ Rétroliens figure au bas de l'espace de travail de Contribute. Ce 
champ vous permet d'insérer, de modifier ou de supprimer des URL de rétrolien. Ces modifications sont également réper-
cutées dans la boîte de dialogue Rétroliens.

Remarque : Certains blogs ne prennent pas en charge la fonction de rétrolien ou exigent que vous définissiez une préférence à 
cet effet. Pour plus d'informations, consultez la documentation de votre blog.

Une fois l'URL de rétrolien ajoutée à l'entrée de blog, vous pouvez modifier celle-ci, la publier ou l'enregistrer sous forme 
de brouillon.

Remarque : Vous pouvez seulement insérer une URL de rétrolien par ligne dans la boîte de dialogue Rétroliens et le champ URL 
de rétrolien de l'espace de travail de Contribute.

Ajout de commentaires à des entrées de blog autorisé
L'option Valeurs par défaut du blog disponible dans la boîte de dialogue Préférences permet de configurer Contribute de 
manière à ce qu'il permette ou non au serveur de blog d'accepter les commentaires relatifs aux entrées de blog. Si vous 
activez l'ajout de commentaires, les utilisateurs ont la possibilité d'insérer des commentaires à propos de vos entrées de blog. 
Vous pouvez également autoriser ou interdire l'ajout de commentaires pour des entrées de blog individuelles.

Remarque : Une préférence permet de déterminer si la fonction d'ajout de commentaires est activée ou non pour les entrées de 
blog. Pour plus d'informations sur l'autorisation d'ajout de balises à des entrées de blog, voir la section « Définition des préfé-
rences dans Contribute », page 27. Certains blogs ne prennent pas en charge les commentaires ou exigent que vous définissiez 
une préférence à cet effet. Pour plus d'informations, consultez la documentation de votre blog. 

Pour autoriser ou interdire l'ajout de commentaires à une entrée de blog :
1 Localisez l'entrée de blog voulue.

2 Cliquez sur le bouton Modifier l'entrée de la barre d'outils ou choisissez Fichier > Actions > Modifier l'entrée.

3 Procédez de l'une des manières suivantes :

• Activez ou désactivez la commande Format > Métadonnées de blog > Autoriser les commentaires afin de configurer 
l'ajout de commentaires pour l'entrée de blog.

• Cliquez sur le bouton Autoriser les commentaires de la barre d'outils afin d'autoriser ou d'interdire l'ajout de commen-
taires. 

4 Une fois l'ajout de commentaires activé ou désactivé pour l'entrée de blog, vous pouvez modifier celle-ci, la publier ou 
l'enregistrer sous forme de brouillon.

Lorsque vous publiez l'entrée de blog dans votre blog, un lien Commentaires permet aux personnes consultant l'entrée de 
publier un commentaire.
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Insertion de documents MS Office au format PDF dans des 
pages Contribute (Windows uniquement)
Contribute vous permet de convertir des documents MS Office tels que des documents Word, des présentations PowerPoint 
et des feuilles de calcul Excel en documents PDF, et de les insérer dans des pages Web Adobe Contribute ou des brouillons 
d'entrées de blog. Le processus d'insertion d'un document MS Office sous forme de fichier PDF implique la conversion du 
document au format PDF préalablement à son insertion.

Remarque : Si vous insérez un document Microsoft Word ou une présentation Microsoft PowerPoint et que vous souhaitez 
indiquer la zone du document à convertir, procédez à l'opération de conversion pendant que vous travaillez dans Word ou 
PowerPoint, puis insérez le document dans la page ouverte dans Contribute.

Pour insérer un document Office au format PDF dans Contribute
1 Dans le brouillon, placez le point d'insertion à l'emplacement cible du document PDF.

2 Choisissez Insertion > Document au format PDF.

La boîte de dialogue Ouvrir apparaît avec une liste de documents PDF convertibles. 

3 Sélectionnez un document MS Office, puis cliquez sur Ouvrir.

La boîte de dialogue Insérer un document Office en tant que PDF s'affiche.

4 Sélectionnez l'une des options suivantes :

• Créer un lien vers le document PDF convertit le document au format PDF et insère un lien pointant vers le document 
sélectionné.

• Insérer le PDF sous forme d'objet incorporé convertit le document au format PDF et incorpore le document PDF sous 
forme d'objet.

Remarque : L'option Insérer le PDF sous forme d'objet incorporé est désactivée si l'administrateur du site Web interdit l'incor-
poration de documents PDF.

5 Le cas échéant, activez la case à cocher Se souvenir de ce paramètre et ne plus le demander. 

6 Cliquez sur OK.

Contribute convertit le document au format PDF et l'insère dans votre brouillon sous forme de lien ou d'objet incorporé.

Pour supprimer un document PDF d'un brouillon : 
1 Dans le brouillon, cliquez sur le document PDF pour le sélectionner. 

2 Appuyez sur la touche Suppr.
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Pour créer et insérer un document PDF par glissement :
1 Dans le brouillon, placez le point d'insertion à l'emplacement cible du document PDF.

Réduisez la taille de la fenêtre de Contribute de manière à voir également l'application contenant le fichier que vous 
souhaitez faire glisser.

2 Ouvrez l'Explorateur Windows.

3 Faites glisser le document à convertir jusqu'au point d'insertion.

La boîte de dialogue Insérer un document Microsoft Office s'affiche.

4 Sélectionnez l'option Convertir en PDF et créer un lien vers le PDF ou l'option Convertir en PDF et incorporer le PDF 
sous forme d'objet, puis cliquez sur OK.

Contribute convertit le document au format PDF et l'insère dans votre brouillon.

Ajout de documents Microsoft Word et Excel à un site Web
Contribute vous permet d'ajouter facilement des documents ou du contenu Word et Excel à votre site Web ou votre entrée 
de blog. 

Si l'un de vos tableaux Word contient par exemple les coordonnées de tous vos commerciaux en France, vous n'avez pas 
besoin de recréer le tableau sur votre page Web : Contribute vous permet de l'ajouter à votre site.

Il existe quatre façons d'ajouter du contenu Word ou Excel à une page Web ou une entrée de blog : 

• Ajout du contenu d'un document Word ou Excel à une page Web/une entrée de blog nouvelle ou existante (Windows 
uniquement)

• Insertion d'un lien pointant vers un document Word ou Excel stocké dans une page Web ou une entrée de blog existante.

• Convertissez un document au format PDF et insérez un lien pointant vers le document dans une page Web ou une entrée 
de blog existante.

• Convertissez un document au format PDF et insérez un lien sous forme d'objet incorporé dans une page Web ou une 
entrée de blog existante.

Sous Windows, vous pouvez définir une préférence utilisateur de telle sorte que Contribute ajoute toujours le contenu du 
document sous forme d'objet incorporé ou insère un lien pointant vers le document lorsque vous ajoutez un document 

Word ou Excel..

Vous pouvez ajouter directement le contenu d'un document Word ou Excel à l'éditeur de Contribute à partir des applica-
tions Microsoft Office. Pour plus d'informations, voir la section « Ouverture de documents dans Contribute à partir d'appli-
cations Microsoft Office (Windows uniquement) », page 77.

Ajout de contenu Microsoft Word ou Excel à une page (Windows uniquement)
Vous pouvez ajouter le contenu d'un document Word ou Excel à une page Web nouvelle ou existante.

Lorsque vous ajoutez du contenu à une page, Contribute le convertit au format HTML et le copie sur la page Web ou l'entrée 
de blog. Vous pouvez ensuite en modifier le contenu dans Contribute ; les modifications que vous apportez au fichier 
d'origine stocké sur votre ordinateur ne figurent pas sur le site Web ou dans l'entrée de blog.

Si la taille du document que vous convertissez au format HTML est supérieure à 300 Ko, Contribute vous signale que le 
fichier est trop volumineux pour l'opération de conversion et vous propose d'autres options d'insertion du document, telles 
que la conversion au format PDF ou l'ajout d'un lien pointant vers le document. Pour plus d'informations sur ces options, 
voir les sections « Insertion de documents MS Office au format PDF dans des pages Contribute (Windows uniquement) », 
page 74 et « Insertion d'un lien pointant vers un document Microsoft Word ou Excel », page 76.

Remarque : Si vous utilisez Microsoft Office 97, vous ne pouvez pas ajouter le contenu d'un document Word ou Excel à une 
page Web. Vous devez impérativement insérer un lien vers le document ou convertir celui-ci au format PDF. 
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Pour ajouter le contenu d'un document Word ou Excel dans un brouillon :
1 Dans votre brouillon, placez le point d'insertion à l'endroit où le contenu doit s'afficher.

2 Procédez de l'une des manières suivantes pour sélectionner le fichier et le contenu à insérer :

• Dans Contribute :

a Choisissez Insertion > Document Microsoft Office. 

La boîte de dialogue Ouvrir s'affiche.

b Sélectionnez le document Microsoft Office requis et cliquez sur Ouvrir.

• (Windows uniquement) Faites glisser le fichier de son emplacement actuel vers le brouillon Contribute, à l'endroit où 
son contenu doit s'afficher. 

3 Dans la boîte de dialogue Insérer un document Microsoft Office, cliquez sur Insérer le contenu du document dans cette 
page, puis sur OK.

4 (Facultatif) Activez la case à cocher Se souvenir de ce paramètre et ne plus le demander si vous préférez ne plus voir 
l'invite relative à l'option d'insertion par la suite. 

Vous pouvez également configurer ces préférences à partir du menu Edition de Contribute. Pour ce faire, choisissez 
Edition > Préférences > Documents Microsoft et configurez les préférences voulues. Pour plus d'informations sur la 

définition de ces préférences, consultez la section« Définition des préférences dans Contribute », page 27.

5 Cliquez sur OK.

Le contenu du document Word ou Excel figure dans votre brouillon.

Insertion d'un lien pointant vers un document Microsoft Word ou Excel
Vous pouvez insérer un lien pointant vers un document Microsoft Word ou Excel dans une page Web ou une entrée de blog 
existante. 

Lorsque vous publiez la page ou l'entrée de blog avec le lien, Contribute copie le document sur votre site Web puis crée le 
lien pointant vers cette copie (et non vers le fichier initial stocké sur votre ordinateur). 

Remarque : Pour modifier le contenu de la page ou de l'entrée de blog liée après sa publication, voir la section « Modification 
de la source d'une page Web dans une application externe », page 53. Les modifications apportées au fichier d'origine ne 
figurent pas sur le site Web ou dans l'entrée de blog.

Pour créer un lien pointant vers un document Word ou Excel :
1 Dans votre brouillon, placez le point d'insertion à l'endroit où le contenu doit s'afficher.

2 Procédez de l'une des manières suivantes pour sélectionner le fichier et le contenu à insérer :

• Placez le point d'insertion dans votre brouillon, à l'endroit où le lien doit s'afficher. Vous pouvez également sélectionner 
du texte ou une image sur le brouillon, puis cliquer sur le bouton Lien de la barre d'outils et choisir Fichier sur mon Poste 
de travail. 

Dans la boîte de dialogue Insérer un lien, tapez le texte du lien, recherchez le fichier cible du lien, puis cliquez sur OK.

• (Windows uniquement) Faites glisser le fichier de son emplacement actuel vers le brouillon Contribute dans lequel le 
lien doit s'afficher. 

Dans la boîte de dialogue Insérer un document Microsoft Office, cliquez sur Créer un lien vers le document, puis sur OK.

Remarque : Le texte du lien correspond au nom du fichier cible du lien. Pour modifier le texte du lien après sa création, voir la 
section « Modification du texte et de la cible du lien », page 148.

Un lien pointant vers le document s'affiche dans le brouillon.
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Conversion de documents au format PDF et insertion dans des brouillons (Windows 
uniquement)
Vous avez la possibilité de convertir un document Microsoft Word ou Excel au format PDF et d'insérer un lien pointant vers 
le document PDF dans une page Web ou une entrée de blog existante ou encore d'insérer le document PDF dans le brouillon 
sous forme d'objet incorporé.

Pour convertir un document MS Office au format PDF et l'insérer sous forme de lien ou d'objet incorporé :
1 Dans le brouillon, placez le point d'insertion à l'emplacement cible du document PDF.

2 Choisissez Insertion > Document Microsoft Office. Dans la boîte de dialogue qui s'affiche, localisez le fichier, puis 
cliquez sur Ouvrir. 

La boîte de dialogue Insérer un document Microsoft Office s'affiche.

3 Choisissez l'une des options d'insertion de document PDF dans un brouillon Contribute suivantes :

Remarque : Ces options sont exclusivement disponibles pour les documents Microsoft Word et Excel.

• Sélectionnez l'option Convertir en PDF et créer un lien vers le PDF afin de convertir le document sélectionné au format 
PDF et d'insérer un lien renvoyant au document PDF.

• Sélectionnez l'option Convertir en PDF et incorporer le PDF sous forme d'objet pour convertir le document sélectionné 
au format PDF et incorporer le document PDF en tant qu'objet.

4 (Facultatif) Activez la case à cocher Se souvenir de ce paramètre et ne plus le demander si vous préférez ne plus voir 
l'invite relative à l'option d'insertion par la suite.

5 Cliquez sur OK.

Le document est converti au format PDF et inséré dans votre brouillon sous forme de lien ou d'objet incorporé.

Ouverture de documents dans Contribute à partir 
d'applications Microsoft Office  (Windows uniquement)
Vous pouvez ouvrir des documents tels que des feuilles de calcul, des documents Word et des messages électroniques dans 
Contribute à l'aide de la barre d'outils de Contribute disponible dans Microsoft Word, Excel et le lecteur de messagerie 
Outlook. Vous pouvez ouvrir les documents au sein de ces applications, utiliser la barre d'outils Office pour Contribute afin 
d'insérer le contenu dans l'éditeur de Contribute et publier le contenu sur votre site Web sans avoir à ouvrir Contribute.

La barre d'outils Microsoft Office est automatiquement installée sur votre ordinateur lors de l'installation de Contribute 
CS3. 

Remarque : La barre d'outils de Contribute s'installe uniquement sur les ordinateurs équipés des versions de Microsoft Office 
2003, Microsoft Office XP et Microsoft Office 2007.

Les modifications effectuées dans la barre d'outils de MS Office sont les suivantes :

• Une nouvelle commande Contribute figure dans le menu de l'application.

• Une barre d'outils relative à Contribute s'affiche sur une rangée distincte dans les applications.
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Ouverture de documents dans Contribute à partir de Microsoft Word, Excel et du lecteur de 
messagerie Outlook.
Chaque fois que vous ouvrez un document dans Contribute à partir d'une application Microsoft Office, trois possibilités 
s'offrent à vous : insérer une partie ou l'intégralité du contenu du document dans l'éditeur de Contribute, créer un lien 
renvoyant au document à partir de la page active dans l'éditeur de Contribute ou insérer le contenu sous forme de document 
PDF.

Remarque : Lorsque vous ouvrez un message électronique Outlook dans Contribute, vous pouvez seulement insérer son 
contenu dans l'éditeur.

Trois modes d'ajout de contenu à une nouvelle page Web sont possibles à partir des applications Microsoft Office :

• Ajout du contenu Word, Excel ou Outlook dans la page

• Insertion d'un lien vers un document Word ou Excel

• Insertion d'un document Word ou Excel au format PDF

Ajout du contenu Microsoft Word, Excel ou Outlook dans une page à partir de Microsoft Office (windows uniquement)
Vous avez la possibilité d'ajouter le contenu d'un document (document Word, feuille de calcul Excel ou message Outlook) 
à une nouvelle page Web. Vous pouvez également associer des modèles à ces documents avant de les ouvrir.

Lorsque vous insérez le contenu dans une page, Contribute copie le contenu du document dans l'éditeur de Contribute. 
Vous pouvez ensuite le modifier dans Contribute et le publier sur votre site Web.

Pour ajouter le contenu Word, Excel ou Outlook à une page à partir de Microsoft Office :
1 Ouvrez un document dans Microsoft Word ou Excel.

2 Pour ouvrir le document dans Contribute, procédez de l'une des manières suivantes à partir de la barre d'outils de 
Contribute disponible dans l'application :

Remarque : Si vous avez apporté des modifications au document, enregistrez ce dernier avant de l'ouvrir dans Contribute.

• Choisissez Contribute > Ouvrir dans Contribute.

• Cliquez sur le bouton Ouvrir dans Contribute de la barre d'outils.

Remarque : Contribute génère un message d'alerte si vous n'avez pas établi de connexion avec un site Web. Pour plus d'infor-
mations sur la création d'une connexion à un site Web, voir la section « Création d'une connexion à un site Web », page 179.

La boîte de dialogue Ouvrir en tant que nouvelle page s'affiche.

3 Sélectionnez le site Web où vous souhaitez placer le document.

4 Cliquez sur le bouton Choisir un modèle pour définir un modèle à jour pour un document MS Office ouvert dans 
Contribute. Pour plus d'informations sur la configuration d'un modèle, voir la section « Définition de modèles lors de 
l'ouverture de documents MS Office dans Contribute (Windows uniquement) », page 82.
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Si vous ne cliquez pas sur le bouton Choisir un modèle de la boîte de dialogue Ouvrir en tant que nouvelle page, le dernier 
modèle utilisé pour ouvrir un document Microsoft Office ou le modèle vierge est associé au document que vous ouvrez. De 
plus, si ce modèle ne correspond pas à celui situé sur le serveur, Contribute affiche la boîte de dialogue Télécharger un 
modèle. Vous pouvez procéder de l'une des manières suivantes :

• Ouvrez le document à l'aide de l'ancien modèle en cliquant sur le bouton prévu à cet effet.

• Téléchargez le modèle mis à jour à partir du serveur et ouvrez le document en cliquant sur le bouton prévu à cet effet.

Remarque : Si le site Web cible ne comporte pas de modèles, un message vous en informe lorsque vous cliquez sur le bouton 
Choisir un modèle.

5 (Facultatif) Si vous avez sélectionné le contenu d'un document et que vous souhaitez ouvrir le document entier au lieu 
de la partie sélectionnée, désactivez la case à cocher Ouvrir uniquement la sélection actuelle.

Remarque : Cette option est uniquement disponible si vous avez sélectionné le contenu du document.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

6 Cliquez sur Ouvrir.

La boîte de dialogue Insérer un document Microsoft Office s'affiche dans Contribute.

Remarque : La boîte de dialogue Insérer un document Microsoft Office ne s'affiche pas si vous insérez le contenu d'un message 
électronique Outlook. En effet, celui-ci est automatiquement inséré dans l'éditeur de Contribute après que vous avez cliqué sur 
Ouvrir.

7 Sélectionnez l'option Insérer le contenu du document dans cette page.

8 (Facultatif) Activez la case à cocher Se souvenir de ce paramètre et ne plus le demander si vous préférez ne plus voir 
l'invite relative à l'option d'insertion par la suite.

Pour plus d'informations sur les options de cette boîte de dialogue, consultez l'aide.

9 Cliquez sur OK.

Le modèle sélectionné s'applique à la page Web et Contribute ouvre le document dans un brouillon. Avant de publier ce 
document, vous devez créer un lien pointant vers cette nouvelle page à partir d'une page existante. Pour plus d'informations, 
voir la section « Création de liens texte ou image », page 135.

Remarque : L'option Ouvrir dans Contribute ne s'applique pas aux fichiers .rtf.

Insertion d'un lien pointant vers un document Microsoft Word ou Excel à partir de Microsoft Office (Windows 
uniquement)
Vous pouvez insérer un lien pointant vers un document Word ou Excel dans une nouvelle page. Lorsque vous publiez la 
page avec le lien, Contribute copie le document sur votre site Web puis crée le lien renvoyant à cette copie (et non au fichier 
initial stocké sur l'ordinateur).
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Pour insérer un lien pointant vers un document Word ou Excel à partir de Microsoft Office :
1 Ouvrez un document dans Microsoft Word ou Excel.

2 (Facultatif) Pour ouvrir uniquement une partie spécifique du document dans Contribute, sélectionnez la partie en 
question.

3 Pour ouvrir le document dans Contribute, procédez de l'une des manières suivantes à partir de la barre d'outils de 
Contribute disponible dans l'application :

Remarque : Si vous avez apporté des modifications au document, enregistrez ce dernier avant de l'ouvrir dans Contribute.

• Choisissez Contribute > Ouvrir dans Contribute.

• Cliquez sur le bouton Ouvrir dans Contribute de la barre d'outils.

Remarque : Contribute génère un message d'alerte si vous n'avez pas établi de connexion avec un site Web. Pour plus d'infor-
mations sur la création d'une connexion à un site Web, voir la section « Création d'une connexion à un site Web », page 179.

La boîte de dialogue Ouvrir en tant que nouvelle page s'affiche dans Contribute.

4 Sélectionnez le site Web où vous souhaitez placer le document.

5 Cliquez sur le bouton Choisir un modèle pour définir un modèle pour un document MS Office ouvert dans Contribute. 
Pour plus d'informations sur la configuration d'un modèle, voir la section « Définition de modèles lors de l'ouverture de 
documents MS Office dans Contribute (Windows uniquement) », page 82.

Si vous ne cliquez pas sur le bouton Choisir un modèle de la boîte de dialogue Ouvrir en tant que nouvelle page, le dernier 
modèle utilisé pour ouvrir un document Microsoft Office est associé au document que vous ouvrez. De plus, si le modèle 
ne correspond pas à celui situé sur le serveur, Contribute affiche la boîte de dialogue Télécharger un modèle. Vous pouvez 
effectuer l'une des opérations suivantes :

• Ouvrez le document à l'aide de l'ancien modèle en cliquant sur le bouton prévu à cet effet.

• Mettez à jour le modèle en y intégrant les modifications stockées sur le serveur et ouvrez le document en cliquant sur le 
bouton prévu à cet effet.

Remarque : Si le site Web cible ne comporte pas de modèles, un message vous en informe lorsque vous cliquez sur le bouton 
Choisir un modèle.

6 (Facultatif) Désactivez la case à cocher Ouvrir uniquement la sélection actuelle afin d'ouvrir la totalité du document et 
pas simplement la sélection.

Remarque : Cette case à cocher est uniquement disponible lorsque vous avez sélectionné un contenu quelconque dans votre 
document.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

7 Cliquez sur Ouvrir.

La boîte de dialogue Insérer un document Microsoft Office s'affiche.

8 Sélectionnez l'option Créer un lien vers le document Office.

9 (Facultatif) Activez la case à cocher Se souvenir de ce paramètre et ne plus le demander si vous préférez ne plus voir 
l'invite relative à l'option d'insertion par la suite.
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Pour plus d'informations sur les options de cette boîte de dialogue, consultez l'aide.

10 Cliquez sur OK.

Le modèle sélectionné s'applique à la page Web et Contribute insère un lien renvoyant au document dans un brouillon. 
Avant de publier ce document, vous devez créer un lien pointant vers cette nouvelle page à partir d'une page existante. Pour 
plus d'informations, voir la section « Création de liens texte ou image », page 135.

Insertion d'un document Microsoft Word ou Excel au format PDF à partir de Microsoft Office (Windows uniquement)
Contribute vous permet d'insérer dans une page Web un document Microsoft Word ou Excel au format PDF à partir de 
l'une ou l'autre de ces applications. Pour plus d'informations sur la conversion de documents MS Office au format PDF et 
l'insertion de documents PDF dans des pages Contribute, voir la section « A propos de la conversion de documents au 
format PDF (Windows uniquement) », page 60.

Pour insérer un document au format PDF à partir de Microsoft Office :
1 Ouvrez un document dans Microsoft Word ou Excel.

2 (Facultatif) Pour ouvrir uniquement une partie spécifique du document dans Contribute, sélectionnez la partie en 
question.

3 Pour ouvrir le document dans Contribute, procédez de l'une des manières suivantes à partir de la barre d'outils de 
Contribute disponible dans l'application :

Remarque : Si vous avez apporté des modifications au document, enregistrez ce dernier avant de l'ouvrir dans Contribute.

• Choisissez Contribute > Ouvrir dans Contribute.

• Cliquez sur le bouton Ouvrir dans Contribute de la barre d'outils.

Remarque : Contribute génère un message d'alerte si vous n'avez pas établi de connexion avec un site Web. Pour plus d'infor-
mations sur la création d'une connexion à un site Web, voir la section « Création d'une connexion à un site Web », page 179.

La boîte de dialogue Ouvrir en tant que nouvelle page s'affiche.

4 Sélectionnez le site Web où vous souhaitez placer le document.

5 Cliquez sur le bouton Choisir un modèle pour définir un modèle pour un document MS Office ouvert dans Contribute. 
Pour plus d'informations sur la configuration d'un modèle, voir la section « Définition de modèles lors de l'ouverture de 
documents MS Office dans Contribute (Windows uniquement) », page 82.

Si vous ne cliquez pas sur le bouton Choisir un modèle de la boîte de dialogue Ouvrir en tant que nouvelle page, le dernier 
modèle utilisé pour ouvrir un document Microsoft Office est associé au document que vous ouvrez. De plus, si ce modèle 
ne correspond pas à celui situé sur le serveur, Contribute affiche la boîte de dialogue Télécharger un modèle. Vous pouvez 
effectuer l'une des opérations suivantes :

• Ouvrez le document à l'aide de l'ancien modèle en cliquant sur le bouton prévu à cet effet.

• Mettez à jour le modèle en y intégrant les modifications stockées sur le serveur et ouvrez le document en cliquant sur le 
bouton prévu à cet effet.

Remarque : Si le site Web cible ne comporte pas de modèles, un message vous en informe lorsque vous cliquez sur le bouton 
Choisir un modèle.

6 (Facultatif) Désactivez la case à cocher Ouvrir uniquement la sélection actuelle afin d'ouvrir la totalité du document et 
pas simplement la sélection.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

7 Cliquez sur Ouvrir.

La boîte de dialogue Insérer un document Microsoft Office s'affiche.

8 Sélectionnez l'option Convertir en PDF et créer un lien vers le PDF ou l'option Convertir en PDF et incorporer le PDF 
sous forme d'objet.
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9 (Facultatif) Activez la case à cocher Se souvenir de ce paramètre et ne plus le demander si vous préférez ne plus voir 
l'invite relative à l'option d'insertion par la suite.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

10 Cliquez sur OK.

Contribute convertit le document au format PDF et l'insère dans votre brouillon sous forme de lien ou d'objet incorporé. 
Contribute applique également le modèle sélectionné à une page Web. 

Définition de modèles lors de l'ouverture de documents MS Office dans Contribute 
(Windows uniquement)
Adobe Contribute CS3 vous permet de placer le contenu de documents MS Office (MS Word et MS Excel) ou des 
documents entiers dans des modèles à leur ouverture dans Contribute. 

Pour sélectionner un modèle à l'ouverture d'un document MS Office dans Contribute :
1 Ouvrez une fichier d'application Microsoft Office. 

2 Modifiez le contenu et enregistrez le document.

3 Cliquez sur le bouton Ouvrir dans Contribute de la barre d'outils.

La boîte de dialogue Ouvrir en tant que nouvelle page s'affiche.

Remarque : L'option Ouvrir dans Contribute ne s'applique pas aux fichiers .rtf.

4 Sélectionnez le site Web requis.

L'URL racine du site Web sélectionné s'affiche automatiquement.

5 Cliquez sur le bouton Choisir un modèle. La boîte de dialogue Choisir un modèle s'affiche.

Si vous ne cliquez pas sur le bouton Choisir un modèle de la boîte de dialogue Ouvrir en tant que nouvelle page, le dernier 
modèle utilisé pour ouvrir un document Microsoft Office est associé au document que vous ouvrez. De plus, si ce modèle 
ne correspond pas à celui situé sur le serveur, Contribute affiche la boîte de dialogue Télécharger un modèle. Vous pouvez 
effectuer l'une des opérations suivantes :

• Ouvrez le document à l'aide de l'ancien modèle en cliquant sur le bouton prévu à cet effet.

• Mettez à jour le modèle en y intégrant les modifications stockées sur le serveur et ouvrez le document en cliquant sur le 
bouton prévu à cet effet.

Remarque : Si le site Web cible ne comporte pas de modèles, un message vous en informe lorsque vous cliquez sur le bouton 
Choisir un modèle. Si le document que vous ouvrez est un fichier au format natif, le bouton Choisir un modèle est désactivé. 

6 Sélectionnez un modèle parmi ceux mis à votre disposition.

L'aperçu du modèle sélectionné s'affiche dans le panneau Aperçu.

Remarque : Lors de la création d'une page, si vous sélectionnez un modèle ne correspondant pas à celui stocké sur le serveur, 
Contribute vous invite à confirmer la création de la page à partir d'un ancien modèle. Si vous cliquez sur Oui, la page est créée 
à partir de l'ancien modèle. Si vous cliquez sur Non, le modèle sélectionné est mis à jour, puis la page est créée.

7 Sélectionnez une zone du modèle dans la liste des zones modifiables disponibles dans le modèle sélectionné.

Remarque : Si le modèle sélectionné ne comporte pas de zones modifiables, la liste de sélection des zones de modèle est vide.

Cette liste est désactivée lorsque vous sélectionnez le modèle vide.

Remarque : Après avoir sélectionné le modèle à utiliser, vous devez sélectionner une région du modèle. Si vous sélectionnez un 
modèle et cliquez sur OK, la première région modifiable de la liste Sélectionner la région du modèle est sélectionnée.

8 Cliquez sur le bouton Actualiser les modèles, puis sélectionnez l'une des options suivantes pour mettre à jour les modèles 
et les zones modifiables dans un modèle sélectionné :

• Pour ce site Web permet d'afficher la liste actualisée des modèles associés au site Web sélectionné.

• Pour le modèle sélectionné permet d'afficher la liste actualisée des zones modifiables du modèle sélectionné.
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9 Par défaut, la case à cocher Définir comme modèle par défaut est activée. Le cas échéant, désactivez cette case à cocher.

10 Cliquez sur OK.

Le modèle sélectionné est appliqué à la page Web contenant le document MS Office et ce dernier est ouvert au format 
HTML.

11 (Facultatif) Si vous avez sélectionné le contenu d'un document et que vous souhaitez ouvrir le document entier au lieu 
de la partie sélectionnée, désactivez la case à cocher Ouvrir uniquement la sélection actuelle.

12 Cliquez sur Ouvrir.

La boîte de dialogue Insérer un document Microsoft Office s'affiche.

13 Sélectionnez l'une des options suivantes :

• Insérer le contenu du document dans cette page copie le contenu du document sélectionné dans le brouillon.

• Créer un lien vers le document insère un lien pointant vers le document sélectionné.

• Convertir en PDF et créer un lien vers le PDF convertit le document sélectionné au format PDF et insère un lien 
renvoyant au document PDF.

• Convertir en PDF et incorporer le PDF sous forme d'objet convertit le document sélectionné au format PDF et incorpore 
le document PDF en tant qu'objet.

14 (Facultatif) Activez la case à cocher Se souvenir de ce paramètre et ne plus le demander si vous préférez ne plus voir 
l'invite relative à l'option d'insertion par la suite.

15 Cliquez sur OK.

Le modèle sélectionné est appliqué à la nouvelle page Web dans laquelle le document est inséré. Le contenu sélectionné 
s'affiche dans le brouillon Contribute ou un lien pointant vers le contenu sélectionné est inséré dans le brouillon. Si vous 
avez converti le document au format PDF, Contribute insère un lien renvoyant au fichier PDF ou incorpore ce fichier sous 
forme d'objet.

Remarque : Si vous ouvrez ou publiez un document dans Contribute sans cliquer sur le bouton Choisir un modèle dans la boîte 
de dialogue Contribute - Publier sur le site Web ou Ouvrir en tant que nouvelle page, le dernier modèle stocké dans le registre 
est appliqué à la page Web contenant le document MS Office. Si vous utilisez pour la première fois la fonction Publier sur le site 
Web ou Ouvrir dans Contribute, un modèle vide est sélectionné.

Insertion de documents PDF dans des pages Contribute
Adobe Contribute CS3 vous permet d'incorporer des documents PDF sous forme d'objets ou d'insérer des liens renvoyant 
à des fichiers PDF dans des pages Web et des brouillons d'entrées de blog Contribute. Vous avez la possibilité d'ajouter du 
contenu PDF riche, des images haute résolution aux modèles tridimensionnels de votre site Web ou de votre page de blog. 
Les documents PDF peuvent être stockés sur votre ordinateur ou sur un site Web. 

Lorsque vous publiez une page Web ou une entrée de blog contenant un objet PDF incorporé, Contribute rend le contenu 
compatible EOLAS.

Remarque : Il est recommandé d'installer Adobe Acrobat 8 sur votre ordinateur avant de manipuler des documents PDF dans 
Contribute CS3.

Pour insérer un document PDF depuis votre ordinateur :
1 Dans le brouillon, placez le point d'insertion à l'emplacement cible du document PDF.

2 Choisissez Insertion > Document PDF > Depuis mon Poste de travail.

La boîte de dialogue Ouvrir s'affiche.

3 Localisez le document PDF requis, puis cliquez sur Ouvrir.

La boîte de dialogue Insérer un document PDF s'affiche.
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4 Sélectionnez l'une des options suivantes :

• Créer un lien vers le document PDF  

• Insérer le PDF sous forme d'objet incorporé

Remarque : L'option Insérer le PDF sous forme d'objet incorporé est désactivée si l'administrateur a activé l'option Interdire 
l'incorporation de PDF pour la connexion au site Web ou blog pertinente.

5 (Facultatif) Le cas échéant, activez la case à cocher Se souvenir de ce paramètre et ne plus le demander.

6 Cliquez sur OK.

Remarque : Si vous avez inséré le fichier PDF sous forme d'objet incorporé, une zone de message vous signale qu'une partie du 
contenu du document PDF n'est pas accessible et que certains navigateurs risquent de ne pas afficher un rendu du contenu PDF. 
Le cas échéant, activez la case à cocher Ne plus m'avertir, puis cliquez sur OK.

Le lien pointant vers le document PDF ou le contenu du document PDF incorporé s'affiche au point d'insertion dans le 
brouillon. Si vous avez inséré le fichier PDF sous forme de lien, son nom apparaît en tant que texte lié.

Pour insérer un document PDF depuis votre site Web :
1 Dans le brouillon, placez le point d'insertion à l'emplacement cible du document PDF.

2 Choisissez Insertion > Document PDF > Depuis le site Web.

Remarque : L'option Insertion > Document PDF > Depuis le site Web s'affiche uniquement lorsqu'un site Web est actif.

La boîte de dialogue Choisir un fichier ou une entrée de blog s'affiche.

3 Double-cliquez sur l'adresse Web et localisez le dossier contenant le document PDF à insérer. Sélectionnez le document 
PDF requis et cliquez sur OK.

4 Selon la préférence utilisateur que vous avez définie, le document PDF est inséré sous forme de lien ou d'objet incorporé. 

Une autre solution consiste à sélectionner l'une des options suivantes dans la boîte de dialogue Insérer un document PDF 
qui s'affiche :

• Créer un lien vers le document PDF

• Insérer le PDF sous forme d'objet incorporé

5 (Facultatif) Le cas échéant, activez la case à cocher Se souvenir de ce paramètre et ne plus le demander.

Remarque : L'option Insérer le PDF sous forme d'objet incorporé est désactivée si l'administrateur a activé l'option Interdire 
l'incorporation de PDF pour le site Web pertinent.

6 Cliquez sur OK.

Remarque : Si vous avez inséré le fichier PDF sous forme d'objet incorporé, une zone de message vous signale qu'une partie du 
contenu du document PDF n'est pas accessible et que certains navigateurs risquent de ne pas afficher un rendu du contenu PDF. 
Le cas échéant, activez la case à cocher Ne plus m'avertir, puis cliquez sur OK.

Le lien pointant vers le document PDF ou le contenu du document PDF incorporé s'affiche au point d'insertion dans le 
brouillon. Si vous avez inséré le fichier PDF sous forme de lien, son nom apparaît en tant que texte lié. 

Remarque : Une autre solution consiste à faire glisser vers le brouillon de votre site Web ou d'entrée de blog un fichier PDF à 
partir de l'Explorateur Windows.

Redimensionnement de fichiers PDF incorporés insérés dans des pages Web ou des 
entrées de blog
Vous pouvez modifier la taille de l'objet PDF incorporé dans un brouillon de page Web ou d'entrée de blog en sélectionnant 
l'objet et en déplaçant ses limites. Une autre méthode de redimensionnement consiste à saisir des valeurs spécifiques dans 
la boîte de dialogue des propriétés du document PDF.
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Pour redimensionner manuellement un fichier PDF incorporé :
1 Dans votre brouillon, sélectionnez le contenu du fichier PDF incorporé à redimensionner.

2 Faites glisser l'une des poignées de sélection jusqu'à obtention de la taille voulue.

Si vous préférez ne pas conserver les proportions hauteur/largeur de l'objet PDF (sous forme de pourcentage), maintenez 
la touche Maj. enfoncée pendant que vous faites glisser la poignée. 

Pour redimensionner un fichier PDF incorporé à l'aide de valeurs spécifiques :
1 Dans votre brouillon, sélectionnez le fichier PDF incorporé à redimensionner.

2 Double-cliquez sur l'objet PDF incorporé, cliquez du bouton droit sur l'objet et choisissez l'option Propriétés du 
document PDF ou sélectionnez l'objet PDF et choisissez Format > Propriétés du document PDF.

La boîte de dialogue des propriétés du document PDF s'affiche.

3 Saisissez les valeurs de largeur et de hauteur, puis activez ou non l'option Respecter les proportions.

4 Cliquez sur OK.

Contribute modifie la hauteur et la largeur de l'objet PDF incorporé.

Remarque : Vous avez également la possibilité de formater un objet PDF incorporé en cliquant du bouton droit sur l'objet et en 
choisissant une option dans le menu contextuel.

Insertion de fragments de code HTML dans des pages 
Contribute
Les utilisateurs expérimentés d'Adobe Contribute peuvent se servir d'Adobe Contribute CS3 pour insérer des fragments de 
code HTML personnalisés dans des pages Contribute. Vous pouvez, par exemple, insérer des fragments de code exécutant 
des fichiers vidéo ou audio dans vos pages Web ou pages de blog. Cependant, vous ne pouvez ajouter des fragments de code 
que si l'administrateur du site Web vous a octroyé les autorisations pertinentes.

Vous avez la possibilité de créer et d'insérer vos propres fragments de code HTML. Bien que Contribute valide la syntaxe 
du fragment de code, il ne valide pas pour autant l'exactitude logique du code. 

Important : Le code HTML ajouté à la page Contribute écrase parfois certains paramètres définis par l'administrateur, 
modifiant ainsi le comportement du produit. Par conséquent, il est recommandé d'appliquer cette fonction avec modération.

Pour insérer des fragments de code HTML dans des pages Contribute :
1 Localisez une page Web ou la page d'accueil de votre blog.

2 Si vous avez localisé la page d'accueil d'un blog, sélectionnez l'entrée de blog à modifier dans le menu déroulant Entrées.

3 Cliquez sur Modifier la page ou Modifier l'entrée.

4 Placez le point d'insertion à l'endroit où vous souhaitez insérer le fragment de code HTML dans votre brouillon.

5 Choisissez Insertion > Fragment de code HTML.

La boîte de dialogue Insérer un fragment de code HTML s'affiche.

Remarque : Si l'administrateur du site Web n'a pas activé l'option Autoriser l'insertion de fragments de code HTML pour votre 
rôle d'utilisateur, l'option Fragment de code HTML du menu Insertion est désactivée. Cette option est cependant activée par 
défaut pour les entrées de blog.

6 Saisissez le fragment de code ou insérez le fragment de code HTML que vous avez copié à partir d'une autre source.

7 Cliquez sur OK.

Le fragment de code HTML est exécuté dans le brouillon pertinent.
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Chapitre 6 : Utilisation de texte

Adobe® Contribute® CS3 vous permet d'ajouter et de mettre en forme du texte comme vous le feriez dans un logiciel de 
traitement de texte standard. Cependant, le travail du texte dans Contribute diffère de celui d'un logiciel de traitement de 
texte (Microsoft Word, par exemple), dans la mesure où Contribute utilise le langage HTML, même s'il le fait de manière 
transparente pour l'utilisateur.

Ce chapitre contient les sections suivantes :

• « A propos des styles CSS et HTML du menu Style de Contribute », page 87

• « Ajout de texte à une page Web », page 88

• « Modification de l'apparence du texte de la page », page 89

• « Positionnement du texte dans la page », page 94

• « Création de listes », page 95

• « Vérification orthographique », page 99

• « Recherche et remplacement de texte », page 99

Pour plus d'informations sur l'utilisation de texte dans les tableaux, voir la section « Utilisation des tableaux », page 121. 
Pour obtenir des informations sur l'alignement du texte autour des images, voir la section « Alignement d'une image », 
page 107. Pour obtenir des informations sur la modification du texte d'un lien, voir la section « Utilisation des liens », 
page 135.

A propos des styles CSS et HTML du menu Style de 
Contribute
Le menu déroulant Style de Contribute énumère les styles d'en-tête et de paragraphe HTML, ainsi que les styles CSS 
(Cascading Style Sheet) définis par l'utilisateur pouvant être appliqués à votre contenu. Tous les styles de la liste sont 
présentés tels qu'ils apparaîtront dans votre texte.

Remarque : Le menu Style n'est pas activé si l'administrateur Contribute a restreint l'application des styles à ce site Web. 

Vous pouvez peut-être également créer des styles CSS lorsque vous mettez le texte en forme. Dans ce cas, Contribute les 
ajoutera automatiquement à la liste des styles. Cette opération simplifie grandement l'application d'une même mise en 
forme à un bloc de texte et permet de conférer à vos pages un aspect cohérent. 

Remarque : Vous ne pouvez pas voir les styles CSS ou d'en-têtes HTML si votre administrateur Contribute les a désactivés. Pour 
activer ou désactiver des styles CSS dans Contribute, contactez l'administrateur Contribute ou reportez-vous à la section 
« Définition des paramètres pour les styles et les polices », page 217.

Contribute ne permet pas d'associer un style CSS à une page pour ajouter des styles supplémentaires ; pour associer une 
feuille de styles, utilisez Dreamweaver. 



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

88

Ajout de texte à une page Web
Pour ajouter du texte à une page Web, saisissez-le, effectuez un copier/coller ou faites-le glisser depuis une autre application 
ou page Web vers votre brouillon Contribute. 

Si vous utilisez la version Windows de Contribute, vous pouvez également ajouter la totalité d'un document Microsoft 
Word ou Excel à une page Web. Pour plus d'informations, voir la section « Ajout de documents Microsoft Word et Excel à 
un site Web », page 75. 

L'administrateur Contribute peut déterminer l'espace que Contribute ajoute automatiquement entre les paragraphes 
lorsque vous appuyez sur Entrée ou Retour. Pour plus d'informations, consultez votre administrateur Contribute ou la 

section « Définition des paramètres de modification de pages et de paragraphes », page 215.

Pour ajouter du texte à un brouillon, procédez de l'une des manières suivantes :
• Placez le point d'insertion dans le brouillon, puis tapez le texte directement.

• Sélectionnez du texte dans une autre application, puis choisissez Edition > Copier. Placez le point d'insertion dans le 
brouillon Contribute, puis choisissez Edition > Coller. 

Ne fermez pas Microsoft Excel avant d'avoir collé le contenu Excel dans Contribute afin de conserver la même mise en 
forme.

• Faites glisser le texte sélectionné depuis une autre application vers votre brouillon Contribute.

Remarque : Il est possible que Contribute conserve la mise en forme appliquée au texte dans l'autre application.

Ajout de la date du jour à une page
Vous pouvez ajouter la date du jour à une page. La date peut également inclure le jour de la semaine et l'heure.

Pour ajouter la date à un brouillon :
1 Placez le point d'insertion à l'endroit où la date doit s'afficher dans votre brouillon.

2 Choisissez Insertion > Date.

La boîte de dialogue Insérer date s'affiche.

3 Choisissez le format désiré pour le jour, la date et l'heure.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK.

Contribute ajoute la date du jour à votre brouillon.
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Insertion de caractères spéciaux dans une page
Vous pouvez insérer des caractères spéciaux (symbole du copyright (©) ou de l'euro (€), par exemple) dans une page. 

Remarque : Cet ajout n'est possible que dans les pages qui utilisent le codage occidental (Latin 1). Pour plus d'informations sur 
la configuration du codage de page, voir la section « Configuration des propriétés d'une page Web », page 67.

Pour insérer un caractère spécial dans un brouillon :
1 Placez le point d'insertion à l'endroit où le caractère doit apparaître dans votre brouillon.

2 Procédez de l'une des manières suivantes :

• Choisissez Insertion > Caractères spéciaux et sélectionnez un caractère dans le menu déroulant.

• Choisissez Insertion > Caractères spéciaux et sélectionnez Autre. Dans la boîte de dialogue Insérer un autre caractère, 
cliquez sur le caractère à insérer, puis sur OK.

Le caractère s'affiche dans votre brouillon.

Modification de l'apparence du texte de la page
Contribute vous permet de mettre en forme du texte (des caractères ou des paragraphes entiers) de façon simple et rapide. 
Vous pouvez utiliser les options de menu ou la barre d'outils de mise en forme pour modifier le texte d'un seul clic de souris.

Vous trouverez une illustration détaillée de la barre d'outils de mise en forme du texte à la section « Barres d'outils de 
Contribute », page 20.

Remarque : Pour plus d'informations sur le déplacement de texte, voir la section « Positionnement du texte dans la page », 
page 94.

Modification de la police et de la taille du texte
Vous pouvez changer l'apparence du texte en modifiant sa police ou sa taille. Sélectionnez une police ou une taille dans les 
options disponibles ; vous ne pouvez pas définir une taille personnalisée.

La plupart des navigateurs prennent en charge l'affichage des polices incluses dans la liste des polices de Contribute. L'usage 
veut que les concepteurs de pages Web utilisent des polices accessibles à la plupart des visiteurs de votre site Web. 

Chaque police de la liste représente en réalité une liste de combinaisons de polices. Pour modifier la liste des polices dispo-
nibles, voir la section « Modification de la liste des polices », page 90.
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Pour modifier la taille du texte :
1 Dans votre brouillon, sélectionnez le texte à modifier.

2 Procédez de l'une des manières suivantes :

• Sélectionnez une taille dans le menu déroulant Taille de police de la barre d'outils de mise en forme.

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis choisissez Taille et 
sélectionnez une valeur dans le menu contextuel.

Remarque : Cette option n'est pas disponible si vous travaillez dans un tableau.

• Choisissez Format > Taille, puis sélectionnez une valeur dans le menu déroulant.

Pour changer la police du texte :
1 Dans votre brouillon, sélectionnez le texte à modifier.

2 Procédez de l'une des manières suivantes :

• Sélectionnez une police dans le menu déroulant Police de la barre d'outils de mise en forme.

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis choisissez Police 
et sélectionnez une police dans le menu contextuel.

Remarque : Cette option n'est pas disponible si vous travaillez dans un tableau.

• Choisissez Format > Police et sélectionnez une police dans le menu déroulant.

Modification de la liste des polices 
Les combinaisons de polices de la liste des polices de Contribute déterminent la façon dont un navigateur affiche le texte 
sur votre page Web. Chaque police figurant dans le menu Police représente la première police de cette combinaison. Vous 
pouvez modifier les combinaisons de polices dans Contribute.

Lorsqu'il rencontre une combinaison de polices, le navigateur de l'internaute choisit la première installée sur l'ordinateur. 
Si aucune des polices de la combinaison n'est installée, le navigateur affiche le texte dans la police par défaut indiquée dans 
ses préférences.

Pour modifier la liste des polices :
1 Dans votre brouillon, sélectionnez Format > Police >Modifier la liste des polices.

La boîte de dialogue Modifier la liste des polices s'affiche.

2 Sélectionnez une combinaison de polices dans la section Liste des polices.

Les polices de la combinaison sélectionnée s'affichent dans la section Polices choisies. La section Polices disponibles réper-
torie les polices installées sur votre ordinateur.
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3 Apportez les modifications nécessaires.

Vous pouvez ajouter ou supprimer une combinaison de polices, en déplacer une dans la liste, ajouter ou supprimer certaines 
polices d'une combinaison ou ajouter une police non installée sur votre système.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Lorsque vous avez terminé vos modifications, cliquez sur OK.

Application de styles au texte
Pour mettre votre texte en forme, vous pouvez très facilement appliquer des styles, par exemple à l'en-tête. Le menu 
déroulant Style de Contribute répertorie les styles de paragraphes et d'en-têtes HTML, ainsi que les styles CSS définis par 
l'utilisateur.

Remarque : Le menu Style n'est pas activé si l'administrateur Contribute a limité l'application des styles au site Web. 

Pour plus d'informations sur les styles CSS et HTML du menu Style, voir la section « A propos des styles CSS et HTML du 
menu Style de Contribute », page 87. 

Pour appliquer un style au texte :
1 Dans votre brouillon, sélectionnez le texte à modifier ou placez le point d'insertion dans le paragraphe concerné.

2 Procédez de l'une des manières suivantes :

• Sélectionnez un style dans le menu déroulant Style de la barre d'outils de mise en forme.

• Choisissez Format > Style et sélectionnez un style dans le menu déroulant.

Le nouveau style est alors appliqué au texte sélectionné ou au paragraphe dans lequel se trouve le point d'insertion.

Remarque : Si vous choisissez un style d'en-tête prédéfini, l'ensemble du paragraphe utilise ce style, même si vous avez sélec-
tionné une portion de texte dans le paragraphe.

Lorsque vous appuyez sur Entrée ou sur Retour à la suite d'un texte auquel un style a été appliqué, Contribute applique ce 
style à la nouvelle ligne, sauf s'il s'agit d'un en-tête. Lorsque vous appuyez sur Entrée ou sur Retour à la suite d'un en-tête, 
la ligne suivante reçoit un style de paragraphe. 

Pour désactiver le style de texte en cours :
1 Dans votre brouillon, sélectionnez le texte à modifier ou placez-y le point d'insertion.

2 Sélectionnez le style Normal dans le menu déroulant Style de la barre d'outils de mise en forme.

Remarque : Vous pouvez également choisir Format > Style > Supprimer les alinéas. Cette option désactive le style et supprime 
toute balise de paragraphe encadrant la sélection.

Création et gestion des styles
Lorsque vous mettez le texte d'une page en forme, Contribute enregistre les styles créés et génère une bibliothèque de styles 
réutilisable dans cette page. 

Remarque : Si l'administrateur Contribute a limité la création des styles pour votre site Web, vous pouvez appliquer des 
propriétés de mise en forme au texte, mais Contribute n'enregistrera pas le style pour vous permettre de le réutiliser. Pour plus 
d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres pour les styles et les 
polices », page 217.

Vous pouvez gérer votre liste de styles CSS définis par l'utilisateur en les renommant ou en les supprimant, selon les besoins. 
Vous ne pouvez pas renommer ni supprimer les styles HTML de la liste.

Pour plus d'informations sur les styles CSS et HTML, voir la section « A propos des styles CSS et HTML du menu Style de 
Contribute », page 87.
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Pour créer un style de texte :
1 Dans votre brouillon, placez le point d'insertion dans le paragraphe ou sélectionnez une partie du texte du paragraphe.

2 Appliquez la police, la taille ou la couleur désirée.

Contribute enregistre les propriétés de mise en forme affectées et nomme le nouveau style à l'aide de la convention 
d'appellation : Style1, Style2, Style3, Stylen. Ce titre s'affiche alors dans le menu déroulant Style de la barre d'outils de mise 
en forme du texte.

Lorsque vous affectez les mêmes attributs de mise en forme à plusieurs éléments de texte, Contribute leur donne le même 
titre, éliminant ainsi les noms de style redondants. 

Pour renommer un style :
1 Dans votre brouillon, choisissez Format > Style > Renommer un style ou sélectionnez Renommer un style dans le menu 
déroulant Style de la barre d'outils de mise en forme.

La boîte de dialogue Renommer un style s'affiche.

2 Sélectionnez le style à renommer dans le menu déroulant Style.

3 Renseignez le champ de texte Nouveau nom de style.

4 Cliquez sur OK.

Contribute renomme le style et le nouveau nom s'affiche dans le menu déroulant Style de la barre d'outils de mise en forme.

Pour supprimer un style :
1 Dans votre brouillon, choisissez Format > Style > Supprimer un style ou sélectionnez Supprimer un style dans le menu 
déroulant Style de la barre d'outils de mise en forme.

La boîte de dialogue Supprimer un style s'affiche.

2 Sélectionnez le style à supprimer.

3 Cliquez sur Supprimer.

Contribute retire le style du menu déroulant Style de la barre d'outils de mise en forme.

Modification du style du texte de la page
Vous pouvez changer le style du texte. Vous pouvez choisir parmi les styles Gras, Italiques, Souligné, Barré, Accentuer, Forte 
accentuation et Largeur fixe.

Remarque : Ces options ne sont pas activées si l'administrateur Contribute a limité l'utilisation des options de mise en forme 
dans votre site Web. 

Pour appliquer le style Gras, Italiques ou Souligné au texte :
1 Dans votre brouillon, sélectionnez le texte à modifier.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Gras ou Italiques de la barre d'outils de mise en forme du texte.

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis sélectionnez Gras, 
Italiques ou Souligné.

Remarque : Cette option n'est pas disponible si vous travaillez dans un tableau.

• Choisissez Format > Gras, Format > Italiques ou Format > Souligné.

L'usage veut que les concepteurs Web évitent le style Souligné dans les pages Web car les internautes risqueraient de 
confondre le texte souligné avec les liens hypertextes. Pour faire ressortir votre texte, choisissez un style autre que Souligné.
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Pour appliquer les styles Barré, Accentuer, Forte accentuation et Largeur fixe au texte :
1 Dans votre brouillon, sélectionnez le texte à modifier.

2 Procédez de l'une des manières suivantes :

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), choisissez Autre, puis 
sélectionnez l'une des options du menu contextuel.

Remarque : Cette option n'est pas disponible si vous travaillez dans un tableau.

• Choisissez Format > Autre, puis sélectionnez l'une des options du menu déroulant.

Remarque : Les options Accentuer et Forte accentuation appliquent les mêmes styles que Italiques et Gras, mais utilisent des 
balises HTML différentes. L'administrateur Contribute détermine quelles balises sont insérées par Contribute.

Application de couleurs au texte
Vous pouvez modifier la couleur du texte ou le mettre en surbrillance.

Pour modifier la couleur du texte :
1 Dans votre brouillon, sélectionnez le texte à modifier.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Couleur du texte de la barre d'outils de mise en forme.

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis choisissez Couleur.

Remarque : Cette option n'est pas disponible si vous travaillez dans un tableau.

• Choisissez Format > Couleur du texte.

Le sélecteur de couleurs s'affiche.

3 Sélectionnez la couleur de votre choix.

Le sélecteur se ferme et la couleur du texte de votre brouillon change.

Pour mettre du texte en surbrillance :
1 Dans votre brouillon, sélectionnez le texte à mettre en surbrillance.

2 Cliquez sur le bouton Couleur de mise en surbrillance de la barre d'outils de mise en forme ou choisissez Format > 
Couleur de mise en surbrillance.

Le sélecteur de couleurs s'affiche.

3 Sélectionnez la couleur de votre choix.

Le sélecteur se ferme et le texte de votre brouillon est mis en surbrillance.
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Positionnement du texte dans la page
Pour positionner le texte de votre page, vous pouvez espacer les paragraphes, aligner le texte ou modifier le retrait. 

Remarque : Pour plus d'informations sur le changement d'apparence du texte grâce à sa mise en forme, voir la section 
« Modification de l'apparence du texte de la page », page 89.

Ajout d'espacements entre les paragraphes
Contribute fonctionne de la même façon que la plupart des logiciels de traitement de texte : les touches Entrée (Windows) 
ou Retour (Macintosh) permettent de créer un paragraphe. Les navigateurs Web insèrent automatiquement une ligne vierge 
entre les paragraphes. Vous pouvez vous-même espacer les paragraphes d'une ligne vierge en insérant un saut de ligne.

Pour insérer un saut de paragraphe :
1 Dans votre brouillon, placez le point d'insertion à la fin d'un paragraphe.

2 Appuyez sur la touche Entrée (Windows) ou Retour (Macintosh). 

Pour ajouter un saut de ligne, procédez de l'une des manières suivantes :
1 Dans votre brouillon, placez le point d'insertion à l'endroit où vous souhaitez insérer le saut de ligne.

2 Procédez de l'une des manières suivantes :

• Choisissez Insertion > Saut de ligne.

• Appuyez sur Maj+Entrée (Windows) ou Maj+Retour (Macintosh).

Alignement du texte 
Vous avez le choix entre quatre options d'alignement : Gauche, Centrer, Droite et Justifier.

Pour modifier l'alignement d'un texte :
1 Dans votre brouillon, sélectionnez le texte ou placez-y le point d'insertion.

Remarque : Contribute applique l'alignement à tout le paragraphe, même si vous avez sélectionné une portion de texte dans le 
paragraphe.

2 Procédez de l'une des manières suivantes :

• Cliquez sur l'un des boutons d'alignement de la barre d'outils de mise en forme.

• Choisissez Format > Aligner et sélectionnez un type d'alignement dans le menu déroulant.

L'alignement du texte de votre brouillon est modifié.

Mise en retrait du texte 
Contribute permet de mettre un paragraphe en retrait à gauche (négatif) ou à droite (positif). Pour augmenter le retrait du 
même paragraphe, vous pouvez effectuer ces opérations plusieurs fois. Le retrait affecte les marges droite et gauche. 

Pour ajouter un retrait positif ou négatif :
1 Dans votre brouillon, sélectionnez le texte à modifier ou placez-y le point d'insertion.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Retrait ou Retrait négatif de la barre d'outils de mise en forme du texte.

• Choisissez Format > Retrait ou Format > Retrait négatif.

L'indentation du texte de votre brouillon est modifiée.
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Création de listes
Dans Contribute, vous pouvez créer des listes numérotées, des listes à puces et des listes de définitions. Vous pouvez 
également créer des sous-listes imbriquées dans vos listes.

Création de listes numérotées
Vous pouvez utiliser des listes numérotées pour classer des informations en séquences ou selon leur progression. Vous 
pouvez appliquer la numérotation lors de la création de la liste ou l'ajouter à une liste existante.

Pour créer une liste numérotée : 
1 Placez le point d'insertion dans le brouillon, à l'endroit où vous souhaitez ajouter la liste.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Liste numérotée de la barre d'outils de mise en forme du texte.

• Choisissez Format > Liste > Liste numérotée.

3 Saisissez le premier élément de la liste.

4 Appuyez sur Entrée (Windows) ou sur Retour (Macintosh) pour saisir le suivant, puis répétez l'opération pour chaque 
élément.

5 Lorsque vous avez saisi toute la série, interrompez la numérotation de l'une des manières suivantes :

• Appuyez à deux reprises sur la touche Entrée ou Retour.

• Appuyez sur Entrée ou sur Retour, puis cliquez sur le bouton Liste numérotée de la barre d'outils de mise en forme.

Pour créer une liste numérotée à partir d'un texte existant :
1 Dans votre brouillon, sélectionnez plusieurs lignes du texte existant.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Liste numérotée de la barre d'outils de mise en forme du texte.

• Choisissez Format > Liste > Liste numérotée.

Contribute ajoute les numéros à votre liste.

Création de listes à puces
Les listes à puces vous permettent de classer des informations sans les hiérarchiser. Vous pouvez appliquer des puces lors 
de la création de la liste ou les ajouter à une liste existante.

Pour créer une liste à puces : 
1 Placez le point d'insertion dans le brouillon, à l'endroit où vous souhaitez ajouter la liste.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Liste à puces de la barre d'outils de mise en forme du texte.

• Choisissez Format > Liste > Liste à puces.

3 Saisissez le premier élément de la liste.

4 Appuyez sur Entrée (Windows) ou sur Retour (Macintosh) pour saisir le suivant, puis répétez l'opération pour chaque 
élément.

5 Lorsque vous avez saisi tous les éléments de la liste, désactivez les puces de l'une des manières suivantes :

• Appuyez à deux reprises sur la touche Entrée ou Retour.

• Appuyez sur Entrée ou sur Retour, puis cliquez sur le bouton Liste à puces de la barre d'outils de mise en forme.
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Pour créer une liste à puces à partir d'un texte existant :
1 Dans votre brouillon, sélectionnez plusieurs lignes du texte existant.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Liste à puces de la barre d'outils de mise en forme du texte.

• Choisissez Format > Liste > Liste à puces.

Contribute ajoute les puces à votre liste.

Création de listes de définitions
Une liste de définitions est une suite d'éléments, chacun comportant un sous-élément mis en retrait. 

Pour créer une liste de définitions :
1 Placez le point d'insertion dans le brouillon, à l'endroit où vous souhaitez créer la liste.

2 Choisissez Format > Liste > Liste de définitions.

3 Tapez le premier élément de la liste, puis appuyez sur Entrée (Windows) ou sur Retour (Macintosh).

4 Tapez la définition mise en retrait, puis appuyez sur Entrée ou sur Retour et répétez l'opération autant de fois que néces-
saire.

5 Lorsque vous avez saisi tous les éléments de la liste, interrompez la mise en retrait de l'une des manières suivantes :

• Appuyez à deux reprises sur la touche Entrée ou Retour. 

• Appuyez sur Entrée ou sur Retour et choisissez Format > Liste > Liste de définitions.

Pour créer une liste de définitions à partir d'un texte existant :
1 Dans votre brouillon, sélectionnez plusieurs lignes du texte existant.

2 Choisissez Format > Liste > Liste de définitions.
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Création de sous-listes
Vous pouvez modifier le niveau d'un élément d'une liste numérotée ou à puces et créer ainsi une liste imbriquée. Par 
exemple, l'un des éléments de votre liste à puces doit contenir une sous-liste de puces.

La liste imbriquée n'est pas nécessairement du même type que la liste principale. Vous pouvez par exemple imbriquer une 
liste à puces dans une liste numérotée. Vous pouvez également avoir plusieurs listes imbriquées dans une liste.

Pour créer une sous-liste : 
1 Dans votre brouillon, placez le point d'insertion à la fin d'une ligne de la liste existante, à l'endroit où vous souhaitez créer 
la sous-liste.

2 Appuyez sur la touche Entrée (Windows) ou Retour (Macintosh).

3 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Retrait de la barre d'outils de mise en forme.

• Appuyez sur la touche de tabulation.

Remarque : Cette option n'est pas disponible pour les pages issues de modèles ou dans les tableaux.

• Choisissez Format > Retrait.

Contribute met en retrait le numéro ou la puce de la nouvelle ligne. 

4 Pour que les types de la sous-liste et de la liste principale diffèrent, cliquez sur le bouton Liste numérotée ou Liste à puces 
de la barre d'outils de mise en forme, en fonction de votre choix.

5 Saisissez l'élément de la liste, puis appuyez sur Entrée ou sur Retour pour ajouter des éléments à la sous-liste.

6 Lorsque la liste est terminée, quittez la sous-liste de l'une des manières suivantes :

• Appuyez à deux reprises sur la touche Entrée ou Retour.

• Appuyez sur Entrée ou sur Retour, puis cliquez sur le bouton Retrait négatif de la barre d'outils de mise en forme du texte.

Remarque : Si vous avez modifié le type de la sous-liste afin qu'il diffère de celui de la liste principale, cliquez sur le bouton Liste 
numérotée ou Liste à puces pour revenir au type de la liste principale.
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Définition des propriétés d'une liste
Vous pouvez modifier l'aspect de la liste entière (à puces ou numérotée) ou seulement d'un de ses éléments.

Pour définir les propriétés d'une liste complète :
1 Dans votre brouillon, sélectionnez l'ensemble d'une liste à puces ou numérotée. 

2 Procédez de l'une des manières suivantes :

• Choisissez Format > Liste > Propriétés.

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis choisissez Liste > 
Propriétés.

Remarque : Cette option n'est pas disponible pour les pages issues de modèles ou dans les tableaux.

La boîte de dialogue Propriétés de la liste s'affiche.

3 Apportez les modifications nécessaires.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK.

Contribute applique vos changements à la liste. Le nouveau style sera également appliqué à tout élément ajouté à la liste.

Pour définir les propriétés d'un élément de liste :
1 Dans votre brouillon, placez le point d'insertion dans l'élément de la liste à puces ou numérotée à modifier.

Remarque : Si vous sélectionnez plusieurs éléments, les propriétés sont appliquées à l'ensemble de la liste.

2 Procédez de l'une des manières suivantes :

• Choisissez Format > Liste > Propriétés.

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis choisissez Liste > 
Propriétés.

Remarque : Cette option n'est pas disponible pour les pages issues de modèles ou dans les tableaux.

La boîte de dialogue Propriétés de la liste s'affiche.

3 Dans la section Elément sélectionné, modifiez les options de la liste selon vos besoins.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK.

Contribute applique vos changements à l'élément de la liste.
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Vérification orthographique
Il est conseillé de passer le correcteur orthographique après l'ajout ou la modification du texte de votre brouillon. 

Pour vérifier et corriger l'orthographe :
1 Dans votre brouillon, choisissez Format > Vérifier l'orthographe.

Si Contribute rencontre un mot inconnu, la boîte de dialogue Vérifier l'orthographe s'ouvre.

2 Sélectionnez l'option appropriée, selon la manière dont vous souhaitez que Contribute gère cette erreur.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

3 Lorsque la correction orthographique est terminée, cliquez sur Fermer dans la boîte de dialogue Vérifier l'orthographe 
ou sur OK dans la boîte contenant le message Vérification de l'orthographe terminée.

Recherche et remplacement de texte 
Vous pouvez rechercher du texte spécifique dans le brouillon que vous êtes en train de modifier. Vous pouvez même 
rechercher du texte et le remplacer.

Pour rechercher du texte :
1 Dans votre brouillon, choisissez Edition > Rechercher.

La boîte de dialogue Rechercher et remplacer s'affiche.

2 Tapez le texte à localiser et cliquez sur Rechercher suivant jusqu'à la fin du brouillon.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

3 Lorsque vous avez terminé, cliquez sur Fermer.

Pour rechercher et remplacer du texte :
1 Dans votre brouillon, choisissez Edition > Rechercher.

La boîte de dialogue Rechercher et remplacer s'affiche.

2 Tapez le texte à rechercher et l'expression de remplacement.

3 Cliquez sur Rechercher suivant.

4 Pour chaque occurrence, vous avez la possibilité de remplacer le texte, de remplacer toutes les occurrences du texte ou 
de rechercher la suivante sans effectuer de remplacement.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

5 Lorsque vous avez terminé, cliquez sur Fermer.
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Chapitre 7 : Utilisation d'images et 
d'éléments graphiques

Adobe® Contribute® CS3 simplifie la modification, l'ajout ou la suppression d'images dans vos pages Web. Vous pouvez 
ajouter des animations Adobe® Flash® Player 9 (fichiers FLV) aussi aisément que s'il s'agissait d'images. Vous pouvez 
également ajouter des suppléments multimédia (fichiers audio et vidéo) à votre blog ou utiliser Contribute pour inclure des 
boutons PayPal et mener à bien des transactions de commerce électronique via votre page Web. A cela s'ajoute la possibilité 
d'insérer des fichiers vidéo, des fichiers Flash et des images multimédia enrichies directement depuis Internet dans des 
pages Contribute.

Contribute prend en charge les formats de fichier suivants : 

• Fichiers d'image .gif, .jfif, .jpe, .jpeg, .jpg, et .png

• Fichiers Flash .swf

• Fichiers vidéo .avi, .flv, .mp4, .mpeg, .mpg, .mov, .qt et .wmv

Pour plus d'informations sur la création d'un lien hypertexte (également appelé lien) à partir d'une image, voir la section 
« Création de liens texte ou image », page 135.

Ce chapitre contient les sections suivantes :

• « Insertion d'images et de boutons », page 101

• « Ajout d'une image à une page », page 103

• « Insertion d'actifs partagés dans une page Web », page 105

• « Modification des propriétés d'une image », page 106

• « Modification de la position ou de l'orientation d'une image », page 107

• « Modification d'une image dans Contribute », page 107

• « Modification d'une image dans une application externe », page 110

• « Insertion de contenu Flash dans une page Web », page 111

• « Insertion d'une séquence vidéo dans une page Web », page 112

• « Modification de la position ou de l'orientation d'une séquence vidéo », page 114

• « Ajout de suppléments multimédia à un blog », page 114

• « Ajout et suppression d'une barre horizontale », page 117

• « Insertion de boutons PayPal pour le commerce électronique », page 118

Insertion d'images et de boutons
L'insertion d'images et de boutons PayPal dans une page Web implique certaines précautions.

A propos de l'insertion d'images
Vous pouvez ajouter des images provenant de plusieurs sources : votre ordinateur, votre réseau local, votre site Web, votre 
messagerie électronique, du navigateur Microsoft Internet Explorer ou d'un autre logiciel, tel que Microsoft Word ou Excel.

Remarque : Les images à ajouter doivent au préalable être enregistrées dans l'un des formats suivants : .gif, .jfif, .jpe, .jpeg, .jpg, 
et .png (16). Si tel n'est pas le cas, utilisez un outil de retouche d'images comme Adobe Fireworks pour convertir l'image en un 
format lisible sur le Web.
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Lorsque vous ajoutez une image à une page, il est recommandé de lui adjoindre un texte descriptif pour que les utilisateurs 
souffrant de handicaps visuels puissent également en bénéficier. L'administrateur Contribute peut imposer l'option d'acces-
sibilité des images : une boîte de dialogue vous invitera à fournir un descriptif chaque fois que vous ajouterez une image. 

Remarque : Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres de 
modification de pages et de paragraphes », page 215.

A propos des boutons PayPal 
Créés par la société WebAssist.com, les boutons PayPal simplifient l'ajout d'une fonction de commerce électronique à une 
page Contribute. Après la création du bouton de paiement, vous pouvez accepter les paiements en ligne par cartes bancaires. 
PayPal héberge un service de contrôle sécurisé qui traite et enregistre toutes vos transactions. Si vous ne possédez pas encore 
de compte PayPal, vous pouvez en ouvrir un gratuitement en quelques minutes. Il n'y a ni configuration, ni abonnement 
mensuel, et les frais ne vous sont facturés que lorsqu'un client effectue un paiement. 

Remarque : Pour que vous puissiez utiliser la fonction PayPal, votre administrateur Contribute doit l'activer pour votre rôle. 
Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres de modification 
de pages et de paragraphes », page 215.

Vous pouvez insérer cinq types de boutons PayPal dans une page Web :

Le bouton Acheter maintenant définit un article en vente, disponible pour un achat immédiat, et comprend le nom du 
produit, son prix, la référence de l'article et les frais de traitement et d'expédition.

Le bouton Ajouter au panier permet au client d'ajouter un article dans son panier pour l'acheter.

Le bouton Panier fonctionne avec le bouton Ajouter au panier ; il permet aux clients d'examiner le contenu de leur panier 
et d'éventuellement valider leur commande.

Le bouton Abonnement offre un service qui propose au client une formule de paiement périodique et présente une option 
permettant de bénéficier d'une période d'essai gratuite. Vous pouvez définir le montant, la période d'abonnement et la 
fréquence de facturation.

Le bouton Faire un don vous permet de collecter des dons via votre site Web ou même par le biais d'un lien dans un courriel.

Tous les assistants des boutons de paiement permettent de définir les prix des articles dans plusieurs devises, par exemple 
en dollars, livres sterling, euros ou yens. Les options proposées permettent également d'afficher le nom et le logo de votre 
société sur la page de validation de la commande. Enfin, vous pouvez spécifier l'adresse Web (URL) de la page devant 
s'afficher lorsque le client a finalisé son achat, par exemple une page de remerciement pour la commande.

Pour insérer dans une page le bouton PayPal et ses fonctionnalités associées, vous devez renseigner les écrans de l'Assistant 
PayPal. Cet Assistant vous permet de sélectionner les images des boutons à insérer dans la page et de définir plusieurs 
options (telles que le numéro de référence, le prix, etc.) pour chaque article proposé à la vente. Pour obtenir de l'aide sur les 
écrans de l'Assistant PayPal, cliquez sur le bouton Aide pour accéder à l'aide en ligne.

Vous pouvez insérer plusieurs boutons PayPal dans la même page. Assurez-vous simplement de ne pas en insérer plusieurs 
dans le même paragraphe ou dans la même cellule d'un tableau. 

Si votre page contient d'autres formulaires HTML, n'insérez pas de bouton PayPal dans l'un d'eux. Si l'un des formulaires 
de votre page est référencé à l'aide de code JavaScript, vérifiez si la fonctionnalité JavaScript est toujours opérationnelle après 
l'ajout d'un ou plusieurs boutons PayPal dans la page.
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Ajout d'une image à une page 
Il existe trois façons d'ajouter une image à votre site Web :

• Utilisez le menu Insertion ou le bouton Image pour ajouter une image depuis votre ordinateur ou depuis le site Web.

• Glissez/déposez une image provenant d'une autre source dans votre brouillon Contribute.

• Copiez/collez une image provenant d'une autre source dans votre brouillon Contribute.

Remarque : Si votre administrateur Contribute a limité les types d'images que votre rôle peut insérer, vous ne pourrez peut-être 
insérer des images qu'à partir des actifs partagés.

Utilisation du menu Insertion ou du bouton Image pour ajouter des images
Pour ajouter une image depuis votre ordinateur ou depuis le site Web, utilisez le menu Insertion ou le bouton Image de la 
barre d'outils. 

Pour ajouter sur la page des images provenant d'autres sources, soit par glissement (voir la section « Glissement des images 
sur une page », page 104), soit par copier/coller (voir la section « Copie et collage d'images », page 104).

Pour ajouter une image à l'aide du menu Insertion ou du bouton Image :
1 Placez le point d'insertion à l'endroit où l'image doit s'afficher dans votre brouillon.

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Image de la barre d'outils. 

• Choisissez Insertion > Image.

3 Sélectionnez l'une des options suivantes dans le menu déroulant : 

• Depuis mon Poste de travail 

• Depuis le site Web 

• A partir d'Internet

• Depuis les actifs partagés

Remarque : Si votre administrateur Contribute a limité les types d'images que votre rôle peut insérer, vous ne pourrez peut-être 
insérer des images qu'à partir des actifs partagés.

La boîte de dialogue Sélectionner une image, Choisir une image du site Web, Rechercher une image ou Insérer l'actif partagé 
s'affiche.

Pour réutiliser une image déjà insérée dans un site Web Contribute, choisissez Depuis le site Web.

4 Recherchez et sélectionnez l'image, puis cliquez sur le bouton Sélectionner.

Remarque : Vous devez sélectionner un fichier spécifique. Vous ne pouvez pas insérer un dossier dans une page Contribute.

5 Si la boîte de dialogue Description de l'image s'ouvre, saisissez un descriptif de l'image destiné aux personnes souffrant 
de handicaps visuels ou celles dont le navigateur n'affiche que du texte, puis cliquez sur OK.

L'image s'affiche dans votre brouillon. Pour garantir la compatibilité avec Internet, Contribute réduit les images volumi-
neuses à la taille prédéfinie par l'administrateur Contribute, si ce dernier a autorisé le traitement des images pour votre rôle.

Remarque : Si l'image insérée provient de votre ordinateur, vous pouvez la modifier en ligne (si votre rôle d'utilisateur y est 
autorisé), mais vous ne pourrez pas la modifier dans une application externe avant d'avoir publié le brouillon. Pour plus 
d'informations sur la modification des images, voir la section « Modification d'une image dans Contribute », page 107.

Après son insertion, double-cliquez sur l'image pour modifier ses propriétés. Pour plus d'informations, voir la section 
« Modification des propriétés d'une image », page 106.
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Glissement des images sur une page
Vous pouvez faire glisser une image d'une autre source vers votre page Contribute.

Remarque : Si votre administrateur Contribute a limité les types d'images que votre rôle peut insérer, vous ne pourrez peut-être 
insérer des images qu'à partir des actifs partagés.

Vous pouvez également utiliser le menu Insertion ou le bouton Image (voir la section « Utilisation du menu Insertion ou 
du bouton Image pour ajouter des images », page 103) ou effectuer un copier/coller (voir la section « Copie et collage 
d'images », page 104).

Pour ajouter une image en la faisant glisser :
1 Réduisez la taille de la fenêtre de Contribute de manière à voir également l'application contenant l'image que vous 
souhaitez faire glisser.

2 Sélectionnez l'image dans l'autre application.

3 Faites glisser l'image à l'endroit où elle doit s'afficher dans votre brouillon Contribute.

Vous ne pouvez pas faire glisser une image depuis un navigateur Web si elle contient un lien. Commencez par enregistrer 
l'image dans votre ordinateur, puis faites-la glisser vers votre brouillon Contribute. Vous pouvez également la copier et la 

coller.

4 Si la boîte de dialogue Description de l'image s'ouvre, saisissez un descriptif de l'image destiné aux personnes souffrant 
de handicaps visuels ou celles dont le navigateur n'affiche que du texte, puis cliquez sur OK.

L'image s'affiche dans votre brouillon. Pour garantir la compatibilité avec Internet, Contribute réduit les images volumi-
neuses à la taille prédéfinie par l'administrateur Contribute, si ce dernier a autorisé le traitement des images pour votre rôle.

Remarque : Si l'image insérée provient de votre ordinateur, vous pouvez la modifier en ligne, mais vous ne pourrez pas la 
modifier dans une application externe avant d'avoir publié le brouillon. Pour plus d'informations sur la modification des 
images, voir la section « Modification d'une image dans Contribute », page 107.

Après son insertion, double-cliquez sur l'image pour modifier ses propriétés. Pour plus d'informations, voir la section 
« Modification des propriétés d'une image », page 106.

Copie et collage d'images
Vous pouvez copier une image issue d'une autre source, puis la coller dans votre page Contribute.

Remarque : Si votre administrateur Contribute a limité les types d'images que votre rôle peut insérer, vous ne pourrez peut-être 
insérer des images qu'à partir des actifs partagés.

Vous pouvez également ajouter des images en utilisant le menu Insertion, le bouton Image (voir la section « Utilisation du 
menu Insertion ou du bouton Image pour ajouter des images », page 103) ou en les faisant glisser jusqu'à la page (voir la 
section « Glissement des images sur une page », page 104).

Pour ajouter une image par l'opération copier/coller :
1 Sélectionnez l'image à copier dans l'application où elle est ouverte.

2 Choisissez Edition > Copier.

3 Placez le point d'insertion à l'endroit où l'image doit s'afficher dans votre brouillon Contribute.

4 Choisissez Edition > Coller.

5 Si la boîte de dialogue Description de l'image s'ouvre, saisissez un descriptif de l'image destiné aux personnes souffrant 
de handicaps visuels ou celles dont le navigateur n'affiche que du texte, puis cliquez sur OK.

L'image s'affiche dans votre brouillon. Pour garantir la compatibilité avec Internet, Contribute réduit les images volumi-
neuses à la taille prédéfinie par l'administrateur Contribute, si ce dernier a autorisé le traitement des images pour votre rôle.

Remarque : Si l'image insérée provient de votre ordinateur, vous pouvez la modifier en ligne, mais vous ne pourrez pas la 
modifier dans une application externe avant d'avoir publié le brouillon. Pour plus d'informations sur la modification des 
images, voir la section « Modification d'une image dans Contribute », page 107.
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Après son insertion, double-cliquez sur l'image pour modifier ses propriétés. Pour plus d'informations, voir la section 
« Modification des propriétés d'une image », page 106.

Insertion d'actifs partagés dans une page Web
Contribute vous permet d'insérer des images, du contenu Flash ou des éléments de la bibliothèque Dreamweaver depuis 
une liste d'actifs partagés pour votre site Web. 

L'administrateur Contribute ajoute des actifs à la liste afin de les mettre à la disposition de la plupart ou de tous les utilisa-
teurs. Il vous suffit ensuite de les insérer depuis la liste lorsque vous en avez besoin. 

Supposons par exemple que votre brouillon doive arborer le logo officiel de la société. Si l'administrateur Contribute a 
ajouté le logo approuvé à la liste des actifs partagés pour votre rôle, il vous suffit de le rechercher et de l'ajouter à votre page. 
Pour plus d'informations, voir la section « Définition des paramètres pour les actifs partagés », page 222.

Pour insérer un actif partagé dans une page Web :
1 Placez le point d'insertion à l'endroit où l'actif partagé doit s'afficher dans votre brouillon.

2 Selon le type d'actif partagé inséré, procédez de l'une des manières suivantes :

• Pour tous les actifs partagés, y compris les éléments de la bibliothèque Dreamweaver, choisissez Insertion > Actif partagé.

• Pour les images seulement, choisissez Insertion > Image > Depuis les actifs partagés ou cliquez sur le bouton Image de 
la barre d'outils et choisissez Depuis les actifs partagés.

• Pour le contenu Flash uniquement, choisissez Insertion > Flash > Depuis les actifs partagés.

Remarque : Les éléments de bibliothèque et le contenu Flash ne sont pas disponibles si votre administrateur Contribute a précisé 
que les utilisateurs de votre rôle ne peuvent insérer des images qu'à partir des actifs partagés. 

La boîte de dialogue Insérer l'actif partagé s'affiche.

3 Sélectionnez un actif partagé dans le panneau gauche.

Son aperçu s'affiche dans le panneau droit. 

4 Cliquez sur OK. 

5 Si la boîte de dialogue Description de l'image s'ouvre, saisissez un descriptif de l'image destiné aux personnes souffrant 
de handicaps visuels ou celles dont le navigateur n'affiche que du texte, puis cliquez sur OK.

L'actif partagé s'affiche dans votre brouillon.
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Modification des propriétés d'une image
Après avoir ajouté une image à une page, (voir la section « Ajout d'une image à une page », page 103), vous pouvez modifier 
ses propriétés d'affichage. Les propriétés d'une image comprennent l'emplacement de sa source, la taille de sa zone 
d'affichage, ses bordures, son alignement et son texte de remplacement. 

La modification des propriétés d'une image n'affecte que son affichage dans la page. Pour modifier l'image, voir la section 
« Modification d'une image dans Contribute », page 107.

Pour modifier les propriétés d'une image : 
1 Dans votre brouillon, procédez de l'une des manières suivantes :

• Double-cliquez sur l'image.

• Sélectionnez l'image et cliquez sur le bouton Propriétés de l'image  de la barre d'outils graphiques.

• Sélectionnez l'image et choisissez Format > Propriétés de l'image.

• Cliquez sur l'image du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Propriétés de l'image.

La boîte de dialogue Propriétés de l'image s'affiche.

2 Apportez les modifications désirées.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

3 Cliquez sur OK.

Contribute applique vos modifications à l'image.
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Modification de la position ou de l'orientation d'une image
Vous pouvez déplacer une image sur la page, modifier son alignement par rapport aux éléments environnants et la faire 
pivoter pour changer son orientation.

Déplacement d'une image
Vous pouvez aisément déplacer une image vers un nouvel emplacement d'une page Web. 

Pour déplacer une image sur un brouillon, procédez de l'une de manières suivantes :
• Faites glisser l'image vers son nouvel emplacement.

• Sélectionnez l'image, puis copiez-la (ou coupez-la) et collez-la dans un nouvel emplacement.

Alignement d'une image
Vous pouvez modifier l'alignement des images de deux manières : vous pouvez changer son alignement dans la page (par 
exemple, son emplacement dans une cellule de tableau) ou par rapport aux éléments environnants.

Pour modifier l'alignement d'une image :
1 Dans votre brouillon, sélectionnez l'image à réaligner. 

2 Cliquez sur une option d'alignement de la barre d'outils de retouche d'image.

Contribute aligne l'image dans le brouillon.

Pour modifier l'alignement d'une image par rapport aux éléments environnants :
1 Dans votre brouillon, sélectionnez l'image à réaligner.

2 Procédez de l'une des manières suivantes :

• Double-cliquez sur l'image, puis sélectionnez une option dans le menu déroulant Alignement de la boîte de dialogue 
Propriétés de l'image.

• Cliquez sur l'image du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis sélec-
tionnez une option dans le menu contextuel Aligner.

Contribute aligne l'image par rapport aux éléments qui l'entourent, tels que du texte.

Modification d'une image dans Contribute
Dans Contribute, permet de modifier la luminosité et le contraste d'une image, sa netteté, son cadrage et ses dimensions. 

Pour effectuer des modifications avancées, utilisez une application de retouche d'images externe. Pour plus d'informations, 
voir la section « Modification d'une image dans une application externe », page 110.

Remarque : Lorsque vous modifiez une image dans l'application Contribute, une copie de l'image est créée, de sorte que les 
modifications n'affectent que cette instance de l'image. Lorsque vous utilisez Contribute pour modifier une image dans une 
application externe, vous modifiez le fichier source de l'image. Les modifications affectent donc toutes les instances de l'image 
sur votre site Web.

Cette section contient les rubriques suivantes :

• « Réglage de la luminosité et du contraste d'une image », page 108

• « Accentuation d'une image », page 108

• « Recadrage d'une image », page 109

• « Redimensionnement d'une image », page 109

• « Rotation d'une image », page 110
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Réglage de la luminosité et du contraste d'une image
Vous pouvez ajuster le contraste ou la luminosité d'une image. L'opération affecte les zones les plus claires, les demi-tons et 
les ombres. L'option Luminosité/Contraste sert généralement à améliorer les images trop sombres ou trop claires.

Remarque : Cette méthode de modification n'affecte que cette instance de l'image, pas son fichier source.

Pour régler la luminosité et le contraste d'une image :
1 Dans votre brouillon, sélectionnez l'image à corriger. 

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Luminosité/Contraste  de la barre d'outils graphiques.

• Choisissez Format > Modifier l'image > Luminosité/Contraste.

• Cliquez sur l'image du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Modifier l'image > Luminosité/Contraste.

Remarque : Ces options ne sont pas disponibles si l'administrateur Contribute a interdit la retouche d'images en ligne à votre 
rôle d'utilisateur. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres 
de modification de pages et de paragraphes », page 215.

La boîte de dialogue Luminosité/Contraste s'affiche.

3 Déplacez les curseurs de luminosité et de contraste pour modifier les valeurs à votre convenance.

Les valeurs sont comprises entre -100 et 100. 

4 Cliquez sur OK.

Accentuation d'une image
L'accentuation augmente le contraste autour des objets et améliore la définition de l'image. 

Remarque : Cette méthode de modification n'affecte que cette instance de l'image, pas son fichier source.

Pour accentuer une image :
1 Dans votre brouillon, sélectionnez l'image à corriger. 

2 Procédez de l'une des manières suivantes :

• Cliquez sur le bouton Accentuer  de la barre d'outils graphiques.

• Choisissez Format > Modifier l'image > Accentuer.

• Cliquez sur l'image du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Modifier l'image > Accentuer.

Remarque : Ces options ne sont pas disponibles si l'administrateur Contribute a interdit la retouche d'images en ligne à votre 
rôle d'utilisateur. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres 
de modification de pages et de paragraphes », page 215.

La boîte de dialogue Accentuer s'affiche.

3 Pour préciser le degré de netteté à appliquer à l'image, déplacez le curseur ou saisissez une valeur comprise entre 0 et 10 
dans le champ.

Pendant l'opération, un aperçu de l'image modifiée s'affiche.

4 Cliquez sur OK.

Pour annuler les modifications et retrouver l'image d'origine :
• Choisissez Edition > Annuler Accentuer.

Vous ne pouvez annuler l'effet de la commande Accentuer (et retrouver le fichier d'origine) que si vous n'avez pas encore 
publié la page contenant l'image. 
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Recadrage d'une image
Vous pouvez recadrer (ou rogner) les images. 

Remarque : Cette méthode de modification n'affecte que cette instance de l'image, pas son fichier source.

Pour recadrer une image :
1 Dans votre brouillon, sélectionnez l'image à corriger. 

2 Procédez de l'une des manières suivantes :

• Cliquez sur l'icône Recadrage  de la barre d'outils graphiques.

• Choisissez Format > Modifier l'image > Recadrer.

• Cliquez sur l'image du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Modifier l'image > Recadrer.

Remarque : Ces options ne sont pas disponibles si l'administrateur Contribute a interdit la retouche d'images en ligne à votre 
rôle d'utilisateur. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres 
de modification de pages et de paragraphes », page 215.

Des poignées de recadrage s'affichent.

3 Ajustez-les de manière à entourer la partie de l'image à conserver.

4 Procédez de l'une des manières suivantes pour finir le recadrage :

• Double-cliquez dans la zone recadrée.

• Appuyez sur la touche Entrée ou Retour.

• Cliquez sur l'image du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Modifier l'image > Terminer le rognage.

La partie ombrée de l'image disparaît. 

Pour annuler les effets du recadrage et retrouver l'image d'origine :
• Choisissez Edition > Annuler Recadrer.

Vous pouvez annuler les effets du recadrage (et retrouver l'image d'origine) jusqu'à la fermeture de Contribute.

Redimensionnement d'une image
Vous pouvez modifier la taille d'une image manuellement ou en saisissant des valeurs spécifiques. 

Remarque : Cette méthode de modification n'affecte que cette instance de l'image, pas son fichier source.

Pour modifier manuellement la taille d'une image :
1 Dans votre brouillon, sélectionnez l'image à redimensionner. 

2 Cliquez sur le bouton Redimensionner  de la barre d'outils graphiques.

3 Faites glisser l'une des poignées de sélection jusqu'à obtenir la taille désirée.

A. Poignées de sélection

Pour ne pas déformer l'image, Contribute conserve le même ratio hauteur/largeur.

Si vous ne souhaitez pas conserver le même ratio hauteur/largeur, maintenez la touche Maj. enfoncée pendant que vous 
faites glisser la poignée. 

Remarque : Cette méthode de redimensionnement affecte la taille de l'image et sa zone d'affichage dans la page. Pour ne 
modifier que la zone d'affichage, voir la section « Modification des propriétés d'une image », page 106.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

110

Pour redimensionner une image à l'aide de valeurs spécifiques :
1 Dans votre brouillon, sélectionnez l'image à redimensionner. 

2 Saisissez des valeurs de largeur et hauteur dans la barre d'outils de retouche d'image.

Contribute modifie la hauteur et la largeur de l'image.

Remarque : Cette méthode de redimensionnement affecte la taille de l'image et sa zone d'affichage dans la page. Pour ne 
modifier que la zone d'affichage, voir la section « Modification des propriétés d'une image », page 106.

Pour restaurer la taille d'origine de l'image :
• Dans votre brouillon, choisissez Format > Modifier l'image > Revenir à l'original. 

Rotation d'une image
Vous pouvez faire pivoter une image afin d'en modifier l'orientation sur la page.

Pour faire pivoter une image :
1 Dans votre brouillon, sélectionnez l'image à faire pivoter. 

2 Procédez de l'une des manières suivantes :

• Cliquez sur l'un des boutons de rotation  de la barre d'outils de retouche d'image.

Pour poursuivre l'opération, cliquez plusieurs fois sur le bouton de rotation.

• Choisissez Format > Modifier l'image > Pivoter dans le sens horaire ou Modifier l'image > Pivoter dans le sens 
anti-horaire.

• Cliquez sur l'image du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Modifier l'image > Pivoter dans le sens horaire ou Modifier l'image > Pivoter dans le sens anti-horaire.

Modification d'une image dans une application externe
Vous pouvez utiliser Contribute pour démarrer un logiciel de retouche d'images externe. Vous pouvez effectuer les 
retouches simples directement dans Contribute, à l'aide de la barre d'outils de retouche d'image (voir la section 
« Modification d'une image dans Contribute », page 107).

Remarque : Lorsque vous modifiez une image dans l'application Contribute, une copie de l'image est créée, de sorte que les 
modifications n'affectent que cette instance de l'image. Lorsque vous utilisez Contribute pour modifier une image dans une 
application externe, vous modifiez le fichier source de l'image. Les modifications affectent donc toutes les instances de l'image 
sur votre site Web.

Pour modifier une image dans une application de retouche d'images externe :
1 Procédez de l'une des manières suivantes :

• Dans le navigateur de Contribute, cliquez sur le bouton Choisir de la barre d'outils, sélectionnez l'image à retoucher, puis 
cliquez sur OK. Lorsque l'image s'affiche, cliquez sur Edition dans la barre d'outils.

• Dans l'éditeur de Contribute, sélectionnez l'image, puis choisissez Format > Modifier l'image dans une application 
externe ou cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et choisissez 
Modifier l'image dans une application externe.

Remarque : L'image sélectionnée doit se trouver sur une page publiée sur votre site Web ou dans l'un de ses dossiers. Si vous 
ajoutez une nouvelle image à un brouillon, vous ne pouvez pas la modifier dans un éditeur externe avant d'avoir publié ce 
brouillon sur le site Web.

Contribute ouvre une application vous permettant de modifier l'image. 
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2 Si vous modifiez une image dans Fireworks, cliquez sur Non dans la boîte de dialogue Rechercher la source pour 
indiquer que vous ne souhaitez pas modifier le fichier source. 

En cliquant sur Non, vous modifiez uniquement l'image du site Web.

3 Effectuez les modifications nécessaires dans l'application externe, enregistrez-les, puis fermez l'application.

Important : Cette méthode d'édition dans une application externe modifie définitivement l'image originale enregistrée sur le 
serveur et affecte toutes ses autres occurrences dans l'ensemble du site.

4 Si vous apportez ces modifications dans Fireworks, cliquez sur Terminé et fermez l'application.

Si vous souhaitez apporter des modifications supplémentaires à l'image avant de publier, cliquez sur Lancer dans Contribute 
pour ouvrir à nouveau le contenu dans l'éditeur externe.

5 Dans Contribute, cliquez sur Publier pour que les modifications apportées soient appliquées au site Web.

Remarque : Selon le rôle que l'administrateur Contribute vous a assigné, vous ne pouvez peut-être pas publier.

L'image mise à jour s'affiche dans Contribute.

Insertion de contenu Flash dans une page Web
De nombreux sites Web contiennent des animations Flash, comme des boutons de navigation ou des bannières. Vous 
pouvez insérer un contenu Flash depuis votre ordinateur, votre site Web, Internet ou votre liste d'actifs partagés. 

Lorsque vous publiez une page comportant un contenu Flash, Contribute copie automatiquement le fichier (.swf) sur votre 
site Web. 

Remarque : Pour plus d'informations sur l'insertion de séquences vidéo autres que Flash, voir la section « Insertion d'une 
séquence vidéo dans une page Web », page 112.

Pour insérer un contenu Flash :
1 Placez le point d'insertion à l'endroit où le contenu Flash doit s'afficher dans votre brouillon.

2 Sélectionnez l'une des options suivantes : 

• Insertion > Flash > Depuis mon Poste de travail

• Insertion > Flash > Depuis le site Web

• Insertion > Flash > A partir d'Internet

• Insertion > Flash > Depuis les actifs partagés.

La boîte de dialogue Ouvrir, Choisir une image du site Web, Rechercher un fichier flash ou Insérer l'actif partagé s'affiche.

3 Localisez et sélectionnez le fichier Flash SWF à insérer, puis cliquez sur Ouvrir ou sur OK. 

Remarque : Vous ne pouvez pas insérer un dossier dans une page Contribute.

L'animation Flash s'affiche dans votre brouillon.

Pour réutiliser une animation Flash (fichier SWF) : 
• Choisissez Insertion > Flash > Depuis le site Web.
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Définition des propriétés des animations Flash
Vous pouvez définir les propriétés des animations Flash (fichiers SWF) que vous insérez dans vos pages Web. 

Pour définir les propriétés d'une animation Flash :
1 Sélectionnez l'animation Flash dans votre brouillon. 

2 Choisissez Format > Propriétés de l'animation Flash.

La boîte de dialogue Propriétés de l'animation Flash s'affiche.

3 Apportez les modifications nécessaires.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK.

Insertion d'une séquence vidéo dans une page Web
Vous pouvez insérer des séquences vidéo dans une page Web, puis les contrôler dans Contribute.

Remarque : Si vous insérez un fichier SWF, le processus diffère légèrement. Pour plus d'informations, voir la section « Insertion 
de contenu Flash dans une page Web », page 111.

Vous pouvez insérer des séquences vidéo enregistrées dans votre ordinateur, ou disponibles sur Internet ou encore 
provenant de votre site Web. Vous pouvez également insérer certains types de séquences vidéo provenant d'un appareil 
photo, d'un caméscope ou d'un logiciel de montage, tel que Movie Maker ou iMovie, dans une page Web. Vous pouvez 
notamment utiliser des types de fichier QuickTime (MOV et QT), vidéo Flash (FLV), vidéo (MP4, MPG, ou MPEG), AVI 
et Windows Media (WMV). 

Lorsque vous modifiez et enregistrez des vidéos pour votre site Web, assurez-vous de les enregistrer pour le Web afin 
qu'elles soient compressées.

Pour insérer une séquence vidéo :
1 Placez le point d'insertion à l'endroit où la séquence vidéo doit s'afficher dans votre brouillon.

2 Sélectionnez l'une des options suivantes : 

• Insertion > Vidéo > Depuis mon Poste de travail

• Insertion > Vidéo > Depuis le site Web

• Insertion > Vidéo > A partir d'Internet

La boîte de dialogue Sélectionner la vidéo, Rechercher la vidéo ou Choisir une vidéo sur le site Web s'affiche.

Remarque : Vous pouvez également faire glisser la séquence vidéo depuis une autre application. Pour ce faire, réduisez la taille 
de la fenêtre de Contribute de manière à voir également l'application contenant la séquence vidéo que vous souhaitez faire 
glisser. Dans l'autre application, sélectionnez la séquence vidéo, puis faites-la glisser sur votre brouillon Contribute et déposez-
la à l'endroit où elle doit s'afficher.

3 Localisez et sélectionnez le fichier vidéo à insérer, puis cliquez sur Ouvrir.
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Remarque : Si vous insérez des fichiers de type MOV dans Contribute, les internautes qui consultent votre site Web devront 
disposer du lecteur QuickTime pour visionner la séquence vidéo sur un ordinateur Windows. Si vous insérez des fichiers de type 
WMV, ils devront disposer du lecteur Windows Media pour visionner la séquence vidéo sur un Macintosh.

L'espace réservé à la séquence vidéo s'affiche dans votre brouillon. 

Remarque : Vous ne pouvez pas insérer une séquence vidéo dont la taille est supérieure aux limites définies par l'administrateur 
Contribute pour votre rôle. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des 
paramètres de placement des fichiers », page 221.

La séquence vidéo n'est pas lue dans le brouillon ; cette opération n'est possible qu'après la publication.

L'affichage par défaut de tous les fichiers vidéo dans Contribute est de 320 x 240, à l'exception des fichiers FLV. Pour un 
tel type de fichier, Contribute détecte sa taille d'affichage et l'affiche à la même taille qu'un fichier FLV. Si Contribute ne 

peut pas détecter la taille d'un fichier FLV, l'affichage est de 320 x 240.

Définition des propriétés d'une séquence vidéo
Vous pouvez définir les propriétés des séquences vidéo insérées dans vos pages Web.

Remarque : Pour modifier les propriétés d'un fichier SWF, consultez la section « Définition des propriétés des animations 
Flash », page 112.

Pour définir les propriétés vidéo :
1 Dans votre brouillon, sélectionnez l'espace réservé à la séquence vidéo.

2 Double-cliquez sur l'espace réservé ou choisissez Format > Propriétés vidéo.

Cliquez avec le bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) sur l'espace réservé 
et choisissez Propriétés vidéo.

La boîte de dialogue Propriétés vidéo qui s'affiche varie selon le fichier que vous insérez.

La boîte de dialogue Propriétés vidéo suivante apparaît si vous insérez n'importe quel fichier sauf un fichier vidéo Flash 
(FLV)  Celle relative aux fichiers FLV contient davantage d'options.

3 Apportez les modifications nécessaires.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK.

Pour connaître la taille de votre propre fichier animation, examinez les propriétés de votre fichier. Double-cliquez ensuite 
sur l'espace réservé à la séquence vidéo dans Contribute afin de configurer la taille d'affichage en fonction de celle de la 

séquence vidéo et d'afficher cette dernière de façon appropriée.
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Modification de la position ou de l'orientation d'une 
séquence vidéo
Vous pouvez déplacer une séquence vidéo sur une page ou modifier son alignement par rapports aux éléments environ-
nants.

Déplacement d'une séquence vidéo
Vous pouvez aisément déplacer une séquence vidéo vers un nouvel emplacement dans une page Web. 

Pour déplacer une séquence vidéo sur un brouillon, procédez de l'une de manières suivantes :
• Faites glisser la séquence vidéo vers son nouvel emplacement.

• Sélectionnez la séquence vidéo, puis copiez-la (ou coupez-la) et collez-la dans un nouvel emplacement.

Alignement d'une séquence vidéo
Vous pouvez modifier l'alignement d'une séquence vidéo par rapport aux éléments environnants.

Pour modifier l'alignement d'une séquence vidéo par rapport aux éléments environnants :
1 Dans votre brouillon, sélectionnez la séquence vidéo.

2 Procédez de l'une des manières suivantes :

• Choisissez Format > Aligner et sélectionnez une option d'alignement.

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis sélectionnez une 
option dans le menu contextuel Aligner.

Contribute aligne la séquence vidéo par rapport aux éléments qui l'entourent, tels que du texte.

Ajout de suppléments multimédia à un blog
Les suppléments multimédia sont des fichiers audio et vidéo que vous ajoutez à vos entrées de blog. Par exemple, vous 
pouvez ajouter un podcast à une entrée de blog, puis le publier dans votre blog. Le supplément multimédia s'affiche sous la 
forme d'un lien dans la page après publication du blog dans lequel il figure.

Remarque : Vous ne pouvez inclure qu'un seul supplément multimédia dans un brouillon d'entrée de blog (nouveau ou 
existant). Vous avez néanmoins la possibilité d'ajouter un supplément multimédia dans une entrée de blog existante en 
contenant plusieurs lorsque vous la modifiez.

Lorsque vous ajoutez un supplément multimédia à un brouillon, ses détails s'affichent au bas de la barre d'état de 
Contribute. Vous pouvez agrandir ou réduire cette barre d'état en cliquant sur la flèche qu'elle contient, ou supprimer le 
supplément multimédia. 

Vous pouvez ajouter des fichiers audio et vidéo à votre brouillon d'entrée de blog depuis les emplacements suivants :

• votre poste de travail ;

• Vos sites Web (ceux auxquels vous êtes connecté)

• Internet.

Ajout de suppléments multimédia depuis votre ordinateur
Vous pouvez ajouter des fichiers audio et vidéo figurant sur le disque dur de votre ordinateur.
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Pour ajouter un supplément multimédia depuis votre ordinateur :
1 Procédez de l'une des manières suivantes :

• Choisissez Insertion > Supplément multimédia > Depuis mon Poste de travail

• Cliquez sur le bouton Supplément multimédia de la barre d'outils, puis sélectionnez Depuis mon Poste de travail dans le 
menu déroulant.

La boîte de dialogue Sélectionner le supplément multimédia s'affiche.

2 Localisez et sélectionnez le fichier audio ou vidéo à insérer, puis cliquez sur Ouvrir.

Le fichier audio ou vidéo s'affiche à présent dans l'espace de travail Supplément multimédia du brouillon. Ce fichier n'est 
pas lu dans le brouillon ; cette opération n'est possible qu'après la publication.

Ajout de suppléments multimédia depuis votre site Web
Contribute vous permet d'ajouter des fichiers audio et vidéo depuis les sites Web auxquels vous êtes connecté.

Pour ajouter un supplément multimédia depuis votre site Web :
1 Procédez de l'une des manières suivantes :

• Choisissez Insertion > Supplément multimédia > Depuis le site Web.

• Cliquez sur le bouton Supplément multimédia de la barre d'outils, puis sélectionnez Depuis le site Web dans le menu 
déroulant.

La boîte de dialogue Choisir un supplément multimédia sur le site Web s'affiche.

2 Localisez et sélectionnez le fichier audio ou vidéo à insérer.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

3 Cliquez sur Ouvrir.

Le fichier audio ou vidéo s'affiche à présent dans l'espace de travail Supplément multimédia du brouillon. Ce fichier n'est 
pas lu dans le brouillon ; cette opération n'est possible qu'après la publication.

Ajout de suppléments multimédia depuis Internet
Vous pouvez ajouter des fichiers audio et vidéo en tant que suppléments multimédia depuis Internet. 

Au préalable, vous devez régler le lecteur par défaut sur Windows Media Player (Windows uniquement) ou QuickTime 
(Windows ou Macintosh).

Ajout de suppléments multimédia depuis Internet (Windows Media Player sous Windows)
Lorsque vous utilisez Windows Media Player comme lecteur par défaut, vous devez lire les fichiers audio et vidéo dans ce 
lecteur avant de les inclure dans votre brouillon d'entrée de blog en tant que suppléments multimédia.

Remarque : Vous ne pouvez pas insérer des fichiers audio ou vidéo en tant que suppléments multimédia s'ils n'ont pas fait 
l'objet d'une lecture préalable dans Windows Media Player.

Pour ajouter un supplément multimédia depuis Internet (Windows Media Player sous Windows) :
1 Dans votre brouillon, procédez de l'une des manières suivantes :

• Choisissez Insertion > Supplément multimédia > A partir d'Internet.

• Cliquez sur le bouton Supplément multimédia de la barre d'outils, puis sélectionnez A partir d'Internet dans le menu 
déroulant.

La boîte de dialogue Rechercher un supplément multimédia s'affiche.

2 Localisez la page Web contenant le lien vers le fichier audio ou vidéo souhaité.

3 Cliquez du bouton droit sur le lien hypertexte du fichier audio ou vidéo et sélectionnez Copier le raccourci. 

Cette opération vous permet de copier le chemin du fichier audio ou vidéo dans le Presse-papiers.
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4 Collez ce chemin dans la barre d'adresse de la boîte de dialogue Rechercher un supplément multimédia et cliquez sur 
Atteindre.

Le fichier audio ou vidéo s'ouvre dans Windows Media Player, dans une fenêtre distincte, et sa lecture commence. 

5 Fermez la fenêtre de l'application Windows Media Player.

Remarque : Il n'est pas nécessaire d'attendre la fin de la lecture pour fermer la fenêtre du lecteur.

6 Revenez à la boîte de dialogue Rechercher un supplément multimédia actuellement ouverte dans Contribute et cliquez 
sur OK.

Le fichier audio ou vidéo est inséré en tant que supplément multimédia et figure à présent dans l'espace de travail 
Supplément multimédia du brouillon. Ce fichier n'est pas lu dans le brouillon ; cette opération n'est possible qu'après la 
publication.

Ajout de suppléments multimédia depuis Internet (QuickTime)
Vous pouvez ajouter des suppléments multimédia depuis Internet si vous utilisez QuickTime comme lecteur par défaut 
sous Windows et Macintosh. QuickTime correspond au lecteur utilisé par défaut sous Macintosh. Ce n'est pas toujours vrai 
sous Windows, auquel cas vous devrez le sélectionner pour pouvoir ajouter des suppléments multimédia.

Pour ajouter un supplément multimédia depuis Internet (QuickTime) :
1 Dans votre brouillon, procédez de l'une des manières suivantes :

• Choisissez Insertion > Supplément multimédia > A partir d'Internet.

• Cliquez sur le bouton Supplément multimédia de la barre d'outils, puis sélectionnez A partir d'Internet dans le menu 
déroulant.

La boîte de dialogue Rechercher un supplément multimédia s'affiche.

2 Localisez la page Web puis le lien hypertexte du fichier audio ou vidéo à insérer.

3 Cliquez sur le lien hypertexte du fichier audio ou vidéo. 

Le fichier audio ou vidéo s'ouvre dans le lecteur QuickTime, dans la boîte de dialogue Rechercher un supplément multi-
média, et sa lecture commence.

4 Cliquez sur OK.

Le fichier audio ou vidéo est inséré en tant que supplément multimédia et figure à présent dans l'espace de travail 
Supplément multimédia du brouillon. Ce fichier n'est pas lu dans le brouillon ; cette opération n'est possible qu'après la 
publication.

Suppression des suppléments multimédia
Vous pouvez supprimer un supplément multimédia présent dans le brouillon que vous modifiez.

Pour supprimer un supplément multimédia :
• Dans l'espace de travail du supplément multimédia, cliquez sur l'icône Supprimer .

Remarque : La suppression d'un supplément multimédia d'une entrée de blog n'a aucune incidence sur le fichier lui-même ; 
elle permet uniquement de supprimer de l'entrée de blog le lien pointant vers ce fichier. Pour supprimer définitivement les 
fichiers du blog, vérifiez la procédure à suivre auprès de votre service de publication de blogs. 
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Ajout et suppression d'une barre horizontale
Vous pouvez ajouter des barres horizontales à vos pages pour séparer les différents contenus. Par exemple, vous pouvez 
regrouper du texte et d'autres éléments par sujet.

Pour insérer une barre horizontale :
1 Placez le point d'insertion à l'endroit où la barre horizontale doit s'afficher dans votre brouillon.

2 Choisissez Insertion > Barre horizontale.

Contribute insère la barre horizontale. Le contenu qui précède le point d'insertion s'affiche au-dessus de la ligne et celui qui 
le suit, en dessous.

Pour supprimer une barre horizontale :
1 Dans votre brouillon, cliquez sur la barre horizontale pour la sélectionner.

2 Appuyez sur la touche Suppr.

Modification des propriétés d'une barre horizontale
Vous pouvez personnaliser la hauteur, la largeur et l'ombrage appliqués à une barre horizontale sur une page. Par défaut, 
l'épaisseur d'une barre horizontale dans Contribute est de 3 pixels. La barre s'étend sur la largeur de la page ou de la cellule 
du tableau dans laquelle elle est insérée et reçoit une légère ombre portée (ou ombrage). 

Pour plus d'informations sur l'ajout et la suppression de barres horizontales, voir la section « Ajout et suppression d'une 
barre horizontale », page 117.

Pour définir les propriétés d'une barre horizontale :
1 Dans votre brouillon, cliquez sur la barre horizontale pour la sélectionner, puis procédez de l'une des manières 
suivantes :

• Choisissez Format > Propriétés de la barre horizontale.

• Cliquez du bouton droit (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis choisissez 
Propriétés.
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La boîte de dialogue Propriétés de la barre horizontale s'ouvre.

2 Modifiez les options, selon vos besoins.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

3 Cliquez sur OK.

Contribute modifie les propriétés de la barre horizontale.

Insertion de boutons PayPal pour le commerce 
électronique 
PayPal est un service de traitement des paiements qui vous permet de vendre des produits ou des services en ligne et 
d'accepter les paiements par cartes bancaires de vos clients. Vous pouvez donc enrichir vos pages Web de fonctions de 
commerce électronique instantané en leur ajoutant des boutons de paiement.

Remarque : Pour que vous puissiez utiliser la fonction PayPal, votre administrateur Contribute doit l'activer pour votre rôle. 
Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres de modification 
de pages et de paragraphes », page 215.

Cette section contient les rubriques suivantes :

• « Insertion d'un bouton PayPal unique », page 118

• « Insertion de plusieurs boutons PayPal », page 119

• « Modification d'un bouton PayPal », page 119

Insertion d'un bouton PayPal unique
Il est très facile d'insérer un bouton PayPal dans votre page. 

Pour insérer un bouton PayPal :
1 Placez le point d'insertion à l'endroit où vous souhaitez insérer le bouton dans votre brouillon.

Remarque : Assurez-vous que le point d'insertion ne chevauche pas un autre bouton PayPal. 

2 Choisissez Insertion > PayPal, puis sélectionnez le type de bouton à insérer.

Remarque : Si l'administrateur Contribute n'a pas activé la fonction PayPal pour votre rôle, vous ne pouvez pas sélectionner 
de bouton. Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres de 
modification de pages et de paragraphes », page 215.

L'Assistant PayPal s'ouvre.

3 Laissez-vous guider par ses écrans pour définir les options à appliquer.

Cliquez sur Suivant pour parcourir les écrans successifs de l'assistant. 

4 Dans le récapitulatif, cliquez sur Terminer.

Le bouton PayPal s'affiche dans votre brouillon.
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Insertion de plusieurs boutons PayPal
Vous pouvez insérer plusieurs boutons PayPal dans la même page. Vous pouvez par exemple insérer les boutons Ajouter au 
panier et Panier dans la même page. Toutefois, vous ne pouvez pas insérer plusieurs boutons PayPal dans un seul 
paragraphe ou une même cellule de tableau. Si vous tentez l'opération, un message d'erreur s'affiche.

Remarque : Pour que vous puissiez utiliser la fonction PayPal, votre administrateur Contribute doit l'activer pour votre rôle. 
Pour plus d'informations, consultez votre administrateur Contribute ou la section « Définition des paramètres de modification 
de pages et de paragraphes », page 215.

Pour ajouter un bouton dans un paragraphe qui en contient déjà un :
1 Dans votre brouillon, placez le point d'insertion dans le paragraphe, puis appuyez sur Entrée (Windows) ou sur Retour 
(Macintosh).

2 Insérez un bouton PayPal.

Pour ajouter un bouton dans une cellule de tableau qui en contient déjà un :
1 Dans votre brouillon, placez le point d'insertion dans la cellule, puis choisissez Tableau > Fractionner la cellule.

2 Insérez un bouton PayPal.

Modification d'un bouton PayPal
Vous pouvez modifier les paramètres définis à l'origine pour un bouton PayPal. Par exemple, vous pouvez augmenter ou 
réduire le prix des articles, mettre à jour le nom ou la description des articles, sélectionner une autre image de bouton, etc. 

Pour modifier un bouton PayPal :
1 Dans le brouillon, sélectionnez le bouton PayPal à modifier.

2 Choisissez Format > Propriétés PayPal.

Le type en surbrillance pour le bouton sélectionné est le seul élément activé dans le menu déroulant.

3 Dans l'écran des options avancées, cliquez sur un onglet pour sélectionner le type d'informations à actualiser et effectuez 
les modifications nécessaires. 

4 Cliquez sur OK pour enregistrer vos modifications.
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Chapitre 8 : Utilisation des tableaux

Un tableau est un outil puissant et incontournable pour présenter des séries de données ou de chiffres. Vous pouvez par 
exemple ajouter un tableau à une page Web pour répertorier tous vos commerciaux dans une colonne et leurs coordonnées 
dans une autre. 

Adobe® Contribute® CS3 vous permet d'ajouter du texte et des images dans les cellules d'un tableau, comme vous le feriez 
dans une page (voir les sections « Utilisation de texte », page 87 et « Utilisation d'images et d'éléments graphiques », 
page 101). Une fois le tableau créé, il est facile d'en modifier l'aspect et la structure. 

Ce chapitre contient les sections suivantes :

• « A propos des conflits de mise en forme d'un tableau », page 121

• « Insertion d'un tableau dans une page », page 122

• « Sélection d'éléments de tableau », page 123

• « Redimensionnement des tableaux, lignes et colonnes », page 124

• « Alignement des tableaux », page 125

• « Coupe et copie de cellules d'un tableau », page 126

• « Ajout, suppression et fusion de lignes et de colonnes », page 127

• « Modification de l'apparence d'un tableau », page 130

• « Tri des données tabulaires », page 133

A propos des conflits de mise en forme d'un tableau 
Lors de la mise en forme d'un tableau, vous pouvez définir les propriétés pour le tableau entier ou pour des cellules, lignes 
ou colonnes sélectionnées. 

Lorsqu'une propriété (une couleur d'arrière-plan ou un alignement, par exemple) est définie avec une valeur pour tout le 
tableau et une autre pour chaque cellule, la mise en forme des cellules prévaut sur celle des lignes, qui elle-même prévaut 
sur celle du tableau. 

L'ordre de priorité pour la mise en forme d'un tableau est le suivant :

1 Cellules

2 Lignes

3 Tableau

Par exemple, si vous définissez la couleur bleue pour l'arrière-plan d'une cellule, puis la couleur jaune pour l'arrière-plan 
du tableau entier, la cellule conservera son fond bleu car la mise en forme de la cellule prévaut sur celle du tableau.

Remarque : Lorsque vous définissez les propriétés d'une colonne, Contribute modifie les attributs de la balise td correspondant 
à chaque cellule de la colonne.
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Insertion d'un tableau dans une page
Vous pouvez insérer un tableau à tout endroit de la page, y compris à l'intérieur d'un autre tableau. Vous pouvez rapidement 
ajouter un tableau standard (trois lignes et trois colonnes) ou modifier les options pour insérer un tableau personnalisé.

Lorsque vous ajoutez du contenu à votre tableau, la fonction Aperçu dans le navigateur présente la façon dont vos modifi-
cations s'afficheront dans les navigateurs des internautes (voir la section « Aperçu d'une page dans le navigateur par 

défaut », page 156).

Pour insérer un tableau :
1 Placez le point d'insertion à l'endroit où le tableau doit s'afficher dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un tableau, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Tableau de la barre d'outils.

• Sélectionnez Insertion > Tableau.

• Sélectionnez Tableau > Insérer > Tableau.

La boîte de dialogue Insérer un tableau s'affiche.

3 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK.

Le tableau s'affiche dans votre brouillon.

Après l'insertion du tableau, sélectionnez-le et cliquez à nouveau sur le bouton Tableau pour modifier ses propriétés. Pour 
obtenir des informations sur la modification des propriétés d'en-tête, voir la section « Modification des propriétés des 

lignes ou des colonnes », page 131.

Pour insérer un tableau dans un autre tableau :
1 Dans votre brouillon, placez le point d'insertion dans la cellule du tableau où le nouveau tableau doit apparaître.

2 Pour ouvrir la boîte de dialogue Insérer un tableau, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Tableau de la barre d'outils.

• Sélectionnez Insertion > Tableau.

• Sélectionnez Tableau > Insérer > Tableau.

La boîte de dialogue Insérer un tableau s'affiche.
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3 Modifiez les options, selon vos besoins.

4 Cliquez sur OK.

Le tableau s'affiche dans la cellule du tableau, à l'endroit où vous avez placé le point d'insertion.

Sélection d'éléments de tableau
Vous pouvez sélectionner la totalité d'un tableau, d'une ligne ou d'une colonne ou un bloc de cellules contiguës dans un 
tableau.

Sélection de la totalité d'un tableau, d'une ligne ou d'une colonne
Vous pouvez sélectionner la totalité d'un tableau, d'une ligne ou d'une colonne pour la coller dans une autre page (voir la 
section « Coupe et copie de cellules d'un tableau », page 126) ou pour modifier en une seule opération l'arrière-plan de 
toutes les cellules sélectionnées (voir la section « Modification de l'apparence d'un tableau », page 130).

Pour sélectionner un tableau entier, procédez de l'une des manières suivantes :
• Cliquez dans le coin supérieur gauche du tableau ou n'importe où sur le bord droit ou inférieur. 

• Cliquez dans une cellule de tableau et choisissez Tableau > Sélectionner le tableau. 

Des poignées de sélection apparaissent sur les bords inférieur et droit du tableau sélectionné. 

Pour sélectionner des lignes ou des colonnes :
1 Positionnez le pointeur sur le bord gauche d'une ligne ou sur le bord supérieur d'une colonne.

2 Lorsque le pointeur se transforme en flèche de sélection, cliquez pour sélectionner la ligne ou la colonne, ou faites-le 
glisser pour en sélectionner plusieurs.

Sélection d'une cellule, d'un bloc de cellules ou de cellules non contiguës
Vous pouvez sélectionner une cellule isolée ou un groupe de cellules pour les coller dans une autre page (voir la section 
« Coupe et copie de cellules d'un tableau », page 126) ou modifier en une seule opération l'arrière-plan de toutes les cellules 
sélectionnées (voir la section « Modification de l'apparence d'un tableau », page 130).

Lorsque vous sélectionnez un bloc de cellules, celui-ci doit former un rectangle. Si vous sélectionnez plusieurs cellules non 
contiguës dans un tableau, seules les propriétés de ces cellules peuvent être modifiées. Il est en revanche impossible de 
copier ou coller des ensembles de cellules non contiguës.

Pour sélectionner une seule cellule, procédez de l'une des manières suivantes :
• Cliquez dans la cellule, puis faites glisser le pointeur de la souris pour la sélectionner.

• Cliquez dans la cellule, puis sélectionnez Edition > Sélectionner tout.
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Pour sélectionner une ligne ou un bloc rectangulaire de cellules, procédez de l'une des manières suivantes :
• Faites glisser le pointeur de la souris d'une cellule à une autre.

• Cliquez dans une cellule, puis maintenez la touche Maj enfoncée tout en cliquant dans une autre cellule.

Toutes les cellules situées à l'intérieur de la zone rectangulaire ou linéaire ainsi délimitée par les deux cellules sont sélec-
tionnées. 

Pour sélectionner des cellules non contiguës :
• Maintenez la touche Ctrl (Windows) ou Commande (Macintosh) enfoncée pendant que vous cliquez sur les cellules, 

lignes ou colonnes à sélectionner.

Remarque : Si la cellule, la ligne ou la colonne sur laquelle vous cliquez en maintenant la touche Ctrl (Windows) ou Commande 
(Macintosh) enfoncée n'est pas déjà sélectionnée, elle s'ajoute à la sélection. Si elle est déjà sélectionnée, elle est retirée de la 
sélection.

Redimensionnement des tableaux, lignes et colonnes
Vous pouvez redimensionner l'ensemble d'un tableau ou certaines de ses cellules ou colonnes. Lorsque vous redimen-
sionnez un tableau entier, toutes ses cellules changent de taille en proportion.

Pour redimensionner un tableau :
1 Dans votre brouillon, sélectionnez le tableau à redimensionner (voir la section « Sélection d'éléments de tableau », 
page 123).

2 Procédez de l'une des manières suivantes :

• Pour redimensionner le tableau horizontalement, faites glisser la poignée de sélection vers la droite.

• Pour redimensionner le tableau verticalement, faites glisser la poignée de sélection vers le bas.

• Pour redimensionner le tableau verticalement et horizontalement, faites glisser la poignée de sélection vers le coin 
inférieur droit.

Pour changer la largeur d'une colonne, procédez de l'une des manières suivantes dans votre brouillon :
• Sélectionnez la colonne, puis faites glisser son bord droit.

• Sélectionnez la colonne et cliquez sur le bouton Tableau de la barre d'outils. 

Dans la boîte de dialogue Propriétés des colonnes du tableau, modifiez la valeur du champ Largeur de colonne, puis 
choisissez Pixels ou Pourcent. Pour effacer la largeur définie et ajuster les colonnes en fonction du contenu ajouté, choisissez 
Adapter au contenu.

Remarque : Si la colonne sélectionnée n'est pas à l'extrême droite du tableau, la largeur de la colonne contiguë est également 
modifiée tandis que Contribute conserve la largeur de tableau. Si vous sélectionnez la colonne située à l'extrême droite du 
tableau, la largeur globale du tableau est modifiée et la largeur de chaque colonne s'adapte en proportion.

Pour changer la hauteur d'une ligne, procédez de l'une des manières suivantes dans votre brouillon :
• Sélectionnez la ligne et faites glisser sa bordure inférieure. 

• Sélectionnez la ligne et cliquez sur le bouton Tableau de la barre d'outils.

Dans la boîte de dialogue Propriétés des lignes du tableau, modifiez le nombre saisi dans le champ Hauteur des lignes. Pour 
effacer la hauteur définie et adapter les lignes au contenu ajouté, choisissez Adapter au contenu.
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Alignement des tableaux
Vous pouvez indiquer de quelle manière un tableau doit s'aligner dans la page par rapport aux éléments qui l'entourent 
(texte ou images).

Vous ne pouvez pas sélectionner une option d'alignement à la création du tableau. Vous devez insérer le tableau (voir la 
section « Insertion d'un tableau dans une page », page 122), puis modifier l'option d'alignement dans ses propriétés.

Pour modifier l'alignement d'un tableau :
1 Dans votre brouillon, sélectionnez le tableau à réaligner (voir la section « Sélection d'éléments de tableau », page 123).

2 Pour ouvrir la boîte de dialogue Propriétés du tableau, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Tableau de la barre d'outils. 

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche contrôle enfoncée (Macintosh) et 
choisissez Propriétés du tableau dans le menu contextuel. 

• Choisissez Tableau > Propriétés du tableau. 

La boîte de dialogue Propriétés du tableau s'affiche. 

3 Sélectionnez une option d'alignement dans le menu contextuel Alignement du tableau :

Par défaut aligne le tableau sur le côté gauche de la page. Le texte et les images ne sont pas disposés autour du tableau.

Gauche aligne le tableau sur le côté gauche de la page et dispose le texte ou les images à droite du tableau.

Centrer place le tableau au centre de la page.

Droite aligne le tableau sur le côté droit de la page et dispose le texte ou les images à gauche du tableau.

4 Cliquez sur Appliquer pour visualiser les modifications sans quitter la boîte de dialogue ou sur OK pour appliquer les 
modifications et fermer la boîte de dialogue.

L'alignement du tableau est modifié dans votre brouillon.
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Coupe, copie et collage de cellules
Vous pouvez couper, copier ou coller une ou plusieurs cellules à la fois, tout en préservant leur mise en forme. Vous pouvez 
coller les cellules au niveau du point d'insertion ou à la place d'une sélection dans un tableau existant. 

Les cellules sélectionnées doivent être contiguës et présenter une forme rectangulaire. Dans cette illustration par exemple, 
la sélection est un rectangle de cellules qui peut être coupé ou copié. 

La sélection dans cette illustration n'est pas un rectangle, par conséquent les cellules ne peuvent être ni coupées ni collées. 

Coupe et copie de cellules d'un tableau
Vous pouvez copier une ou plusieurs cellules et les couper, ou copier uniquement leur contenu. Vous pouvez copier une ou 
plusieurs cellules, puis les coller dans le même tableau ou bien dans un autre (voir la section « Collage des cellules d'un 
tableau », page 127).

Pour copier des cellules, des lignes ou des colonnes de tableau :
1 Dans votre brouillon, sélectionnez une ou plusieurs cellules, lignes ou colonnes du tableau (voir la section « Sélection 
d'éléments de tableau », page 123). 

2 Procédez de l'une des manières suivantes :

• Choisissez Edition > Copier.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Copier.

Contribute copie la sélection dans le Presse-papiers.

Pour couper des cellules, des lignes ou des colonnes de tableau :
1 Dans votre brouillon, sélectionnez une ou plusieurs cellules, lignes ou colonnes du tableau (voir la section « Sélection 
d'éléments de tableau », page 123). 

2 Effectuez l'une des opérations suivantes :

• Sélectionnez Edition > Couper.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Couper.

Contribute coupe la sélection dans le tableau et la colle dans le Presse-papiers.

Pour supprimer le contenu de cellules tout en conservant ces dernières :
1 Dans votre brouillon, sélectionnez une ou plusieurs cellules. 

Remarque : Ne sélectionnez pas une ligne ou une colonne entière : si vous le faites, lorsque vous choisissez Edition > Effacer ou 
appuyez sur la touche Suppr, Contribute supprime du tableau la ligne ou la colonne entière, pas seulement son contenu.

2 Choisissez Edition > Supprimer ou appuyez sur la touche Suppr. 

Contribute conserve les cellules sélectionnées dans le tableau, mais supprime leur contenu.
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Collage des cellules d'un tableau
Vous pouvez copier des cellules (voir la section « Coupe et copie de cellules d'un tableau », page 126), puis les coller au point 
d'insertion ou à la place d'une sélection dans un tableau existant. 

Pour coller plusieurs cellules, le contenu du Presse-papiers doit être compatible avec la structure du tableau ou du bloc sélec-
tionné dans lequel vous souhaitez le coller. Par exemple, si vous copiez un bloc de quatre cellules, vous devez le coller dans 
un bloc identique.

Pour coller des cellules de tableau :
1 Copiez certaines cellules du tableau (voir la section « Coupe et copie de cellules d'un tableau », page 126).

2 Dans votre brouillon, procédez de l'une des manières suivantes pour indiquer où vous souhaitez les coller :

• Pour remplacer des cellules existantes par celles que vous collez, sélectionnez une série de cellules dont la mise en forme 
est identique à celle des cellules copiées. 

Par exemple, si vous avez coupé ou copié un bloc de trois cellules sur deux, collez-le dans un bloc de cellules de taille 
identique.

• Pour coller une ligne entière de cellules au-dessus d'une cellule spécifique, cliquez dans celle-ci.

• Pour coller une colonne entière de cellules à gauche d'une cellule spécifique, cliquez dans celle-ci.

• Pour créer un tableau avec les cellules collées, placez le point d'insertion hors du tableau.

Remarque : Si vous avez placé moins d'une ligne ou d'une colonne entière dans le Presse-papiers et que vous cliquez dans une 
cellule, puis collez le contenu du Presse-papiers, il se peut que les cellules collées remplacent la cellule dans laquelle vous avez 
cliqué ainsi que les cellules voisines (selon son emplacement dans le tableau).

3 Procédez de l'une des manières suivantes :

• Choisissez Edition > Coller.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Coller. 

Contribute colle les cellules à partir du Presse-papiers.

Ajout, suppression et fusion de lignes et de colonnes
Vous pouvez modifier un tableau existant en ajoutant ou en supprimant des lignes ou des colonnes. Vous pouvez également 
fusionner des cellules pour y réunir des données.

Ajout de lignes et de colonnes
Vous pouvez ajouter une seule ligne ou colonne ou plusieurs lignes ou colonnes en une seule opération.

Pour ajouter une seule ligne à un tableau :
1 Dans votre brouillon, placez le point d'insertion dans une cellule de tableau ou sélectionnez une ligne entière.

2 Procédez de l'une des manières suivantes : 

• Cliquez sur le bouton Insérer une ligne en dessous de la barre d'outils.

Une nouvelle ligne est incluse sous le point d'insertion ou sous la sélection.

• Choisissez Tableau > Insérer > Insérer une ligne au-dessus ou Tableau > Insérer > Insérer une ligne en dessous.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Insérer une ligne au-dessus ou Insérer une ligne en dessous.
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Pour ajouter une seule colonne à un tableau :
1 Dans votre brouillon, placez le point d'insertion dans une cellule de tableau ou sélectionnez une colonne entière.

2 Procédez de l'une des manières suivantes : 

• Cliquez sur le bouton Insérer une colonne à droite dans la barre d'outils.

Une nouvelle colonne est incluse à droite du point d'insertion ou de la sélection.

• Choisissez Tableau > Insérer > Insérer une colonne à gauche ou Tableau > Insérer > Insérer une colonne à droite.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Insérer une colonne à gauche ou Insérer une colonne à droite.

Pour ajouter plusieurs lignes ou colonnes à un tableau :
1 Dans votre brouillon, placez le point d'insertion dans une cellule du tableau.

2 Procédez de l'une des manières suivantes :

• Choisissez Tableau > Insérer > Plusieurs lignes ou colonnes.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Insérer plusieurs lignes ou colonnes.

La boîte de dialogue Insérer des lignes ou des colonnes s'affiche.

3 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK.

Contribute insère les lignes ou les colonnes dans le tableau.

Suppression de lignes et de colonnes
Vous pouvez supprimer une seule ligne ou colonne ou plusieurs lignes ou colonnes en une seule opération.

Pour supprimer des lignes ou des colonnes de tableau dans votre brouillon, procédez de l'une des manières 
suivantes :
• Sélectionnez des lignes ou des colonnes entières et appuyez sur la touche Suppr ou Retour arrière. 

• Sélectionnez des lignes ou des colonnes entières, ou placez le point d'insertion dans une seule ligne ou colonne et cliquez 
sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis choisissez 
Supprimer la ligne ou Supprimer la colonne.

• Sélectionnez des lignes ou des colonnes entières, puis cliquez sur Tableau > Supprimer > Ligne ou Tableau > Supprimer 
> Colonne. 
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Fusion et fractionnement de cellules
Vous pouvez fusionner le nombre de cellules contiguës de votre choix (tant que la sélection forme une ligne ou un rectangle 
de cellules) pour créer une cellule unique, s'étendant sur plusieurs colonnes ou lignes. De même, vous pouvez fractionner 
une cellule en un certain nombre de lignes et de colonnes, qu'elle ait été précédemment fusionnée ou non. 

Pour fusionner des cellules d'un tableau : 
1 Dans le brouillon, sélectionnez les cellules à fusionner. 

Remarque : Vous devez en sélectionner au moins deux.

2 Procédez de l'une des manières suivantes :

• Choisissez Tableau > Fusionner les cellules.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Fusionner les cellules.

Contribute fusionne le contenu des cellules sélectionnées en une seule cellule. 

Pour fractionner les cellules d'un tableau : 
1 Dans votre brouillon, placez le point d'insertion dans la cellule à fractionner. 

Remarque : Contribute fractionne une seule cellule à la fois, même lorsque plusieurs sont sélectionnées.

2 Procédez de l'une des manières suivantes :

• Choisissez Tableau > Fractionner la cellule.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et sélec-
tionnez Fractionner la cellule.

La boîte de dialogue Fractionner la cellule s'affiche.

3 Pour indiquer si la cellule doit être divisée en lignes ou en colonnes, activez le bouton radio approprié, puis saisissez le 
nombre de lignes ou de colonnes désiré.

4 Cliquez sur OK.

Contribute fractionne la cellule en plusieurs lignes ou colonnes.
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Modification de l'apparence d'un tableau
Vous pouvez modifier l'apparence d'un tableau en procédant de l'une des manières suivantes :

• Modification des propriétés de l'ensemble d'un tableau (voir la section « Modification des propriétés d'un tableau », 
page 130)

• Modification des propriétés des cellules, lignes ou colonnes individuelles d'un tableau (voir les sections « Modification 
des propriétés des lignes ou des colonnes », page 131 et « Modification des propriétés des cellules », page 131)

• Application d'un modèle prédéfini à un tableau (voir la section « Utilisation d'une mise en forme de tableau prédéfinie », 
page 132)

Remarque : Avant de modifier les propriétés, il est recommandé de bien comprendre comment Contribute résout les conflits de 
mise en forme entre les cellules, les lignes et les tableaux (voir la section « A propos des conflits de mise en forme d'un tableau », 
page 121).

Modification des propriétés d'un tableau
Vous pouvez modifier l'alignement, la largeur, la couleur d'arrière-plan, ainsi que la couleur et la largeur de bordure d'un 
tableau sélectionné. 

Pour modifier les propriétés d'un tableau : 
1 Dans votre brouillon, sélectionnez le tableau à modifier (voir la section « Sélection d'éléments de tableau », page 123).

2 Pour ouvrir la boîte de dialogue Propriétés du tableau, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Tableau de la barre d'outils. 

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche contrôle enfoncée (Macintosh) et 
choisissez Propriétés du tableau dans le menu contextuel. 

• Choisissez Tableau > Propriétés du tableau. 

La boîte de dialogue Propriétés du tableau s'affiche.

3 Modifiez les propriétés du tableau selon vos besoins.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur Appliquer pour appliquer les modifications sans fermer la boîte de dialogue, ou sur OK pour appliquer les 
modifications et fermer la boîte de dialogue.

Les modifications sont appliquées au tableau dans le brouillon.
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Modification des propriétés des lignes ou des colonnes
Vous pouvez modifier l'alignement horizontal et vertical, la couleur d'arrière-plan, la hauteur ou la largeur, ainsi que le 
renvoi à la ligne pour une ligne ou une colonne sélectionnée.

Remarque : Pour plus d'informations sur la résolution des conflits de mise en forme entre les cellules, les lignes et les tableaux 
par Contribute, voir la section « A propos des conflits de mise en forme d'un tableau », page 121.

Pour modifier les propriétés d'une ligne ou d'une colonne d'un tableau : 
1 Dans votre brouillon, sélectionnez la ligne ou la colonne à modifier (voir la section « Sélection de la totalité d'un tableau, 
d'une ligne ou d'une colonne », page 123).

2 Pour ouvrir la boîte de dialogue Propriétés du tableau, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Tableau de la barre d'outils. 

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche contrôle enfoncée (Macintosh) et 
choisissez Propriétés des cellules du tableau dans le menu contextuel. 

• Choisissez Tableau > Propriétés des cellules du tableau. 

La boîte de dialogue Propriétés du tableau s'affiche, l'onglet approprié sélectionné.

3 Modifiez les propriétés des lignes ou des colonnes selon vos besoins.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur Appliquer pour visualiser vos modifications ou sur OK pour les appliquer et fermer la boîte de dialogue.

Modification des propriétés des cellules
Vous pouvez modifier l'alignement horizontal et vertical, la couleur de l'arrière-plan et le renvoi à la ligne pour une 
cellule sélectionnée.

Remarque : Pour plus d'informations sur la résolution des conflits de mise en forme entre les cellules, les lignes et les tableaux 
par Contribute, voir la section « A propos des conflits de mise en forme d'un tableau », page 121.

Pour modifier les propriétés des cellules du tableau : 
1 Dans votre brouillon, sélectionnez la ou les cellules à modifier (voir la section « Sélection de la totalité d'un tableau, d'une 
ligne ou d'une colonne », page 123).

2 Pour ouvrir la boîte de dialogue Propriétés du tableau, procédez de l'une des manières suivantes :

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche contrôle enfoncée (Macintosh) et 
choisissez Propriétés de la cellule du tableau dans le menu contextuel. 

• Choisissez Tableau > Propriétés des cellules du tableau. 
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• Cliquez sur le bouton Tableau de la barre d'outils.

Remarque : Si vous avez placé le point d'insertion dans la cellule au lieu de la sélectionner, cette option ouvre la boîte de 
dialogue Insérer un tableau et non la boîte de dialogue Propriétés du tableau pour les cellules.

La boîte de dialogue Propriétés du tableau s'affiche, l'onglet approprié sélectionné.

3 Modifiez les propriétés des cellules selon vos besoins.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur Appliquer pour visualiser vos modifications ou sur OK pour les appliquer et fermer la boîte de dialogue 
Propriétés du tableau.

Utilisation d'une mise en forme de tableau prédéfinie
Vous pouvez appliquer un modèle prédéfini à un tableau et sélectionner des options pour le personnaliser.

Remarque : Vous ne pouvez appliquer les modèles prédéfinis qu'à des blocs de cellules rectangulaires. Vous ne pouvez pas 
utiliser ces modèles pour mettre en forme des tableaux contenant des cellules fusionnées ou d'autres mises en forme inhabi-
tuelles.

Pour utiliser une mise en forme de tableau prédéfinie :
1 Dans votre brouillon, sélectionnez le tableau à modifier ou placez le point d'insertion dans l'une de ses cellules.

2 Choisissez Tableau > Formater le tableau. 
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La boîte de dialogue Formater le tableau apparaît, l'onglet Elémentaire sélectionné.

3 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK.

Contribute met votre tableau en forme à l'aide du modèle sélectionné.

Tri des données tabulaires
Vous pouvez trier les lignes d'un tableau en fonction du contenu d'une seule colonne. Par exemple, si le tableau contient une 
colonne Noms, vous pouvez trier ses éléments par ordre alphabétique.

Vous pouvez également effectuer un tri plus complexe, basé sur le contenu de deux colonnes. 

Remarque : Vous ne pouvez pas trier une colonne contenant des cellules fusionnées.

Pour trier un tableau :
1 Dans votre brouillon, sélectionnez le tableau à trier ou placez le point d'insertion dans l'une de ses cellules.

2 Choisissez Tableau > Trier le tableau.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

134

La boîte de dialogue Trier le tableau s'affiche.

3 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

4 Cliquez sur OK. 

Contribute trie le tableau.
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Chapitre 9 : Utilisation des liens

Un lien hypertexte, souvent appelé lien, crée une connexion reliant une page à une autre. Dans les pages Web, les liens sont 
généralement soulignés et d'une couleur différente du reste du texte. Lorsqu'un internaute clique sur un lien, une autre page 
s'ouvre.

Les liens permettent aux internautes de naviguer dans votre site Web. Lorsque vous ajoutez une page à un site, vous devez 
également inclure un lien pointant vers cette nouvelle page dans une page existante. Les utilisateurs peuvent alors cliquer 
sur ce lien pour accéder à la nouvelle page.

Lorsque vous ajoutez un lien à une page Web ou à un brouillon d'entrée de blog, le lien n'est pas actif tant que la page n'est 
pas publiée (voir « Publication de pages Web et d'entrées de blog », page 155). Avant de publier une page Web ou une entrée 
de blog contenant un lien, testez celui-ci à l'aide de la fonction Aperçu dans le navigateur afin de vérifier qu'il fonctionne 
correctement.

Ce chapitre contient les sections suivantes :

• « Création de liens texte ou image », page 135

• « Définition des options de liaison avancées », page 143

• « Modification des liens », page 148

• « Test des liens », page 149

Création de liens texte ou image
Adobe® Contribute® CS3 vous permet de transformer du texte ou des images de votre page Web ou blog pour qu'ils se 
comportent comme des liens. Lorsqu'un internaute clique sur un lien correspondant à un texte spécifique ou une image, 
son navigateur ouvre une autre page Web ou un autre fichier, ou lance son application de messagerie ; si le lien figure dans 
un blog, Contribute affiche une autre entrée de blog.

Le texte ou l'image pointe alors vers l'un des éléments suivants :

• un brouillon en cours ou une page récemment publiée sur votre site Web ;

• une nouvelle page Web créée par Contribute en même temps que le lien ;

• une nouvelle entrée de blog créée par Contribute en même temps que le lien ;

• une page Web existante de votre site ou d'un autre site Web ; 

• une adresse électronique ; 

• un fichier stocké sur votre ordinateur, par exemple un document Microsoft Word ou PDF.

Remarque : Pour établir un lien avec des éléments de votre compte Adobe® Acrobat® Connect 5.5 et 6, consultez « Création d'un 
lien vers des réunions, des formations et du contenu Adobe® Acrobat® Connect™ », page 142.

Création d'un lien vers un brouillon ou une page récemment publiée sur votre site Web
Dans votre page, vous pouvez créer un lien vers un brouillon en cours de modification ou vers une page récemment publiée 
sur votre site Web. Contribute conserve la liste de tous les brouillons vers lesquels vous pouvez créer un lien, ainsi que la 
liste des dix dernières pages publiées sur votre site Web. 

Pour plus d'informations sur la création d'un lien pointant vers une page autre qu'un brouillon en cours ou qu'une page 
récemment publiée, voir la section « Création d'un lien vers une page de votre site ou d'un autre site », page 139.
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Pour créer un lien vers un brouillon ou une page récemment publiée sur votre site Web :
1 Dans le brouillon, effectuez l'une des opérations suivantes pour indiquer l'emplacement du lien :

• Placez le point d'insertion dans le brouillon.

• Sélectionnez du texte dans le brouillon.

• Sélectionnez une image dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Lien de la barre d'outils, puis choisissez Brouillons et pages récentes.

• Choisissez Insertion > Lien > Brouillons et pages récentes.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Insérer un lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Dans la partie supérieure de la boîte de dialogue, cliquez sur Brouillons et pages récentes (Windows) ou Brouillons 
(Macintosh) si l'option n'est pas déjà sélectionnée.

4 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

5 Cliquez sur OK.

Le lien s'affiche dans votre brouillon.

Création d'un lien vers une nouvelle page
Vous pouvez créer un lien vers une nouvelle page de votre site Web ; Contribute génèrera la page en même temps que le lien. 

Remarque : La nouvelle page s'affichera sur votre site lorsque vous publierez le brouillon contenant le lien.

Prenons un exemple : vous travaillez sur une page répertoriant vos produits et vous devez définir un lien vers un produit 
dont la page n'est pas encore créée. Contribute vous permet de créer la page et le lien utilisé pour y accéder avant d'y ajouter 
du contenu. 

La meilleure méthode pour ajouter une page à votre site Web consiste à créer simultanément le lien et la nouvelle page et à 
ajouter le contenu ultérieurement. Vous pouvez également procéder en créant d'abord la page, puis le lien. Pour plus d'infor-
mations, voir la section « Création ou copie d'une page sur un site Web », page 60.
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Il est recommandé de créer la nouvelle page et son lien simultanément. Vous éviterez ainsi d'oublier de créer le lien vers la 
page ultérieurement et vous serez assuré que les utilisateurs pourront accéder à la page sur votre site Web.

Pour créer un lien pointant vers une nouvelle page :
1 Dans le brouillon, procédez de l'une des manières suivantes pour indiquer l'emplacement du lien :

• Placez le point d'insertion dans le brouillon.

• Sélectionnez du texte dans le brouillon.

• Sélectionnez une image dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Lien de la barre d'outils, puis sélectionnez Créer une page.

• Choisissez Insertion > Lien > Créer une page.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Insérer un lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Dans la partie supérieure de la boîte de dialogue, cliquez sur l'option Créer une page (Windows) ou Nouvelle page 
(Macintosh) si elle n'est pas déjà sélectionnée.

La partie inférieure de la boîte de dialogue change.

4 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

5 Cliquez sur OK.

Contribute ajoute le lien au brouillon, puis ouvre la nouvelle page dans l'éditeur de Contribute. Pour revenir au brouillon 
dans lequel vous avez ajouté le lien, cliquez sur son titre dans le panneau Pages.

Remarque : Si vous n'avez pas sélectionné un autre site Web, Contribute enregistre automatiquement la nouvelle page dans le 
même dossier que le brouillon contenant le lien qui y mène. Lorsque vous publiez votre brouillon, Contribute publie également 
la nouvelle page. Au besoin, vous pouvez modifier l'emplacement du dossier de la nouvelle page à ce niveau.
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Création d'un lien vers une nouvelle entrée de blog vide
Vous pouvez créer un lien vers une nouvelle entrée de blog vide dans votre blog ; Contribute crée l'entrée de blog en même 
temps que le lien. 

Remarque : La nouvelle entrée de blog vide s'affiche dans votre blog lorsque vous publiez le brouillon d'entrée de blog (entrée 
dans laquelle insérer le lien) contenant le lien

Pour créer un lien pointant vers une nouvelle entrée de blog vide : 
1 Dans votre brouillon d'entrée de blog, procédez de l'une des manières suivantes pour indiquer l'emplacement du lien :

• Placez le point d'insertion dans le brouillon.

• Sélectionnez du texte dans le brouillon.

• Sélectionnez une image dans le brouillon.

Remarque : Dans certains blogs, vous ne pouvez pas publier des images, des suppléments multimédia, des fichiers multimédia 
ou des liens vers des fichiers locaux. Vérifiez si cela est vrai pour votre blog.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Lien de la barre d'outils, puis sélectionnez Créer une entrée.

• Choisissez Insertion > Lien > Créer une entrée.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Insérer un lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Dans la partie supérieure de la boîte de dialogue, cliquez sur l'option Créer une entrée (Windows) ou Nouvelle entrée 
(Macintosh) si elle n'est pas déjà sélectionnée.

La partie inférieure de la boîte de dialogue change.

4 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

5 Cliquez sur OK.

Remarque : Contribute enregistre automatiquement la nouvelle entrée de blog dans le même dossier que le brouillon contenant 
le lien qui y mène. Lorsque vous publiez le brouillon (c'est-à-dire l'entrée de blog dans laquelle vous avez inséré le lien), 
Contribute publie également la nouvelle entrée de blog. Pour plus d'informations sur la création d'entrées de blog, voir la section 
« Publication d'une entrée sur votre blog », page 171.
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Création d'un lien vers une page de votre site ou d'un autre site
Vous pouvez créer un lien pointant vers une autre page de votre site Web ou d'un autre site. Si la page concernée n'est encore 
reliée à aucune autre page (vous ne pouvez pas y accéder en naviguant), Contribute vous permet d'utiliser le système de 
fichiers pour la localiser.

Remarque : Si cette page a été récemment publiée ou est encore à l'état de brouillon, reportez-vous à la section « Création d'un 
lien vers un brouillon ou une page récemment publiée sur votre site Web », page 135.

Pour créer un lien vers une page de votre site Web ou d'un autre site :
1 Dans le brouillon, procédez de l'une des manières suivantes pour indiquer l'emplacement du lien :

• Placez le point d'insertion dans le brouillon.

• Sélectionnez du texte dans le brouillon.

• Sélectionnez une image dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Lien de la barre d'outils, puis sélectionnez Rechercher une page Web.

• Choisissez Insertion > Lien > Rechercher une page Web.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Insérer un lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Dans la partie supérieure de la boîte de dialogue, cliquez sur l'option Rechercher une page Web (Windows) ou Parcourir 
(Macintosh) si elle n'est pas déjà sélectionnée.

4 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

5 Cliquez sur OK.

Contribute ajoute le lien dans le brouillon.
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Création d'un lien vers une adresse électronique
Vous pouvez créer un lien vers une adresse électronique. Lorsqu'un internaute clique sur ce lien, Contribute crée un 
message, avec l'adresse électronique spécifiée, dans l'application de messagerie par défaut de l'internaute.

Vous pouvez par exemple créer un lien dont le texte est « Pour plus d'informations sur nos nouveaux produits, contactez-
nous ». Lorsqu'un visiteur clique sur ce lien, Contribute ouvre l'application de messagerie de cet internaute et crée un 
message adressé au service commercial.

Pour créer un lien vers une adresse électronique :
1 Dans le brouillon, procédez de l'une des manières suivantes pour indiquer l'emplacement du lien :

• Placez le point d'insertion dans le brouillon.

• Sélectionnez du texte dans le brouillon.

• Sélectionnez une image dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Lien de la barre d'outils, puis sélectionnez Adresse électronique.

• Choisissez Insertion > Lien > Adresse électronique.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Insérer un lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Dans la partie supérieure de la boîte de dialogue, cliquez sur le bouton Adresse électronique (Windows) ou le bouton 
Courriel (Macintosh) si elle n'est pas déjà sélectionnée.

4 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

5 Cliquez sur OK.

Contribute ajoute le lien à la page.
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Création d'un lien vers un fichier stocké dans votre ordinateur
Pour ajouter à votre site Web du contenu enregistré dans votre ordinateur ou sur votre réseau, vous devez créer un lien entre 
la page de votre site et ce fichier. 

Par exemple, vous pouvez créer un lien pointant vers un document Word de votre disque dur ou vers une page HTML 
enregistrée sur votre poste de travail. Cette opération ajoute une nouvelle page au site Web, avec le contenu du fichier. 

Lorsque vous publiez la page contenant le lien, Contribute copie le fichier dans votre site Web, puis crée un lien pointant 
vers cette copie et non vers le fichier stocké dans votre ordinateur. 

Si vous souhaitez remplacer une page existante sur votre site Web par le contenu d'un fichier enregistré sur votre 
ordinateur, consultez la section « Remplacement d'un fichier sur votre site Web », page 161.

Vous pouvez utiliser la boîte de dialogue Insérer un lien pour ajouter un lien pointant vers un fichier stocké dans votre 
ordinateur ou faire glisser le fichier sur votre page (voir la section « Insertion d'un lien pointant vers un document Microsoft 
Word ou Excel à partir de Microsoft Office (Windows uniquement) », page 79).

Remarque : Si le fichier en question est déjà enregistré sur votre serveur Web, mais pas dans votre ordinateur, voir la section 
« Création d'un lien vers une page de votre site ou d'un autre site », page 139.

Pour créer un lien pointant vers un fichier de votre ordinateur à l'aide de la boîte de dialogue Insérer un lien :
1 Dans votre brouillon, procédez de l'une des manières suivantes pour indiquer l'emplacement du lien :

• Placez le point d'insertion dans le brouillon.

• Sélectionnez du texte dans le brouillon.

• Sélectionnez une image dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Cliquez sur le bouton Lien de la barre d'outils et choisissez Fichier sur le Poste de travail.

• Choisissez Insertion > Lien > Fichier sur le Poste de travail.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh), puis 
choisissez Insérer un lien.

La boîte de dialogue Insérer un lien s'affiche.
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3 Dans la partie supérieure de la boîte de dialogue, cliquez sur le bouton Fichier sur le Poste de travail (Windows) ou le 
bouton Fichier (Macintosh) si elle n'est pas déjà sélectionnée.

4 Renseignez la boîte de dialogue.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

5 Cliquez sur OK.

Contribute copie le fichier pour créer une page sur votre site Web. Un lien pointant vers la nouvelle page s'affiche dans le 
brouillon.

Remarque : Pour modifier le contenu de la page liée après sa publication, voir la section « Modification du contenu d'une page 
Web dans un logiciel externe », page 52. Les modifications apportées au fichier d'origine n'apparaîtront pas dans votre site Web.

Création d'un lien vers des réunions, des formations et du contenu Adobe® Acrobat® 
Connect™
Si vous utilisez Acrobat Connect, vous pouvez créer un lien vers des réunions, des formations et du contenu Acrobat 
Connect sur une page Web.

Acrobat Connect est un programme de communication qui inclut les composants suivant : Acrobat Connect Live, Acrobat 
Connect Presentation, Acrobat Connect Training et Acrobat Connect Manager, qui correspond à une application Web 
utilisée comme point d'accès et de contrôle des trois autres composants.

Dans Acrobat Connect Manager, le contenu (qui inclut tout fichier utilisé dans le cadre de formations, de réunions, etc.), 
les formations et les réunions sont organisés dans des dossiers appelés bibliothèques. Avec Contribute, vous pouvez aisément 
accéder aux éléments contenus dans les bibliothèques Acrobat Connect Manager et créer des liens pointant vers ces 
éléments.

Remarque : Le contenu, les formations et les réunions auxquels vous pouvez accéder sont fonction de la configuration d'Acrobat 
Connect et des autorisations qui vous ont été accordées.

Pour créer un lien vers des réunions, des formations et du contenu Acrobat Connect :
1 Dans votre brouillon, placez le point d'insertion à l'endroit où le lien doit s'afficher.

Le texte du lien inséré par Contribute correspond au nom du contenu relié. Par exemple, si vous créez un lien vers une 
réunion intitulée « Ma réunion », le texte du lien sera « Ma réunion ». Vous pourrez modifier le texte du lien après son 
insertion.

Remarque : Si vous sélectionnez du texte dans le brouillon au lieu d'y placer le point d'insertion, Contribute modifie le texte en 
fonction du nom du contenu relié. Si vous sélectionnez une image, Contribute place le texte du lien en regard de cette image.

2 Sélectionnez Insérer > un lien Acrobat Connect.

La boîte de dialogue Adobe Connexion à Acrobat Connect apparaît si c'est la première fois que vous insérez un lien Acrobat 
Connect après avoir démarré Contribute.
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3 Si la boîte de dialogue Connexion à Acrobat Connect apparaît, saisissez votre URL de serveur Acrobat Connect et des 
informations utilisateur, puis cliquez sur OK.

La boîte de dialogue Sélectionner le compte Acrobat Connect s'affiche si vous disposez de plusieurs comptes Acrobat 
Connect.

4 Si la boîte de dialogue Sélectionner le compte Acrobat Connect apparaît, sélectionnez un compte Acrobat Connect, puis 
cliquez sur OK. 

La boîte de dialogue Insérer un lien Acrobat Connect s'affiche. Cette boîte de dialogue répertorie les dossiers contenant les 
éléments de bibliothèques Acrobat Connect pour le compte Acrobat Connect auquel vous êtes connecté.

5 (Facultatif) Pour accéder à un autre compte Acrobat Connect, vous pouvez cliquer sur le bouton Paramètres ; saisir les 
informations dans la boîte de dialogue Connexion à Acrobat Connect, puis cliquer sur OK.

6 Recherchez et sélectionnez l'élément auquel vous souhaitez vous relier, puis cliquez sur OK.

Contribute insère un lien vers l'élément sélectionné.

Pour modifier le texte du lien vers du contenu Acrobat Connect :
❖ Dans le brouillon, sélectionnez le texte du lien et remplacez-le en tapant celui de votre choix.

Définition des options de liaison avancées
La boîte de dialogue Insérer un lien comprend trois options de liaison avancées autorisant les opérations suivantes : modifi-
cation de l'URL du lien, définition d'une cible et création d'un lien vers un emplacement spécifique dans une page.

Modification de l'URL d'un lien
Si la création de liens en langage HTML est une opération qui vous est familière, vous pouvez utiliser Contribute pour 
modifier l'URL d'un lien. 

Lorsque vous créez un lien pointant vers une page de site Web, son URL s'affiche dans le champ Adresse Web (URL) et dans 
le champ HREF de la section Avancé de la boîte de dialogue Insérer un lien. Utilisez ce champ HREF pour modifier l'URL 
que Contribute place dans le code HTML de la page.

Remarque : S'il s'agit d'une nouvelle page, la mention (Nouveau) apparaît à la fin de l'URL. Contribute supprimera ce suffixe 
lors de la publication de la nouvelle page.
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Le champ Adresse Web contient toujours l'URL complète, alors que le champ HREF contient l'URL spécifiée dans le code 
HTML de la page. L'adresse indiquée dans le champ HREF peut sembler différente (généralement plus courte) de l'URL.

Pour modifier l'URL d'un lien :
1 Sélectionnez un lien dans le brouillon.

Remarque : Pour insérer un lien, voir la section « Création de liens texte ou image », page 135.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Choisissez Format > Propriétés du lien.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Propriétés du lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Cliquez sur le bouton Avancé (Windows) ou sur la flèche de développement (Macintosh) pour agrandir la boîte de 
dialogue, si ce n'est pas déjà fait.

4 Modifiez l'adresse Web (URL) dans le champ HREF.

Remarque : Vous remarquerez peut-être que le contenu du champ Lien change au fur et à mesure que vous tapez du texte dans 
le champ HREF. En réalité, Contribute place le contenu du champ HREF dans le code HTML de la page pour l'URL.

5 Cliquez sur OK.

Définition d'une cible pour la page
Vous pouvez désigner l'emplacement d'ouverture d'une page liée en créant une cible pour le lien. La page peut par exemple 
s'ouvrir dans une nouvelle fenêtre au lieu d'écraser l'affichage actuel.

Si vous créez un lien pointant vers un document contenant des cadres, vous pouvez indiquer le cadre, ou cible, qui recevra 
le nouveau contenu. Pour plus d'informations sur la création de cibles pour les cadres, voir la section « Définition du 
contenu d'un cadre comme cible », page 154.

Remarque : Vous ne pouvez pas contrôler l'emplacement d'ouverture du lien d'un courriel. Lorsque l'utilisateur clique sur un 
lien de courriel, son application de messagerie par défaut s'ouvre automatiquement.

Vous pouvez choisir la cible lors de la création du lien (voir la section « Définition de la cible d'un nouveau lien », page 144) 
ou modifier un lien existant pour changer ou ajouter la cible (voir la section « Définition de la cible d'un lien existant », 
page 145).

Définition de la cible d'un nouveau lien
Vous pouvez choisir la cible d'un lien lors de la création de ce dernier.

Pour créer un lien avec une cible :
1 Créez un lien dans le brouillon (voir la section « Création de liens texte ou image », page 135).

2 Dans la boîte de dialogue Insérer un lien, cliquez sur le bouton Avancé (Windows) ou sur la flèche de développement 
(Macintosh) pour agrandir la boîte de dialogue, si ce n'est pas déjà fait.

3 Sélectionnez une cible dans le menu déroulant :

Par défaut ouvre le document lié dans la fenêtre déjà affichée. Si la page contient des cadres, la page liée s'ouvre dans celui 
qui contient le lien.
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Fenêtre entière ouvre le document lié dans la fenêtre déjà affichée. Si la page contient des cadres, la page liée occupe toute 
la fenêtre et pas uniquement le cadre du lien.

 

Nouvelle fenêtre ouvre le document lié dans une nouvelle fenêtre du navigateur, plutôt que dans celle qui est affichée.

4 Cliquez sur OK.

Contribute ajoute le lien dans le brouillon.

Définition de la cible d'un lien existant
Vous pouvez modifier un lien afin de changer ou d'ajouter une cible.

Pour spécifier la cible d'un lien existant :
1 Sélectionnez un lien dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Choisissez Format > Propriétés du lien.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Propriétés du lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Cliquez sur le bouton Avancé (Windows) ou sur la flèche de développement (Macintosh) pour agrandir la boîte de 
dialogue, si ce n'est pas déjà fait.

4 Sélectionnez une cible dans le menu contextuel :

Par défaut ouvre le document lié dans la fenêtre déjà affichée. Si la page contient des cadres, la page liée s'ouvre dans celui 
qui contient le lien.

Fenêtre entière ouvre le document lié dans la fenêtre déjà affichée. Si la page contient des cadres, la page liée occupe toute 
la fenêtre et pas uniquement le cadre du lien.

Nouvelle fenêtre ouvre le document lié dans une nouvelle fenêtre du navigateur, plutôt que dans celle qui est affichée.

Remarque : Si la page d'origine du lien est placée dans un cadre, la liste des cadres s'affiche. Si vous sélectionnez un cadre ou 
tapez son nom, la page liée s'ouvrira dans ce cadre lorsque l'internaute cliquera sur le lien. 

5 Cliquez sur OK.

Contribute modifie le lien existant en tenant compte des informations sur la cible.

Création d'un lien vers un emplacement spécifique dans une page
Vous pouvez placer un marqueur invisible, appelé ancre de section, sur votre page pour désigner un titre ou un emplacement 
spécifique. Vous pourrez ensuite créer des liens pointant vers cette ancre afin de renvoyer les internautes vers l'emplacement 
qu'elle désigne dans la page.

Par exemple, vous pouvez ajouter une ancre aux coordonnées de votre entreprise dans la page intitulée Informations sur la 
société. Vous pouvez ensuite ajouter un lien, dont le texte est « Contactez-nous ! », sur votre page d'accueil. Lorsqu'un inter-
naute clique sur ce lien, la page Informations sur la société s'ouvre à hauteur de la section contenant les coordonnées. Ainsi, 
l'utilisateur n'a pas besoin de faire défiler la page Informations sur la société pour afficher les coordonnées de l'entreprise.
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Ajout d'une ancre de section
Vous pouvez ajouter une ancre de section à une page, puis créer un lien vers cette ancre depuis la même page ou depuis une 
autre page. Pour plus d'informations sur les ancres de section, voir la section « Création d'un lien vers un emplacement 
spécifique dans une page », page 145.

Pour ajouter une ancre à une page :
1 Dans le brouillon, placez le point d'insertion au début de la section qui doit s'afficher lorsqu'un internaute clique sur le 
lien.

2 Choisissez Insertion > Ancre de section.

La boîte de dialogue Ancre de section apparaît.

3 Saisissez le nom de l'ancre.

Ce nom ne peut pas commencer par un chiffre et ne doit contenir aucun espace. Vous ne pouvez pas attribuer le même nom 
à deux ancres d'une même page Web.

4 Cliquez sur OK.

Contribute insère un marqueur d'ancre dans le brouillon. 

Remarque : Si les éléments invisibles sont désactivés, Contribute les active pour que vous puissiez voir le marqueur de l'ancre. 
Pour désactiver à nouveau les éléments invisibles, choisissez Edition > Préférences et sélectionnez Eléments invisibles.

Liaison d'une ancre de section
Vous pouvez créer un lien pointant vers une ancre de section lorsque vous créez le lien, ou vous pouvez modifier un lien 
existant pour qu'il pointe vers l'ancre de section. Pour plus d'informations sur les ancres de section, voir « Création d'un lien 
vers un emplacement spécifique dans une page », page 145.

Pour créer un lien vers une ancre de section :
1 Créez un lien dans le brouillon (voir la section « Création de liens texte ou image », page 135).

2 Dans la boîte de dialogue Insérer un lien, cliquez sur le bouton Avancé (Windows) ou sur la flèche de développement 
(Macintosh) pour agrandir la boîte de dialogue, si ce n'est pas déjà fait.

3 Sélectionnez une ancre dans le menu contextuel Ancre de section.

Remarque : Toutes les ancres définies pour la page que vous reliez s'affichent dans la liste.

4 Cliquez sur OK.

Contribute ajoute le lien dans le brouillon.

Pour spécifier une ancre pour un lien existant :
1 Sélectionnez un lien dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Choisissez Format > Propriétés du lien.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Propriétés du lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Cliquez sur le bouton Avancé (Windows) ou sur la flèche de développement (Macintosh) pour agrandir la boîte de 
dialogue, si ce n'est pas déjà fait.
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4 Sélectionnez une ancre dans le menu contextuel Ancre de section ou tapez le nom d'une ancre.

Toutes les ancres définies pour la page que vous reliez s'affichent dans la liste.

5 Cliquez sur OK.

Contribute modifie le lien existant.

Modification des ancres de section
Après avoir créé une ancre de section, vous pouvez modifier son nom ou la supprimer.

Remarque : Si vous modifiez une ancre de section, ses liens seront rompus jusqu'à ce que vous redéfinissiez le lien qui la désigne 
dans la page.

Pour modifier le nom d'une ancre de section :
1 Dans le brouillon, sélectionnez l'ancre, puis procédez de l'une des manières suivantes :

• Double-cliquez sur l'ancre de section.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche contrôle enfoncée (Macintosh) et 
choisissez Propriétés de l'ancre dans le menu contextuel.

• Choisissez Format > Propriétés de l'ancre.

La boîte de dialogue Modifier l'ancre de section apparaît.

2 Modifiez le nom de l'ancre.

Ce nom ne peut pas commencer par un chiffre et ne doit contenir aucun espace. Vous ne pouvez pas attribuer le même nom 
à deux ancres d'une même page Web.

3 Cliquez sur OK.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

148

Pour supprimer une ancre de section :
• Dans le brouillon, sélectionnez l'ancre de section et appuyez sur la touche Suppr.

Modification des liens
Vous pouvez modifier le texte ou la cible d'un lien, le supprimer ou modifier ses propriétés.

Modification du texte et de la cible du lien
Après l'insertion d'un lien, vous pouvez modifier plus tard son texte ou la page qu'il ouvre.

Pour modifier le texte du lien :
1 Dans le brouillon, sélectionnez le texte du lien à modifier.

2 Tapez le nouveau texte.

Pour modifier la cible du lien :
1 Sélectionnez un lien dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Choisissez Format > Propriétés du lien.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Propriétés du lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Si vous souhaitez modifier le type de page désigné par le lien, cliquez sur l'un des boutons situés dans la partie supérieure 
de la boîte de dialogue, sinon passez à l'étape suivante.

4 Sélectionnez ou recherchez la nouvelle page.

5 Cliquez sur OK.

Suppression d'un lien
Après avoir inséré un lien, vous pouvez aisément le retirer du texte ou de l'image.

Pour supprimer un lien :
1 Sélectionnez le lien à supprimer dans le brouillon.

2 Procédez de l'une des manières suivantes :

• Choisissez Format > Supprimer le lien.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche contrôle enfoncée (Macintosh) et 
choisissez Supprimer le lien dans le menu contextuel. 

Le texte ou l'image du brouillon n'est plus un lien.
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Modification des propriétés d'un lien
Vous pouvez modifier les propriétés d'un lien, y compris son texte, sa cible et les paramètres de liaison avancés.

Pour modifier les propriétés d'un lien :
1 Sélectionnez un lien dans le brouillon.

2 Pour ouvrir la boîte de dialogue Insérer un lien, procédez de l'une des manières suivantes :

• Choisissez Format > Propriétés du lien.

• Cliquez sur le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Macintosh) et 
choisissez Propriétés du lien.

La boîte de dialogue Insérer un lien s'affiche.

3 Modifiez une ou plusieurs des propriétés suivantes :

• Texte du lien

Vous pouvez également modifier le texte du lien en le sélectionnant dans le brouillon et en tapant par-dessus.

• Fichier, page Web ou adresse électronique liés

• Adresse Web

Pour plus d'informations sur l'adresse Web, voir la section « Modification de l'URL d'un lien », page 143.

• Ancre

Pour plus d'informations sur les ancres, voir la section « Création d'un lien vers un emplacement spécifique dans une page », 
page 145.

• Cible

Pour plus d'informations sur la configuration d'une cible, voir la section « Définition d'une cible pour la page », page 144.

4 Cliquez sur OK.

Test des liens
Contribute vous permet de prévisualiser une copie temporaire d'une page Web sur un navigateur Web ou un brouillon 
d'entrée de blog sur un serveur de blog pour que vous puissiez tester les liens.

Remarque : Si votre rôle d'utilisateur ne vous autorise pas à publier, vous ne pouvez pas utiliser la fonction Aperçu dans le 
navigateur pour tester les liens.

Pour tester un lien :
1 Dans le brouillon, choisissez Fichier > Aperçu dans le navigateur.

Votre page s'affiche dans le navigateur Web par défaut.

2 Cliquez sur les liens pour vous assurer qu'ils ouvrent les pages appropriées ou démarrent votre application de messagerie.

3 Fermez l'aperçu dans le navigateur pour revenir au brouillon en cours de modification.
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Chapitre 10 : Utilisation de pages 
contenant des cadres

Les jeux de cadres divisent la fenêtre du navigateur en plusieurs zones, chacune pouvant afficher un contenu spécifique. 
Pour concevoir des pages contenant des cadres, utilisez une application de conception HTML, telle que Adobe Dream-
weaver. Dans Adobe® Contribute® CS3, vous pouvez modifier les pages contenant des cadres.

Remarque : Pour plus d'informations sur la création de pages contenant des cadres dans Dreamweaver, reportez-vous à l'aide 
de ce logiciel (Aide > Utilisation de Dreamweaver).

Ce chapitre contient les sections suivantes :

• « A propos des cadres », page 151

• « Modification du contenu d'un cadre », page 152

• « Enregistrement et publication d'une page contenant des cadres », page 153

• « Définition du contenu d'un cadre comme cible », page 154

A propos des cadres
Une page Web conçue avec des cadres permet de diviser la fenêtre du navigateur en plusieurs zones, chacune pouvant 
contenir des données distinctes. Ce type de page est généralement choisi pour afficher un contenu permanent dans une 
zone, par exemple une barre de navigation, et des données variables dans la zone principale.

Une page Web peut par exemple présenter un cadre vertical étroit contenant les liens de navigation sur le côté gauche, un 
cadre horizontal réservé au logo et au titre du site Web en haut de la page et un troisième cadre occupant le reste de la page 
et affichant le contenu principal.

A. Cadre de navigation B. Cadre de titre et logoC. Cadre de contenu principal
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Cadres et jeux de cadres
Une page contenant des cadres est appelée jeu de cadres. Un jeu de cadres est un fichier qui définit la disposition et les 
propriétés de tous les cadres d'une page donnée : leur nombre, leur taille, leur emplacement et l'adresse Web (URL) de la 
page apparaissant au départ dans chaque cadre. 

Un cadre est un élément d'organisation d'une page de type jeu de cadres. On a tendance à considérer la page affichée dans 
un cadre comme partie intégrante de ce dernier. En réalité, chaque cadre fait uniquement office de conteneur d'une page. 
Les pages chargées au départ dans les cadres sont référencées par le jeu de cadres, mais n'importe quelles pages peuvent y 
être chargées.

Les données qui s'affichent dans chacun des cadres sont enregistrées dans des fichiers distincts. Une page composée de trois 
cadres (navigation, logo et contenu principal) possède en réalité quatre fichiers : un fichier pour le jeu de cadres et trois 
fichiers de pages Web, une pour chaque cadre. Lorsqu'un internaute clique sur un lien dans un cadre, une nouvelle page 
peut être chargée dans un autre cadre. Chaque lien placé dans un cadre peut correspondre à une page distincte.

Un cadre peut charger les pages d'un seul ou de plusieurs sites Web. Vous pouvez donc être en mesure de modifier le 
contenu de certains cadres, mais pas de tous.

A propos de la sélection d'un cadre cible
Pour utiliser le lien d'un cadre afin d'ouvrir une nouvelle page dans un autre cadre, vous devez définir la cible du lien. 
L'opération qui consiste à choisir le cadre dans lequel doit s'ouvrir une page est appelée sélection du cadre cible.

Chaque lien d'un jeu de cadres doit avoir sa cible, c'est-à-dire un cadre dans lequel s'ouvrira la page lorsque l'utilisateur 
cliquera sur le lien. Par exemple, le cadre principal peut être la cible de plusieurs liens : son contenu changera chaque fois 
que l'utilisateur cliquera sur un lien du cadre de navigation. 

Remarque : Si vous ne spécifiez pas de cible pour un lien, Contribute utilise l'option Par défaut et ouvre la nouvelle page dans 
le cadre contenant le lien.

Lorsque vous ajoutez un lien à une page dans un jeu de cadres, vous pouvez désigner le cadre cible de cette page. Pour que 
vous puissiez sélectionner les cadres en tant que cibles, le concepteur du jeu de cadres doit avoir nommé chacun d'eux. Une 
fois le lien inséré, vous pouvez également modifier sa cible dans ses propriétés (voir la section « Modification des liens », 
page 148).

Modification du contenu d'un cadre
Si vous y êtes autorisé, vous pouvez modifier le contenu des cadres d'une page à l'aide de Contribute. 

Pour plus d'informations sur les cadres et les jeux de cadres, voir la section « A propos des cadres », page 151.

Pour modifier le contenu d'un cadre :
1 A l'aide de votre navigateur, accédez à la page contenant les cadres à modifier, puis cliquez sur le bouton Modifier la page.

La boîte de dialogue Sélectionner un cadre à modifier s'affiche. Elle contient la liste des pages contenant des cadres, avec 
leur titre et leur adresse Web (URL).

2 Sélectionnez le cadre à modifier.

Lorsque vous sélectionnez un cadre, une bordure l'entoure dans l'éditeur de Contribute.
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A. Image sélectionnée dans la boîte de dialogue B. Indicateur de sélection dans l'éditeur

Remarque : Une icône de verrouillage est visible à côté du nom de la page si vous ne pouvez pas la modifier. Le verrouillage 
signifie que vous ne disposez pas des autorisations pour modifier le contenu du cadre ou qu'un autre utilisateur est en train de 
modifier la page.

3 Cliquez sur Modifier.

Un brouillon contenant le cadre sélectionné s'affiche dans l'éditeur de Contribute, sans les autres cadres.

4 Modifiez le contenu comme vous le faites habituellement.

5 Lorsque vous êtes prêt pour la publication, reportez-vous à la section « Enregistrement et publication d'une page 
contenant des cadres », page 153.

Enregistrement et publication d'une page contenant des 
cadres
Chaque jeu de cadres est composé de plusieurs pages Web distinctes. Ainsi, lorsque vous modifiez la page apparaissant dans 
un cadre, vous n'altérez que le contenu de la page en cours de modification, pas le jeu de cadres. La publication d'une page 
affichée dans un jeu de cadres est identique à celle d'une page individuelle. Comme vous ne modifiez pas le jeu de cadres, 
sa publication n'est pas nécessaire.

Après modification d'une page de cadre, (voir la section « Modification du contenu d'un cadre », page 152), les options 
suivantes sont à votre disposition avant sa publication :

• Cliquez sur Annuler dans la barre d'outils (voir la section « Annulation d'un brouillon, d'une nouvelle page ou d'une 
nouvelle entrée de blog », page 54).

Le cadre individuel du jeu de cadres s'affiche dans Contribute sans tenir compte de vos modifications. Cliquez sur Retour 
de la barre d'outils pour revenir à la page du jeu de cadres.

• Choisissez Fichier > Aperçu dans le navigateur (voir la section « Aperçu d'une page dans le navigateur par défaut », 
page 156). 

Le cadre s'affiche dans un navigateur avec vos modifications.

• Dans la barre d'outils, cliquez sur Envoi pour la révision (voir la section « Révision de brouillons de pages Web et de 
fichiers par des tiers », page 42). 

Contribute envoie le brouillon à un autre utilisateur pour sa révision.
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Pour publier une page apparaissant à l'intérieur d'un cadre :
• Dans le brouillon, cliquez sur Publier (voir la section « Publication d'une page sur votre site Web », page 156).

Remarque : Selon le rôle que l'administrateur Contribute vous a attribué, il se peut que vous ne puissiez pas publier la page.

Contribute affiche le jeu de cadres avec la page mise à jour et chargée dans le cadre approprié.

Remarque : Si vous publiez vos modifications dans un jeu de cadres imbriqué dans un autre jeu de cadres, le jeu de cadres 
enfant que vous avez modifié s'affiche dans Contribute. Si vous avez plusieurs jeux de cadres imbriqués, seul le premier jeu 
contenant la page modifiée s'affiche.

Définition du contenu d'un cadre comme cible
Vous pouvez modifier le contenu s'affichant dans un cadre en y ajoutant des liens qui ouvrent des pages dans un autre cadre.

Pour plus d'informations, voir la section « A propos de la sélection d'un cadre cible », page 152.

Pour insérer un lien et sélectionner un cadre cible pour la page liée :
1 A l'aide de votre navigateur, accédez à la page contenant les cadres à modifier, puis cliquez sur le bouton Modifier la page.

La boîte de dialogue Sélectionner un cadre à modifier s'affiche.

2 Sélectionnez le cadre dans lequel vous souhaitez ajouter un lien ouvrant une nouvelle page dans un autre cadre, puis 
cliquez sur Modifier.

Un brouillon contenant le cadre sélectionné s'affiche dans l'éditeur de Contribute.

3 Placez le point d'insertion à l'endroit où votre lien doit apparaître dans le brouillon, ou sélectionnez du texte ou 
une image.

4 Procédez de l'une des manières suivantes :

• Choisissez Insertion >Lien, puis un type de page dans le menu contextuel.

• Dans la barre d'outils, cliquez sur Lien, puis choisissez un type de page dans le menu contextuel.

La boîte de dialogue Insérer un lien s'affiche.

5 Renseignez la boîte de dialogue.

Les options visibles dans la boîte de dialogue dépendent du type de page reliée. 

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

6 Dans la boîte de dialogue Insérer un lien, cliquez sur le bouton Avancé pour développer la boîte de dialogue, si ce n'est 
pas déjà fait.

7 Dans le menu contextuel Cadre cible, sélectionnez le cadre dans lequel vous souhaitez que la page liée s'ouvre. Vous 
pouvez saisir un nom de cadre personnalisé dans le champ Cadre cible (qui ouvre la page dans ce cadre) ou sélectionner 
l'un des cadres cible suivants :

Par défaut ouvre la page dans le même cadre que la page en cours.

Fenêtre entière remplace le jeu de cadres par la page.

Nouvelle fenêtre ouvre la page dans une nouvelle fenêtre du navigateur.

8 Cliquez sur OK.

Le lien s'affiche dans votre brouillon.

Remarque : Si vous avez créé un lien pointant vers une nouvelle page, le brouillon de celle-ci s'affiche et vous devez revenir au 
brouillon dans lequel vous avez ajouté le lien.

9 Cliquez sur Publier.

La page contenant les cadres s'affiche, le contenu mis à jour dans le cadre modifié.
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Chapitre 11 : Publication de pages Web et 
d'entrées de blog

La publication d'un brouillon a pour effet d'appliquer les modifications au site Web ou au blog que les internautes peuvent 
consulter. 

Avant de publier un brouillon, vous pouvez en afficher un aperçu dans votre navigateur. De même, avant sa publication, 
vous pouvez faire réviser ce brouillon par d'autres utilisateurs afin d'obtenir leur approbation ou leurs commentaires (voir 
la section « Révision de brouillons de pages Web et de fichiers par des tiers », page 42). Si vous ne souhaitez pas publier votre 
brouillon, vous pouvez l'annuler et conserver l'ancienne version publiée de la page. 

Si le brouillon que vous publiez faisait déjà partie de votre site Web, Adobe® Contribute® CS3 remplace la page existante par 
la version mise à jour. Vous pouvez également mettre à jour une page, puis la publier en tant que nouvelle page sans modifier 
celle d'origine. 

Si le brouillon que vous publiez est une page qui ne faisait pas partie de votre site Web ou de votre blog, Contribute l'ajoute 
au site. Pour les nouvelles pages, Contribute vous demande de nommer leur fichier avant de les publier. 

Enfin, si vous changez d'avis après avoir publié un brouillon, vous pouvez encore annuler la publication. Il vous suffit, dans 
ce cas, de rétablir une version précédente de la page si l'administrateur Contribute a activé la fonction de restauration des 
pages.

Vous pouvez publier vos documents Microsoft Office sur les sites Web auxquels vous êtes connecté sans même ouvrir 
Contribute. Les plug-ins Contribute installés dans Word, Excel et le programme de messagerie Outlook permettent de 
publier facilement vos documents Word, vos feuilles de calcul Excel et vos messages électroniques sur votre site Web. Vous 
pouvez publier un document sur un site Web au format par défaut de celui-ci (en tant que fichier .doc/.docx dans Word ou 
.xls/.xlsx/.xlsm dans Excel), au format .htm ou en tant que PDF. Vous ne pouvez publier les documents Microsoft Outlook 
qu'au format .htm.

Dans Contribute, vous pouvez aisément publier du contenu sur votre blog, directement depuis une application Microsoft 
Office ou un navigateur Web comme Internet Explorer et Mozilla Firefox. Vous pouvez également publier du contenu sur 
votre blog, notamment des actualités à l'aide d'un programme d'ajout de flux RSS. En outre, vous pouvez ajouter toute page 
Web ou tout document sur votre blog puis en modifier le contenu avant de le publier.

Il est également possible d'utiliser Contribute pour publier des entrées de blog vides sur votre blog. En outre, vous pouvez 
publier des entrées de blog contenant des liens pointant vers de nouvelles entrées de blog vides et publier toutes les entrées 
de blog en une seule fois.

Ce chapitre contient les sections suivantes :

• « A propos de la fonction de restauration des pages Web », page 156

• « Aperçu d'une page dans le navigateur par défaut », page 156

• « Publication d'une page sur votre site Web », page 156

• « Publication d'un fichier depuis votre ordinateur sur votre site Web », page 160

• « Remplacement d'un fichier sur votre site Web », page 161

• « Restauration d'une version précédente d'une page », page 163

• « Publication d'un document sur votre site Web à l'aide de Microsoft Office », page 164

• « Publication de contenu sur un blog », page 166

• « Publication de contenu sur un blog depuis un programme d'ajout de flux RSS », page 169

• « Publication d'une entrée sur votre blog », page 171
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A propos de la fonction de restauration des pages Web
Vous pouvez utiliser la fonction de restauration pour rétablir une version précédente d'une page publiée. Vous n'êtes pas 
obligé de restaurer la dernière version publiée. Vous pouvez sélectionner n'importe quelle version enregistrée par 
Contribute en tant que fichier de restauration.

Lorsque vous restaurez une version précédente d'une page, Contribute rétablit le texte contenu dans la version sélectionnée. 
Toutefois, il est possible que les actifs importés dans la page ne soient pas tous récupérés. Cela peut être le cas, par exemple, 
si vous mettez à jour un fichier image en dehors de Contribute et que vous remplacez l'image d'origine par une autre dont 
le nom est identique. Dans ce cas, Contribute ne peut pas restaurer la version précédente de l'image car il ne gère pas les 
actifs à l'extérieur des pages qu'il crée.

Contribute conserve néanmoins l'ancienne version d'une image si vous modifiez l'image dans une application externe à 
l'aide de Contribute ; celui-ci considère alors les images, les documents Microsoft Word et les autres types de contenu 
modifiés dans une application externe comme des actifs. Vous pouvez restaurer les actifs modifiés via Contribute de la 
même façon que vous restaurez des pages.

Supposons que vous ayez effectué une restauration à partir de la version C d'une page vers la version A et que vous ayez 
utilisé Contribute pour modifier une image dans la version B : la version actuelle de l'image ne s'affichera pas lorsque vous 
restaurerez la version A. Outre la page, vous devez également restaurer l'image.

Aperçu d'une page dans le navigateur par défaut
Lorsque vous modifiez un brouillon dans Contribute, vous pouvez à tout moment voir les changements effectués dans un 
navigateur pour vérifier qu'ils correspondent à vos besoins. L'aperçu vous permet également de tester les liens avant de 
publier la page.

Vous pouvez afficher le code source d'une page lorsque vous consultez l'aperçu dans le navigateur.

Remarque : Si le rôle que vous a assigné l'administrateur Contribute ne vous permet pas de publier, vous ne pouvez pas utiliser 
la fonction Aperçu dans le navigateur.

Pour afficher l'aperçu d'une page dans votre navigateur, procédez de la manière suivante :
• Choisissez Fichier > Aperçu dans le navigateur.

• Appuyez sur la touche F12.

Publication d'une page sur votre site Web
Une fois la modification et la révision du brouillon terminées, vous pouvez le publier sur votre site Web. Lorsque vous 
publiez un brouillon, Contribute le rend effectif dans votre site Web. Si cette page a déjà été publiée, Contribute remplace 
la page existante par la version mise à jour.

Remarque : Selon le rôle que l'administrateur Contribute vous a attribué, il se peut que vous ne puissiez pas publier la page.

Vous pouvez publier tous les types de pages suivants sur votre site Web :

• Mises à jour apportées à une page existante 

• Nouvelle page, qui n'a pas été publiée au préalable 

• Pages existante en tant que nouvelle page
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Publication de mises à jour d'une page existante
Lorsque vous publiez les mises à jour d'une page existante, Contribute remplace la version de la page actuellement publiée 
sur le site Web par la nouvelle version.

Lorsque Contribute publie le brouillon, toutes les nouvelles pages vers lesquelles le brouillon pointe par l'intermédiaire de 
liens sont publiées, mais pas les pages contenant un lien vers le brouillon. Contribute vous invite à attribuer un nom à toutes 
les pages liées qui n'ont pas été publiées auparavant. La publication de toutes les nouvelles pages liées au brouillon permet 
de vous assurer que votre site Web ne contient pas de liens rompus. 

Remarque : Si vous souhaitez remplacer une page du site Web par une autre portant le même nom de fichier, supprimez la page 
existante dans le site (voir la section « Suppression d'une page Web ou d'une entrée de blog », page 55), puis publiez celle qui la 
remplace. Si vous n'êtes pas autorisé à supprimer des pages, contactez l'administrateur Contribute.

Pour publier les mises à jour d'une page :
1 Dans le brouillon, cliquez sur le bouton Publier de la barre d'outils.

Remarque : Selon le rôle que l'administrateur Contribute vous a attribué, il se peut que vous ne puissiez pas publier la page.

Si le brouillon contient des liens vers des nouvelles pages, la boîte de dialogue Publier les nouvelles pages liées s'ouvre.

2 Si la boîte de dialogue Publier les nouvelles pages liées s'ouvre, vous pouvez modifier le nom de fichier et l'emplacement 
de chaque page liée non publiée. Cliquez sur le nom de la page pour la sélectionner, puis cliquez sur Tout publier.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

Contribute publie le brouillon sur votre site Web (ainsi que toutes les nouvelles pages liées), puis l'affiche dans le navigateur 
de Contribute.

Publication d'une nouvelle page sur votre site Web
Lorsque vous publiez une nouvelle page sur votre site Web, Contribute vous demande de nommer le fichier de la page, ainsi 
que ceux de toutes les pages qui y sont liées. Contribute publie ensuite sur votre site Web la nouvelle page avec toutes les 
pages auxquelles elle est liée. La publication de toutes les pages liées à la nouvelle page permet de vous assurer que votre site 
Web ne contient pas de liens rompus.

Si vous n'avez pas créé de lien vers la nouvelle page sur une autre page du site, les internautes ne pourront pas l'afficher. 
N'oubliez pas d'ajouter un lien vers la nouvelle page dans une page existante avant (ou juste après) la publication de la 
nouvelle page (voir la section « Création d'un lien vers un brouillon ou une page récemment publiée sur votre site Web », 
page 135).

Vous pouvez créer un lien pointant vers la page en même temps que vous créez la page. Pour plus d'informations, voir la 
section « Création d'un lien vers une nouvelle page », page 136.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

158

Pour publier une nouvelle page :
1 Dans le nouveau brouillon en cours de modification, cliquez sur le bouton Publier de la barre d'outils.

Remarque : Selon le rôle que l'administrateur Contribute vous a attribué, il se peut que vous ne puissiez pas publier la page.

La boîte de dialogue Publier une nouvelle page s'ouvre.

2 Modifiez au besoin le nom du fichier, puis cliquez sur le bouton Choisir un dossier si vous désirez enregistrer ce brouillon 
dans un autre emplacement du site Web.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

Remarque : Contribute attribue automatiquement au fichier le même nom que la page. 

3 Cliquez sur Publier ou sur Suivant.

Remarque : Contribute vous avertit que le nouveau brouillon n'est lié à aucune page existante. Après avoir publié la nouvelle 
page, vous devez créer un lien la désignant (voir la section « Création d'un lien vers un brouillon ou une page récemment publiée 
sur votre site Web », page 135).

Si votre nouveau brouillon est lié à d'autres pages, la boîte de dialogue Publier les nouvelles pages liées s'ouvre.

4 Si la boîte de dialogue Publier les nouvelles pages liées s'ouvre, vous pouvez modifier le nom de fichier et l'emplacement 
de chaque page liée non publiée. Cliquez sur le nom de la page pour la sélectionner, puis cliquez sur Tout publier.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

Contribute publie la nouvelle page sur votre site Web et l'affiche dans le navigateur de Contribute.
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Publication d'une page existante en tant que nouvelle page
Contribute vous permet de mettre à jour une page existante, puis de la publier en tant que nouvelle page sans écraser la page 
d'origine. Cette fonction correspond dans d'autres applications à la commande Enregistrer sous.

Par exemple, si vous ouvrez une page consacrée aux pantalons pour hommes, que vous y ajoutez des informations sur les 
pantalons pour femmes et que vous vous rendez compte que vous n'avez pas enregistré de copie de la page existante avant 
d'y apporter des modifications, la page d'origine n'est pas modifiée tant que vous ne cliquez pas sur Publier. Utilisez la 
fonction Publier en tant que nouvelle page pour publier la page modifiée en tant que nouvelle page du site Web.

Cette opération est possible car, lorsque vous cliquez sur Modifier la page dans une page, Contribute crée une copie (un 
brouillon) destinée à recevoir vos modifications. Lorsque vous enregistrez les modifications apportées au brouillon, la page 
originale du site Web n'est pas modifiée. 

Pour publier une page existante en tant que nouvelle page :
1 Ouvrez la page existante qui doit recevoir le lien, puis cliquez sur le bouton Modifier la page.

2 Apportez les modifications au brouillon.

3 Choisissez Fichier > Actions > Publier en tant que nouvelle page.

Remarque : Selon le rôle que l'administrateur Contribute vous a attribué, il se peut que vous ne puissiez pas publier la page.

Contribute vous avertit que la nouvelle page n'est liée à aucune page existante. Après avoir publié la nouvelle page, vous 
devez créer un lien la désignant (voir la section « Création d'un lien vers un brouillon ou une page récemment publiée sur 
votre site Web », page 135).

La boîte de dialogue Publier en tant que nouvelle page s'ouvre. 

4 Vous pouvez changer le titre et le nom du fichier du brouillon, puis, si vous désirez enregistrer ce brouillon dans un autre 
emplacement du site Web, cliquez sur le bouton Choisir un dossier placé à côté du nom de fichier.

Remarque : Contribute attribue automatiquement au fichier le même nom que la page. 

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

5 Cliquez sur Publier ou sur Suivant.
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Si votre nouveau brouillon est lié à d'autres pages, la boîte de dialogue Publier les nouvelles pages liées s'ouvre.

6 Si la boîte de dialogue Publier les nouvelles pages liées apparaît, vous pouvez modifier le nom de fichier et l'emplacement 
de chaque page liée non publiée. Cliquez sur le nom de la page pour la sélectionner, puis cliquez sur Tout publier.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

Contribute publie le brouillon sur votre site Web et l'affiche dans le navigateur de Contribute. 

Publication d'un fichier depuis votre ordinateur sur votre 
site Web
Vous pouvez ajouter un document ou un fichier (pas des pages HTML) directement depuis vers votre ordinateur sur votre 
site Web. 

Vous pouvez également ajouter des documents ou des fichiers, ainsi que des pages HTML, à votre site Web en créant un 
lien vers ce contenu depuis un brouillon. Pour plus d'informations, voir la section « Création d'un lien vers un fichier stocké 
dans votre ordinateur », page 141.

Remarque : Selon le rôle que l'administrateur Contribute vous a attribué, il est possible que vous ne puissiez pas ajouter de 
fichiers à votre site Web.

Si vous souhaitez remplacer une page existante sur votre site Web par le contenu d'un fichier enregistré sur votre 
ordinateur, consultez « Remplacement d'un fichier sur votre site Web », page 161.

Pour publier un fichier depuis votre ordinateur sur votre site Web :
1 Sélectionnez Fichier > Publier un fichier depuis Poste de travail.

Pour réviser le fichier avant de le publier ou si vous ne parvenez pas à publier la page sur le site Web, choisissez Fichier > 
Envoyer un fichier depuis Poste de travail pour envoyer le fichier en vue de le réviser. Pour plus d'informations, voir la 

section « Envoi d'un fichier en révision à partir de votre ordinateur », page 44.

La boîte de dialogue Sélectionner un fichier s'ouvre.

2 Sélectionnez le fichier à ajouter au site Web, puis cliquez sur Sélectionner.

Remarque : Vous ne pouvez pas sélectionner de fichier HTML, exécutable ni de fichier modèle. Si vous sélectionnez un type de 
fichier incorrect, Contribute vous en avertit et affiche une liste complète des types de fichier incorrects.

En cas de connexions à plusieurs sites Web, la boîte de dialogue Sélectionner un site Web s'ouvre.

3 Si la boîte de dialogue Sélectionner un site Web s'ouvre, sélectionnez le site auquel vous souhaitez ajouter le fichier depuis 
votre ordinateur.
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La liste des sites Web comprend tous les sites auxquels vous êtes connecté et sur lesquels vous êtes autorisé à publier du 
contenu. 

La boîte de dialogue Publier une nouvelle page s'ouvre.

4 Vous pouvez modifier le nom du fichier, puis cliquer sur le bouton Choisir un dossier si vous souhaitez enregistrer ce 
brouillon dans un autre emplacement du site Web.

Pour remplacer un fichier de votre site Web par celui que vous publiez, attribuez le même nom que celui du fichier existant 
et veillez à sélectionner le dossier contenant le fichier à remplacer. 

5 Cliquez sur Publier.

Si le brouillon porte le même nom qu'un fichier de votre site Web, la boîte de dialogue Remplacer le fichier s'ouvre.

6 Si la boîte de dialogue Remplacer le fichier s'ouvre, optez soit pour remplacer le fichier existant par celui que vous 
souhaitez publier, soit pour conserver le fichier existant sur le site et publier le nouveau fichier en lui attribuant un nom 
similaire. Cliquez enfin sur OK.

Le fichier est ajouté à votre site Web. Mémorisez l'adresse Web (URL) de la page ou reliez la nouvelle page depuis une autre 
page pour y revenir facilement.

Utilisez Contribute pour modifier ce fichier après l'avoir publié. Les modifications apportées au fichier d'origine se 
trouvant sur votre ordinateur n'apparaissent pas sur votre site.

Remplacement d'un fichier sur votre site Web
Vous pouvez remplacer un fichier sur votre site Web par un fichier sur votre ordinateur. 

Supposez que vous publiez chaque trimestre sur votre site Web vos bénéfices dans une feuille de calcul. Vous pouvez 
facilement remplacer la version actuelle en ligne par la nouvelle feuille de calcul sur votre ordinateur.

Deux méthodes permettent de remplacer un fichier :

• Publier un fichier directement depuis votre ordinateur.

• Créer un lien vers le fichier depuis un brouillon.
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Pour remplacer un fichier de votre site en publiant un autre fichier directement depuis votre ordinateur :
1 Sélectionnez Fichier > Publier un fichier depuis Poste de travail.

La boîte de dialogue Sélectionner un fichier s'ouvre.

2 Sélectionnez le fichier que vous souhaitez ajouter au site Web, puis cliquez sur Sélectionner le fichier.

Remarque : Vous ne pouvez pas sélectionner de fichier HTML, exécutable ni de fichier modèle. Si vous sélectionnez un type de 
fichier incorrect, Contribute vous en avertit et affiche une liste complète des types de fichier incorrects.

En cas de connexions à plusieurs sites Web, la boîte de dialogue Sélectionner un site Web s'ouvre.

3 Si la boîte de dialogue Sélectionner le site Web apparaît, sélectionnez le site Web qui contient la version courante du 
fichier que vous êtes en train de remplacer, puis cliquez sur OK.

La boîte de dialogue Publier une nouvelle page s'ouvre.

4 Si nécessaire, attribuez le même nom que celui du fichier que vous souhaitez remplacer et veillez à sélectionner le dossier 
contenant le fichier à remplacer.

5 Cliquez sur Publier.

La boîte de dialogue Remplacer le fichier s'ouvre.

6 Sélectionnez l'option Remplacer nom de fichier par votre version et cliquez sur OK.

Contribute remplace le fichier existant sur votre site Web par celui qui est présent sur votre ordinateur. 

Utilisez Contribute pour modifier ce fichier après l'avoir publié. Les modifications apportées au fichier d'origine se 
trouvant sur votre ordinateur n'apparaissent pas sur votre site.

Pour remplacer un fichier sur votre site en créant un lien vers un fichier sur votre ordinateur :
1 Accédez à la page contenant le lien à modifier, puis cliquez sur le bouton Modifier la page.

2 Dans le brouillon, sélectionnez le fichier que vous souhaitez remplacer et cliquez sur le bouton Lien dans la barre d'outils 
et sélectionnez Fichier sur mon Poste de travail.

La boîte de dialogue Insérer un lien s'affiche. Le bouton Fichier sur mon Poste de travail devrait être sélectionné dans la 
partie supérieure de la boîte de dialogue.
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3 Cliquez sur le bouton Parcourir, naviguez jusqu'au fichier de votre ordinateur auquel vous souhaiter vous relier, puis 
sélectionnez-le.

Remarque : Vous ne pouvez pas sélectionner de fichier HTML, exécutable ni de fichier modèle. Si vous sélectionnez un type de 
fichier incorrect, Contribute vous en avertit et affiche une liste complète des types de fichier incorrects.

Le nom du nouveau fichier doit être identique à celui que vous souhaitez remplacer. Si les noms des fichiers ne sont pas 
identiques, Contribute ne remplace pas le fichier.

4 Cliquez sur OK pour fermer la boîte de dialogue Insérer un lien.

5 Dans votre brouillon, cliquez sur le bouton Publier. 

La boîte de dialogue Remplacer le fichier s'ouvre.

6 Sélectionnez l'option Remplacer le fichier et cliquez sur OK.

Contribute publie le fichier depuis votre ordinateur et met à jour le lien dans le brouillon afin de remplacer l'ancien fichier 
par le nouveau situé sur votre ordinateur.

Utilisez Contribute pour modifier ce fichier après l'avoir publié. Les modifications apportées au fichier d'origine se 
trouvant sur votre ordinateur n'apparaissent pas sur votre site.

Restauration d'une version précédente d'une page
Pour plus de sécurité, Contribute vous permet d'annuler la publication d'une page et de restaurer une version précédente.

Pour plus d'informations sur les restaurations, voir la section « A propos de la fonction de restauration des pages Web », 
page 156.

Remarque : Cette fonction de restauration n'est disponible que si l'administrateur Contribute l'a activée. Pour plus d'informa-
tions, contactez l'administrateur Contribute ou reportez-vous à la section « Activation et désactivation des restaurations », 
page 190.

Pour restaurer une version précédente d'une page ou d'un actif :
1 Localisez la page à restaurer.

2 Sélectionnez Fichier > Actions > Restaurer la version précédente.

La boîte de dialogue Restaurer la page s'ouvre. 



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

164

3 Sélectionnez une version précédente de la page publiée dans la liste des pages disponibles. 

Remarque : La liste des pages précédemment publiées peut répertorier un certain nombre de versions de la même page, selon 
le paramètre sélectionné par l'administrateur Contribute. 

Contribute affiche la page dans la section Aperçu.

4 Si la page sélectionnée correspond à celle que vous souhaitez publier, cliquez sur le bouton Restaurer. Si la page ne 
correspond pas à celle que vous souhaitez publier, sélectionnez-en une autre dans la liste, puis cliquez sur Restaurer.

Contribute remplace la version actuellement publiée par la version que vous avez sélectionnée. La version sélectionnée 
devient la version active sur le site Web.

Remarque : La page remplacée par la version sélectionnée apparaît désormais dans la boîte de dialogue Restaurer la page et 
vous pouvez la restaurer ultérieurement, si nécessaire.

Publication d'un document sur votre site Web à l'aide de 
Microsoft Office
Vous pouvez publier des documents de Microsoft Word, Excel et du programme de messagerie Outlook sur votre site Web 
sans ouvrir l'application Contribute. Vous pouvez également associer des modèles à ces documents avant de les publier. Par 
exemple, vous pouvez créer des modèles standard via Adobe Dreamweaver avant de les associer à un document de MS 
Office et ouvrir en même temps le document dans Contribute ou le publier sur le site Web de votre entreprise via 
Contribute. Si la prochaine fois que vous souhaitez modifier l'aspect général de vos documents de MS Office sur le site de 
votre entreprise, il vous suffit de mettre à jour le modèle associé du document. Les modules externes (plug-ins) Contribute 
installés dans ces applications accélèrent et optimisent le processus de publication.

Les modèles et les régions modifiables des modèles affichés sur le bureau côté client sont régulièrement et automatiquement 
mis à jour avec les modèles et le contenu des modèles les plus récents disponibles sur le serveur. Dans Adobe Contribute 
CS3, vous pouvez aussi synchroniser manuellement ces composants à l'aide de l'option Actualiser.

Pour publier un document Microsoft Office sur votre site Web :
1 Ouvrez un fichier Microsoft Office.

2 (Facultatif) Pour publier uniquement une partie spécifique du document, sélectionnez-la.

Remarque : Vous ne pouvez publier une sélection d'un message électronique de Microsoft Outlook si le message est au format 
de texte brut.

3 Pour publier le fichier, procédez de la manière suivante :

Remarque : Avant de publier le document, si vous y avez apporté des modifications, vous devez l'enregistrer.

• Choisissez Contribute > Publier sur le site Web.

• Cliquez sur le bouton Publier sur le site Web de la barre d'outils.

Remarque : Vous ne pouvez pas utiliser l'option Publier sur le site Web pour les fichiers .rtf.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

165

La boîte de dialogue Publier sur le site Web s'ouvre.

4 Pour sélectionner les paramètres de publication du document, procédez de la manière suivante :

a Sélectionnez un site Web sur lequel vous souhaitez publier le fichier.

Remarque : Si vous n'avez pas encore établi de connexion avec votre site Web avant de publier un document, faites-le à présent 
en choisissant Créer une connexion dans le menu déroulant de sélection de la boîte de dialogue Publier sur le site Web. Pour 
plus d'informations sur la création d'une connexion à un site Web, voir la section « Création d'une connexion à un site Web », 
page 179.

b Sélectionnez l'emplacement de stockage du fichier.

c Saisissez un nom de fichier.

Remarque : Le nom de fichier ne doit pas contenir d'espaces, de tabulations et de caractères alphanumériques.

d Sélectionnez un format.

e Cliquez sur le bouton Choisir un modèle. La boîte de dialogue Choisir un modèle s'ouvre.

Si vous ne cliquez pas sur le bouton Choisir un modèle de la boîte de dialogue Publier sur le site Web, le dernier modèle 
utilisé pour publier un document Microsoft Office est associé au document que vous publiez. En outre, si le modèle ne 
correspond pas à celui situé sur le serveur, Contribute ouvre la boîte de dialogue Télécharger un modèle. Vous pouvez 
effectuer l'une des opérations suivantes :

• Publiez le document à l'aide de l'ancien modèle en cliquant sur le bouton prévu à cet effet.

• Téléchargez le modèle mis à jour à partir du serveur et publiez le document en cliquant sur le bouton prévu à cet effet.

Remarque : Le bouton Choisir un modèle est désactivé lorsque le format natif est sélectionné. 

f Sélectionnez un modèle dans la liste des modèles disponibles.

L'aperçu du modèle sélectionné s'affiche dans le champ Aperçu.

g Si le modèle sélectionné pour publier un document de MS Office sur un site Web a été mis à jour sur le serveur, la boîte 
de dialogue Ouvrir en tant que nouvelle page s'ouvre. Vous pouvez choisir de publier le contenu via l'ancien modèle ou 
de télécharger le modèle à jour disponible sur le serveur avant de publier le document.

h Dans la liste des zones modifiables disponible dans le modèle sélectionné, sélectionnez une zone modèle.

Si vous sélectionnez le modèle _blank, cette liste est désactivée.

i Cliquez sur le bouton Actualiser les modèles, puis sélectionnez l'une des options suivantes pour mettre à jour la liste des 
modèles et les zones modifiables dans un modèle sélectionné :

• Pour ce site Web pour afficher une liste de modèles mise à jour pour le site Web sélectionné

• Pour le modèle sélectionné pour afficher une liste de zones modifiables mise à jour dans les modèles sélectionnés
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j Par défaut, la case à cocher Définir comme modèle par défaut est activée.

Le cas échéant, désactivez cette case à cocher.

k Cliquez sur OK.

l (Facultatif) Désactivez la case à cocher Publier la sélection actuelle uniquement afin de publier l'intégralité du document 
et pas simplement la sélection.

5 Cliquez sur Publier.

Contribute publie le document sur votre site Web et une boîte de dialogue de confirmation s'ouvre.

6 Cliquez sur OK.

Le modèle sélectionné est appliqué à la page Web contenant le document de MS Office et le document est publié au format 
HTML.

Remarque : Si vous ouvrez ou publiez un document dans Contribute sans cliquer sur le bouton Choisir un modèle dans la boîte 
de dialogue Publier sur le site Web ou Ouvrir en tant que nouvelle page, le dernier modèle stocké dans le registre est appliqué à 
la page Web contenant le document MS Office. Si vous utilisez pour la première fois la fonction Publier sur le site Web ou Ouvrir 
dans Contribute, un modèle vide est sélectionné.

Publication de contenu sur un blog
Dans Contribute, vous pouvez désormais publier du contenu directement sur votre blog sans l'ouvrir. Vous pouvez utiliser 
les plug-ins Publier dans le blog pour publier du contenu sur votre blog depuis un navigateur ou une application Microsoft 
Office, par exemple Word, Excel et le programme de messagerie électronique Outlook. A l'aide du module externe Publier 
dans le blog, vous pouvez, depuis une page Web du navigateur ou un document de Microsoft Office, transférer le contenu 
de la page vers l'éditeur de Contribute, apporter des modifications et publier le contenu mis à jour sur votre blog.

Pour plus d'informations, consultez les rubriques suivantes :

• « Publication de contenu sur un blog à partir d'un navigateur », page 166

• « Publication d'un contenu de blog depuis des applications Microsoft Word (Windows unqiuement) », page 167

Vous pouvez également publier du contenu sur votre blog, notamment des actualités à l'aide d'un programme d'ajout de 
flux RSS. Pour plus d'informations, voir la section « Publication de contenu sur un blog depuis un programme d'ajout de 
flux RSS », page 169.

Publication de contenu sur un blog à partir d'un navigateur
Vous pouvez utiliser les modules externes (plug-ins) Contribute installés sur votre navigateur pour publier sur votre blog 
des pages Web depuis un navigateur, par exemple Internet Explorer ou Mozilla Firefox. A l'aide du module externe Publier 
dans le blog, vous pouvez, depuis une page Web du navigateur, transférer le contenu de la page vers l'éditeur de Contribute, 
apporter des modifications et publier le contenu mis à jour sur votre blog.

Remarque : Vous devez installer les plug-ins du navigateur pour utiliser cette fonction. Cette fonction n'est disponible que dans 
certains navigateurs et systèmes d'exploitation. Pour une liste complète des navigateurs et des systèmes d'exploitation pris en 
charge, voir « Ouverture d'une page Web ou d'une entrée de blog à des fins de modification dans un navigateur », page 39.

Pour publier du contenu sur un blog à partir d'un navigateur :
1 Depuis le navigateur, ouvrez ou accédez à la page dont vous souhaitez publier le contenu sur votre blog.

Vous devez être connecté à votre blog pour publier une page. Pour plus d'informations, voir la section « Création d'une 
connexion à un serveur de blog », page 180.

2 Sélectionnez le contenu de la page Web que vous souhaitez publier.

3 Cliquez sur Publier dans le blog dans la barre d'outils.

Le contenu sélectionné dans la page Web s'ouvre dans l'éditeur de Contribute.
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4 Apportez les modifications nécessaires.

Remarque : Dans certains blogs, vous ne pouvez pas publier des images, des suppléments multimédia, des fichiers multimédia 
ou des liens vers des fichiers locaux. Vérifiez si c'est le cas de votre blog.

5 Pour publier ce contenu sur un autre blog, sélectionnez-en un à partir du menu déroulant Blog dans l'éditeur de 
Contribute.

Une autre solution consiste à définir ces préférences via l'onglet Valeurs par défaut du blog dans le menu Edition de 
Contribute. Choisissez Edition > Préférences > Valeurs par défaut du blog (si cette option n'est pas déjà sélectionnée) et 

sélectionnez un blog dans le menu contextuel Blog par défaut. Pour plus d'informations sur la définition de ces préférences, 
consultez la section« Définition des préférences dans Contribute », page 27.

6 Cliquez sur Publier.

Publication d'un contenu de blog depuis des applications Microsoft Word (Windows 
unqiuement)
Vous pouvez publier sur votre blog des documents de Microsoft Office, par exemple Word, Excel et le programme de 
messagerie Outlook. Vous pouvez utiliser le plug-in Publier dans le blog dans un document Word, Excel ou dans un 
message Outlook, transférer le contenu de la page vers l'éditeur de Contribute, apporter des modifications et publier le 
contenu mis à jour sur votre blog.

Remarque : Vous ne pouvez publier un message électronique de Microsoft Outlook sur votre blog que si le message est au format 
HTML.

Vous pouvez publier un document sur un site Web au format par défaut de celui-ci (en tant que fichier .doc/.docx dans 
Word ou .xls/.xlsx/.xlsm dans Excel), au format .htm ou en tant que PDF. Vous ne pouvez publier les documents Microsoft 
Outlook qu'au format .htm.

Pour publier du contenu sur un blog depuis Microsoft Office :
1 Ouvrez un fichier dans Microsoft Word ou Excel.

Vous devez être connecté à votre blog pour publier une page. Pour plus d'informations, voir la section « Création d'une 
connexion à un serveur de blog », page 180.

2 Sélectionnez le contenu que vous voulez publier dans une entrée de blog dans Contribute.

3 Pour publier la sélection, procédez de la manière suivante :

Avant de publier le document sur le blog, enregistrez le document si vous y avez apporté des modifications.

• Choisissez Contribute > Publier dans le blog.

• Dans la barre d'outils, cliquez sur Publier dans le blog.

La boîte de dialogue Insérer un document Microsoft Office s'ouvre.
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4 Les options suivantes sont disponibles :

Remarque : Ces options sont disponibles uniquement pour les documents Microsoft Word et Excel.

• Insérer le contenu du document dans cette page pour copier le contenu du document sélectionné dans le brouillon.

• Créer un lien vers le document Office pour insérer un lien vers le document.

• Convertir en PDF et créer un lien vers le PDF pour convertir le document sélectionné au format PDF et insérer un lien 
vers le document PDF.

• Convertir en PDF et incorporer le PDF sous forme d’objet pour convertir le document sélectionné au format PDF et 
incorporer le document PDF sous forme d’objet.

5 (Facultatif) Activez la case à cocher Se souvenir de ce paramètre et ne plus le demander si vous préférez ne plus voir 
l'invite relative à l'option d'insertion par la suite.

Vous pouvez aussi définir ces préférences dans l'onglet Documents Microsoft du menu Modifier dans Contribute. Pour ce 
faire, choisissez Edition > Préférences > Documents Microsoft et effectuez votre choix. Pour plus d'informations sur la 

définition de ces préférences, consultez la section« Définition des préférences dans Contribute », page 27.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

6 Cliquez sur OK.

Le contenu sélectionné ou un lien vers le contenu sélectionné s'affiche dans le brouillon Contribute de votre entrée de blog. 
Si vous avez converti le document au format PDF, Contribute insère un lien vers le document PDF ou incorpore ce dernier 
sous forme d'objet.

7 Dans la zone Date, fixez la date et l'heure à laquelle vous souhaitez publier votre document. L'entrée de blog sera publié 
uniquement à la date et l'heure indiquées et non pas lorsque vous cliquez sur le bouton Publier.

Remarque : Les paramètres de date et d'heure de publication ne sont pris en compte que par des serveurs de blog compatibles.

A. Cité à partir de B. Titre de la page C. Contenu inséré
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8 Apportez les modifications nécessaires.

Remarque : Dans certains blogs, vous ne pouvez pas publier des images, des suppléments multimédia, des fichiers multimédia 
ou des liens vers des fichiers locaux. Vérifiez si c'est le cas de votre blog.

9 Cliquez sur Publier.

Publication de contenu sur un blog depuis un programme 
d'ajout de flux RSS
Dans Contribute, vous pouvez facilement publier du contenu sur votre blog, notamment des actualités à l'aide d'un 
programme d'ajout de flux RSS. Vous pouvez définir Contribute comme étant l'outil de publication sur votre blog dans les 
programmes d'ajout de flux RSS, tels que FeedDemon (Windows) et NetNewsWire (Macintosh). Vous pouvez désormais 
publier vos nouveaux clips préférés sur votre blog et ajouter des commentaires avant de les publier.

Utilisation de Contribute avec le programme d'ajout de flux RSS
Vous pouvez utiliser Contribute dans un programme d'ajout de flux RSS, tel que FeedDemon (Windows) et NetNewsWire 
(Macintosh). Vous pouvez configurer Contribute dans ces programmes d'ajout de flux RSS et publier sur votre blog vos 
nouveaux éléments préférés, ainsi que des commentaires.

Configuration de Contribute dans FeedDemon (Windows)
FeedDemon est un programme d'ajout de flux RSS de bureau pour Windows. Vous pouvez configurer Contribute dans 
FeedDemon et publier des actualités sur votre blog. Vous pouvez transférer des actualités vers Contribute, ajoutez des 
commentaires et les publier sur votre blog. Pour plus d'informations sur l'installation de FeedDemon, rendez-vous sur 
http://www.newsgator.com/NGOLProduct.aspx?ProdID=FeedDemon.

La configuration de Contribute dans FeedDemon peut varier en fonction de la version du programme d'ajout de flux RSS. 
Le processus de configuration ci-dessous s'applique à FeedDemon 2.0.

Pour configurer Contribute dans FeedDemon :
1 Ouvrez FeedDemon.

2 Sélectionnez une ou plusieurs actualités dans la liste.

3 Procédez de la manière suivante :

• Avec le bouton droit de la souris, cliquez sur l'actualité et choisissez Envoyer l'élément > Publier cette actualité > Confi-
gurer les outils de publication sur le blog.

• Appuyez sur Maj+Ctrl+B.

La boîte de dialogue Blog Publishing Tool (Outil de publication) sur le blog s'ouvre.

http://www.newsgator.com/NGOLProduct.aspx?ProdID=FeedDemon
http://www.newsgator.com/NGOLProduct.aspx?ProdID=FeedDemon
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4 Cliquez sur Ajouter.

La boîte de dialogue Program (Programme) s'ouvre.

5 Saisissez les informations suivantes :

• Saisissez Contribute dans le champ Nom.

• Saisissez la commande dans le champ Ligne de commande ou URL. Pour saisir la commande, accédez au fichier 
contribute.exe situé sur le disque dur de votre ordinateur. Après avoir sélectionné le fichier, le chemin s'affiche dans le 
champ Ligne de commande. Vous devez ensuite cliquer à la fin du chemin d'accès, saisir un espace et taper : 
-mmPostToBlog.

6 (Facultatif) Activez la case à cocher Définir par défaut pour que Contribute devienne l'outil de publication sur le blog 
par défaut.

7 Cliquez sur OK.

Contribute s'affiche désormais dans la boîte de dialogue Blog Publishing Tool (Outil de publication sur le blog).

8 Cliquez sur OK.

Pour vérifier si Configure est bien configuré dans FeedDemon, procédez de la manière suivante :

• Sélectionnez une actualité dans FeedDemon. 

• Cliquez du bouton droit sur l'actualité. 

• Choisissez Envoyer l'élément > Publier cette actualité et vérifiez que Contribute figure dans la liste.

Publication sur un blog depuis FeedDemon
Si vous avez réussi à configurer Contribute dans FeedDemon, vous pouvez publier des actualités sur votre blog.

Pour publier un blog depuis FeedDemon :
1 Ouvrez l'actualité dans FeedDemon.

2 Cliquez du bouton droit sur l'actualité et choisissez Envoyer l'élément > Publier cette actualité > Contribute. 
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L'actualité s'affiche dans l'éditeur de Contribute.

3 Effectuez les modifications nécessaires.

4 Cliquez sur Publier.

Contribute publie l'actualité sur votre blog et l'affiche dans le navigateur de Contribute.

Configuration de Contribute dans NetNewsWire (Macintosh)
NetNewsWire est un programme d'ajout de flux RSS de bureau pour Macintosh. Vous pouvez configurer Contribute dans 
NetNewsWire et publier des actualités sur votre blog. Vous pouvez transférer des actualités vers Contribute, ajoutez des 
commentaires et les publier sur votre blog. Pour plus d'informations sur l'installation de NetNewsWire, consultez 
http://www.newsgator.com/NGOLProduct.aspx?ProdID=NetNewsWire.

Pour configurer Contribute dans NetNewsWire :
1 Ouvrez NetNewsWire.

2 Sélectionnez Preferences (Préférences).

3 Cliquez sur l'éditeur Weblog.

4 Dans le menu déroulant de l'éditeur Weblog, accédez au fichier contribute.app.

Publication sur un blog depuis NetNewsWire
Si vous avez réussi à configurer Contribute dans NetNewsWire, vous pouvez publier des actualités sur votre blog.

Pour publier un blog depuis NetNewsWire :
1 Sélectionnez l'actualité dans la liste des actualités de NetNewsWire.

2 Cliquez sur Publier sur Weblog.

L'actualité s'affiche dans l'éditeur de Contribute.

3 Apportez les modifications nécessaires.

4 Cliquez sur Publier.

Contribute publie l'actualité sur votre blog et l'affiche dans le navigateur de Contribute.

Pour afficher l'aperçu de l'entrée de blog dans votre navigateur, procédez de la manière suivante :
• Choisissez Fichier > Aperçu dans le navigateur.

• Appuyez sur la touche F12.

Publication d'une entrée sur votre blog
Après avoir modifié et vérifié votre entrée, vous êtes prêt à la publier sur votre blog. Une fois publiée, vous pouvez publier 
toutes les entrées de blog ou pages Web associées à l'entrée. Une fois une entrée publiée, Contribute la publie sur votre blog. 

Vous pouvez publier tous les types d'entrées suivants sur votre blog :

• Mises à jour d'une entrée de blog existante

• Entrée de blog existante en tant que nouvelle entrée

• Nouvelle entrée de blog vide

http://www.newsgator.com/NGOLProduct.aspx?ProdID=NetNewsWire
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Publications de mises à jour d'une entrée de blog existante
Lorsque vous publiez les mises à jour d'une entrée de blog existante, Contribute remplace la version actuellement publiée 
de l'entrée par la nouvelle version.

Vous pouvez créer un lien pointant vers l'entrée de blog en même temps que vous créez une entrée. Pour plus d'informa-
tions, voir la section « Création d'un lien vers une nouvelle entrée de blog vide », page 138.

Pour publier des mises à jour d'une entrée de blog existante :
1 Dans le brouillon, cliquez sur le bouton Publier de la barre d'outils.

Remarque : Dans certains blogs, vous ne pouvez pas publier des images, des suppléments multimédia, des fichiers multimédia 
ou des liens vers des fichiers locaux. Il se peut que vous ne soyez pas en mesure de publier ces types de contenu si le blog que 
vous publiez n'accepte pas ces fichiers. Vérifiez si c'est le cas de votre blog.

Si le brouillon de l'entrée de blog comporte des liens vers de nouvelles entrées, la boîte de dialogue Publier les nouvelles 
entrées de blog liées s'ouvre.

Si le brouillon d'entrée de blog contient des liens vers des pages Web, la boîte de dialogue Publier les nouvelles pages liées 
s'ouvre.

2 Si la boîte de dialogue Publier les nouvelles entrées de blog liées ou Publier les nouvelles pages liées s'ouvre, procédez de 
la manière suivante :

a Cliquez sur l'entrée de blog ou la page Web pour la sélectionner.

b Si vous sélectionnez une page Web, modifiez l'emplacement du fichier et du dossier si nécessaire.

c Cliquez sur Tout publier.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

Contribute publie l'entrée de blog, ainsi que toute nouvelle entrée ou page Web liée à celle-ci avant de l'afficher dans le 
navigateur de Contribute.

Pour afficher l'aperçu de l'entrée de blog dans votre navigateur, procédez de la manière suivante :
• Choisissez Fichier > Aperçu dans le navigateur.

• Appuyez sur la touche F12.

Publication d'une entrée de blog existante en tant que nouvelle entrée
Vous pouvez publier une entrée existante sur votre blog, apporter des modifications et la publier de nouveau en tant que 
nouvelle entrée.

La fonction Publier en tant que nouvelle entrée permet de publier une entrée de blog existante comme s'il s'agissait d'une 
nouvelle entrée. Supposons que vous ayez une entrée de blog contenant la liste de vos stations radio préférées et que vous 
souhaitiez ajouter la liste des stations radio préférées d'un ami. Vous pouvez ouvrir l'entrée de blog contenant la liste de vos 
éléments préférés, apporter vos modifications puis publier sur le même blog l'entrée en tant que nouvelle entrée de blog.

Pour publier une entrée de blog existante en tant que nouvelle entrée :
1 Naviguez jusqu'à l'entrée de blog de votre blog et cliquez sur le bouton Modifier l'entrée.

2 Apportez les modifications nécessaires à l'entrée de blog.

3 Choisissez Fichier > Actions > Publier en tant que nouvelle entrée.

Si l'entrée de blog comporte des liens vers de nouvelles entrées, la boîte de dialogue Publier les nouvelles entrées de blog 
liées s'ouvre :

4 Si la boîte de dialogue Publier les nouvelles entrées de blog liées s'ouvre, procédez de la manière suivante :

a Cliquez sur l'entrée de blog pour la sélectionner.

b Cliquez sur Tout publier.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.
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Contribute publie l'entrée sur votre blog et l'affiche dans le navigateur de Contribute.

Pour afficher l'aperçu de l'entrée de blog dans votre navigateur, procédez de la manière suivante :
• Choisissez Fichier > Aperçu dans le navigateur.

• Appuyez sur la touche F12.

Publication d'une nouvelle entrée de blog vide
Vous pouvez publier une nouvelle entrée vide sur votre blog. Vous pouvez également publier une entrée de blog vide 
contenant des liens pointant vers d'autres nouvelles entrées vides ou pages Web. Lorsque vous publiez une nouvelle entrée 
contenant un lien vers une autre entrée de blog ou page Web, Contribute publie la nouvelle entrée de blog ainsi que toutes 
les entrées liées à l'entrée de blog.

Vous pouvez créer un lien pointant vers l'entrée de blog en même temps que vous créez une entrée. Pour plus d'informa-
tions, voir la section « Création d'un lien vers une nouvelle entrée de blog vide », page 138.

Pour publier une nouvelle entrée de blog :
1 Dans le brouillon, cliquez sur le bouton Publier de la barre d'outils.

Remarque : Dans certains blogs, vous ne pouvez pas publier des images, des suppléments multimédia, des fichiers multimédia 
ou des liens vers des fichiers locaux. Il se peut que vous ne soyez pas en mesure de publier ces types de contenu si le blog que 
vous publiez ne peut pas lire ces fichiers. Vérifiez si c'est le cas de votre blog.

Si le brouillon de l'entrée de blog comporte des liens vers de nouvelles entrées, la boîte de dialogue Publier les nouvelles 
entrées de blog liées s'ouvre.

Si le brouillon d'entrée de blog contient des liens vers des pages Web, la boîte de dialogue Publier les nouvelles pages liées 
s'ouvre.

2 Pour chaque entrée de blog ou page Web non publiée, procédez de la manière suivante :

• Cliquez sur l'entrée de blog ou la page Web pour la sélectionner.

• Si vous sélectionnez une page Web pour la lier à votre entrée de blog, modifiez l'emplacement du fichier et du dossier si 
nécessaire.

• Cliquez sur Tout publier.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide.

Contribute publie le brouillon d'entrée de blog, ainsi que toute nouvelle entrée ou page Web liée à celle-ci avant de l'afficher 
dans le navigateur de Contribute.

Pour afficher l'aperçu de l'entrée de blog dans votre navigateur, procédez de la manière suivante :
• Choisissez Fichier > Aperçu dans le navigateur.

• Appuyez sur la touche F12.
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Chapitre 12 : Création et gestion des 
connexions à un site Web et un serveur de 
blog

Après avoir installé Adobe® Contribute® CS3, vous devez créer une connexion à un site Web ou à un blog pour pouvoir créer 
de nouvelles pages et entrées de blog ou modifier celles qui existent déjà.

Ce chapitre explique comment créer une connexion à l'aide de l'Assistant de connexion Contribute pour Windows ou pour 
Macintosh. Il décrit également comment définir les paramètres administratifs d'un site Web, renommer et supprimer une 
connexion à un site Web ou un serveur de blog et définir les types de fichiers audio, vidéo et image que vous pouvez publier 
dans vos blogs.

Une fois que vous avez créé la connexion au site Web, vous pouvez créer des rôles (voir la section « Gestion des utilisateurs 
et des rôles », page 207) puis exporter les informations de connexion au site vers vos utilisateurs.

Ce chapitre contient les sections suivantes :

• « A propos de la création d'une connexion à un site Web et de l'envoi des informations correspondantes », page 175

• « Préparation de la connexion à un site Web ou un blog », page 178

• « Création d'une connexion à un site Web », page 179

• « Création d'une connexion à un serveur de blog », page 180

• « Activation et désactivation de CPS pour un site Web », page 183

• « Comment devenir l'administrateur d'un site Web Contribute existant », page 186

• « Configuration des paramètres d'administration de Contribute », page 188

• « Envoi de clés de connexion pour des sites Web », page 195

• « Envoi de clés de connexion pour des sites gérés par CPS », page 197

• « Ajout d'utilisateurs aux sites Web gérés par CPS », page 197

• « Suppression d'utilisateurs de sites Web gérés par CPS », page 199

• « Gestion des connexions à un site Web ou un serveur de blog », page 200

A propos de la création d'une connexion à un site Web et 
de l'envoi des informations correspondantes
Lorsque vous vous connectez à un site Web, selon la configuration de votre serveur Web et la complexité de votre site Web, 
il est possible que Contribute ne détecte pas automatiquement toutes les configurations de serveur possibles. Les 
paramètres Serveur Web de la boîte de dialogue Administrer le site Web vous permettent de spécifier d'autres configura-
tions pour les fichiers d'index de votre site Web et d'autres adresses Web.

Après avoir défini une connexion à un site Web, vous pouvez envoyer les informations la concernant à d'autres utilisateurs, 
dans un fichier de clé de connexion. Si le site Web est géré par Contribute Publishing Server (CPS), vous pouvez également 
utiliser l'URL.

Remarque : Les clés de connexion ne sont pas disponibles pour les blogs.
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Cette section aborde les sujets conceptuels suivants :

• « Pages d'index du serveur Web », page 176

• « Autres adresses du site Web », page 176

• « Clés de connexion », page 177

Pages d'index du serveur Web
La page d'index d'un site Web est la page qui s'affiche par défaut lorsqu'un internaute accède à un site Web (tel que 
www.monsite.com) sans spécifier une page particulière du site. Un serveur Web peut être configuré pour rechercher une 
page portant un nom de fichier spécifique lorsque aucune page n'est spécifiée ; les noms de fichiers de page d'index par 
défaut les plus fréquents sont index.htm, index.html, default.htm et default.html. En cas de doute sur les noms de fichiers 
de page d'index utilisés par votre serveur Web, consultez la documentation de ce dernier.

Outre le nom de fichier de la page d'index principale, la plupart des serveurs Web sont configurés avec d'autres noms de 
fichiers de page d'index, indiquant les pages à afficher si aucune page correspondant au nom de fichier requis n'est trouvée 
en tant que page d'index principale.

Remarque : Les pages d'index sont disponibles pour les sites Web uniquement. Les blogs n'utilisent pas de telles pages.

Par exemple, un serveur Web peut rechercher les noms de page d'index suivants (dans l'ordre spécifié) :

1 index.htm

2 index2.htm

3 404error.htm

Si une page intitulée index.htm est trouvée, le serveur envoie cette page au navigateur pour affichage ; si cette page est 
introuvable, le serveur envoie la page index2.htm au navigateur. Si aucune de ces pages d'index n'est disponible, le serveur 
envoie la page 404error.htm au navigateur. Ce type de pages secondaires constitue très souvent un autre moyen d'accéder 
au site Web ; elles permettent également d'informer l'internaute que le site Web n'est pas disponible.

Contribute comprend une liste des noms de fichiers de page d'index les plus courants qui utilisent les types d'extension de 
document les plus fréquents (htm, .html, .cfm, .asp, .jsp, .php, etc.). Si le nom de fichier de page d'index que vous utilisez 
est répertorié dans la section Fichiers d'index de la boîte de dialogue Mappage des URL et des index (index.cfm par 
exemple), vous pouvez ignorer cette option de configuration. Cependant, si vos noms de fichiers de page d'index ne sont 
pas inclus dans la liste de la boîte de dialogue, vous devez les ajouter et les classer en respectant l'ordre dans lequel votre 
serveur Web est configuré pour les rechercher.

Par exemple, si votre site Web fait appel à un serveur d'applications Adobe ColdFusion utilisant l'extension de document 
.cfm, et si la page d'index de votre site Web utilise le nom de fichier main.cfm, vous devez ajouter le nom de fichier main.cfm 
à la liste des pages d'index de la boîte de dialogue Mappage des URL et des index, puis classer ce nom de telle sorte que la 
page sera la première page que Contribute recherchera sur le site Web. « Ajout de noms de fichiers de page d'index », 
page 191 décrit la procédure d'ajout d'un nom de fichier de pages d'index à vos paramètres Contribute. 

Autres adresses du site Web
Les serveurs Web peuvent être configurés de multiples manières afin de répondre aux besoins variés des utilisateurs. L'un 
des éléments courants de la configuration d'un serveur Web est le mappage d'adresses Web avec différentes adresses IP 
(souvent pour des questions d'emplacement ou d'équilibre de charge) ou le mappage d'adresses Web renvoyant à une 
adresse IP unique. Les configurations de serveur Web suivantes incluent le mappage des URL :

Alias DNS multiples : au moins deux alias de serveurs de noms de domaine renvoient à un même serveur (dans cet 
exemple, un serveur unique comporte une adresse IP unique). Lors de la connexion à un serveur configuré avec plusieurs 
alias DNS, Contribute considère le site Web spécifié et les alias comme des sites Web distincts, même si pour l'utilisateur, 
ceux-ci sont identiques.
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Par exemple, si votre serveur héberge le site Web www.voituresenligne.com et que vous configurez deux adresses Web 
supplémentaires qui se rapportent à ce même site (par exemple, www.voitures.com et www.mesvoitures.com), vous devez 
configurer l'application Contribute afin qu'elle reconnaisse ces adresses de site Web distinctes comme correspondant au 
même site Web. 

Serveur virtuel : ces configurations possèdent au moins deux alias DNS renvoyant au même serveur ; cependant, pour 
l'utilisateur, ces alias correspondent à deux sites Web distincts. Lorsqu'un serveur configuré de cette manière reçoit une 
requête d'extraction d'une page Web, il utilise différentes pages Web en fonction de l'adresse utilisée dans la requête. Il existe 
deux types de configuration de serveur virtuel :

• Les serveurs virtuels DNS utilisent une adresse IP unique à laquelle au moins deux alias DNS renvoient. Dans cette confi-
guration, le serveur Web identifie la requête de page basée sur l'adresse Web, en distribuant des pages différentes aux 
différentes adresses.

• Les serveurs virtuels IP utilisent des adresses IP multiples pour distinguer les différents serveurs Web. 

Les configurations de serveur virtuel sont souvent utilisées pour fournir un contenu localisé selon l'emplacement géogra-
phique. Par exemple, un site Web d'informations peut fournir aux utilisateurs des informations locales qui diffèrent selon 
l'endroit où ils se trouvent. 

Numéros de port : ils sont souvent utilisés pour qu'un nom de domaine puisse être utilisé par davantage de sites Web. Ceci 
permet au site Web de fournir une fonction logicielle différente, basée sur un port pouvant recevoir des requêtes entrantes.

Une adresse Web qui utilise un numéro de port différent est considérée comme un site Web différent. Cependant, ceci n'est 
pas toujours le cas. Comme pour les configurations de serveur Web utilisant des alias DNS multiples, il est important que 
vous mappiez des noms d'hôte en utilisant des numéros de port différents pour le site Web approprié.

Par exemple, s'il est possible d'accéder au site Web de votre entreprise via deux adresses Web ayant des numéros de port 
différents, vous devez ajouter ces adresses Web dans le champ Autres adresses. Dans cet exemple, supposons que votre 
entreprise gère les adresses Web suivantes :

www.voitures.com
www.voitures.com:8080

Chacune de ces adresses renvoie au même site Web, mais les sites qui utilisent le numéro de port 8080 lisent le fichier cookie 
du navigateur pour vérifier si l'internaute est nouveau ou non. Si l'utilisateur est déjà enregistré, le site Web s'affiche sans lui 
demander de s'enregistrer. S'il s'agit d'un nouvel utilisateur, une boîte de dialogue s'affiche, invitant l'internaute à 
s'enregistrer pour avoir accès au site Web.

Clés de connexion
L'Assistant de connexion (Windows ou Macintosh) vous permet de définir facilement des connexions à des sites Web pour 
d'autres utilisateurs. Cet Assistant permet aux utilisateurs de Contribute de partager des connexions à des sites Web, 
favorisant ainsi le travail en équipe.

Contribute permet d'incorporer les informations de connexion d'un site Web dans un fichier de clé de connexion pour 
faciliter leur partage. La clé de connexion est cryptée et protégée par un mot de passe afin que les informations de connexion 
réseau ou FTP (File Transfer Protocol) que vous envoyez dans le fichier soient toujours sécurisées et uniquement consul-
tables dans Contribute. Le fichier de clé de connexion utilise l'extension .stc. Vous pouvez envoyer le fichier aux utilisateurs 
par courriel ou l'enregistrer sur votre ordinateur pour que les utilisateurs le téléchargent et l'importent. Lorsque vous 
double-cliquez sur le fichier, sur le bureau ou dans le courriel, Contribute démarre et importe la connexion.

Les clés de connexion FTP et SFTP peuvent être utilisées sur toutes les plates-formes, tandis que les clés de connexion LAN 
sont spécifiques à une plate-forme.

La procédure d'envoi d'une clé de connexion varie en fonction du type de modèle utilisateur que vous avez choisi pour gérer 
votre site Web. Si vous laissez les utilisateurs se connecter à un site manuellement en indiquant des informations de 
connexion ou en utilisant un fichier de clé de connexion, reportez-vous à la section « Envoi de clés de connexion pour des 
sites Web », page 195. Si vous gérez les utilisateurs par le biais d'un serveur de connexion, reportez-vous à la section « Envoi 
de clés de connexion pour des sites gérés par CPS », page 197.

Remarque : Les clés de connexion ne sont pas disponibles pour les blogs.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

178

Préparation de la connexion à un site Web ou un blog
Avant de commencer, réunissez les informations suivantes :

• Votre nom d'utilisateur et votre adresse électronique

Le nom d'utilisateur et l'adresse électronique identifient à la fois les utilisateurs et les pages Web ou les entrées de blog sur 
lesquelles ils travaillent. Contribute empêche la modification simultanée d'une même page par plusieurs utilisateurs. 
(Contribute utilise un système similaire au système d'archivage et d'extraction de fichiers de Dreamweaver pour éviter les 
conflits lors d'opérations de modification de pages Web.) 

Si vous disposez de plusieurs copies de Contribute, utilisez un nom d'utilisateur différent pour chacune d'entre elles. Par 
exemple, Christophe(portable) et Christophe(Mac). L'utilisation d'un même nom d'utilisateur peut poser problème dans 

la mesure où vous risquez d'écraser des extractions effectuées sur un autre ordinateur.

• Adresse Web du site Web ou du serveur de blog

L'adresse URL (Uniform Resource Locator) d'un site Web correspond à l'adresse de ce site sur Internet ou sur l'intranet 
d'une société. Les adresses URL de sites Web ont généralement le format suivant :

http://www.monsite.com/

L'adresse URL (Uniform Resource Locator) du point d'accès d'un serveur de blog correspond à l'adresse de ce serveur sur 
Internet ou sur l'intranet d'une société. Les adresses URL de serveurs de blog ont généralement le format suivant :

http://nomdublog.sitedublog.com

• Chemin d'accès réseau au site Web (pour les connexions aux réseaux locaux)

Le chemin d'accès réseau correspond à l'emplacement du site Web sur le réseau local de la société. Ce chemin inclut le nom 
du serveur sur lequel se trouve le site Web et le chemin d'accès au répertoire contenant les fichiers sur ce serveur. Le chemin 
d'accès réseau peut se présenter sous l'une des deux formes suivantes : \\monordinateur\wwwroot\ (Windows) ou 
afp://serveur:volume: (Macintosh).

Remarque : Si vous utilisez Macintosh OS X et que vous souhaitez créer une connexion LAN, installez le volume réseau du 
serveur vers lequel vous créez une connexion sur le bureau de votre ordinateur avant de créer la connexion. Dans le Finder, 
choisissez Aller > Se connecter au serveur pour installer le réseau auquel vous souhaitez vous connecter. 

• Informations de connexion FTP ou SFTP

Le protocole FTP fournit une méthode sécurisée de transfert de fichiers vers votre serveur Web local ou distant. Si vous 
vous connectez à votre site Web au moyen d'une connexion distante (si vous travaillez depuis votre domicile ou un autre 
bureau, par exemple), utilisez le protocole FTP. Si vous ne disposez pas de connexion réseau locale à votre site Web, ce 
protocole vous permet de transférer des fichiers depuis un emplacement distant vers votre site Web. 

Si vous-même ou vos utilisateurs souhaitez vous connecter à votre site Web via FTP ou SFTP, vous devez connaître l'adresse 
du serveur FTP, ainsi que le nom d'utilisateur et le mot de passe vous permettant de vous connecter à ce serveur. Par 
exemple, votre adresse de serveur FTP peut être ftp.monsite.com. 

Remarque : S'agissant des sites Web gérés par CPS, demandez aux utilisateurs d'utiliser leurs propres informations de compte 
FTP ou SFTP. 

• Confirmation de la prise en charge directe de votre blog par Contribute

Les blogs hébergés sur Blogger, TypePad, Roller ou WordPress sont directement pris en charge dans Contribute.

Si votre blog est hébergé par un autre service, l'hôte doit prendre en charge l'API MetaWeblog. L'API MetaWeblog permet 
la modification du texte et des attributs d'entrées de blog dans Contribute et d'autres applications externes. Si l'hôte de blog 
prend en charge l'API MetaWeblog, vous devez indiquer l'URL du point d'accès du blog (par exemple, 
http://nomdublog.sitedublog.com), ainsi que vos nom d'utilisateur et mot de passe pour le blog hébergé par ce service.

Remarque : Vous devez déjà disposer d'un compte de blog sur l'hôte de blog avant de vous connecter à ce dernier au moyen de 
Contribute.
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Création d'une connexion à un site Web
L'Assistant de connexion Windows ou Macintosh vous guide tout au long du processus de création d'une connexion à un 
site Web, en vous invitant à saisir les informations nécessaires à l'établissement de cette connexion. 

Le processus est différent lorsqu'il s'agit d'établir une connexion à un blog ; pour plus d'informations, consultez la section 
« Création d'une connexion à un serveur de blog », page 180.

Remarque : Si vous utilisez un système Macintosh et que vous disposez d'un compte .Mac, vous pouvez aisément créer une 
connexion à votre compte .Mac. Dans l'Assistant de connexion, activez la case à cocher .Mac. Pour plus d'informations sur la 
sélection d'un dossier auquel se connecter sur votre site Web .Mac, voir la section « Création d'une connexion à un compte 
.Mac », page 182.

Pour créer une connexion à un site Web :
1 Démarrez Contribute.

2 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche. Les options de cette boîte de dialogue vous permettent de créer et de gérer 
vos connexions Contribute. 

La boîte de dialogue Mes connexion vous permet également de créer une connexion à des blogs. Pour plus d'informations 
sur la création de connexions à des blogs, voir la section « Création d'une connexion à un serveur de blog », page 180. 

3 Cliquez sur Créer.

L'assistant de connexion (Windows ou Macintosh) s'affiche. Cet assistant ou les guides d'assistance vous aident à configurer 
une nouvelle connexion à un site Web. 

Pour retourner à l'écran précédent, cliquez sur Précédent, le cas échéant. Pour plus d'informations sur un écran, cliquez 
sur le bouton Aide.

4 Cliquez sur Suivant.

5 Dans le menu contextuel A quoi souhaitez-vous vous connecter, sélectionnez un site Web.

6 Saisissez l'adresse Web (URL) du site auquel vous souhaitez vous connecter dans votre champ Quelle est l'adresse Web 
de votre site Web. Au besoin, cliquez sur le bouton Parcourir pour rechercher ce site.

7 Cliquez sur Suivant.
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8 Sélectionnez votre service de connexion dans le menu contextuel Comment vous connectez-vous à votre serveur Web 
et exécutez l'une des opérations suivantes :

a Si vous avez sélectionné FTP, saisissez le nom du serveur FTP, le nom d'utilisateur et le mot de passe.

b Si vous avez sélectionné Secure FTP (SFTP), saisissez le nom du serveur SFTP, le nom d'utilisateur et le mot de passe.

c Si vous avez sélectionné Local ou Réseau, saisissez le chemin du réseau à votre site Web.

d Si vous avez sélectionné WebDAV, saisissez l'URL de WebDAV, le nom d'utilisateur et le mot de passe.

9 (Facultatif) Cliquez sur Avancé et sélectionnez les options de connexion avancées appropriées pour le service de 
connexion que vous avez indiqué à l'étape 7.

10 Cliquez sur Suivant.

11 Dans l'écran Résumé, passez en revue les paramètres de connexion afin de vérifier leur exactitude, puis cliquez sur 
Terminer pour établir la connexion.

Contribute crée une connexion au site Web.

Une fois la connexion au site Web correctement créée par Contribute, l'Assistant de connexion se ferme et la page principale 
du site Web s'affiche dans le navigateur de Contribute.

Création d'une connexion à un serveur de blog
L'Assistant de connexion (Windows ou Macintosh) vous guide tout au long du processus de création d'une connexion à un 
blog, en vous invitant à saisir les informations nécessaires à l'établissement de cette connexion.

Deux méthodes s'offrent à vous pour créer une connexion à un serveur de blog :

• Vous pouvez indiquer le nom d'utilisateur et le mot de passe du serveur de blog.

• Vous pouvez définir l'adresse (URL) du blog, ainsi que le nom d'utilisateur et le mot de passe du serveur de blog.

Pour créer une connexion à un site Web, voir « Création d'une connexion à un site Web », page 179.

Vous pouvez vous connecter à un blog hébergé sur l'un des serveurs suivants :

• Blogger, TypePad, Roller ou WordPress. Les utilisateurs dont les blogs sont hébergés sur l'un de ces hôtes peuvent s'y 
connecter directement, en sélectionnant l'hôte voulu dans l'Assistant de connexion. 

• Autres serveurs internes, tels que Movable Type, prenant en charge l'API MetaWeblog. 

Remarque : L'API MetaWeblog permet aux utilisateurs de Contribute de modifier le texte et les attributs d'entrées de blog.

Pour créer une connexion à un serveur de blog :
1 Démarrez Contribute.

2 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh). 

La boîte de dialogue Mes connexions s'affiche. Les options de cette boîte de dialogue vous permettent de créer et de gérer 
vos connexions Contribute. 
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Pour plus d'informations sur la création de connexions à des sites Web, voir la section « Création d'une connexion à un site 
Web », page 179.

3 Cliquez sur Créer.

L'assistant de connexion (Windows ou Macintosh) s'affiche. Cet assistant ou les guides d'assistance vous aident à configurer 
une nouvelle connexion à un site Web. 

4 Cliquez sur Suivant.

5 Dans le menu contextuel A quoi souhaitez-vous vous connecter, sélectionnez Blogs.

6 Sélectionnez l'hôte de votre blog du menu contextuel Quel est l'hôte de votre blog.

7 Cliquez sur Suivant.

8 Si vous avez sélectionné Blogger, TypePad ou WordPress, indiquez le nom d'utilisateur et le mot de passe du blog. 

9 Cliquez sur Terminer pour achever la connexion.

Contribute crée une connexion au serveur de blog.

Remarque : Si vous souhaitez vous connecter au serveur de blog Roller, sélectionnez Autres serveurs de blog du menu déroulant 
Quel est l'hôte de votre blog et saisissez les informations demandées.

Une fois la connexion au blog correctement créée par Contribute, l'Assistant de connexion se ferme. La boîte de dialogue 
Mes connexions s'affiche, indiquant les blogs auxquels vous êtes connecté. Ces blogs figurent également sur la page de 
démarrage de Contribute. 

Remarque : Lorsque vous disposez d'une connexion à un serveur de blog et que vous souhaitez créer un autre blog sur ce même 
serveur, il vous suffit de vous reconnecter à ce serveur pour ajouter le nouveau blog et les informations le concernant. Pour plus 
d'informations, voir la section « Reconnexion à un serveur de blog », page 182.

Pour créer une connexion à un serveur de blog par le biais de l'URL du blog :
1 Démarrez Contribute.

2 Dans la zone Créer, cliquez sur le lien de connexion au blog. 

L'écran Sélection d'une connexion de l'Assistant Créer une connexion s'affiche.

3 Par défaut, l'option Blogs est sélectionné dans le menu contextuel A quoi souhaitez-vous vous connecter.
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4 Sélectionnez Autres serveurs de blog du menu contextuel Quel est l'hôte de votre blog si votre blog est hébergé sur un 
serveur interne qui prend en charge le protocole MetaWeblog.

Le champ Quelle est l'URL de votre blog et le bouton Parcourir s'affichent. 

5 (Facultatif)Dans le champ Quelle est l'URL de votre blog, saisissez ou naviguez jusqu'à l'URL de la page d'accueil de votre 
blog.

6 Cliquez sur Suivant.

L'écran Informations sur la connexion au site de blog de l'assistant Créer une connexion s'affiche.

Si vous avez sélectionné Blogger ou si Contribute est en mesure de trouver le point d'accès du serveur de blog correspondant 
à l'URL que vous avez spécifiée, seuls s'affichent les champs Saisissez le nom d'utilisateur de votre serveur de blog et Saisissez 
le mot de passe de votre serveur de blog. Cependant, si vous avez sélectionné Autres serveurs de blog ou si Contribute n'est 
pas en mesure de trouver le point d'accès du serveur de blog que vous avez spécifié, le menu déroulant Protocole de blog 
(qui est désactivé) et le champ Point d'accès s'affichent également.

7 Saisissez votre nom d'utilisateur dans le champ Saisissez le nom d'utilisateur de votre serveur de blog.

8 Saisissez le mot de passe pour vous connecter à votre blog dans le champ Saisissez le mot de passe de votre serveur de 
blog. 

9 Si le champ Point d'accès s'affiche, indiquez le point d'accès.

Remarque : Le point d'accès est une URL utilisée pour vous connecter à votre serveur de blog.  Vous pouvez afficher une liste 
de points d'accès courants dans la documentation de l'aide. Appuyez sur la touche F1 pour obtenir de l'aide en ligne.

Remarque : Au besoin, cliquez sur le bouton Précédent ou Retour pour revenir en arrière.

10 Cliquez sur Terminer. 

Contribute crée une connexion au serveur de blog et la page d'accueil du blog s'ouvre dans le navigateur de Contribute.

Reconnexion à un serveur de blog
Si vous avez créé un blog par l'intermédiaire du service de publication des blogs (auquel vous êtes déjà connecté dans 
Contribute) et que vous voulez vous connecter à ce nouveau blog, vous devrez peut-être vous connecter de nouveau au 
serveur. Cette opération aboutit à la création d'une connexion et à l'ajout de modèles pour le nouveau blog dans Contribute.

Pour vous reconnecter à un serveur de blog :
• Si Contribute n'est pas en cours d'utilisation, ouvrez l'application. Contribute se reconnecte au serveur de blog et met à 

jour automatiquement la connexion en fonction des informations des nouveaux blogs.

• Si Contribute est en cours d'utilisation, procédez de l'une des manières suivantes :

a Quittez Contribute, puis ouvrez à nouveau cette application.

b Modifiez la connexion au serveur de blog sans changer les informations utilisateur. Pour plus d'informations sur les 
modifications au serveur de blog, voir « Modification d'une connexion à un site Web ou un serveur de blog », page 201.

c Désactivez la connexion au serveur de blog, puis réactivez-la. Pour plus d'informations, voir les sections « Désactivation 
de connexions à des sites Web et à des blogs », page 203 et « Activation de la connexion à un site Web ou à un serveur de 
blog », page 204.

Création d'une connexion à un compte .Mac
Vous pouvez utiliser Contribute avec votre compte .Mac et configurer facilement une connexion à votre site Web. 
L'intégration de Contribute et de .Mac est prise en charge sur Mac OS X 10.2 et les versions ultérieures. 

Remarque : Sur 10.1.X, vous devez installer votre iDisk pour que Contribute détecte votre compte .Mac. Pour ce faire, rendez-
vous dans le Finder et choisissez Aller > iDisk.

Si Contribute détecte la présence d'un compte .Mac actif vous appartenant, vous êtes invité à créer une connexion à ce 
compte dès le démarrage. Vous pouvez refuser et créer la connexion ultérieurement à l'aide de l'Assistant de connexion. 
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Pour créer une connexion à un compte .Mac :
1 Sélectionnez Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche. 

2 Cliquez sur Créer.

L'assistant de connexion s'affiche.

3 Sélectionnez Site Web .Mac dans le menu contextuel A quoi souhaitez-vous vous connecter.

Grâce aux informations .Mac enregistrées dans les préférences système de votre ordinateur, Contribute installe votre IDisk 
et crée la connexion au dossier racine de votre site Web. Pour savoir comment sélectionner un autre dossier de connexion, 
voir la section « Sélection d'un dossier de site Web .Mac auquel se connecter », page 183.

Remarque : Si Contribute ne détecte pas votre compte .Mac, vous êtes invité à en configurer un nouveau. 

4 Cliquez sur Continuer pour passer à l'écran Résumé, puis sur Terminer : la connexion au site Web est établie.

Sélection d'un dossier de site Web .Mac auquel se connecter
Lorsque vous sélectionnez l'option Obtenir des informations de connexion depuis mon compte .Mac, Contribute détecte 
automatiquement le chemin d'accès au dossier racine de votre site Web .Mac. Pour créer une connexion à un sous-dossier 
de votre site Web .Mac, laissez Contribute fournir les informations relatives au chemin d'accès, puis modifiez ce chemin 
vers le dossier souhaité.

1 Sélectionnez Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche. 

2 Cliquez sur Créer.

L'assistant de connexion s'affiche.

3 Sélectionnez Site Web .Mac dans le menu contextuel A quoi souhaitez-vous vous connecter.

4 Dans l'assistant de connexion, cliquez sur Continuer pour ajouter les informations de connexion .Mac.

5 Dans l'assistant de connexion, cliquez sur Précédent et désactivez la case Obtenir des informations de connexion depuis 
mon compte .Mac pour pouvoir sélectionner le chemin auquel vous souhaitez vous connecter. 

Les informations de connexion au site Web .Mac ne sont pas supprimées ; vous pouvez apporter les modifications de votre 
choix dans les écrans de l'Assistant de connexion.

6 Cliquez sur Continuer pour mettre à jour les paramètres. Dans l'écran Résumé, cliquez sur Terminer pour fermer 
l'assistant de connexion. 

Activation et désactivation de CPS pour un site Web
Après l'installation et la configuration de CPS, vous pouvez activer CPS pour votre site Web. Vous êtes libre de désactiver 
CPS ou le service Annuaire des utilisateurs à tout moment.

Remarque : Pour désactiver d'autres services, vous devez utiliser la Console CPS. Reportez-vous à l'aide de cette console pour 
plus d'informations.

Cette section contient les rubriques suivantes :

• « Activation de CPS pour un site Web », page 184

• « Désactivation de CPS pour un site Web », page 185

• « Désactivation du service Annuaire des utilisateurs pour un site Web », page 186
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Activation de CPS pour un site Web
Avant d'utiliser CPS avec votre site Web, vous devez procéder à son installation et à sa configuration (voir l'Aide de la 
console CPS pour plus d'informations sur la procédure de configuration). Vous devez également créer une connexion 
Contribute à votre site Web (voir « Création d'une connexion à un site Web », page 179).

Cela fait, vous pouvez activer CPS pour votre site Web.

Avant d'activer CPS pour utiliser l'annuaire des utilisateurs avec votre site Web, assurez-vous que tous les utilisateurs qui 
se sont connectés au site auparavant à l'aide d'une clé de connexion ont publié tous les brouillons en souffrance. En effet, 

après l'activation de CPS, ils ne pourront pas se connecter au site Web tant que vous ne les aurez pas ajoutés au site au moyen 
du service LDAP, Active Directory ou de la base de données d'utilisateurs de type fichier. 

Pour utiliser CPS avec votre site Web :
1 Démarrez Contribute.

2 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez Publishing Server dans la liste des catégories administratives, sur la gauche.

4 Cliquez sur le bouton Activer Publishing Server.

La boîte de dialogue Activer Publishing Server s'affiche.

5 Tapez l'adresse Web de Publishing Server dans le champ d'adresse et cliquez sur OK.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide. 

Contribute établit une connexion à CPS pour que vous puissiez ensuite démarrer la Console CPS.

Remarque : Lorsque vous activez l'Annuaire des utilisateurs, tous les utilisateurs s'étant connectés précédemment au site sont 
supprimés et toutes les clés de connexion que vous avez envoyées ne fonctionnent plus. Vous devez ajouter les utilisateurs à 
partir de votre répertoire LDAP, Active Directory ou de votre base de données d'utilisateurs de type fichier. Pour savoir comment 
ajouter des utilisateurs aux sites gérés à l'aide de CPS, voir la section « Ajout d'utilisateurs aux sites Web gérés par CPS », 
page 197.
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6 (Facultatif) Dans la boîte de dialogue Administrer le site Web, cliquez sur le lien Console Publishing Server pour lancer 
la console CPS. 

Désactivation de CPS pour un site Web
Vous pouvez désactiver CPS pour un site Web géré par CPS. Ceci peut se révéler utile pour empêcher temporairement des 
utilisateurs de se connecter au serveur, par exemple lorsqu'il est nécessaire de modifier l'emplacement du serveur ou de 
procéder à sa maintenance.

Lorsque vous désactivez CPS, les utilisateurs qui étaient connectés au site Web ne peuvent plus y accéder tant que vous 
n'activez pas de nouveau CPS. Contribute ne supprime pas le fichier de paramètres d'administration relatif au site Web lors 
de la désactivation de CPS ; les rôles et autorisations demeurent donc inchangés.

Pour désactiver une connexion à un site Web CPS :
1 Publiez tous les brouillons ouverts pour ce site Web.

Vous ne pourrez peut-être plus accéder aux brouillons ouverts après la désactivation de ce service.

Remarque : Assurez-vous que les utilisateurs connectés au site Web publient également tous les brouillons en suspens. 

2 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

La boîte de dialogue Administrer le site Web s'affiche.

3 Dans la liste des catégories situées à gauche de la boîte de dialogue, sélectionnez Publishing Server.

4 Cliquez sur le bouton Activer Publishing Server.

Une boîte de dialogue de confirmation s'ouvre.

5 Cliquez sur Oui pour continuer.

Contribute désactive CPS pour ce site Web, sans toutefois supprimer le fichier de paramètres d'administration le 
concernant ; les rôles et autorisations restent donc inchangés. Vous disposez toujours d'une connexion au site Web en tant 
que site non géré.

Remarque : Les utilisateurs précédemment connectés à ce site Web ne peuvent plus y accéder tant que vous ne réactivez pas 
CPS ou que vous ne leur envoyez pas les clés de connexion avec les nouvelles informations de connexion.

6 Cliquez sur Fermer pour fermer la boîte de dialogue Administrer le site Web.
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Désactivation du service Annuaire des utilisateurs pour un site Web
Vous pouvez désactiver le service Annuaire des utilisateurs pour un site Web géré par CPS.

Remarque : Pour désactiver d'autres services, vous devez utiliser la Console CPS. Reportez-vous à l'aide de cette console pour 
plus d'informations.

Lorsque vous désactivez le service Annuaire des utilisateurs pour un site Web, les utilisateurs précédemment connectés à 
ce site ne peuvent plus y accéder tant que vous ne leur envoyez pas les clés de connexion avec les nouvelles informations de 
connexion.

Pour désactiver le service Annuaire des utilisateurs pour un site Web :
1 Publiez tous les brouillons ouverts pour ce site Web.

Vous ne pourrez peut-être plus accéder aux brouillons ouverts après la désactivation de ce service.

Remarque : Assurez-vous que les utilisateurs connectés au site Web publient également tous les brouillons en suspens. 

2 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

La boîte de dialogue Administrer le site Web s'affiche.

3 Dans la liste des catégories situées à gauche de la boîte de dialogue, sélectionnez Publishing Server.

4 Cliquez sur le bouton Désactiver l'annuaire des utilisateurs.

Contribute désactive le service Annuaire des utilisateurs pour ce site Web

Remarque : Les utilisateurs précédemment connectés à ce site Web ne peuvent plus y accéder tant que vous ne leur envoyez pas 
les clés de connexion avec les nouvelles informations de connexion.

5 Cliquez sur Fermer pour fermer la boîte de dialogue Administrer le site Web.

Comment devenir l'administrateur d'un site Web 
Contribute existant
Lorsque vous créez une connexion au site Web avec Contribute, vous avez la possibilité de devenir l'administrateur de ce 
site. Si vous ne souhaitez pas devenir l'administrateur du site Web au moment de la création de la connexion, vous ou un 
autre utilisateur pouvez le devenir ultérieurement.

Vous pouvez devenir l'administrateur de tout site Web pour lequel aucun administrateur n'est défini. L'administrateur du 
site Web est responsable de la configuration des autorisations relatives au site Web et sert de point de contact pour les utili-
sateurs ayant besoin d'assistance.

Remarque : Si un utilisateur devient accidentellement l'administrateur d'un site Web ou si vous oubliez le mot de passe 
administrateur, vous pouvez redéfinir ce mot de passe et créer une connexion d'administration. Pour plus d'informations, voir 
la section « Contribute se bloque lors de l'envoi d'une clé de connexion », page 233.

Pour devenir administrateur d'un site Web Contribute :
1 Sélectionnez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh) pour afficher la boîte 
de dialogue Mes connexions, qui répertorie tous les sites Web avec lesquels vous avez établi une connexion, ainsi que 
l'administrateur assigné à chaque site Web, le cas échéant.
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Si aucun administrateur n'est défini pour un site Web, le texte Aucun administrateurs'affiche dans la colonne Adminis-
trateur de la boîte de dialogue.

Si aucun administrateur n'est défini pour un site Web, vous pouvez devenir l'administrateur en suivant les étapes ci-après.

2 Sélectionnez le site Web que vous souhaitez administrer et cliquez sur Administrer.

3 Une boîte de dialogue s'affiche, vous demandant si vous souhaitez devenir l'administrateur du site Web. Cliquez sur Oui 
si tel est le cas.

Après cette sélection, Contribute vous définit comme l'administrateur du site et la boîte de dialogue Administrer le site Web 
s'affiche. Vous pouvez définir un mot de passe d'administration pour le site. 

4 (Facultatif) Sélectionnez la catégorie Administration dans la boîte de dialogue Administrer le site Web.

5 Cliquez sur Définir le mot de passe administrateur.

La boîte de dialogue Mot de passe administrateur s'affiche.

6 Tapez deux fois un mot de passe administrateur pour le site Web et cliquez sur OK.

Une fois que vous avez défini un mot de passe administrateur pour le site, la boîte de dialogue Administrer le site Web 
s'affiche. Vous pouvez ainsi configurer les paramètres et les groupes d'autorisations du site Web.
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Configuration des paramètres d'administration de 
Contribute
Grâce à la boîte de dialogue Administration du site Web, vous pouvez gérer les utilisateurs et configurer différents 
paramètres définissant l'interaction entre Contribute et votre site Web.

Vous pouvez définir des paramètres qui affectent le site Web tout entier, tels que les informations de mot de passe ou de 
contact de l'administrateur, le nombre de versions de restauration de pages à enregistrer et les conventions de nom de fichier 
des pages d'accueil par défaut du site Web. 

Pour ouvrir la boîte de dialogue Administrer le site Web :
1 Choisissez Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web pour lequel vous souhaitez définir des options.

2 Si l'invite correspondante s'affiche, tapez le mot de passe administrateur, puis cliquez sur OK.

L'affectation d'un administrateur à un site et celle d'un mot de passe pour le compte administratif sont facultatives. Pour 
plus d'informations, voir la section « Comment devenir l'administrateur d'un site Web Contribute existant », page 186.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie de paramètres administratifs que vous souhaitez modifier dans la liste située à gauche de la 
boîte de dialogue.

Pour plus d'informations sur l'utilisation des options visibles dans cette boîte de dialogue, voir les sections suivantes :

• « Modification de l'administrateur du site Web », page 189

• « Modification du mot de passe de l'administrateur », page 189

• « Activation et désactivation des restaurations », page 190

• « Définition de nouvelles préférences de page », page 190

• « Ajout de noms de fichiers de page d'index », page 191

• « Suppression de noms de fichiers de page d'index », page 192

• « Définition d'autres adresses de site Web », page 193

• « Spécification d'une page de garde », page 194

• « Activation de la compatibilité avec des versions antérieures de Contribute », page 194

• « Activation ou désactivation de l'incorporation de PDF », page 195
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Modification de l'administrateur du site Web
Vous pouvez changer l'administrateur d'un site Web Contribute en modifiant l'adresse électronique associée à ce site. Les 
utilisateurs écrivent à cette adresse pour contacter l'administrateur du site Web en cas de problème. 

Remarque : Lorsque vous modifiez l'adresse électronique de l'administrateur du site, son mot de passe reste inchangé. Pour le 
modifier, consultez la référence « Modification du mot de passe de l'administrateur », page 189.

Pour changer l'adresse électronique de l'administrateur :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Procédez de l'une des manières suivantes :

• Si la boîte de dialogue Mot de passe administrateur s'affiche, tapez le mot de passe administrateur puis cliquez sur OK.

• Si le site n'a aucun administrateur, cliquez sur Oui lorsqu'une boîte de dialogue s'affiche pour vous inviter à devenir 
l'administrateur de ce site Web. Ensuite, tapez deux fois un mot de passe administrateur pour le site Web et cliquez sur 
OK.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Administration sur le côté gauche de la boîte de dialogue.

4 Tapez une nouvelle adresse électronique dans le champ Adresse électronique de l'administrateur.

5 Sélectionnez une autre catégorie à modifier ou cliquez sur Fermer pour quitter la boîte de dialogue Administration du 
site Web.

Modification du mot de passe de l'administrateur
Vous pouvez modifier le mot de passe utilisé par l'administrateur.

Pour modifier le mot de passe administrateur :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Le cas échéant, tapez le mot de passe administrateur, puis cliquez sur OK.

L'affectation d'un administrateur à un site et celle d'un mot de passe pour le compte administratif sont facultatives. Pour 
plus d'informations, voir la section « Comment devenir l'administrateur d'un site Web Contribute existant », page 186.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Administration sur le côté gauche de la boîte de dialogue.

4 Cliquez sur Changer le mot de passe dans la section Informations sur l'administrateur de la boîte de dialogue.

La boîte de dialogue Modification du mot de passe administrateur s'affiche.

5 Tapez le mot de passe actuel puis le nouveau mot de passe que vous souhaitez utiliser dans les champs prévus à cet effet. 
Vous devez taper le nouveau mot de passe à deux reprises pour le confirmer.

6 Cliquez sur OK.

7 Sélectionnez une autre catégorie à modifier ou cliquez sur Fermer pour quitter la boîte de dialogue Administration du 
site Web.
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Activation et désactivation des restaurations
Les pages de restauration sont des versions de sauvegarde des pages Web publiées avec Contribute. La restauration est 
activée par défaut. Vous pouvez désactiver cette fonction ou modifier le nombre de versions de restauration. Chaque page 
de restauration est une copie de la dernière version publiée de cette page, antérieure à la version actuellement publiée. 

Par exemple, si vous recherchez une page pour l'éditer dans Contribute, en modifier le contenu et publier vos modifications 
sans avoir préalablement mis à jour et publié cette page, il n'existera qu'une seule version de restauration de cette page (dans 
ce cas, la version de restauration correspond à la page originale).

Contribute peut conserver jusqu'à 99 versions de restauration pour chaque page publiée. Lorsque vous spécifiez le nombre 
de pages de restauration, pensez à prendre en compte l'espace disque qui sera occupé lors du stockage de ces pages. Ces 
pages sont enregistrées sur le serveur Web. Par défaut, le nombre de pages de restauration est de trois.

Pour activer et désactiver les pages de restauration :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Le cas échéant, tapez le mot de passe administrateur, puis cliquez sur OK.

L'affectation d'un administrateur à un site et celle d'un mot de passe pour le compte administratif sont facultatives. Pour 
plus d'informations, voir la section « Comment devenir l'administrateur d'un site Web Contribute existant », page 186.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Restaurations sur le côté gauche de la boîte de dialogue.

4 Sélectionnez l'option Activer les restaurations pour rendre les restaurations possibles ou désélectionnez-la pour désac-
tiver l'option.

5 Tapez le nombre de versions de restauration que vous souhaitez conserver dans le champ Conserver les versions précé-
dentes de chaque page ou utilisez les flèches pour sélectionner la quantité souhaitée. Contribute peut conserver jusqu'à 
99 versions de restauration pour chaque page Web.

6 Sélectionnez une autre catégorie à modifier ou cliquez sur Fermer pour quitter la boîte de dialogue Administration du 
site Web.

Définition de nouvelles préférences de page
La catégorie Nouvelles pages vous permet de déterminer le codage du document à appliquer à vos pages Web ainsi que 
l'extension de fichier à utiliser lors de la création de pages à partir d'une page vierge ou de modèles dans un site.

Le codage du document précise le codage utilisé pour les caractères sur une page Web. Sélectionnez Occidental (Latin1) 
pour l'anglais et les langues européennes occidentales. Les principales autres possibilités sont Europe centrale, Cyrillique, 
Grec, Islandais, Japonais, Chinois traditionnel, Chinois simplifié ou Coréen. Si l'option de codage que vous souhaitez 
utiliser n'est pas disponible, choisissez UTF-8 pour créer une page basée sur le codage utilisé par votre système d'exploitation.

Pour définir le codage pour de nouvelles pages :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Le cas échéant, tapez le mot de passe administrateur puis cliquez sur OK.

L'affectation d'un administrateur à un site et celle d'un mot de passe pour le compte administratif sont facultatives. Pour 
plus d'informations, voir la section « Comment devenir l'administrateur d'un site Web Contribute existant », page 186.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Nouvelles pages sur le côté gauche de la boîte de dialogue.

Le panneau Nouvelles pages s'affiche.

4 Sélectionnez le format de codage du document que vous souhaitez utiliser dans le menu déroulant Codage par défaut.

5 Sélectionnez une autre catégorie à modifier ou cliquez sur Fermer pour quitter la boîte de dialogue Administration du 
site Web.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

191

Pour définir l'extension de fichier par défaut pour de nouvelles pages :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Procédez de l'une des manières suivantes :

• Si la boîte de dialogue Mot de passe administrateur s'affiche, tapez le mot de passe administrateur, puis cliquez sur OK.

• Si le site n'a aucun administrateur, cliquez sur Oui lorsqu'une boîte de dialogue s'affiche pour vous inviter à devenir 
l'administrateur de ce site Web. Ensuite, tapez deux fois un mot de passe administrateur pour le site Web et cliquez sur 
OK.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Nouvelles pages sur le côté gauche de la boîte de dialogue.

Le panneau Nouvelles pages s'affiche.

4 Tapez l'extension de fichier par défaut que vous souhaitez utiliser pour les nouvelles pages vierges et les nouvelles pages 
créées à partir de modèles.

L'extension de fichier par défaut est .htm mais vous pouvez définir toute extension de fichier appropriée à votre site Web. 
Par exemple, si votre site Web utilise exclusivement des pages Adobe ColdFusion, vous pouvez créer des pages avec 
l'extension de fichier .cfm.

5 Sélectionnez une autre catégorie à modifier ou cliquez sur Fermer pour quitter la boîte de dialogue Administration du 
site Web et enregistrer vos changements.

Ajout de noms de fichiers de page d'index
Vous pouvez inclure des noms de fichiers d'index correspondant aux fichiers d'index de votre site Web dans les paramètres 
de ce dernier.

Remarque : Pour plus d'informations sur les noms de fichier de page d'index, voir la section « Pages d'index du serveur Web », 
page 176.

Pour ajouter un nom de fichier d'index :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Le cas échéant, tapez le mot de passe administrateur puis cliquez sur OK.

L'affectation d'un administrateur à un site et celle d'un mot de passe pour le compte administratif sont facultatives. Pour 
plus d'informations, voir la section « Comment devenir l'administrateur d'un site Web Contribute existant », page 186.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Serveur Web situé à gauche de la boîte de dialogue et cliquez sur l'onglet Fichiers d'index.
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Le panneau Fichiers d'index s'affiche.

4 Cliquez sur le bouton Ajouter.

La boîte de dialogue Ajout ou modification d'un nom de fichier d'index s'affiche.

5 Saisissez un nom de fichier d'index, puis cliquez sur OK.

Le nouveau nom de fichier d'index s'affiche en bas de la liste des noms de fichiers d'index possibles.

6 A l'aide des flèches, classez les pages d'index selon l'ordre spécifié par la configuration de votre serveur Web. Par exemple, 
si votre serveur Web est configuré pour utiliser trois pages d'index (index.htm, index2.htm et 404error.htm) et que la page 
d'index principale est index.htm, alors les pages doivent être classées comme suit :

• index.htm 

• index2.htm 

• 404error.htm

Il s'agit de l'ordre d'extraction et d'affichage des pages d'index par le serveur Web, si une ou plusieurs des pages ne sont pas 
disponibles.

7 Une fois que vous avez ajouté et classé les noms de fichier dans la liste des fichiers d'index, cliquez sur Fermer pour 
quitter la boîte de dialogue Administration du site Web et enregistrer vos changements ou sélectionnez une autre catégorie 
à modifier.

Suppression de noms de fichiers de page d'index
Vous pouvez supprimer des noms de pages d'index de la liste par défaut fournie avec Contribute. Lors de cette opération, 
assurez-vous que vos sites Contribute ne se basent pas sur les noms des pages que vous supprimez dans la liste Fichiers 
d'index.

Pour supprimer un nom de fichier de page d'index :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Le cas échéant, tapez le mot de passe administrateur puis cliquez sur OK.

L'affectation d'un administrateur à un site et celle d'un mot de passe pour le compte administratif sont facultatives. Pour 
plus d'informations, voir la section « Comment devenir l'administrateur d'un site Web Contribute existant », page 186.

La boîte de dialogue Administrer le site Web s'affiche.
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3 Sélectionnez la catégorie Serveur Web situé à gauche de la boîte de dialogue et cliquez sur l'onglet Fichiers d'index.

Le panneau Fichiers d'index s'affiche.

4 Sélectionnez le nom de fichier que vous souhaitez supprimer de la liste Fichiers d'index.

Remarque : Vous ne pouvez pas sélectionner plusieurs fichiers d'index dans la liste ; vous devez sélectionner chaque fichier 
séparément, puis cliquez sur Supprimer.

5 Cliquez sur Supprimer.

6 Une fois que vous avez supprimé le nom de fichier de la liste des fichiers d'index, cliquez sur Fermer pour quitter la boîte 
de dialogue Administration du site Web et enregistrer vos changements ou sélectionnez une autre catégorie à modifier.

Définition d'autres adresses de site Web
Si les utilisateurs de Contribute visitent un site Web en utilisant un nom d'hôte, un chemin de répertoire ou un numéro de 
port différents, vous devez configurer l'application Contribute pour qu'elle reconnaisse ces autres adresses et les associe à 
la connexion de site Web appropriée.

Remarque : Pour plus d'informations sur les autres adresses Web, voir la section « Autres adresses du site Web », page 176.

Si vous ne configurez pas Contribute de cette manière, les utilisateurs ne pourront peut-être pas modifier ni publier des 
pages Web s'ils se connectent à un site Web non défini dans Contribute.

Il n'est pas nécessaire de configurer l'application Contribute pour qu'elle reconnaisse toutes les autres adresses Web 
possibles mais uniquement celles dont les utilisateurs se serviront pour accéder au site Web.

Pour spécifier une autre adresse pour un site Web :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Le cas échéant, tapez le mot de passe administrateur puis cliquez sur OK.

L'affectation d'un administrateur à un site et celle d'un mot de passe pour le compte administratif sont facultatives. Pour 
plus d'informations, voir la section « Comment devenir l'administrateur d'un site Web Contribute existant », page 186.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez Serveur Web dans la liste des catégories située à gauche dans la boîte de dialogue, puis cliquez sur l'onglet 
Adresses Web.

Le panneau Adresses Web apparaît.
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4 Cliquez sur le bouton Ajouter.

La boîte de dialogue Ajouter ou modifier une autre adresse s'affiche.

5 Tapez une autre adresse URL et cliquez sur OK.

La nouvelle URL apparaît dans la liste Autres adresses.

6 Une fois que vous avez tapé toutes les autres adresses Web, cliquez sur Fermer pour quitter la boîte de dialogue 
Administrer le site Web et enregistrer vos changements ou sélectionnez une autre catégorie à modifier.

Spécification d'une page de garde
Les pages de garde sont des pages Web que Contribute place dans des dossiers contenant des fichiers administratifs et des 
copies temporaires de pages envoyées pour la révision. La page de garde empêche les utilisateurs de rechercher un dossier 
de Contribute contenant des fichiers auxquels vous ne souhaitez pas qu'ils aient accès. 

Pour spécifier une page de garde pour un site Web :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Le cas échéant, tapez le mot de passe administrateur puis cliquez sur OK.

L'affectation d'un administrateur à un site et celle d'un mot de passe pour le compte administratif sont facultatives. Pour 
plus d'informations, voir la section « Comment devenir l'administrateur d'un site Web Contribute existant », page 186.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Serveur Web situé à gauche de la boîte de dialogue et cliquez sur l'onglet Page de garde.

La boîte de dialogue Guard Page (Page de garde) s'affiche.

4 Cliquez sur Rechercher la page de garde.

La page Web que vous avez spécifiée comme page d'index pour le site est définie comme page de garde. Lorsque vous placez 
une copie de la page d'index du site Web dans un dossier, Contribute peut rediriger les utilisateurs vers la page d'accueil de 
ce site Web.

5 Une fois que vous avez spécifié une page de garde, cliquez sur Fermer pour quitter la boîte de dialogue Administrer le 
site Web et enregistrer vos changements ou sélectionnez une autre catégorie à modifier.

Activation de la compatibilité avec des versions antérieures de Contribute
Contribute permet aux administrateurs de choisir entre deux options de compatibilité : l'une autorise les utilisateurs 
disposant de versions antérieures de cette application à travailler sur le site Web, tandis que l'autre les en empêche.

• Mode de transition 

Dans ce mode, les utilisateurs qui disposent de versions antérieures de Contribute peuvent travailler sur le site Web conjoin-
tement avec les utilisateurs qui se servent de la version 4.0 ou ultérieure de Contribute. Ceci vous permet d'évaluer la 
nouvelle version et de définir de nouveaux rôles et autorisations sans gêner les utilisateurs travaillant avec des versions 
antérieures de Contribute. 

• Mode de compatibilité 

Dans ce mode, tous les utilisateurs doivent disposer de la version 4.0 ou ultérieure de Contribute. Ceux qui utilisent des 
versions antérieures ne peuvent pas travailler sur le site Web. 

Par défaut, les versions 4.0 et ultérieures de Contribute démarrent en mode de transition lors de la migration effectuée à 
partir d'une version antérieure de Contribute. Utilisez temporairement ce mode, puis lorsque vous êtes prêt, faites migrer 
tous les utilisateurs vers Contribute 4.0 ou une version ultérieure et activez le mode de compatibilité. 
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Pour activer le mode de compatibilité :
1 Dans Contribute 4.0 (ou versions ultérieures), sélectionnez Edition > Administrer les sites Web, puis sélectionnez un site 
Web.

La boîte de dialogue Administrer le site Web s'affiche.

2 Dans la liste des catégories située à gauche de la boîte de dialogue, sélectionnez Compatibilité.

Les options de compatibilité s'affichent dans la boîte de dialogue Administrer le site Web.

3 Cliquez sur OK, puis sur Fermer.

Une fois le mode de compatibilité activé, tous les utilisateurs connectés au site Web doivent utiliser Contribute 4.0 ou une 
version ultérieure. 

Activation ou désactivation de l'incorporation de PDF
Contribute permet à l'administrateur d'interdire l'incorporation de documents PDF en tant qu'objets dans une page Web. 
Si les utilisateurs sont autorisés à insérer des objets PDF, ils peuvent le faire sous forme de liens ou de PDF incorporés. En 
revanche, s'ils ne sont pas autorisés à effectuer une telle opération, ils peuvent uniquement créer un lien vers les documents 
PDF.

Pour activer ou désactiver l'incorporation de PDF :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu. 

2 Le cas échéant, tapez le mot de passe administrateur puis cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Activation de l'intégration de PDF, sur le côté gauche de la boîte de dialogue.

4 Sélectionnez l'option Autoriser l'intégration de PDF ou Ne pas autoriser l'intégration de PDF.

5 Cliquez sur Fermer.

Envoi de clés de connexion pour des sites Web
L'assistant Exportation de la connexion vous permet de définir facilement des connexions à des sites Web pour d'autres 
utilisateurs en leur envoyant une clé de connexion. Pour plus d'informations sur les clés de connexion, voir la section « Clés 
de connexion », page 177.

Remarque : Pour envoyer à d'autres utilisateurs une clé de connexion à un site Web, vous devez créer une ou plusieurs 
connexions au site Web Contribute que vous souhaitez partager. Pour plus d'informations sur la création d'une connexion à un 
site Web Contribute, voir la section « Création d'une connexion à un site Web », page 179.

Pour toute information sur l'envoi de clés de connexion des sites Web gérés par CPS, voir « Envoi de clés de connexion pour 
des sites gérés par CPS », page 197.
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Pour créer une clé de connexion à un site Web à partager avec des utilisateurs :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 Procédez de l'une des manières suivantes :

Si le site n'a aucun administrateur, cliquez sur Oui lorsqu'une boîte de dialogue s'affiche pour vous inviter à devenir 
l'administrateur de ce site Web. Ensuite, tapez deux fois un mot de passe administrateur pour le site Web et cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Utilisateurs et rôles, sur le côté gauche de la boîte de dialogue.

La boîte de dialogue Utilisateurs et rôles s'ouvre.

4 Vous pouvez envoyer un fichier de clé de connexion à un nouvel utilisateur ou envoyer une clé de connexion à un utili-
sateur qui s'est déjà connecté au site et lui affecter un nouveau rôle.

• Pour envoyer une clé de connexion à un nouvel utilisateur, cliquez sur Envoyer la clé de connexion.

• Pour envoyer une clé de connexion à un utilisateur existant en lui affectant un nouveau rôle, sélectionnez le nom de 
l'utilisateur dans la liste des utilisateurs connectés et cliquez sur Envoyer la clé de connexion.

L'Assistant d'envoi de la clé de connexion s'affiche. 
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5 Suivez les instructions de l'assistant, puis cliquez sur Suivant (Windows) ou Continuer (Macintosh) pour passer à l'écran 
suivant.

6 Une fois que vous avez terminé l'Assistant, un nouveau fichier de clé de connexion est créé pour l'utilisateur, lui affectant 
un nouveau rôle. 

Vous pouvez envoyer le fichier de clé de connexion à l'utilisateur par courriel ou l'enregistrer sur votre ordinateur.

7 Sélectionnez une autre catégorie à modifier ou cliquez sur Fermer pour quitter la boîte de dialogue Administration du 
site Web et enregistrer vos changements.

Envoi de clés de connexion pour des sites gérés par CPS
Si vous utilisez CPS pour gérer votre site Web, vous envoyez une clé de connexion aux utilisateurs pour qu'ils se connectent 
au serveur. Pour plus d'informations sur les clés de connexion, voir la section « Clés de connexion », page 177.

Remarque : Lorsqu'un site Web est géré par CPS, vous devez ajouter les utilisateurs à ce site pour qu'ils puissent s'y connecter 
à l'aide d'une clé de connexion. Si vous ne l'avez pas déjà fait, consultez la section « Ajout d'utilisateurs aux sites Web gérés par 
CPS », page 197.

Si vous n'utilisez pas CPS pour gérer votre site Web, reportez-vous à « Envoi de clés de connexion pour des sites Web », 
page 195 pour toute information sur l'envoi de clés de connexion.

Pour envoyer une clé de connexion CPS :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

Si le site n'a aucun administrateur, cliquez sur Oui lorsqu'une boîte de dialogue s'affiche pour vous inviter à devenir 
l'administrateur de ce site Web. Ensuite, tapez deux fois un mot de passe administrateur pour le site Web et cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche.

2 Cliquez sur Envoyer la clé de connexion.

La boîte de dialogue Envoyer une clé de connexion s'affiche.

3 Vous pouvez envoyer le lien de connexion à l'utilisateur par courriel ou l'enregistrer sur votre ordinateur local.

4 Sélectionnez une autre catégorie à modifier ou cliquez sur Fermer pour quitter la boîte de dialogue Administrer le site 
Web et enregistrer vos changements.

Ajout d'utilisateurs aux sites Web gérés par CPS
Le service Annuaire des utilisateurs vous permet d'ajouter des utilisateurs tirés du service LDAP ou Active Directory de 
votre entreprise. 

Remarque : Pour ajouter des utilisateurs à des sites gérés par CPS, vous devez d'abord activer CPS pour les sites concernés. Pour 
plus d'informations, voir la section « Activation et désactivation de CPS pour un site Web », page 183.

Lorsqu'un site Web est géré par CPS, vous devez ajouter manuellement les utilisateurs à la liste d'utilisateurs de ce site pour 
que ceux-ci puissent s'y connecter, contrairement aux sites non gérés auxquels tout utilisateur disposant d'une clé de 
connexion ou d'informations de connexion peut se connecter.

Après avoir ajouté un utilisateur à un site Web, vous pouvez lui envoyer une clé de connexion ou les informations de 
connexion voulues pour qu'il puisse se connecter au site.
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Pour ajouter des utilisateurs à des sites gérés par CPS :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

Si le site n'a aucun administrateur, cliquez sur Oui lorsqu'une boîte de dialogue s'affiche pour vous inviter à devenir 
l'administrateur de ce site Web. Ensuite, tapez deux fois un mot de passe administrateur pour le site Web et cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche.

2 Sélectionnez la catégorie Utilisateurs et rôles dans la liste située à gauche.

Le panneau Utilisateurs et rôles de la boîte de dialogue Administrer le site Web s'affiche.

3 Cliquez sur Ajouter des utilisateurs.

La boîte de dialogue Ajouter des utilisateurs s'affiche.

4 Sélectionnez un rôle pour les utilisateurs à ajouter dans le menu contextuel Rôle des nouveaux utilisateurs.

Le rôle que vous affectez détermine les autorisations de modification dont disposent les nouveaux utilisateurs sur les pages 
du site.

5 Vous pouvez utiliser Rechercher pour trouver des utilisateurs, puis les ajouter au rôle que vous avez sélectionné. 

6 (Facultatif) Pour envoyer un courriel aux utilisateurs que vous avez ajoutés au rôle, activez l'option Envoyer un courriel 
de clé de connexion aux utilisateurs. 

Vous pouvez également demander aux utilisateurs de taper connect:nom du domaine du serveur (c'est-à-dire le nom du 
serveur où est installé CPS) dans la barre d'adresse du navigateur Contribute pour se connecter au site Web.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide. 

7 Cliquez sur OK.

Contribute ajoute au site Web les utilisateurs définis et leur envoie un courriel contenant la clé de connexion.
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Suppression d'utilisateurs de sites Web gérés par CPS
CPS vous permet d'ajouter des utilisateurs à partir du service LDAP ou Active Directory de votre entreprise (voir « Ajout 
d'utilisateurs aux sites Web gérés par CPS », page 197). Par la suite, libre à vous de supprimer les utilisateurs que vous avez 
ajoutés si vous ne voulez pas qu'ils se connectent au site Web.

Pour supprimer des utilisateurs de rôles de sites gérés :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

Si le site n'a aucun administrateur, cliquez sur Oui lorsqu'une boîte de dialogue s'affiche pour vous inviter à devenir 
l'administrateur de ce site Web. Ensuite, tapez deux fois un mot de passe administrateur pour le site Web et cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche.

2 Sélectionnez la catégorie Utilisateurs et rôles.

Le panneau Utilisateurs et rôles de la boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez le nom de l'utilisateur que vous souhaitez supprimer et cliquez sur Supprimer.

4 Lorsque vous avez terminé de supprimer des utilisateurs, cliquez sur Fermer.

Configuration de fichiers dépendants pour les blogs
Lorsque vous créez une connexion de serveur de blog Contribute, vous pouvez spécifier les types de fichiers audio, vidéo 
et image que vous pouvez publier dans les entrées des blogs qui sont hébergés par le service de blogs.

Pour configurer les fichiers dépendants disponibles pour un blog :
1 Sélectionnez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh) pour afficher la boîte 
de dialogue Mes connexions qui répertorie tous vos blogs connectés.

2 Sélectionnez l'hôte de blog souhaité et cliquez sur Configure.

La boîte de dialogue Options de publication du serveur de blog s'ouvre.

Remarque : Le bouton Configure est disponible uniquement pour les hôtes de blog ; il ne l'est pas pour un blog hébergé.

3 Sélectionnez les options de publication voulues pour l'hôte de blog :

• Autoriser les images (GIF, JPG, PNG, etc.)

• Autoriser audio (MP3, WMA, WAV, etc.)

• Autoriser la vidéo (MPG, MPEG, WMV, etc.)

4 Cliquez sur OK.

Vous pouvez à présent publier des entrées de blog contenant les types de fichiers choisis.
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Gestion des connexions à un site Web ou un serveur de 
blog
Vous pouvez utiliser la boîte de dialogue Mes connexions pour gérer les connexions de vos sites Web et de vos serveurs de 
blogs. Les options de gestion disponibles dans cette boîte de dialogue varient selon les types de connexion (sites Web gérés 
ou non par CPS et blogs).

Vous pouvez également utiliser la boîte de dialogue Mes connexions pour définir les types de fichiers audio, vidéo et image 
que vous pouvez publier dans des entrées de blog.

Pour des sites Web gérés par CPS, vous pouvez soit désactiver les connexions de sites individuels, soit supprimer la 
connexion CPS. Vous ne pouvez pas renommer ni supprimer une connexion à un site individuel si celui-ci est géré par CPS.

S'agissant des blogs, vous pouvez désactiver le serveur de blog uniquement. Cette opération entraîne la désactivation de 
tous les blogs hébergés sur ce serveur. Vous ne pouvez pas désactiver des blogs spécifiques hébergés sur le serveur. De 
même, vous pouvez renommer uniquement le serveur de blog répertorié dans la boîte de dialogue Mes connexions, non 
des blogs spécifiques hébergés sur ce serveur.

Pour gérer des connexions à un site Web et un serveur de blog :
1 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

2 Sélectionnez un site Web ou un serveur de blog dans la liste des connexions.

3 Gérez les connexions en procédant de l'une des manières suivantes :

• « Modification d'une connexion à un site Web ou un serveur de blog », page 201

Si vous avez utilisé l'Assistant de connexion pour créer une connexion, vous pouvez mettre à jour les informations de 
connexion lorsque les configurations serveur ou réseau sont corrompues (par exemple, lors de la modification de chemins 
d'accès réseau ou de l'URL d'un site Web).

Remarque : Si vous importez une clé de connexion, les seules informations que vous pouvez changer sont votre nom et votre 
adresse électronique.

• « Changement de nom d'une connexion à un site Web ou un serveur de blog », page 202

Vous pouvez renommer une connexion à un site Web ou à un serveur de blog dans Contribute.

Vous pouvez renommer uniquement le serveur de blog répertorié dans la boîte de dialogue Mes connexions, non des blogs 
individuels hébergés sur un serveur de blog.
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• « Suppression de connexions à un site Web ou un serveur de blog », page 202

Vous pouvez supprimer une connexion à un site Web ou à un serveur de blog dans Contribute dès lors qu'elle est obsolète. 
Lorsque vous supprimez un serveur de blog répertorié dans la boîte de dialogue Mes connexions, tous les blogs individuels 
hébergés sur ce serveur le sont également. Il est impossible de supprimer des blogs spécifiques.

• « Désactivation de connexions à des sites Web et à des blogs », page 203

Vous pouvez désactiver les connexions à un site Web ou à un serveur de blog afin de réduire le nombre de connexions 
actives et ainsi améliorer les performances de Contribute.

• « Activation de la connexion à un site Web ou à un serveur de blog », page 204

Vous pouvez activer une connexion à un site Web ou un serveur de blog que vous avez précédemment désactivée.

• « Connexion aux sites Web et aux serveurs de blog au démarrage », page 204

Vous pouvez configurer l'application Contribute pour qu'elle démarre sans se connecter aux sites Web ou aux blogs, ce qui 
améliore ses performances au démarrage.

4 Cliquez sur Fermer lorsque vous avez terminé.

Modification d'une connexion à un site Web ou un serveur de blog
Vous pouvez modifier les informations de connexion de tout site Web ou blog Contribute. Vous pouvez ainsi modifier une 
connexion si l'un des paramètres a changé (par exemple, si vous déplacez un site Web vers un nouvel emplacement réseau 
ou si vous modifiez l'URL d'un blog).

Remarque : Si vous importez une clé de connexion pour un site Web, les seules informations de connexion que vous pouvez 
changer sont votre nom et votre adresse électronique.

Si vos brouillons sont ouverts, vous ne pouvez pas changer votre nom ou votre adresse électronique pour le site Web lié à 
ces brouillons, ni changer changer votre nom d'utilisateur ou votre mot de passe pour le blog lié à ces brouillons. Vous 

devez fermer les brouillons pour pouvoir modifier ces informations.

Pour modifier une connexion à un site Web ou un serveur de blog :
1 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

2 Sélectionnez un site Web ou un serveur de blog dans la liste des connexions.

3 Cliquez sur le bouton Modifier.

L'Assistant de connexion s'affiche.

4 Parcourez l'assistant de connexion en utilisant le bouton Suivant ou Continuer et modifiez les paramètres de connexion 
aux sites Web ou serveurs de blog souhaités. 

Pour plus d'informations sur les paramètres de site Web et de serveur de blog dans l'assistant de connexion, voir les sections 
« Création d'une connexion à un site Web », page 179 et « Création d'une connexion à un serveur de blog », page 180.

5 Une fois que vous avez modifié les paramètres de connexion pour un site Web et vérifié qu'ils sont corrects, vous devez 
envoyer un fichier de connexion aux utilisateurs. Ce fichier comporte les informations relatives aux nouveaux paramètres 
de connexion.

Pour modifier une connexion à un site Web géré par CPS :
1 Fermez tous les brouillons ouverts associés au site Web à supprimer.

Contribute ne supprime pas une connexion à un site Web sur lequel des modifications sont en cours.

2 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

3 Sélectionnez un site Web dans la liste de connexions.
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4 Cliquez sur le bouton Modifier.

L'Assistant de modification de connexion s'affiche.

5 Faites les modifications souhaitées, puis cliquez sur Terminer.

6 Cliquez sur Fermer pour fermer la boîte de dialogue Mes connexions.

Changement de nom d'une connexion à un site Web ou un serveur de blog
Vous pouvez changer le nom d'une connexion de site Web ou de serveur de blog affiché dans Contribute. Le nouveau nom 
s'affiche dans le menu Pages d'accueil, la boîte de dialogue Mes Connexions et s'il s'agit d'un site Web, le sous-menu 
Administrer les sites Web. La modification du nom de la connexion au site Web ou au serveur de blog n'a aucune incidence 
sur le nom actuel du site Web ou du serveur de blog ; elle permet uniquement de modifier la référence au site Web ou au 
serveur de blog utilisée dans Contribute.

Remarque : Vous ne pouvez pas renommer une connexion à un site Web lorsque celui-ci est géré par CPS. Les noms de site Web 
sont issus du titre de la page d'accueil du site. Pour vous assurer que les sites sont facilement identifiables, attribuez un nom 
significatif à la page d'accueil. S'agissant des connexions à un serveur de blog, vous pouvez modifier leur nom, mais pas celui 
de blogs spécifiques hébergés sur ce serveur.

Pour modifier le nom d'un site Web ou d'un serveur de blog tel qu'il apparaît dans Contribute :
1 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

2 Sélectionnez la connexion au site Web ou serveur de blog voulue dans la liste des connexions.

3 Cliquez sur le bouton Renommer.

Le nom de la connexion au site Web ou au serveur de blog est mis en surbrillance dans un champ modifiable.

4 Cliquez dans ce champ et tapez un nouveau nom pour la connexion au site Web ou au serveur de blog.

5 Appuyez sur la touche Entrée ou Retour pour appliquer vos changements.

6 Cliquez sur Fermer pour enregistrer vos changements et fermer la boîte de dialogue Mes connexions.

Suppression de connexions à un site Web ou un serveur de blog
Vous pouvez supprimer les connexions aux sites Web et aux serveurs de blogs Contribute lorsqu'elles ne sont plus néces-
saires. La suppression d'une connexion Contribute ne supprime pas le site Web ni le serveur de blog ; seules les informations 
de connexion au site Web ou au serveur de blog le sont.

Le processus de suppression d'un site Web diffère légèrement, suivant que le site Web utilise CPS ou non.

Pour plus d'informations sur la suppression des brouillons non publiés d'un site Web ou d'un blog désactivé, voir la section 
« Suppression de brouillons non publiés d'un site Web ou blog désactivé », page 204.

Pour supprimer la connexion d'un site Web ou d'un serveur de blog :
1 Fermez tous les blogs ouverts liés au site Web ou aux entrées de blog hébergées par le serveur de blog que vous souhaitez 
supprimer.

Contribute ne supprime pas une connexion à un site Web ou à un blog sur lequel des modifications sont en cours.

2 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

3 Sélectionnez un site Web ou un serveur de blog dans la liste des connexions.

4 Cliquez sur Supprimer.

Contribute supprime la connexion au site Web ou au serveur de blog de la boîte de dialogue Mes connexions. Tous les blogs 
hébergés sur le serveur de blog supprimé le sont également.
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Pour supprimer une connexion à un site Web géré par CPS :
1 Fermez tous les brouillons ouverts pour le site Web à supprimer.

Contribute ne supprime pas une connexion à un site Web sur lequel des modifications sont en cours.

2 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

3 Sélectionnez un site Web dans la liste de connexions.

4 Cliquez sur Administrer.

La boîte de dialogue Administrer le site Web s'affiche.

5 Dans la liste des catégories située à gauche de la boîte de dialogue, sélectionnez Administration.

6 Cliquez sur le bouton Supprimer l'administration.

Une boîte de dialogue de confirmation s'ouvre.

Remarque : Contribute supprime la connexion au site Web de la liste des sites Web dans la console CPS. Le site Web ne figurera 
pas dans votre liste lors de votre prochaine connexion à la Console. Si le site Web est toujours affiché dans la liste, cliquez sur le 
bouton Supprimer dans la console pour le supprimer.

7 Cliquez sur Oui pour continuer.

Contribute supprime les informations de connexion et les fichiers de paramètres d'administration (y compris les rôles utili-
sateur et les autorisations) associés à ce site Web. Les utilisateurs qui étaient connectés à ce site Web ne peuvent pas s'y 
connecter.

Si des utiisateurs ont néanmoins besoin de s'y connecter, vous pouvez créer une connexion, recréer les rôles et rétablir les 
autorisations. Cela fait, vous devez envoyer les clés de connexion contenant les nouvelles informations de connexion à ces 

utilisateurs. 

8 Cliquez deux fois sur Fermer.

Vous pouvez supprimer ce site Web non administré de Contribute. Pour plus d'informations, voir « Pour supprimer la 
connexion d'un site Web ou d'un serveur de blog : », page 202.

Désactivation de connexions à des sites Web et à des blogs
Au démarrage, Contribute vérifie toutes les connexions définies dans la boîte de dialogue Mes connexions et ouvre une 
connexion pour chaque site Web et blog définis. Il arrive qu'un site Web ou un blog ne soit pas disponible. C'est le cas par 
exemple lorsque la connexion réseau est faible ou irrégulière, le délai défini pour le réseau a expiré ou le nombre de 
connexions au serveur dépasse la limite maximale définie. Si un ou plusieurs sites Web ou blogs ne sont pas disponibles 
pour une raison quelconque, Contribute ne peut pas ouvrir les connexions à ces sites ou à ces blogs.

Remarque : Si Contribute ne parvient pas à se connecter à un site Web ou à un blog, il est possible que cette connexion soit 
désactivée automatiquement. Un message d'alerte indiquant que l'application Contribute n'est pas connectée au site Web ou 
au blog s'affiche dans le navigateur de Contribute.

Pour améliorer les performances de Contribute, vous pouvez désactiver les connexions aux sites Web et aux serveurs de 
blog que vous n'avez pas besoin de mettre à jour très souvent. En effet, un nombre important de sites Web et serveurs de 
blog requiert de nombreuses connexions sur une longue période, ce qui entraîne une dégradation des performances. 
Lorsque vous souhaitez modifier un site Web ou un blog pour lequel la connexion est désactivée, il vous suffit de réactiver 
cette dernière.

La désactivation d'une connexion à des sites Web gérés par CPS se fait de la même façon que pour des sites qui ne le sont 
pas. De surcroît, la désactivation d'une connexion à un serveur de blog se fait de la même façon que la désactivation de sites 
Web gérés par CPS.

Si vous ne souhaitez pas que votre site Web soit géré par le serveur de publication (CPS), vous pouvez désactiver celui-ci 
dans la boîte de dialogue Administrer les sites Web. Pour plus d'informations, voir « Désactivation de CPS pour un site 

Web », page 185.
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Pour désactiver des connexions spécifiques à un site Web ou un serveur de blog Contribute :
1 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

2 Sélectionnez la connexion au site Web ou serveur de blog voulue dans la liste des connexions. Les connexions désactivées 
sont signalées par une barre oblique rouge.

3 Cliquez sur le bouton Désactiver.

4 Une boîte de dialogue s'affiche vous informant que la connexion a été désactivée. Cliquez sur OK pour vérifier qu'il s'agit 
de la connexion que vous souhaitez désactiver. Si vous avez accidentellement désactivé la mauvaise connexion, vous pouvez 
la réactiver. Pour plus d'informations, voir la section « Activation de la connexion à un site Web ou à un serveur de blog », 
page 204.

5 Cliquez sur Fermer pour enregistrer vos changements et fermer la boîte de dialogue Mes connexions.

Suppression de brouillons non publiés d'un site Web ou blog désactivé
Lorsque vous utilisez une boîte de dialogue Mes connexions pour supprimer une connexion à un site Web ou à un blog qui 
contient des brouillons non publiés, Contribute vous avertit que vous devez annuler ou publier les brouillons non publiés 
avant de pouvoir supprimer la connexion.

Activation de la connexion à un site Web ou à un serveur de blog
Si vous désactivez une connexion à un site Web ou à un serveur de blog, ou si l'application Contribute désactive automati-
quement une connexion parce qu'elle ne peut pas se connecter au site Web ou au serveur de blog, vous pouvez réactiver 
cette connexion ultérieurement.

Pour activer la connexion actuelle au site Web ou au serveur de blog :
❖ Cliquez sur Connecter dans la barre d'outils.

Pour activer une connexion quelconque à un site Web ou un serveur de blog :
1 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

2 Sélectionnez la connexion au site Web ou serveur de blog voulue dans la liste des connexions. Les connexions désactivées 
sont signalées par une barre oblique rouge.

3 Cliquez sur le bouton Activer.

4 Cliquez sur Fermer pour enregistrer vos changements et fermer la boîte de dialogue Mes connexions.

Connexion aux sites Web et aux serveurs de blog au démarrage
Au démarrage, Contribute ne se connectera à aucun site Web ou serveur de blog. Cependant, vous pouvez sélectionner le 
site Web ou le serveur de blog qui vous intéresse et configurer Contribute pour qu'il s'y connecte à ce moment-là. Vous 
pouvez également configurer Contribute pour qu'il se connecte à tous les sites Web ou serveurs de blog au démarrage.

Pour définir les paramètres de connexion pour des sites et des blogs spécifiques :
1 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

2 Sélectionnez un site Web ou un serveur de blog

Remarque : Par défaut, Contribute est configuré pour qu'il ne se connecte à aucun site Web ou serveur de blog. Pour modifier 
ce comportement, consultez « Pour définir des paramètres de connexion pour tous les sites et blogs : », page 205.

3 Désactivez la case à cocher de l'option Ne pas se connecter au nom de siteWeb/serveur de blog au démarrage pour confi-
gurer Contribute afin qu'il se connecte au site Web ou au serveur de blog sélectionné au démarrage. 

Remarque : Vous ne pouvez pas définir cette option pour une entrée de blog particulière. 
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Au prochain démarrage de Contribute, une connexion sera établie uniquement au site Web ou au serveur de blog sélec-
tionné. Dans le cas de connexions de blogs, toutes les entrées de blog du serveur de blog sélectionné seront activées. 

Pour plus d'informations sur l'accès aux sites Web gérés par CPS, voir la section Présentation de l'accès au serveur pour la 
connexion à des sites Web gérés par CPS dans Deploying Contribute and Contribute Publishing Server (Déploiement de 
Contribute et Contribute Publishing Server). 

Vous pouvez configurer Contribute pour qu'il se connecte à tous les sites Web ou serveurs de blog au démarrage.

Pour définir des paramètres de connexion pour tous les sites et blogs :
1 Choisissez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh).

La boîte de dialogue Mes connexions s'affiche.

2 Sélectionnez chaque connexion de site Web et de blog et exécutez les opérations suivantes :

• Activez la connexion.

• Désactivez la case à cocher de l'option Ne pas se connecter au nom de site Web ou de serveur de blog au démarrage.

3 Désactivez la case à cocher Ne pas se connecter à un site au démarrage (ceci améliore la vitesse de démarrage).

4 Cliquez sur Fermer.

Lorsque vous redémarrez Contribute, toutes les connexions activées avant la fermeture de Contribute demeurent activées. 

Cette option apparaît la première fois que vous vous connectez à ce serveur ou lorsque les informations sur le serveur sont 
modifiées (à l'expiration du certificat de sécurité, par exemple). Pour vérifier que vous pouvez approuver ce serveur avant 
d'activer la case à cocher, procédez comme suit :

• Cliquez sur le lien Certificat et notez l'Empreinte digitale de la clé publique.

• Demandez à votre administrateur CPS de vérifier la validité de l'empreinte digitale de la clé publique.

Si vous n'activez pas la case Approuver ce serveur, vous ne pouvez pas vous connecter au site Web.

http://help.adobe.com/en_US/Contribute/4.1_CPS/ContributeCS3Help-Deploying.pdf
http://help.adobe.com/en_US/Contribute/4.1_CPS/ContributeCS3Help-Deploying.pdf
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Chapitre 13 : Gestion des utilisateurs et 
des rôles 

Adobe® Contribute® CS3 vous permet de contrôler les informations qu'un utilisateur peut modifier sur un site Web. Pour 
cela, vous créez des rôles pour chaque site Web et définissez des autorisations pour chaque rôle. Une fois les autorisations 
d'un site définies, Contribute crée un dossier appelé _mm à la racine du site Web, ainsi qu'un fichier de paramètres partagés 
qu'il place dans ce dossier. Ce fichier de paramètres partagés contient tous les paramètres et autorisations de vos connexions 
de site Web Contribute. Tous les utilisateurs de Contribute qui se connectent au site Web héritent automatiquement des 
paramètres définis pour leur rôle.

• « Description des rôles », page 207

• « Création de rôles dans Contribute », page 208 

• « Modification des paramètres d'un rôle », page 210

• « Gestion des brouillons envoyés pour la révision », page 223

Description des rôles
Contribute vous permet de définir un ensemble d'autorisations utilisateur allant de l'accès aux fichiers au niveau de contrôle 
typographique, en tant que rôle. Vous affectez les rôles que vous créez aux utilisateurs de Contribute, ce qui détermine dans 
quelle mesure un utilisateur spécifique peut modifier le contenu d'un site.

Contribute a trois rôles par défaut que vous pouvez affecter « tels quels » à des utilisateurs ou modifier en fonction du type 
de modifications à apporter au contenu de votre site Web. Les rôles de Contribute par défaut sont :

Administrateur Les utilisateurs dans ce rôle sont des administrateurs de ce site Web.

Éditeur Les utilisateurs dans ce rôle peuvent créer, modifier et publier des pages sur le site Web.

Auteur Les utilisateurs dans ce rôle peuvent créer et modifier des pages sur le site Web, mais ils ne sont pas autorisés à les 
publier. Pour publier de nouvelles pages ou des modifications de page sur un site, les utilisateurs dans ce rôle doivent 
envoyer leurs mises à jour à un utilisateur dans le rôle d'éditeur pour la révision. L'éditeur peut ensuite publier la page sur 
le site ou la renvoyer à l'auteur pour qu'il effectue d'autres modifications.

Dans la plupart des cas, vous pouvez utiliser les paramètres par défaut spécifiés pour ces rôles. Cependant, si votre site Web 
présente certaines caractéristiques qui doivent être conservées, vous pouvez configurer l'application Contribute pour qu'elle 
fonctionne conformément à vos exigences.

Si les éléments de conception de pages Web, tels que les polices et les paragraphes, les styles CSS (feuilles de style en 
cascade), les formats de fichier image et les limitations de taille, ne vous sont pas familiers, consultez un concepteur de pages 
Web ou un autre professionnel du Web qui connaît le site Web de votre société. 

A propos des paramètres de rôle
Contribute vous permet de définir les catégories d'autorisations et de paramètres ci-après pour les sites Web dans la boîte 
de dialogue Rôle :

Général permet de sélectionner une première page (page d'accueil) que les utilisateurs du rôle sélectionné voient s'afficher 
lorsqu'ils se connectent au site Web. Pour plus d'informations, voir la section « Définition des paramètres de rôle 
généraux », page 212.

Accès au dossier/fichier permet de limiter l'accès d'un rôle à un ou plusieurs dossiers sélectionnés, ainsi qu'à tous les sous-
dossiers qu'ils contiennent. Pour plus d'informations, voir la section « Définition des paramètres d'accès aux dossiers et 
fichiers », page 213.
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Modification permet de spécifier le contenu que les utilisateurs peuvent modifier et de déterminer comment Contribute 
traite les paragraphes, l'espacement entre les lignes et les options d'accessibilité. Pour plus d'informations, voir la section 
« Définition des paramètres de modification de pages et de paragraphes », page 215. Vous avez également la possibilité de 
définir si les utilisateurs sont autorisés à insérer des fragments de code HTML dans des pages Contribute. Pour plus d'infor-
mations, voir la section « Définition de l'option d'insertion de fragments de code HTML », page 216.

Styles et polices permet de spécifier les familles de polices auxquelles les utilisateurs ont accès, ainsi que les styles et les 
formats qu'ils peuvent appliquer au texte. Pour plus d'informations, voir la section « Définition des paramètres pour les 
styles et les polices », page 217.

Nouvelles pages permet de spécifier si les utilisateurs de Contribute peuvent créer des pages vierges et, le cas échéant, les 
modèles Dreamweaver MX d'Adobe qu'ils peuvent utiliser pour créer des pages. Cette option permet également de spécifier 
les pages que l'utilisateur peut copier, le cas échéant. Les options de cette catégorie déterminent les options visibles dans la 
boîte de dialogue Nouvelle page. Pour plus d'informations, voir la section « Définition des paramètres pour les nouvelles 
pages Web », page 219.

Nouvelles images permet de spécifier une taille de fichier, une largeur et une hauteur maximales pour les images. Vous 
pouvez également limiter les autorisations des utilisateurs afin qu'ils se servent uniquement des images issues d'une biblio-
thèque d'actifs partagés que vous créez, ou vous pouvez les autoriser à ajouter des images à une page Web. Pour plus d'infor-
mations, voir la section « Définition des paramètres pour les nouvelles images », page 220.

Placement de fichier permet de spécifier des emplacements de dossiers pour des fichiers en fonction de l'extension utilisée 
pour identifier leur type. Vous pouvez également spécifier que Contribute ne doit pas autoriser le transfert de fichiers d'une 
certaine taille sur le serveur Web. Pour plus d'informations, voir la section « Définition des paramètres de placement des 
fichiers », page 221.

Actifs partagés permet de créer une bibliothèque d'actifs (tels que des images, un contenu Flash ou des éléments de biblio-
thèque Dreamweaver) que les utilisateurs peuvent ajouter à des pages Web. Vous pouvez limiter l'accès aux actifs partagés 
à des utilisateurs spécifiques ou permettre à tous les utilisateurs de Contribute accédant au site Web d'ajouter les actifs à 
leurs pages. Pour plus d'informations, voir la section « Définition des paramètres pour les actifs partagés », page 222.

Création de rôles dans Contribute
Lorsque les utilisateurs de Contribute se connectent à un site Web, ils sont invités à indiquer le rôle auquel ils appartiennent. 
Par exemple, un utilisateur de Contribute peut choisir ou être affecté au rôle Auteur. Une fois connecté au site Web, l'utili-
sateur dispose des autorisations que vous avez configurées pour le rôle Auteur.

Pour créer un rôle :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

Si le site n'a aucun administrateur, cliquez sur Oui lorsqu'une boîte de dialogue s'affiche pour vous inviter à devenir 
l'administrateur de ce site Web. Ensuite, tapez deux fois un mot de passe administrateur pour le site Web et cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche. 

2 Sélectionnez Utilisateurs et rôles.
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Par défaut, Contribute crée trois rôles : Administrateur, Éditeur et Auteur.

3 Cliquez sur Créer un rôle. 

La boîte de dialogue Créer un nouveau rôle s'affiche.

4 Sélectionnez un rôle dans la zone de liste Créer un nouveau rôle à partir de la copie de.

La sélection d'un rôle existant comme base pour un nouveau rôle vous permet de réutiliser les paramètres du rôle sélec-
tionné. Vous pouvez modifier les paramètres du nouveau rôle en fonction de vos besoins.

5 Tapez un nom pour le rôle à créer, puis cliquez sur OK. 

Le nouveau rôle s'affiche dans la liste des noms de rôle du panneau Utilisateurs et rôles de la boîte de dialogue Administrer 
le site Web.

6 Sélectionnez le nom du rôle, puis cliquez sur Modifier les paramètres de rôle.

La boîte de dialogue Modifier les paramètres de rôle s'affiche. Elle vous permet de modifier les paramètres utilisateur 
associés à chaque rôle. 

7 Modifiez les paramètres pour le rôle. 

Lorsque vous avez terminé de définir le rôle, cliquez sur OK pour enregistrer vos changements. La boîte de dialogue se 
ferme et vous revenez à la boîte de dialogue Administrer le site Web. 

8 Pour créer des rôles supplémentaires, répétez les étapes 4 à 7 pour chaque rôle que vous souhaitez ajouter.
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9 Sélectionnez une autre catégorie administrative à modifier ou cliquez sur Fermer pour appliquer vos changements et 
quitter la boîte de dialogue Administrer le site Web.

Remarque : Vous pouvez modifier les paramètres d'un rôle à tout moment, même après avoir distribué une clé de connexion. 
Les informations de connexion et les autorisations pour les sites Web sont conservées séparément.

• Pour modifier les rôles que vous avez créés, sélectionnez le rôle dont vous souhaitez modifier les paramètres et cliquez 
sur Modifier les paramètres de rôle. La boîte de dialogue correspondante s'affiche. Pour en savoir davantage sur les 
paramètres que vous pouvez modifier, reportez-vous à la section « Modification des paramètres d'un rôle », page 210.

• Pour envoyer la connexion aux utilisateurs appartenant au rôle, cliquez sur Envoyer la clé de connexion. L'Assistant 
d'exportation du fichier de connexion s'affiche. Pour apprendre à exporter une clé de connexion, voir la section « Envoi 
de clés de connexion pour des sites Web », page 195.

Pour modifier le rôle, passez à l'étape 4 de la procédure suivante. Autrement, cliquez sur Fermer pour fermer la boîte de 
dialogue Définir les rôles puis cliquez sur Fermer pour fermer la boîte de dialogue Administrer le site Web.

Modification des paramètres d'un rôle
La boîte de dialogue Modifier les paramètres de rôle permet de définir diverses pages d'accueil pour les utilisateurs en 
fonction du rôle auquel ils appartiennent, de limiter le travail des rôles à des dossiers spécifiques et de déterminer les 
modifications qu'un rôle peut apporter à un site Web.

Remarque : Pour plus d'informations sur les rôles, voir la section « Création de rôles dans Contribute », page 208.

Pour modifier les paramètres pour un rôle Contribute :
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

Si la boîte de dialogue Mot de passe administrateur s'affiche, tapez le mot de passe administrateur puis cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche.

2 Sélectionnez Utilisateurs et rôles.

La catégorie Utilisateurs et rôles de la boîte de dialogue Administrer le site Web permet d'afficher les rôles existants, 
d'ajouter des utilisateurs à des rôles, de modifier et de supprimer des rôles et d'envoyer des fichiers de la clé de connexion 
à des utilisateurs afin de leur affecter un rôle.
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3 Sélectionnez le rôle dont vous souhaitez modifier les paramètres puis cliquez sur Modifier les paramètres de rôle.

La boîte de dialogue Modifier les paramètres Nom du rôle apparaît. Elle vous permet de modifier les paramètres utilisateurs 
associés à chaque rôle. 

4 Sélectionnez une catégorie de paramètres à modifier.

Pour plus d'informations sur les paramètres de rôle que vous pouvez modifier dans une catégorie particulière, voir les 
sections suivantes :

• « Définition des paramètres de rôle généraux », page 212

• « Définition des paramètres d'accès aux dossiers et fichiers », page 213

• « Définition des paramètres de modification de pages et de paragraphes », page 215

• « Définition de l'option d'insertion de fragments de code HTML », page 216

• « Définition des paramètres pour les styles et les polices », page 217

• « Définition des paramètres pour les nouvelles pages Web », page 219

• « Définition des paramètres de placement des fichiers », page 221

• « Définition des paramètres pour les actifs partagés », page 222

• « Définition des paramètres pour les nouvelles images », page 220

5 Modifiez les paramètres du rôle.

Lorsque vous avez terminé de définir le rôle, cliquez sur OK pour enregistrer vos changements. La boîte de dialogue se 
ferme et vous revenez à la boîte de dialogue Administrer le site Web.

6 Sélectionnez une autre catégorie administrative à modifier ou cliquez sur Fermer pour appliquer vos changements et 
quitter la boîte de dialogue Administration du site Web.
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Définition des paramètres de rôle généraux 
La catégorie Général permet de spécifier la première page (page d'accueil) que les utilisateurs du rôle sélectionné voient 
s'afficher lorsqu'ils se connectent au site Web. Par exemple, si des utilisateurs dans un certain rôle sont affectés à une section 
du site qui exclut la page d'accueil (principale) du site, spécifiez une page à un autre endroit du site comme page d'accueil 
pour ce rôle.

Pour définir des paramètres de site Web généraux pour un rôle :
1 Ouvrez la boîte de dialogue Edition Nom du rôle Paramètres, si elle ne l'est pas déjà. (Voir la section « Modification des 
paramètres d'un rôle », page 210).

2 Cliquez sur la catégorie Général sur le côté gauche de la boîte de dialogue.

3 (Facultatif) Sélectionnez Autoriser les utilisateurs à publier des fichiers.

Si vous sélectionnez cette option, les utilisateurs affectés à ce rôle peuvent publier les pages qu'ils créent. Ils peuvent 
également publier ou supprimer les brouillons qu'ils reçoivent pour la révision. 

La définition d'autorisations de publication et de suppression pour des révisions de brouillon permet aux utilisateurs de 
supprimer et de publier des brouillons que d'autres utilisateurs de Contribute leur envoient. Avant d'autoriser un utilisateur 
à publier et à supprimer des brouillons, vérifiez si son rôle doit disposer de ce niveau de contrôle dans la publication de 
documents. Vous devrez peut-être créer un rôle spécifique avec cette autorisation.

Les utilisateurs ne disposant pas d'autorisations de publication et de suppression peuvent uniquement envoyer des 
brouillons pour la révision ou les modifier dans le cadre du processus de révision. Pour plus d'informations sur le processus 
de révision des brouillons, voir la section « Révision de brouillons de pages Web et de fichiers par des tiers », page 42.

4 Dans le champ Description du rôle, tapez une brève description du rôle et de ses responsabilités.

Cette description s'affiche lorsqu'un utilisateur sélectionne un rôle à rejoindre.

5 Lors de la création du site Web, vous avez spécifié sa page d'accueil. Si vous souhaitez que les utilisateurs du rôle sélec-
tionné disposent d'une page d'accueil plus spécifique dans le site Web, tapez l'adresse URL dans le champ Page d'accueil des 
utilisateurs de ce rôle ou cliquez sur le bouton Parcourir pour rechercher la page d'accueil.

Vous pouvez choisir de spécifier une page quelconque du site Web comme page d'accueil pour le rôle en question. 

6 Sélectionnez une autre catégorie de paramètres de rôle à modifier ou cliquez sur OK pour appliquer vos modifications.
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Définition des paramètres d'accès aux dossiers et fichiers
La catégorie de paramètres Accès au dossier/fichier permet de limiter l'accès d'un rôle aux dossiers (ou répertoires) sélec-
tionnés et à tous les sous-dossiers qu'ils contiennent, et de déterminer si les utilisateurs peuvent supprimer des pages Web 
et leurs fichiers associés.

Définition des paramètres d'accès aux dossiers
Vous pouvez choisir de limiter l'accès des utilisateurs à des dossiers spécifiques du site Web ou les autoriser à accéder à tous 
les dossiers du site Web défini.

Pour définir des paramètres d'accès aux dossiers :
1 Ouvrez la boîte de dialogue Modifier les paramètres « Nom du rôle » si ce n'est pas déjà fait. (Voir la section 
« Modification des paramètres d'un rôle », page 210).

2 Cliquez sur la catégorie Accès au dossier/fichier sur le côté gauche de la boîte de dialogue.

3 Sélectionnez Autoriser les utilisateurs à modifier les fichiers de tous les dossiers pour permettre aux utilisateurs d'accéder 
à tous les dossiers et fichiers à la racine du site Web ou Autoriser la modification uniquement dans ces dossiers pour limiter 
l'accès à un sous-dossier ou un groupe de sous-dossiers spécifique.

4 Si vous avez sélectionné Autoriser la modification uniquement dans ces dossiers, cliquez sur Ajouter un dossier pour 
spécifier les dossiers. 
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La boîte de dialogue Choisir un dossier s'affiche.

5 Cette boîte de dialogue répertorie tous les dossiers et les fichiers à la racine du site Web. 

Au besoin, sélectionnez les pages pour en afficher un aperçu. Cette opération vous permet de voir les pages dont vous êtes 
en train de limiter l'accès.

6 Recherchez le dossier pour lequel vous souhaitez fournir un accès, puis cliquez sur Choisir un dossier.

Par exemple, si la racine du site Web est : http://www.monsite.com et que vous souhaitez que les utilisateurs puissent 
uniquement modifier les pages dans un dossier appelé marketing, cliquez sur le dossier marketing. Le chemin d'accès 
correspond alors à : http://www.monsite.com/marketing. 

La boîte de dialogue Choisir un dossier se ferme et le dossier sélectionné apparaît dans la liste Accès au dossier. Vous pouvez 
ajouter des dossiers à la liste Accès au dossier pour permettre aux utilisateurs d'accéder à plusieurs répertoires dans le site 
Web.

7 Cliquez sur OK. 

Lors de sa prochaine connexion au site Web, l'utilisateur de Contribute pourra uniquement modifier les pages et les fichiers 
contenus dans les dossiers définis. 

Pour modifier l'accès à un dossier de la liste, effectuez l'une des opérations suivantes :
• Pour supprimer un dossier de la liste des dossiers accessibles, sélectionnez-le dans la liste et cliquez sur Supprimer.

• Pour modifier un dossier auquel l'utilisateur a accès, sélectionnez le dossier souhaité dans la liste, puis cliquez sur 
Modifier.

Définition des paramètres de suppression de fichiers
Vous pouvez autoriser les utilisateurs à supprimer des pages du serveur Web. Au moment de déterminer si les utilisateurs 
sont autorisés à supprimer une page du site Web, réfléchissez attentivement à la possibilité de conserver une version de 
sauvegarde des pages supprimées. 

Si vous souhaitez conserver des copies de sauvegarde, vous devez vous assurer que la fonction de restauration de Contribute 
est activée. Pour en savoir plus sur la restauration des pages Web, voir la section « Activation et désactivation des 
restaurations », page 190.
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Pour permettre aux utilisateurs de supprimer des fichiers du serveur Web :
1 Ouvrez la boîte de dialogue Edition Nom du rôle Paramètres, si elle ne l'est pas déjà. (Voir la section « Modification des 
paramètres d'un rôle », page 210).

2 Cliquez sur la catégorie Accès au dossier/fichier dans la partie gauche de la boîte de dialogue.

3 Sélectionnez Autoriser les utilisateurs à supprimer les fichiers qu'ils sont autorisés à modifier. 

4 Vous pouvez choisir de supprimer tous les fichiers de restauration associés à une page en sélectionnant Effacer également 
les versions de restauration lors de la suppression. Réfléchissez attentivement à la possibilité de conserver des copies de 
sauvegarde des pages Web avant d'autoriser des utilisateurs à supprimer une page Web active et l'ensemble de ses versions 
de restauration. 

5 Sélectionnez une autre catégorie de paramètres à modifier ou cliquez sur OK pour appliquer vos modifications.

Si un utilisateur supprime un fichier, mais pas ses copies de restauration, il peut récupérer le fichier à partir de ces 
exemplaires sauvegardés. Pour plus d'informations, voir la section « Restauration d'une version précédente d'une page », 

page 163.

Définition des paramètres de modification de pages et de paragraphes
La catégorie Modification permet de spécifier les types de modification que les utilisateurs peuvent apporter aux pages Web 
d'un site et la manière dont Contribute traite les paragraphes et les éléments typographiques.

Pour définir les paramètres de modification de page :
1 Ouvrez la boîte de dialogue Edition Nom du rôle Paramètres, si elle ne l'est pas déjà. (Voir la section « Modification des 
paramètres d'un rôle », page 210).

2 Cliquez sur la catégorie Modification sur le côté gauche de la boîte de dialogue.

La catégorie Modification fournit des options permettant de spécifier les attributs de modification de page appliqués par 
Contribute. Lorsque vous définissez ces options, assurez-vous de connaître les responsables du contenu et le niveau de 
modification de page dont ils ont besoin.
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3 Modifiez les options dans les sections suivantes, selon vos besoins :

• Restrictions de modification générales permet de spécifier les types de modification que les utilisateurs peuvent effectuer 
sur les pages.

• Espacement entre les paragraphes Cette section vous permet de spécifier la manière dont Contribute applique les balises 
de paragraphes HTML, ce qui détermine l'apparition ou non de lignes vierges entre les paragraphes pendant la saisie de 
texte.

• Autres options de modification Cette section vous propose davantage d'options de modifications.

Remarque : Dans Contribute CS3, les utilisateurs peuvent insérer des fragments de code HTML dans les pages Web si vous 
sélectionnez l'option Autoriser l'insertion de fragments de code HTML. Pour plus d'informations, voir la section « Définition 
de l'option d'insertion de fragments de code HTML », page 216.

4 Sélectionnez une autre catégorie de paramètres de rôle à modifier ou cliquez sur OK pour appliquer vos modifications.

Définition de l'option d'insertion de fragments de code HTML
Suivant les autorisations attribuées par l'administrateur aux rôles des utilisateurs, ceux-ci peuvent exécuter les opérations 
appropriées dans Adobe Contribute CS3.

Pour permettre aux utilisateurs d'insérer des fragments de code HTML dans des pages Contribute :
1 Ouvrez Contribute.

2 Sélectionnez Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), 
puis sélectionnez un site Web.

Si la boîte de dialogue Mot de passe administrateur s'affiche, tapez le mot de passe administrateur, puis cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez Utilisateurs et rôles. Sélectionnez Administrateur, puis cliquez sur Modifier les paramètres de rôle.

La boîte de dialogue de modification des paramètres de l'administrateur s'affiche.

4 Sélectionnez Modification dans la liste située à gauche.

Les paramètres correspondants s'affichent à droite.

5 Activez l'option Autoriser l'insertion de fragments de code HTML.

Par défaut, l'option Autoriser l'insertion de fragments de code HTML n'est activée que pour un site de blog. Vous devez 
modifier manuellement le fichier bloghub.csi pour désactiver cette fonction pour les sites de blog.

Remarque : Si l'administrateur du site Web n'a pas activé l'option Autoriser l'insertion de fragments de code HTML pour votre 
rôle, l'option Fragment de code HTML du menu Insertion est désactivée. Par défaut, cette option n'est pas activée pour les sites 
Web.

6 Cliquez sur OK pour appliquer vos changements.

Remarque : Cette fonction est également applicable sur la plate-forme Macintosh.
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Définition des paramètres pour les styles et les polices
La catégorie Styles et polices de la boîte de dialogue Nouveau rôle permet de contrôler l'affichage ou non des styles typogra-
phiques et des polices dans la barre d'outils de Contribute, ainsi que les types de style typographique que les utilisateurs 
peuvent appliquer au texte.

Pour définir les paramètres de style et de police pour un site Web :
1 Ouvrez la boîte de dialogue Edition Nom du rôle Paramètres, si elle ne l'est pas déjà. 

2 Cliquez sur la catégorie Styles et polices sur le côté gauche de la boîte de dialogue.

3 Sélectionnez un paramètre de style dans le menu contextuel Prise en charge du style. Les options de style et de police 
varient en fonction de la sélection effectuée dans ce menu.

Les options Prise en charge du style sont les suivantes :

Interdire aux utilisateurs de créer des styles empêche les utilisateurs de créer des styles. Les utilisateurs ne peuvent 
modifier aucune option de mise en forme de style et de texte.

CSS au niveau du document vous permet de déterminer si les utilisateurs peuvent créer des styles CSS dans le document et 
dans quelle mesure ils peuvent appliquer les styles CSS à partir de feuilles de style CSS existantes.

Balises HTML vous permet de déterminer si les utilisateurs peuvent créer des styles HTML et dans quelle mesure ils peuvent 
modifier et appliquer des styles dans le site Web. 

4 Modifiez les paramètres de style pour l'option de prise en charge de style choisie en fonction de vos besoins.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide. 

5 Sélectionnez une autre catégorie de paramètres de rôle à modifier ou cliquez sur OK pour appliquer vos modifications.
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Limite du nombre de styles CSS disponibles 
Même si les feuilles de style CSS comprennent souvent de nombreuses définitions de style, vous pouvez limiter le nombre 
de styles disponibles pour un rôle utilisateur de Contribute donné. Le fait de limiter le nombre de styles disponibles à ceux 
nécessaires à la mise à jour d'informations dans le corps d'une page Web peut servir à éliminer les erreurs de modification 
stylistiques éventuelles des éditeurs de contenu ayant des connaissances limitées sur les pages Web et les styles CSS.

Contribute vous permet de limiter le nombre de styles CSS disponibles dans le menu Style en sélectionnant une feuille de 
style CSS à partir de laquelle vous filtrez des styles pour un rôle donné. Le fichier de filtre que vous sélectionnez peut inclure 
uniquement les styles auxquels vous souhaitez que les membres de ce rôle puissent accéder, ou vous pouvez créer des feuilles 
de style CSS séparées pour chaque rôle et les sélectionner comme styles CSS à utiliser pour ce rôle.

Pour limiter le nombre de styles CSS disponibles :
1 Ouvrez la boîte de dialogue Edition Nom du rôle Paramètres, si elle ne l'est pas déjà. (Voir la section « Modification des 
paramètres d'un rôle », page 210).

2 Cliquez sur la catégorie Styles et polices sur le côté gauche de la boîte de dialogue.

3 Dans le menu contextuel Prise en charge du style, sélectionnez CSS au niveau du document.

4 Sélectionnez les options suivantes :

• Autoriser les utilisateurs à appliquer des styles

• Inclure les styles CSS dans le menu Style

• Afficher uniquement les styles CSS inclus dans ce fichier CSS

5 Cliquez sur Choisir.

La boîte de dialogue Choisir un fichier ou une entrée de blog affiche tous les dossiers et les fichiers à la racine du site Web. 

6 Recherchez la feuille de style CSS dont vous souhaitez inclure les styles dans le menu Styles.

7 Sélectionnez la feuille de style CSS et cliquez sur OK.

8 Sélectionnez une autre catégorie de paramètres de rôle à modifier ou cliquez sur OK pour appliquer vos modifications.
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Définition des paramètres pour les nouvelles pages Web
La catégorie Nouvelles pages de la boîte de dialogue Edition Nom du rôle Paramètres permet de spécifier si les utilisateurs 
peuvent créer des pages vierges ou des copies de la page en cours. Vous pouvez également définir les modèles Dreamweaver 
que les utilisateurs peuvent consulter et utiliser. 

Pour définir les options Nouvelles pages pour un site Web :
1 Ouvrez la boîte de dialogue Edition Nom du rôle Paramètres, si elle ne l'est pas déjà. (Voir la section « Modification des 
paramètres d'un rôle », page 210).

2 Cliquez sur la catégorie Nouvelles pages sur le côté gauche de la boîte de dialogue.

3 Modifiez les options, selon vos besoins.

Contribute permet de contrôler les types de pages que les utilisateurs peuvent créer et de spécifier les modèles qu'ils peuvent 
utiliser dans le cadre de cette opération. 

Lorsque vous spécifiez les types de pages que les utilisateurs peuvent créer, faites attention à l'aspect général du site. Dans 
la plupart des cas, il est préférable de contraindre les utilisateurs à se servir des copies de pages existantes ou, le cas échéant, 
à utiliser uniquement des modèles Dreamweaver.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide. 

4 Sélectionnez une autre catégorie de paramètres de rôle à modifier ou cliquez sur OK pour appliquer vos modifications.
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Définition des paramètres pour les nouvelles images
Vous pouvez utiliser la catégorie Nouvelles images de la boîte de dialogue Nouveau rôle pour indiquer si les utilisateurs 
peuvent importer des images, les modifier, limiter la taille de fichier maximale d'une image qu'un utilisateur peut ajouter à 
une page et réduire les images de taille supérieure à une valeur que vous spécifiez. 

Pour définir les options Nouvelles images pour un site Web :
1 Ouvrez la boîte de dialogue Modifier les paramètres Nom du rôle si ce n'est pas déjà fait. (Voir la section « Modification 
des paramètres d'un rôle », page 210).

2 Cliquez sur la catégorie Nouvelles images dans la partie gauche de la boîte de dialogue.

3 Indiquez les options utilisées par Contribute pour limiter l'ajout d'images à une page.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide. 

4 Sélectionnez une autre catégorie de paramètres de rôle à modifier ou cliquez sur OK pour appliquer vos modifications.
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Définition des paramètres de placement des fichiers 
Contribute vous permet de spécifier les dossiers dans lesquels vous pouvez copier différents types de fichier. Les types de 
fichier comprennent les images, les documents liés (documents Microsoft Office et fichiers PDF Acrobat, par exemple) et 
le contenu Adobe® Flash®. Par défaut, Contribute place ces fichiers en fonction de la page Web à laquelle ils sont liés. 

Pour définir les options de placement de fichier pour un site Web :
1 Ouvrez la boîte de dialogue Modifier les paramètres Nom du rôle si ce n'est pas déjà fait. (Voir la section « Modification 
des paramètres d'un rôle », page 210).

2 Cliquez sur la catégorie Placement de fichier dans la partie gauche de la boîte de dialogue.

3 Indiquez les règles utilisées par Contribute pour placer les fichiers, selon vos besoins.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide. 

4 Sélectionnez une autre catégorie de paramètres de rôle à modifier ou cliquez sur OK pour appliquer vos modifications.
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Définition des paramètres pour les actifs partagés
Contribute vous permet d'ajouter des images, du contenu Adobe® Flash® ou des éléments de bibliothèques Adobe Dream-
weaver à votre site Web depuis une liste d'actifs partagés. L'administrateur du site Web peut ajouter les actifs partagés à la 
liste d'actifs afin de les mettre à la disposition de la majorité voire la totalité des utilisateurs. Les utilisateurs peuvent ensuite 
insérer les actifs depuis la liste au gré des besoins. 

Pour plus d'informations, voir la section « Insertion d'actifs partagés dans une page Web », page 105.

Vous pouvez modifier votre liste d'actifs partagés de la façon suivante :

• Ajoutez des fichiers image, un contenu Flash et des éléments de bibliothèque Dreamweaver à votre liste d'actifs partagés.

Les actifs que vous ajoutez à votre liste d'actifs partagés doivent déjà se trouver sur le serveur ; Contribute ne transfère pas 
les fichiers. Vous pouvez utiliser Contribute pour rechercher des fichiers puis les ajouter à une liste centrale pour les utili-
sateurs.

• Supprimez des actifs partagés de votre liste.

Vous pouvez supprimer des actifs partagés de listes individuelles pour des rôles spécifiques ou d'une liste qui s'applique au 
site Web entier.

• Modifiez les propriétés des actifs partagés.

Les propriétés comprennent le nom utilisé pour se référer à l'actif, le texte secondaire pour les images et l'attribut de modifi-
cation pour les éléments de la bibliothèque Dreamweaver.

Vous créez une seule liste d'actifs partagés pour tous les rôles dans votre site Web ou vous personnalisez ces listes pour 
chaque rôle.

Si différents rôles sont limités à différents actifs partagés, il peut être utile d'ajouter tous les actifs partagés pour le site Web 
en une seule fois, puis de modifier la liste pour chaque rôle. Il est plus judicieux d'ajouter les actifs partagés en une seule 

fois et de les supprimer au moment souhaité plutôt que d'ajouter les mêmes actifs plusieurs fois.
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Pour ajouter des actifs partagés, les supprimer ou modifier leurs propriétés pour un site Web entier ou pour un rôle 
spécifique :
1 Ouvrez la boîte de dialogue Modifier les paramètres Nom du rôle si ce n'est pas déjà fait. (Voir la section « Modification 
des paramètres d'un rôle », page 210).

Remarque : Si vous effectuez des changements qui s'appliquent à tous les rôles associés au site Web, le rôle que vous sélectionnez 
importe peu.

2 Sélectionnez Actifs partagés dans la liste à gauche.

Les paramètres Actifs partagés s'affichent.

Si votre liste contient déjà des actifs partagés, ils sont triés par type, par ordre alphabétique. Pour afficher la liste par ordre 
alphabétique, cliquez sur l'en-tête Nom en haut de cette colonne.

3 Procédez de l'une des manières suivantes :

• Pour ajouter un actif partagé, cliquez sur le bouton Ajouter puis sélectionnez Image, Elément de bibliothèque ou Flash.

Vous pouvez utiliser la touche Maj. tout en cliquant sur plusieurs actifs pour les sélectionner.

• Pour supprimer un actif partagé, sélectionnez-le dans la liste puis cliquez sur le bouton Supprimer.

• Pour afficher ou modifier les propriétés d'un actif partagé, sélectionnez l'actif voulu dans la liste puis cliquez sur le 
bouton Modifier.

4 Procédez de l'une des manières suivantes :

• Pour que vos changements s'appliquent à tous les rôles associés au site Web, vérifiez que l'option Utiliser cette liste pour 
tous les rôles est sélectionnée.

• Pour que vos changements s'appliquent uniquement au rôle que vous avez sélectionné dans la boîte de dialogue de 
paramétrage des rôles, désélectionnez l'option Utiliser cette liste pour tous les rôles.

Remarque : Cette option s'applique à la liste entière des actifs partagés visible dans le panneau. Elle n'est pas propre à un actif 
partagé que vous pouvez sélectionner dans le panneau.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide. 

5 Cliquez sur OK.

Gestion des brouillons envoyés pour la révision 
En tant qu'administrateur, vous pouvez afficher et modifier l'état des brouillons se trouvant actuellement dans le processus 
de révision pour votre site Web. Vous pouvez modifier les propriétaires d'un brouillon qui a été envoyé pour la révision et 
supprimer un brouillon du processus de révision.

Remarque : Pour plus d'informations sur le processus de révision des brouillons, voir la section « Description du processus de 
révision des brouillons », page 35.

Pour afficher les brouillons envoyés pour révision :
1 Choisissez Edition > Administrer les sites Web > Gérer les brouillons envoyés.

La boîte de dialogue Gérer les brouillons envoyés s'affiche.

2 Effectuez l'une des opérations suivantes :

• Pour afficher un brouillon, sélectionnez-le puis cliquez sur Afficher le brouillon.

• Pour transférer la propriété d'un brouillon à quelqu'un d'autre, sélectionnez-le puis cliquez sur Modifier le propriétaire.

• Pour supprimer un brouillon du processus de révision, sélectionnez-le puis cliquez sur Annuler l'extraction.

Pour plus d'informations sur les options de cette boîte de dialogue, cliquez sur le bouton Aide. 

3 Cliquez sur Fermer lorsque vous avez terminé.
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Chapitre 14 : Dépannage

Ce chapitre décrit les problèmes les plus fréquents que vous pouvez rencontrer en tant qu'utilisateur de Adobe® 
Contribute® CS3 et propose des solutions pour y remédier.

Ce chapitre contient les sections suivantes :

• « Problèmes liés à l'installation Contribute », page 225

• « Problèmes liés au démarrage de Contribute », page 225

• « Problèmes liés à la création d'une connexion », page 227

• « Problèmes liés à la modification d'une page », page 229

• « Problèmes liés à l'annulation des pages », page 231

• « Problèmes liés à l'envoi de révisions par courriel », page 231

• « Problèmes liés à la publication d'une page », page 231

• « Problèmes liés à la création de documents à partir de modèles », page 232

• « Problèmes d'administration de Contribute », page 232

• « Utilisation de Contribute avec des pages dynamiques », page 236

• « Problèmes liés à la configuration de Contribute dans des agrégateurs RSS », page 237

Problèmes liés à l'installation Contribute
Contribute est une application conçue pour fonctionner correctement lorsqu'elle est installée sur la plate-forme Windows. 
Les erreurs courantes suivantes peuvent poser problème lors de l'installation du logiciel Contribute :

• saisie d'un numéro de série non valide ;

• saisie incorrecte du numéro de série ;

• installation de Contribute sur un système dont les autorisations utilisateur sont limitées.

Si vous rencontrez des difficultés lors de l'installation de Contribute, assurez-vous que le numéro de série destiné à activer 
le produit est valide et correct. Vérifiez également que l'ordinateur sur lequel vous installez le logiciel dispose des droits 
d'accès au lecteur et au réseau appropriés pour votre compte utilisateur.

Problèmes liés au démarrage de Contribute
Les sections suivantes décrivent les problèmes que vous pouvez rencontrer lors du démarrage de Contribute :

• « Le démarrage est lent ou l'application semble être bloquée », page 226

• « La boîte de dialogue Echec de la connexion s'affiche lorsque l'application Contribute est connectée au réseau », 
page 226

• « Contribute ne détecte pas la déconnexion du réseau », page 226

• « La boîte de dialogue Numérotation s'affiche lorsque l'application Contribute est connectée au réseau », page 226

• « Contribute indique que l'utilisateur n'appartient pas à un rôle valide », page 227
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Le démarrage est lent ou l'application semble être bloquée
Lorsque vous démarrez Contribute, une connexion est établie pour chaque site Web défini dans la boîte de dialogue Mes 
connexions. Si vous avez défini un grand nombre de sites Web Contribute, l'application peut être lente ou ne pas répondre 
au démarrage. Pour remédier à ce problème, désactivez les sites Web que vous n'avez pas besoin de mettre à jour 
fréquemment. Vous pouvez les réactiver très facilement lorsqu'une mise à jour est nécessaire.

Pour plus d'informations, voir les sections suivantes :

• « Désactivation de connexions à des sites Web et à des blogs », page 203 

• « Activation de la connexion à un site Web ou à un serveur de blog », page 204

• « Désactivation de sites Web pour améliorer les performances de l'application », page 234

La boîte de dialogue Echec de la connexion s'affiche lorsque l'application Contribute est 
connectée au réseau
Il arrive parfois que la boîte de dialogue Echec de la connexion s'affiche même si vous avez une connexion réseau active. Ce 
problème peut survenir lorsque l'application Contribute est installée sur un ordinateur sur lequel d'autres applications 
accèdent régulièrement au réseau. 

Cliquez sur OK pour fermer la boîte de dialogue Echec de la connexion. Si la boîte de dialogue continue de s'afficher, 
vérifiez que votre ordinateur est bien connecté au réseau ou, si vous utilisez une connexion par numérotation, vérifiez que 
votre connexion a été établie correctement.

Contribute ne détecte pas la déconnexion du réseau
Dans certaines situations, Contribute ne détecte pas que la connexion au réseau a été interrompue ou qu'elle n'a pas pu être 
établie. Si ce problème se produit, Contribute tente de se connecter à la première connexion répertoriée dans la liste de 
connexions aux sites Web. Si cette opération échoue et qu'il existe d'autres sites Web auxquels se connecter, Contribute 
affiche une boîte de dialogue vous invitant à indiquer si vous souhaitez continuer à vous connecter aux sites Web restants. 
Si vous cliquez sur Oui, Contribute affiche la même boîte de dialogue pour chaque site Web (si vous avez cliqué sur Oui à 
chaque fois). Si vous cliquez sur Non, Contribute désactive les autres sites Web. 

Contribute désactive le site Web si elle ne parvient pas à s'y connecter, même si vous avez cliqué sur Oui. Si cela se produit, 
Contribute n'affiche pas la page Travailler hors connexion mais indique tous les sites comme étant désactivés. Choisissez 
Fichier > Travailler hors connexion (Windows) ou Contribute > Travailler hors connexion (Macintosh). Pour vous 
connecter à vos sites Web, vérifiez que votre ordinateur est connecté au réseau et que ce dernier fonctionne.

La boîte de dialogue Numérotation s'affiche lorsque l'application Contribute est 
connectée au réseau
Par défaut, la configuration du navigateur Web Internet Explorer de Microsoft permet d'établir automatiquement une 
connexion au réseau si aucune n'est en cours. Dans certaines situations, Contribute tente d'établir une connexion au réseau 
au démarrage.

Pour remédier à ce problème, vous pouvez mettre à jour les paramètres de connexion d'Internet Explorer afin qu'aucune 
connexion d'accès réseau ne soit établie.

Pour désactiver la connexion d'accès réseau dans Internet Explorer, procédez comme suit :
1 Si Internet Explorer n'est pas en cours d'utilisation, lancez-le.

2 Sélectionnez Outils > Options Internet.

La boîte de dialogue Options Internet s'affiche.

3 Cliquez sur l'onglet Connexions.

4 Sous Options de numérotation, sélectionnez Ne jamais établir de connexion ou Etablir une connexion s'il n'existe pas de 
connexion réseau.
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5 Cliquez sur Appliquer.

6 Cliquez sur OK.

Contribute indique que l'utilisateur n'appartient pas à un rôle valide
Si le rôle de l'utilisateur est supprimé ou modifié par l'administrateur, ou si l'utilisateur a créé la connexion, il peut démarrer 
l'Assistant de connexion Windows ou Macintosh pour créer une connexion puis sélectionner un rôle valide. Si l'utilisateur 
a importé une clé de connexion modifiée, l'administrateur peut lui envoyer une nouvelle clé de connexion contenant un 
rôle valide à importer.

Pour plus d'informations, voir la section « Envoi de clés de connexion pour des sites Web », page 195.

Problèmes liés à la création d'une connexion
Les sections ci-dessous décrivent les problèmes que vous pouvez rencontrer lors de la création d'une connexion avec 
Contribute :

• « La boîte de dialogue Mes connexions ne s'affiche pas », page 227

• « La fenêtre suivante de l'Assistant de connexion n'est pas accessible », page 227

• « L'Assistant de connexion ne trouve pas le dossier distant », page 227

• « La connexion LAN ne trouve pas le dossier distant », page 228

• « La boîte de dialogue FTP n'accepte pas votre nom d'utilisateur et votre mot de passe », page 228

La boîte de dialogue Mes connexions ne s'affiche pas
Si vous ne réussissez pas à afficher la boîte de dialogue Mes connexions ou à modifier vos connexions, il se peut que 
Contribute soit en mode hors connexion. Cliquez sur le bouton Travail en ligne pour établir une connexion avec votre 
serveur.

La fenêtre suivante de l'Assistant de connexion n'est pas accessible
Si vous ne parvenez pas à accéder à l'écran suivant de l'Assistant de connexion, vous n'avez peut-être pas saisi correctement 
les informations de connexion. Vérifiez que vous avez correctement tapé l'adresse du site Web, le nom du serveur, le nom 
d'utilisateur, le mot de passe et le chemin d'accès réseau. Si ces éléments sont corrects, vérifiez que le site Web est en ligne à 
l'aide du navigateur Web de votre ordinateur. 

L'Assistant de connexion ne trouve pas le dossier distant
Lorsque vous saisissez des informations de connexion FTP ou SFTP dans Contribute, l'Assistant de connexion vérifie que 
le dossier FTP correspond au dossier contenant les fichiers de votre site Web. Si ces chemins de dossiers ne correspondent 
pas, Contribute ne peut pas écrire sur la page affichée par votre navigateur. Vous devez donc vous assurer que des droits 
d'accès en lecture et écriture sont définis de manière appropriée pour votre dossier FTP.

Sur les serveurs UNIX®, comme Apache, le bit de lecture publique est défini à 1 pour les fichiers et le bit d'exécution 
publique est défini à 1 pour les répertoires Web. 

Pour vous assurer que le dossier du site Web et le dossier FTP sont identiques, Contribute télécharge un fichier temporaire 
en utilisant les informations de l'hôte FTP que vous avez indiquées. L'Assistant de connexion utilise l'adresse du site Web 
pour « deviner » le chemin d'accès FTP. Contribute tente ensuite de lire le fichier temporaire via HTTP en utilisant l'adresse 
Web que vous avez indiquée. Si Contribute réussit à retrouver le fichier temporaire, les chemins d'accès correspondent et 
l'Assistant crée alors la connexion. 

Si les chemins ne correspondent pas, l'Assistant de connexion vous invite à saisir le chemin d'accès FTP correct, Contribute 
n'ayant pas réussi à le deviner. 
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Pour vous assurer que le chemin FTP que vous avez saisi est correct, cliquez sur le bouton Parcourir dans l'Assistant de 
connexion pour retrouver et sélectionner le dossier FTP. Si le chemin d'accès au dossier est correct, assurez-vous que les 
utilisateurs disposent des autorisations d'accès en lecture et en écriture appropriées pour ce dossier. Si vous créez un compte 
FTP anonyme, le serveur doit être configuré de telle sorte que l'utilisateur anonyme puisse disposer d'autorisations de 
suppression, de changement de nom et de modification. 

Pour apprendre à vérifier les autorisations au niveau des dossiers et du FTP sur votre serveur, reportez-vous à la documen-
tation fournie avec le système d'exploitation de votre serveur.

Pour que des groupes d'autorisations spécifiques disposent d'un accès aux sous-dossiers d'un dossier racine FTP en lecture 
seule, procédez de l'une des manières suivantes : 

• Définissez des autorisations d'accès en écriture pour le dossier racine.

• Créez une connexion unique pour chaque sous-dossier du dossier racine et définissez des autorisations d'accès en 
écriture pour ces sous-dossiers.

La connexion LAN ne trouve pas le dossier distant
Si le répertoire distant contenant vos pages Web ne peut être trouvé par le réseau local (LAN), essayez l'une des solutions 
ci-dessous :

• Le répertoire distant doit être défini sur partagé pour êre visible sur le réseau, ainsi que par tout client tentant de s'y 
connecter.

• Le dossier doit présenter les autorisations appropriées pour permettre l'accès en lecture, écriture, suppression, modifi-
cation et changement.

Pour vérifier qu'un dossier est visible sur votre réseau local, procédez comme suit :
1 Dans le menu Windows, sélectionnez Démarrer > Exécuter.

La boîte de dialogue Exécuter s'affiche.

2 Tapez le chemin d'accès réseau au dossier dans le champ Ouvrir, puis cliquez sur OK.

Par exemple, tapez \\Monserveur\Mondossier.

3 Assurez-vous que le dossier est visible sur le réseau et que vous disposez des autorisations d'accès au fichier appropriées.

La boîte de dialogue FTP n'accepte pas votre nom d'utilisateur et votre mot de passe
Veillez à saisir un nom d'utilisateur et un mot de passe corrects pour le serveur FTP ou SFTP spécifié. Le nom et le mot de 
passe d'utilisateur FTP peuvent différer des informations de connexion de votre ordinateur. 

Remarque : Si vous tapez un nom d'utilisateur et un mot de passe plusieurs fois sans réussir à vous connecter au serveur, il est 
possible que le serveur FTP rejette toute nouvelle tentative de connexion. Si cette situation se présente, quittez l'application et 
essayez de vous reconnecter ou contactez l'administrateur de votre site Web pour qu'il déverrouille votre compte.
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Problèmes liés à la modification d'une page
Les sections ci-dessous décrivent les problèmes que vous pouvez rencontrer lors de la modification d'une page :

• « Le bouton Modifier la page n'est pas visible », page 229

• « Le bouton de modification est désactivé », page 229

• « Un message d'erreur s'affiche lors de la sélection du bouton de modification », page 230

• « La sélection du bouton Modifier la page entraîne l'affichage d'une page différente », page 230

Le bouton Modifier la page n'est pas visible 
Si le bouton Modifier la page n'est pas visible pour une page sélectionnée, assurez-vous qu'une connexion est établie avec 
le site Web correspondant et que vous disposez des autorisations vous permettant de modifier la page affichée. Pour plus 
d'informations, voir les sections suivantes :

• « Création d'une connexion à un site Web », page 179

• « Définition des paramètres d'accès aux dossiers et fichiers », page 213

Si le site Web dispose d'autres adresses (par exemple, lorsque vous accédez à la page via une adresse IP au lieu d'utiliser le 
nom DSN du site Web), il peut être nécessaire de configurer l'application Contribute afin qu'elle reconnaisse ces adresses. 
Pour plus d'informations, voir la section « Définition d'autres adresses de site Web », page 193.

Il est possible que vous rencontriez des anomalies au niveau du réseau ou du serveur. Actualisez la page ou cliquez sur les 
boutons Retour et Avant pour accéder de nouveau à la page.

Le bouton de modification est désactivé
Plusieurs raisons peuvent expliquer la désactivation du bouton de modification pour une page spécifique :

• Lorsque vous accédez à une page, Contribute vérifie que vous disposez des autorisations appropriées pour la modifier 
sur le site Web. En fonction du trafic réseau et du temps de réponse du serveur, cette opération peut prendre plusieurs 
minutes, pendant lesquelles le bouton Modifier la page est affiché en grisé. 

• La page peut être verrouillée par un autre utilisateur qui est en train de la modifier. Contribute affiche alors un message 
indiquant que le fichier est verrouillé, ainsi que les informations de contact de l'utilisateur qui modifie le fichier.

Dans certaines situations, il se peut que vous deviez supprimer un fichier de verrouillage pour pouvoir accéder à la page. 
Pour plus d'informations, voir la section « Vous devez écraser l'extraction d'un fichier », page 235.

• Il est possible que l'utilisateur ne dispose pas d'une autorisation d'accès en écriture au serveur, au dossier contenant la 
page Web ou à la page. Pour apprendre à vérifier les autorisations au niveau des dossiers sur le serveur, reportez-vous à 
la documentation fournie avec le système d'exploitation de votre serveur.

• Il est possible que l'adresse URL spécifiée désigne une liste de répertoires et non une page spécifique. Cliquez sur une 
page pour l'afficher, puis accédez à la page que vous souhaitez modifier.

• Lorsque vous accédez à un site Web et qu'aucun fichier d'index n'est disponible, Contribute répertorie le contenu du 
répertoire. Cliquez sur une page pour l'afficher, puis accédez à la page que vous souhaitez modifier.

• Il peut s'agir d'un type de fichier ne pouvant pas être modifié par Contribute.

• Il est possible que la page n'existe pas, soit parce qu'elle a été supprimée, soit parce que l'utilisateur a saisi un nom de 
fichier incorrect.

• Le chemin d'accès au fichier excède peut-être le nombre maximum de caractères autorisés.

• L'utilisateur a saisi un mot de passe de démarrage de Contribute incorrect.

• Sur le Macintosh, le volume du serveur n'est pas monté sur le bureau de votre ordinateur.
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Un message d'erreur s'affiche lors de la sélection du bouton de modification
L'utilisateur ne dispose peut-être pas des autorisations d'accès en lecture et en écriture appropriées sur le serveur pour 
modifier la page, ou bien le fichier de paramètres partagés est endommagé ou a été modifié.

Pour apprendre à vérifier les autorisations au niveau des dossiers sur le serveur, reportez-vous à la documentation fournie 
avec le système d'exploitation de votre serveur.

Si les autorisations d'accès en lecture et en écriture du serveur sont correctement définies, alors le fichier de paramètres 
partagés est peut-être endommagé. Dans ce cas, vous devez supprimer ce fichier de paramètres partagés sur le serveur Web, 
puis en créer un nouveau.

Pour supprimer le fichier de paramètres partagés :
1 Connectez-vous au serveur, soit en créant un point de montage sur le bureau (Macintosh), soit directement (à l'aide d'un 
client FTP, telnet, SSH ou autre).

Remarque : Vous ne pouvez pas effectuer cette opération à partir d'un navigateur Web.

2 Sur le serveur, ouvrez le dossier racine de votre site Web Contribute, puis le dossier _mm qui se trouve dans ce dossier.

Sous Windows, le chemin de répertoire pour le dossier _mm se présente généralement sous la forme suivante :

\\monserveur\wwwroot\monsite\_mm

Sous Unix, le chemin de répertoire pour le dossier _mm se présente généralement sous la forme suivante :

/monserveur/serveurWeb/monsite/_mm

Le fichier de paramètres partagés se trouve dans le dossier _mm. 

3 Supprimez le fichier de paramètres partagés.

4 Dans Contribute, cliquez sur Edition > Administrer les sites Web, puis sélectionnez le site Web dont vous avez supprimé 
le fichier de paramètres partagés.

Une boîte de dialogue s'affiche ; elle indique qu'aucun administrateur n'est défini pour le site Web s'affiche et vous demande 
si vous souhaitez en devenir l'administrateur. Cliquez sur Oui si tel est le cas.

5 Vous êtes alors invité à définir un mot de passe d'administrateur.

Tapez et confirmez ce nouveau mot de passe, puis cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche. 

6 Cliquez sur Terminer ou continuez l'administration du site Web.

La sélection du bouton Modifier la page entraîne l'affichage d'une page différente
Si la page affichée par Contribute lorsque vous cliquez sur le bouton Modifier la page ne correspond pas à celle souhaitée, 
il est possible que le mappage du fichier de page d'index ne soit pas défini correctement dans les paramètres d'adminis-
tration de Contribute. Pour en savoir plus, voir la section « Pages d'index du serveur Web », page 176.

Pour vérifier le mappage de la page d'index : 
1 Cliquez sur Edition > Administrer les sites Web (Windows) ou Contribute > Administrer les sites Web (Macintosh), puis 
sélectionnez le site Web à administrer dans le sous-menu.

2 A l'invite, tapez le mot de passe administrateur, puis cliquez sur OK.

La boîte de dialogue Administrer le site Web s'affiche.

3 Sélectionnez la catégorie Serveur Web située à gauche de la boîte de dialogue et cliquez sur l'onglet Fichiers d'index.

Le panneau Fichiers d'index s'affiche ; il contient une liste des pages d'index.
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Problèmes liés à l'annulation des pages
Les sections ci-dessous décrivent les problèmes que vous pouvez rencontrer lors de l'annulation de pages dans Contribute :

Le bouton Annuler n'est pas visible lorsque vous révisez un brouillon, ce qui signifie que vous travaillez peut-être hors ligne 
sans le savoir. Sélectionnez Fichier > Travailler hors connexion (Windows) ou Contribute > Travailler hors connexion 
(Macintosh) pour établir à nouveau une connexion avec le serveur. 

Une erreur s'affiche lors de la sélection du bouton Annuler si le serveur Web n'est pas disponible ou si les autorisations de 
l'utilisateur sur le serveur ne sont pas définies correctement. Assurez-vous qu'une connexion est établie avec le serveur et 
que les autorisations d'accès en lecture et en écriture sur le serveur sont définies correctement.

Problèmes liés à l'envoi de révisions par courriel
Dans certaines situations, il est possible que Contribute ne retrouve pas l'application de messagerie par défaut ou ne 
parvienne pas à la démarrer pour créer un message pour la révision par courriel. 

Remarque : Sur Macintosh, Contribute fonctionne avec les applications de messagerie par défaut suivantes : Mail, Eudora et 
Entourage.

Si Contribute ne trouve pas l'emplacement de votre application de messagerie par défaut ou ne parvient pas à la démarrer, 
vous pouvez créer le message électronique en cliquant sur le lien Cliquer ici, dans la zone de message sous la barre d'outils. 
Copiez l'adresse Web (URL) du brouillon qui s'affiche dans la fenêtre du navigateur puis collez-la dans le message à envoyer 
aux réviseurs.

Problèmes liés à la publication d'une page
Les sections suivantes décrivent les problèmes que vous pouvez rencontrer lors de la publication d'une page 
avec Contribute :

Le bouton Publier n'est pas visible lors de la révision d'un brouillon :

• Vous travaillez peut-être hors ligne. Sélectionnez Fichier > Travailler hors connexion (Windows) ou Contribute > 
Travailler hors connexion (Macintosh) pour établir à nouveau une connexion avec le serveur. 

• Le rôle qui vous est affecté ne dispose peut-être pas d'autorisations de publication. Consultez l'administrateur Contribute 
pour savoir si votre rôle dispose d'autorisations de publication.

Des erreurs s'affichent lors de la sélection du bouton Publier pour une page particulière ; ce problème peut avoir plusieurs 
causes :

• Le serveur est peut-être hors connexion ou indisponible. 

Vérifiez que le serveur Web fonctionne en accédant au site à l'aide du navigateur Web de votre ordinateur.

• Les autorisations de l'utilisateur sur le serveur, le dossier contenant la page Web ou la page elle-même ont peut-être été 
modifiées. 

Assurez-vous que l'utilisateur dispose des autorisations d'accès appropriées au dossier et au fichier. Pour apprendre à 
vérifier les autorisations au niveau des dossiers et des fichiers sur le serveur, reportez-vous à la documentation fournie avec 
le système d'exploitation de votre serveur.

• Le dossier contenant la page que l'utilisateur souhaite publier a peut-être été supprimé ou n'existe pas. 

Enregistrez la page dans un autre dossier du site Web ou créez un dossier approprié pour la page.

• Il est possible qu'un autre utilisateur ait verrouillé la page. Cette situation peut se présenter lorsqu'un utilisateur disposant 
de Dreamweaver MX ouvre le fichier et réinitialise le fichier de verrouillage.

Vérifiez si un autre utilisateur a extrait le fichier ou contrôlez la validité du fichier de verrouillage. S'il n'est pas valide, il doit 
être supprimé. Pour éliminer le fichier de verrouillage, voir « Vous devez écraser l'extraction d'un fichier », page 235.
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Problèmes liés à la création de documents à partir de 
modèles
Les sections ci-dessous décrivent les problèmes que vous pouvez rencontrer lors de la création de pages Web ou d'entrées 
de blog à partir de modèles dans Contribute :

• « Les modèles de pages pour les sites Web et les blogs n'apparaissent pas dans Contribute », page 232

• « Des images ou d'autres éléments ne s'affichent pas sur la nouvelle page », page 232

Les modèles de pages pour les sites Web et les blogs n'apparaissent pas dans Contribute
Si vos modèles pour les pages Web et les blogs n'apparaissent pas dans Contribute, cliquez d'abord sur le bouton Actualiser 
les modèles dans la boîte de dialogue Nouvelle page Web ou Entrée de blog, puis sélectionnez Pour tous les sites Web ou 
Pour le site Web/blog sélectionné afin de télécharger les modèles. Si l'une des options Pour tous les sites Web ou Pour le site 
Web/blog sélectionné semble désactivée, vous pouvez vérifier si vous avez sélectionné le site Web ou le blog pour lequel 
vous souhaitez actualiser les modèles.

Si les modèles correspondant à vos pages Web ou blogs ne sont toujours pas visibles, procédez comme suit :

• Assurez-vous que les modèles ont été téléchargés correctement à partir du serveur. Il arrive parfois que l'utilisateur qui 
télécharge les modèles clique sur le bouton Annuler lors du téléchargement, annulant ainsi la totalité du téléchargement. 

• Il est possible que l'accès aux modèles de pages Web défini pour le groupe d'autorisations auquel l'utilisateur appartient 
soit limité. Pour plus d'informations, voir la section « Définition des paramètres pour les nouvelles pages Web », 
page 219.

• Vérifiez que l'extension du nom de fichier de modèle est .dwt.

• Assurez-vous que tous les modèles du site se trouvent dans le répertoire Templates à la racine de votre site.

Des images ou d'autres éléments ne s'affichent pas sur la nouvelle page
Si un utilisateur crée une page à partir d'un modèle qui contient des images ou des fichiers dépendants et que les liens vers 
ces fichiers semblent être rompus, l'utilisateur n'a peut-être pas accès au répertoire dans lequel se trouvent ces fichiers. Pour 
remédier à ce problème :

• Assurez-vous que l'utilisateur dispose de l'autorisation d'accès en lecture sur les dossiers contenant les images ou autres 
éléments de page référencés (par exemple, des animations Flash).

• Vérifiez que le modèle lui-même ne comporte pas de liens rompus ou de syntaxe non valide.

• Vérifiez que le seuil de téléchargement de fichiers défini sur le serveur n'a pas été dépassé.

• Assurez-vous que le disque du serveur n'est pas plein.

Problèmes d'administration de Contribute
Les sections ci-dessous décrivent les problèmes que vous pouvez rencontrer lors de l'administration de Contribute :

• « Le menu Administrer les sites Web est désactivé », page 233

• « Vous avez oublié le mot de passe du rôle administrateur », page 233

• « Contribute se bloque lors de l'envoi d'une clé de connexion », page 233

• « Une page Web est supprimée accidentellement », page 233

• « Les utilisateurs ne voient pas suffisamment de copies de restauration de pages », page 234

• « Désactivation de sites Web pour améliorer les performances de l'application », page 234

• « Vous devez supprimer un utilisateur dans un rôle », page 235

• « Vous devez écraser l'extraction d'un fichier », page 235
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Le menu Administrer les sites Web est désactivé
Si le menu Administrer les sites Web est désactivé, assurez-vous que Contribute fonctionne en ligne en sélectionnant Fichier 
> Travailler hors connexion (Windows) ou Contribute> Travailler hors connexion (Macintosh).

Si les sites Web répertoriés dans le menu déroulant Administrer les sites Web sont inactifs, ils ont peut-être été désactivés. 
Pour plus d'informations, voir la section « Activation de la connexion à un site Web ou à un serveur de blog », page 204.

Vous avez oublié le mot de passe du rôle administrateur
Si vous avez oublié le mot de passe défini pour le rôle d'administrateur de Contribute, vous pouvez le redéfinir. Pour cela, 
supprimez le fichier de paramètres partagés du site Web et créez-en un nouveau.

Remarque : Si vous supprimez le fichier de paramètres partagés, tous les rôles précédemment créés le seront également. Vous 
devez alors redéfinir les autorisations.

Pour supprimer le fichier de paramètres partagés :
1 Connectez-vous au serveur, soit en créant un point de montage sur le bureau, soit directement (à l'aide d'un client FTP, 
telnet, SSH ou autre).

Remarque : Vous ne pouvez pas effectuer cette opération à partir d'un navigateur Web.

2 Sur le serveur, ouvrez le dossier racine de votre site Web Contribute, puis le dossier _mm qui se trouve dans ce dossier.

Sous Windows, le chemin de répertoire pour le dossier _mm se présente généralement sous la forme suivante :

\\monserveur\wwwroot\monsite\_mm

Sous Unix, le chemin de répertoire pour le dossier _mm se présente généralement sous la forme suivante :

/<chemin_racine_du_doc_de_serveur_web/monsite/_mm/

Le fichier de paramètres partagés est un fichier XML (nommé contribute.xml) qui se trouve dans le dossier _mm. 

3 Supprimez le fichier de paramètres partagés.

4 Dans Contribute, sélectionnez Edition > Mes connexions (Windows) ou Contribute > Mes connexions (Macintosh), 
sélectionnez le site Web dont vous avez modifié le fichier de paramètres partagés, puis cliquez sur Modifier.

5 Etablissez de nouveau une connexion au site.

6 Lorsque vous redéfinissez la connexion au site Web, sélectionnez Edition > Administrer les sites Web (Windows) ou 
Contribute > Administrer les sites Web (Macintosh) et administrez le site Web auquel vous êtes connecté. 

Contribute vous invite à devenir l'administrateur du site Web. 

7 Sélectionnez Définir le Mot de passe administrateur pour devenir l'administrateur du site et redéfinissez le mot de passe 
administrateur.

Contribute se bloque lors de l'envoi d'une clé de connexion
Si vous utilisez un compte de messagerie sur le Web (tel que Hotmail ou Yahoo!) ou une application de messagerie que 
Contribute ne reconnaît pas, l'Assistant d'exportation du fichier de connexion se bloque lorsque vous essayez de joindre et 
d'envoyer automatiquement la clé de connexion par courriel.

Pour remédier à ce problème, enregistrez la clé de connexion sur votre ordinateur local, puis joignez-la manuellement à un 
message que vous créez dans votre application de messagerie électronique.

Une page Web est supprimée accidentellement
Si un utilisateur supprime par inadvertance une page du serveur Web, vous pouvez la recréer à partir des copies de restau-
ration conservées sur le serveur Web. Pour cela, la fonction de restauration doit être activée et l'option de suppression de 
toutes les copies de restauration d'une page ne doit pas être sélectionnée. Pour en savoir plus sur les restaurations de pages, 
voir la section « Activation et désactivation des restaurations », page 190.
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Pour remplacer une page Web supprimée :
1 Recherchez la page supprimée à l'aide de Contribute. 

Pour ce faire, vous pouvez saisir l'URL de la page en question ou cliquer sur le lien d'une page existante permettant d'accéder 
à la page supprimée. Lorsque vous effectuez cette opération, le serveur Web répond en envoyant l'erreur HTTP 404 (page 
not found), indiquant que la page est introuvable. 

Remarque : Certains serveurs Web sont configurés de manière à vous rediriger vers la page d'accueil du site Web ou vers une 
page d'erreur personnalisée si une erreur de type « file not found » (fichier introuvable) survient. Lorsque cette situation se 
présente, vous pouvez copier manuellement la page à partir du répertoire _baks situé à la racine du site Web Contribute.

2 Sélectionnez Fichier > Actions > Restaurer la version précédente.

La boîte de dialogue Restaurer la page s'affiche.

3 Sélectionnez une version précédente de la page publiée dans la liste des pages disponibles. 

Remarque : La liste des pages précédemment publiées répertorie jusqu'à 99 versions précédentes de la page. 

Contribute affiche la page dans la section Aperçu.

4 Si la page sélectionnée correspond à celle que vous souhaitez publier, cliquez sur le bouton Restaurer. Si elle ne 
correspond pas à celle que vous souhaitez publier, sélectionnez-en une autre dans la liste, puis cliquez sur Restaurer.

Contribute remplace la version actuellement publiée par la version que vous avez sélectionnée. La version sélectionnée 
devient la version effective sur le site Web.

Remarque : La page remplacée par la page de restauration sélectionnée s'affichera dans la boîte de dialogue Restaurer la page 
à la prochaine ouverture de cette boîte de dialogue. Vous pourrez donc choisir de restaurer la page avec cette version.

Les utilisateurs ne voient pas suffisamment de copies de restauration de pages
Si les utilisateurs estiment ne pas voir suffisamment de copies de restauration de pages, vous pouvez y remédier en 
augmentant le nombre de fichiers de restauration que Contribute conserve.

Pour plus d'informations, voir la section « Activation et désactivation des restaurations », page 190.

Désactivation de sites Web pour améliorer les performances de l'application
Dans certaines conditions, il est préférable de désactiver un site Web Contribute. Ceci permet d'éviter que Contribute 
n'accède à ce site Web, ce qui pourrait entraîner une dégradation des performances de l'application. Vous pouvez être amené 
à désactiver un site Web pour les raisons suivantes :

• Plusieurs sites Web sont définis dans l'application Contribute, mais seuls un ou deux sont mis à jour régulièrement.

Lorsque vous démarrez Contribute, une connexion à chaque site Web défini est établie et demeure ouverte et active aussi 
longtemps que l'application s'exécute. Si plusieurs sites Web sont définis (six ou plus, par exemple) mais que vous ne 
travaillez activement qu'avec un ou deux sites, vous améliorerez les performances de l'application en désactivant les autres 
sites Web.

• Vous utilisez un accès réseau à distance qui authentifie les connexions ouvertes et les désactive après un délai spécifié.

De nombreux réseaux d'entreprise interrompent les connexions qui restent inactives pendant un certain laps de temps. Si 
vous avez défini des sites Web Contribute avec lesquels vous ne travaillez pas activement, vous devrez peut-être les désac-
tiver pour éviter les erreurs liées à des sites Web non disponibles.

• Le site Web est hors connexion.

Si un site Web Contribute est hors connexion ou non disponible, vous améliorerez les performances de l'application en le 
désactivant. Lorsque Contribute détecte qu'un site Web n'est pas disponible, le message d'erreur suivant s'affiche : « Le 
serveur Nomduserveur ne répond pas. Contactez votre administrateur système. ».

Vous pouvez essayer de vous reconnecter en cliquant sur le bouton Essayer de se connecter à nouveau dans la barre d'outils 
du navigateur.
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• Le groupe d'autorisations de l'utilisateur a été supprimé.

Si un utilisateur est membre d'un groupe d'autorisations qui a été supprimé, Contribute envoie un message d'erreur lorsqu'il 
tente de charger le site Web. 

• Vous tentez de vous connecter à des sites Web en dehors de leurs pare-feux, c'est pourquoi certaines connexions 
réussissent et d'autres échouent.

Pour plus d'informations, voir la section « Désactivation de connexions à des sites Web et à des blogs », page 203.

Vous devez supprimer un utilisateur dans un rôle
Si vous utilisez Contribute Publishing Server (CPS) pour gérer les utilisateurs, vous pouvez supprimer un utilisateur dans 
un rôle ou le réaffecter à un autre rôle.

Pour en savoir plus, voir la section « Suppression d'utilisateurs de sites Web gérés par CPS », page 199.

Si vous n'utilisez pas CPS pour gérer les utilisateurs, Contribute ne prend pas en charge la suppression d'un utilisateur dans 
un rôle. Pour supprimer un utilisateur dans un rôle, procédez de la manière suivante :

• Supprimez la connexion de cet utilisateur de sa copie personnelle de Contribute. Une mesure supplémentaire consiste à 
configurer l'authentification réseau de la société de telle sorte que l'utilisateur ne dispose pas des autorisations d'accès en 
lecture et en écriture au site Web.

• Renommez le rôle et redistribuez-le aux utilisateurs que vous souhaitez inclure, puis supprimez l'ancien rôle.

Pour en savoir plus, voir la section « Création de rôles dans Contribute », page 208.

Vous devez écraser l'extraction d'un fichier
Si un utilisateur a ouvert une page pour la modifier, Contribute crée un fichier de verrouillage (identifié par l'extension .lck) 
qui empêche les autres utilisateurs de modifier cette page. Dans les situations suivantes, vous devrez peut-être supprimer 
un fichier de verrouillage pour permettre à un autre utilisateur de modifier cette page :

• Un utilisateur qui ne travaille plus dans votre entreprise a laissé un fichier verrouillé sur le serveur.

• Un administrateur Web ou un autre professionnel du Web a verrouillé (extrait) une page à l'aide de Dreamweaver MX et 
ne l'a pas déverrouillée.

• Une erreur système ou toute autre anomalie empêche un utilisateur d'archiver une page qu'il ne souhaite plus modifier.

Avant d'écraser une page extraite de Contribute, assurez-vous que la dernière personne ayant travaillé sur la page en a 
réellement terminé avec cette page et ne peut pas la déverrouiller à l'aide de Contribute ou de Dreamweaver.

Pour supprimer un fichier de verrouillage :
1 Dans Contribute, recherchez la page que vous souhaitez déverrouiller.

2 A la fin de l'URL de la page, ajoutez l'extension .lck au nom de fichier dans le navigateur de Contribute 
(www.monsite.com/index.htm.lck, par exemple).

3 Contribute affiche la page Espace réservé pour le fichier. 

La page Espace réservé pour le fichier s'affiche lorsque Contribute rencontre un type de fichier qu'il ne peut pas ouvrir. Le 
fichier de verrouillage de Contribute est d'un type particulier, que Contribute ne peut pas afficher.

4 Sélectionnez Fichier > Supprimer la page.

Remarque : Cet élément de menu est désactivé si vous ne disposez pas des autorisations pour supprimer des pages de votre site 
Web. Lorsque cette situation se présente, vous devez activer la suppression de fichiers pour le groupe d'autorisations de l'utili-
sateur. Pour plus d'informations, voir la section « Définition des paramètres d'accès aux dossiers et fichiers », page 213.

Un message d'alerte vous invite à confirmer la suppression de ce fichier.
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5 Cliquez sur Oui pour confirmer la suppression du fichier.

Un autre message d'alerte s'affiche vous avertissant que vous êtes sur le point de supprimer un fichier spécial et vous 
demandant si vous souhaitez continuer.

6 Cliquez sur Oui pour confirmer la suppression du fichier.

Contribute supprime le fichier de verrouillage et affiche la dernière page visualisée.

Utilisation de Contribute avec des pages dynamiques
Contribute est conçu pour modifier du contenu HTML sur un site Web et ne permet pas de modifier du contenu 
dynamique conservé dans une base de données, ni d'ajouter ou de modifier des balises dynamiques. Contribute ne traite 
pas votre code de document dynamique et fournit des outils pour protéger les éléments de vos pages Web et de votre site 
Web qui ne doivent pas être modifiés par les utilisateurs de Contribute.

Le navigateur de Contribute est un navigateur Web doté de toutes les fonctions permettant aux utilisateurs d'afficher des 
pages dynamiques, d'entrer des données dans des formulaires et de soumettre ces derniers.

Contribute prend également en charge de nouvelles pages et de nouveaux modèles contenant des éléments dynamiques. Par 
exemple, vous pouvez créer un modèle avec des balises ColdFusion pour l'initialisation, les inclusions, les compteurs et les 
éléments de données dynamiques. Les utilisateurs peuvent également copier des pages dynamiques existantes. Dans tous 
les cas, en tant qu'administrateur de sites Web Contribute, vous devez vous assurer que le code de votre site Web est protégé.

Comment empêcher les utilisateurs de modifier des pages dynamiques
Pour que les utilisateurs de Contribute ne puissent pas modifier des éléments dynamiques sur des pages, prenez les précau-
tions suivantes : 

• Autorisez les modifications dans certains dossiers uniquement. 

Utilisez les groupes d'autorisations de Contribute pour limiter l'accès aux dossiers. Par exemple, si votre site Web comprend 
une page dynamique répertoriant des travaux, vous pouvez placer la page dans un dossier distinct et exclure ce dernier de 
la liste des dossiers modifiables sur le site Web. Lorsqu'un utilisateur de Contribute accède à ce dossier, le bouton Modifier 
la page est désactivé.

• Verrouillez les pages que vous souhaitez protéger à l'aide des outils d'accès au fichier du serveur. 

Définissez des autorisations d'accès en lecture seule pour les pages dynamiques. Lorsque des utilisateurs de Contribute 
affichent une page dynamique et cliquent sur Modifier la page, un message s'affiche, indiquant que cette page est en lecture 
seule et qu'ils ne sont pas autorisés à la modifier.

• Dans les paramètres d'administration de Contribute, sélectionnez Protéger les scripts et les formulaires.

Modification du contenu statique dans les pages dynamiques
Vous pouvez autoriser les utilisateurs à modifier du contenu statique dans des pages dynamiques et protéger uniquement 
les parties dynamiques de la page.

Les utilisateurs de Contribute ne peuvent pas modifier le code source ni le contenu situé en dehors des balises <body> et 
<title> d'une page. Les scripts d'initialisation et les fichiers d'inclusion ne peuvent ainsi pas être modifiés. Pour protéger 
des éléments dynamiques dans le corps de votre page, prenez les précautions suivantes :

• Utilisez des modèles afin de verrouiller les parties dynamiques de votre page. Par exemple, si votre page comporte du 
contenu généré de façon dynamique (tel que CFLOOP dans ColdFusion ou des pages ASP répétées), vous pouvez trans-
former cette page en modèle. Assurez-vous que ces parties du modèle sont verrouillées et créez une instance du modèle. 
Les utilisateurs Contribute peuvent apporter des modifications uniquement dans les limites des parties spécifiées. 

Si vous le souhaitez, vous pouvez empêcher les utilisateurs de créer des pages à partir de ces modèles ou de copier ces pages. 
Pour savoir comment empêcher les utilisateurs de créer des pages à partir de vos modèles ou de copier ces pages, voir la 
section « Définition des paramètres pour les nouvelles pages Web », page 219.
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• Par défaut, Contribute est configuré pour accepter toutes les modifications apportées aux pages non définies comme 
modèle et pour empêcher toute modification des scripts et formulaires. Si vous désélectionnez l'option de protection des 
scripts et formulaires, les utilisateurs pourront modifier le code de vos pages (par exemple, les balises SCRIPT, les inclu-
sions côté serveur, ASP, JSP, ColdFusion et PHP). Cette option permet également de protéger les caractères qui ne sont 
pas considérés comme du texte dans le nom de balise, par exemple ASP:MaBalise. Cependant, Contribute peut ne pas 
reconnaître ou protéger les balises personnalisées, telles que MaBalisePersonnalisée, ni les éléments de données 
entourés par des balises CFOUTPUT de ColdFusion (tels que #...#). 

Les utilisateurs peuvent modifier du texte brut HTML inséré dans des balises conditionnelles (tel que le contenu entre CFIF 
et CFELSE, ainsi que d'autres balises de conteneur HTML telles que CFOUTPUT).

Pour plus d'informations, voir la section « Définition des paramètres de modification de pages et de paragraphes », 
page 215.

• Autorisez uniquement la modification de texte. Il s'agit d'une option de la catégorie Modification de la boîte de dialogue 
de paramètres Edition Nom du rôle que vous pouvez sélectionner pour autoriser les utilisateurs à modifier ou mettre en 
forme uniquement du texte. Pour toutes les pages qui ne sont pas protégées par des modèles, cette option permet aux 
utilisateurs de modifier du texte et les balises de texte les plus courantes (telles que b, font, span, etc.). Les utilisateurs 
ne pourront sélectionner ou supprimer aucun autre type de balises. Cependant, ils pourront modifier le contenu HTML 
se trouvant entre les balises.

Pour plus d'informations, voir la section « Définition des paramètres de modification de pages et de paragraphes », 
page 215.

Problèmes liés à la configuration de Contribute dans des 
agrégateurs RSS
La section suivante décrit les problèmes que vous pouvez rencontrer lors de la configuration de Contribute dans des agréga-
teurs RSS :

Contribute ne figure pas dans la liste des outils de publication de blog de FeedDemon
Si l'application Contribute ne figure pas dans la liste des outils de publication de blog bien que vous l'ayez configurée, 
vérifiez les informations de configuration suivantes dans FeedDemon :

• Vérifiez si la ligne de commande ou le champ URL affiche le chemin d'accès correct au fichier Contribute.exe.

• Vérifiez si vous avez tapé un espace et -mmPostToBlog après Contribute.exe dans la case Ligne de commande ou URL.



ADOBE CONTRIBUTE CS3
Guide de l'utilisateur

238



239

Chapitre 15 : Raccourcis clavier pour 
Windows

Les sections suivantes contiennent des tableaux répertoriant les raccourcis clavier du système d'exploitation Windows que 
vous pouvez utiliser dans Adobe® Contribute® CS3.

Menu Fichier 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Fichier 
de Contribute.

Menu Edition 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Edition 
de Contribute.

Action Raccourci

Créer une page Ctrl+N

Ouvrir un fichier stocké dans votre ordinateur Ctrl+O

Fermer un brouillon Ctrl+W

Modifier la page Ctrl+E

Envoyer pour la révision Ctrl+Maj+S

Publier Ctrl+Maj+P

Modifier la source de la page dans une application externe Ctrl+Maj+E

Enregistrer sans publier Ctrl+S

Enregistrer pour plus tard Ctrl+Maj+L

Afficher un aperçu dans le navigateur F12

Imprimer Ctrl+P

Fermer/Quitter Ctrl+Q

Action Raccourci

Annuler Ctrl+Z 

Répéter Ctrl+Y 

Couper Ctrl+X 

Copier Ctrl+C

Coller Ctrl+V 

Coller comme texte Ctrl+Maj+V
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Menu Affichage
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Affichage 
de Contribute.

Menu Insertion 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Insertion 
de Contribute.

Menu Format 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Format 
de Contribute.

Supprimer Suppr.

Sélectionner tout Ctrl+A

Rechercher Ctrl+F

Action Raccourci

Ouvrir ou fermer le panneau de navigation F4

Ouvrir la Console de brouillons Ctrl+Maj+D

Ouvrir le navigateur Ctrl+Maj+B

Retour Alt+Gauche

Avant Alt+Droite

Actualiser le navigateur F5

Sélectionner un fichier du site Web Ctrl+Maj+O

Action Raccourci

Insérer une image depuis votre poste de travail Ctrl+Alt+I

Insérer un tableau Ctrl+Alt+T

Insérer un lien vers une page Web Ctrl+Alt+L

Insérer une ancre de section Ctrl+Alt+A

Ajouter un saut de ligne Maj+Entrée

Ajouter un espace insécable Ctrl+Maj+Espace

Action Raccourci

Vérifier l'orthographe F7

Mettre le texte sélectionné en gras Ctrl+G

Mettre le texte sélectionné en italique Ctrl+I

Action Raccourci
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Menu Tableau 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Tableau 
de Contribute.

Travailler avec des entrées de blog
Le tableau suivant indique le raccourci clavier que vous pouvez utiliser lorsque vous travaillez avec des entrées de blog.

Utilisation de modèles 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour naviguer dans les zones d'un modèle.

Souligner le texte sélectionné Ctrl+U

Aligner à gauche Ctrl+Alt+Maj+L

Centrer Ctrl+Alt+Maj+C

Aligner à droite Ctrl+Alt+Maj+R

Justifier Ctrl+Alt+Maj+J

Mettre un paragraphe en retrait Ctrl+Alt+]

Mettre un paragraphe en retrait négatif Ctrl+Alt+[ 

Ajouter un mot-clé ou une description Ctrl+Alt+K

Définir les propriétés d'une page Ctrl+J

Action Raccourci

Sélectionner un tableau Ctrl+T

Insérer un tableau Ctrl+Alt+T

Fusionner les cellules sélectionnées Ctrl+Alt+M

Fractionner les cellules sélectionnées Ctrl+Alt+S

Insérer une ligne Ctrl+M

Insérer une colonne Ctrl+Maj+A

Afficher les propriétés du tableau Ctrl+Maj+T

Action Raccourci

Actualisation des entrées de blog dans la liste Entrées Ctrl+Maj+R

Action Raccourci

Passer à la prochaine zone modifiable Ctrl+Alt+E

Passer à la zone modifiable précédente Ctrl+Maj+Alt+E

Action Raccourci
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Modifier du texte 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour modifier du texte dans Contribute.

Utiliser des tableaux 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour modifier des tableaux dans Contribute.

Utiliser des images
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer des opérations sur les images 
dans Contribute.

Action Raccourci

Créer un paragraphe Entrée

Insérer un saut de ligne (<BR>) Maj+Entrée

Insérer un espace Espace

Insérer un espace insécable Ctrl+Maj+Espace

Déplacer du texte ou un objet sur la page Faire glisser l'élément sélectionné vers un autre emplacement

Sélectionner un mot Double-cliquer sur le mot

Sélectionner un paragraphe Cliquer trois fois sur un mot du paragraphe

Mettre un paragraphe en retrait Ctrl+Alt+]

Mettre un paragraphe en retrait négatif Ctrl+Alt+[

Aligner à gauche Ctrl+Maj+Alt+L

Centrer Ctrl+Maj+Alt+C

Aligner à droite Ctrl+Maj+Alt+R

Action Raccourci

Sélectionner une cellule (avec point d'insertion dans la cel-
lule)

Ctrl+A

Passer à la prochaine cellule Tab

Passer à la cellule précédente Maj+Tab

Insérer une ligne (au-dessus de celle sélectionnée) Ctrl+M

Ajouter une ligne à la fin du tableau Placer le curseur dans la dernière cellule du tableau et appuyer sur 
la touche de tabulation

Insérer une colonne Ctrl+Maj+A

Fusionner les cellules sélectionnées du tableau Ctrl+Alt+M

Fractionner une cellule du tableau Ctrl+Alt+S

Action Raccourci

Insérer une image Ctrl+Alt+I

Modifier les propriétés d'une image Double-cliquer sur l'image
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Obtenir de l'aide
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour accéder au système d'aide en ligne de 
Contribute.

Action Raccourci

Ouvrir l'aide en ligne F1

Ouvrir la page de démarrage Alt+Origine
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Chapitre 16 : Raccourcis clavier pour 
Macintosh

Les sections suivantes contiennent des tableaux répertoriant les raccourcis clavier du système d'exploitation Macintosh que 
vous pouvez utiliser dans Adobe® Contribute® CS3.

Menu Fichier 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Fichier 
de Contribute.

Menu Edition 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Edition 
de Contribute.

Action Raccourci

Créer une page Commande+N

Ouvrir un fichier stocké dans votre ordinateur Commande+O

Fermer un brouillon Commande+W

Modifier la page Commande+Maj+E

Envoyer pour révision Commande+Maj+S

Publier Commande+Maj+P

Modifier la source de la page dans une application externe Commande+Maj+E

Enregistrer sans publier Commande+S

Enregistrer pour plus tard Commande+Maj+L

Imprimer Commande+P

Fermer/Quitter Commande+Q

Action Raccourci

Annuler Commande+Z 

Répéter Commande+Y 

Couper Commande+X 

Copier Commande+C

Coller Commande+V 

Coller comme texte Commande+Maj+V

Supprimer Suppr.

Sélectionner tout Commande+A

Rechercher Commande+F
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Menu Affichage
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Affichage 
de Contribute.

Menu Insertion
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Insertion 
de Contribute.

Menu Format 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Format 
de Contribute. 

Action Raccourci

Ouvrir le navigateur Commande+Maj+B

Ouvrir la Console de brouillons Commande+Maj+D

Retour Option+Flèche gauche

Avant Option+Flèche droite

Actualiser le navigateur Commande+R

Choisir un fichier ou une entrée de blog Commande+Maj+O

Action Raccourci

Insérer une image depuis votre poste de travail Commande+Option+I

Insérer un tableau Commande+Option+T

Insérer un lien Commande+Option+L

Insérer une ancre de section Commande+Option+A

Ajouter un saut de ligne Maj+Retour

Ajouter un espace insécable Commande+Maj+Espace

Action Raccourci

Mettre le texte sélectionné en gras Commande+G

Mettre le texte sélectionné en italiques Commande+I

Souligner le texte sélectionné Commande+U

Aligner à gauche Commande+Option+Maj+L

Centrer Commande+Option+Maj+C

Aligner à droite Commande+Option+Maj+R

Justifier Commande+Option+Maj+J

Mettre un paragraphe en retrait Commande+Option+]
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Menu Tableau 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Tableau 
de Contribute.

Menu Aide
Le tableau suivant répertorie le raccourci clavier que vous pouvez utiliser pour accéder à la page de démarrage de 
Contribute.

Utilisation de modèles 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour naviguer dans les zones d'un modèle.

Mettre un paragraphe en retrait négatif Commande+Option+[

Ajouter un mot-clé ou une description Commande+Option+K

Définir les propriétés d'une page Commande+J

Action Raccourci

Sélectionner un tableau Commande+T

Insérer un tableau Commande+Option+T

Fusionner les cellules sélectionnées Commande+Option+M

Fractionner les cellules sélectionnées Commande+Option+S

Insérer une ligne Commande+M

Insérer une colonne Commande+Maj+A

Afficher les propriétés du tableau Commande+Maj+T

Action Raccourci

Ouvrir la page de démarrage Option+Origine

Action Raccourci

Passer à la prochaine zone modifiable Commande+Option+E

Passer à la zone modifiable précédente Commande+Maj+Option+E

Action Raccourci
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Modification du texte 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour modifier du texte dans Contribute.

Utilisation des tableaux 
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer les opérations du menu Tableau 
de Contribute.

Action Raccourci

Créer un paragraphe Entrée

Insérer un saut de ligne (<BR>) Maj+Entrée

Insérer un espace Espace

Insérer un espace insécable Commande+Maj+Espace

Déplacer du texte ou un objet sur la page Faire glisser un élément vers un autre emplacement

Sélectionner un mot Double-cliquer sur le mot

Sélectionner un paragraphe Cliquer trois fois sur un mot du paragraphe

Mettre un paragraphe en retrait Commande+Option+]

Mettre un paragraphe en retrait négatif Commande+Option+[

Aligner à gauche Commande+Maj+Option+L

Centrer Commande+Maj+Option+C

Aligner à droite Commande+Maj+Option+R

Action Raccourci

Sélectionner une cellule (avec point d'insertion dans la cel-
lule)

Commande+A

Passer à la prochaine cellule Tab

Passer à la cellule précédente Maj+Tab

Insérer une ligne (avant celle sélectionnée) Commande+M

Ajouter une ligne à la fin du tableau Placer le curseur dans la dernière cellule du tableau et appuyer sur 
la touche de tabulation

Insérer une colonne Commande+Maj+A

Fusionner les cellules sélectionnées du tableau Commande+Option+M

Fractionner une cellule du tableau Commande+Option+S
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Utiliser des images
Le tableau suivant répertorie les raccourcis clavier que vous pouvez utiliser pour effectuer des opérations sur les images 
dans Contribute.

Action Raccourci

Insérer une image Commande+Option+I

Modifier les propriétés d'une image Double-cliquer sur l'image
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Index

A
à propos 60

conversion de documents au 
format PDF 60

Abonnement
ajout des boutons PayPal 102

accentuation des images 108
accentuer le texte Voir aussi italiques
accès 47

nouveau brouillon à réviser 47
Accès au dossier/fichier, option 213
accessibilité

à propos 31
actifs partagés 224
contraste élevé 29
de l'aide 3
images 101
lecteurs 29
navigation clavier uniquement 29
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239
texte secondaire, obligatoire 224

Acheter maintenant
ajout du bouton PayPal 102

actifs partagés
autorisations 222
insertion dans une page 105

activation
connexion à un serveur de blog 204
connexion à un site Web 14, 204
CPS 183
restaurations 190

activation du logiciel 1
Activer Publishing Server, boîte de 

dialogue 184
actualisation

brouillons 45
connexion à un serveur de blog 182
liste des entrées 56

actualisation des modèles
création de pages Web 50

Actualiser les brouillons 45
administrateurs

annulation de l’extraction de 
fichiers 235

attribution du rôle 186
connexion à un site Web, 

configuration 12
définis 9

documentation pour 4
modification 189
mot de passe, modification 189
mot de passe, redéfinition 233
paramètres 188
processus de révision des 

brouillons, gestion 223
rôles 207

Administrer le site Web, boîte de 
dialogue

dépannage en cas de 
désactivation 233

options 188
Adobe Acrobat Connect, lien vers du 

contenu 142
Adobe Bridge CS3

insertion de fichiers dans Adobe 
Contribute CS3 16

intégration à Adobe Contribute 
CS3 16

ouverture de fichiers dans Adobe 
Contribute CS3 16

publication de fichiers dans Adobe 
Contribute CS3 17

Adobe Bridge Home 6
Adobe Contribute CS3

insertion de fichiers depuis Adobe 
Bridge CS3 16

intégration à Adobe Bridge CS3 16
ouverture de fichiers depuis Adobe 

Bridge CS3 16
publication de fichiers d'Adobe 

Bridge CS3 17
Adobe Contribute Publishing Server 

Voir CPS.
Adobe CS3, applications

exécution de scripts de démarrage 
pour intégrer Adobe 
Contribute 15

Adresse électronique, boîte de 
dialogue 140

affichage
brouillons 25
commentaires des brouillons 46
entrées de blog 25
liste de signets 26
pages d'accueil 25
pages et fichiers non liés 25
pages Web et blogs publiés 

récemment 25
Affichage (menu), raccourcis clavier

Macintosh 246

Windows 240
Afficher le panier

ajout du bouton PayPal 102
agrégateurs RSS, publication de 

contenu de blog depuis 237
Aide 2
Aide Adobe 2
aide en ligne

raccourcis clavier, Macintosh 247
raccourcis clavier, Windows 243

ajout
Acheter maintenant, bouton 

PayPal 102
Ajouter au panier, bouton 

PayPal 102
bouton Afficher le panier de 

PayPal 102
bouton PayPal, Abonnement 102
Faire un don, bouton PayPal 102
mots-clés et descriptions, pour les 

pages Web 68
Ajouter au panier

ajout du bouton PayPal 102
Ajouter un signet, boîte de 

dialogue 26
alignement

images 107, 119
raccourcis clavier 248
raccourcis clavier pour 

Macintosh 246
raccourcis clavier, Macintosh 248
raccourcis clavier, Windows 240, 

242
tableaux 125, 134
texte 94
vidéo 114

Ancre de section, boîte de 
dialogue 146

ancres de section
à propos de 145
ajout 146
liaison vers 146
modification 147
raccourcis clavier, Macintosh 246
raccourcis clavier, Windows 240

animations
alignement 114
déplacement 114
fichiers de blog 114, 199
Flash, insertion 105, 111
Flash, propriétés 112
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insertion 112
propriétés 113

animations, lecture automatique 119
Annuaire des utilisateurs

ajout d'utilisateurs à un site 
Web 197

désactivation 186
suppression d'utilisateurs d'un site 

Web 199
annulation

dépannage 231
envoi d'un brouillon en révision 43
modification 40
modifications de pages, entrées de 

blog ou brouillons 54
annulation de l’extraction de 

fichiers 235
annulation de la publication de 

plusieurs pages
à propos 156
utilisation de la fonction de 

restauration 163
Annuler

raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239

aperçu
liens 149
pages Web 156

API MetaWeblog 178
application, externe

images, modification 110
applications

contenu de page Web, 
modification 53

images, modification 110
modification de code source 224

applications externes
contenu de page Web, 

modification 53
modification de code source 224

ASP, pages 224, 236
Assistant de connexion

configuration pour un serveur de 
blog 180

configuration pour un site 
Web 179

dépannage 227
Atelier vidéo 4
Atelier vidéo Adobe 4
audio, fichiers de blog 114, 199
Auteur, rôle 207
autorisation de modifier du code 

source
code source, utilisation 

d’applications externes 224

autorisations
accès aux dossiers 213
actifs partagés 222
autorisation d'insérer des 

fragments de code HTML 224
boutons PayPal 224
champs de recherche Google 224
code source 224, 236
création de pages Web 219
dépannage 227
fichier de paramètres partagés 207, 

233
images 220
modification de pages Web 215
modification du code HTML 216
modification du texte 224
paramètres de page d'accueil 212, 

224
paramètres de style 217, 218, 224
placement de fichier 221
publication 212, 224
rôle, paramètres de 207, 210, 212, 

224
suppression 235
suppression de fichiers 214
Voir aussi rôles
zones de modèle 36

Autoriser les commentaires 73
autres adresses Web

types de 176
autres serveurs de blog

sélection pour création de serveurs 
de blog 181

sélection pour la connexion 181
AVI, fichiers 112

B
balisage d'entrées de blog 71
balises HTML

autorisations individuelles 217
espacement entre les 

paragraphes 224
barré 92
barre d'outils de l'éditeur 20
barre d'outils de métadonnées du 

blog 20
barre d'outils de retouche d'image 21
barre d'outils du navigateur 20
barres d'outils

éditeur 20
espace de travail 19
métadonnées du blog 20
navigateur 20
panneau de navigation 21
retouche d’image 21

barres horizontales 117
blog, connexion à un serveur

activation 14
administrateurs 12
travail hors connexion 14, 51

blog, entrées 38
annulation des modifications 54
balisage 71
catégories, attribution 71
commentaires autorisés 73
création à partir d'un modèle 64
création à partir d'une sélection 66
création d'une entrée vide 65
enregistrement d'un brouillon lors 

du travail 41
enregistrement des brouillons 

pour plus tard 41
exportation 56
fixation de la date et de l'heure 67
fonctionnalités 33, 59
impression 57
liaison vers 138
métadonnées, saisie 69
modèles 36, 48, 64, 232
modification, méthodes 67
modifications à partir d'un 

navigateur 39
modifications hors connexion 51
ouverture à des fins de 

modification 38
personnalisation des modèles 49
préférences 69
sélection des blogs de 

publication 70
suppléments multimédia 114
suppression 55
titres 70
URL de rétrolien 72

blogs
fichiers dépendants, 

configuration 199
fichiers non liés, affichage 25
flux des travaux, présentation 11
mise à jour des entrées 172
pages d'accueil, affichage 25
publication d'entrées existantes en 

tant que nouvelles 172
publication de contenu depuis 

Microsoft Office 167
publication de contenu depuis un 

agrégateur RSS 237
publication de contenu depuis un 

programme d'ajout de flux 
RSS 169

publication de nouvelles 
entrées 173
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publication du contenu depuis un 
navigateur 166

sélection pour la publication 70
Boîte de dialogue Importer la clé de 

connexion 13
boîte de dialogue Insérer un 

document Microsoft Office 167
Boîte de dialogue Publier les 

nouvelles pages liées 158, 160
Boîte de dialogue Publier une 

nouvelle page 158
boîtes de dialogue, navigation clavier 

uniquement 30
bordures de tableau

épaisseur 134
bordures, images 119
boutons PayPal

à propos de 102
ajout 118
autorisations 224
insertion d'un seul bouton 118
insertion de plusieurs 

éléments 119
modification 119

Bridge CS3 16
brouillons

à propos 33
affichage 25
annulation des modifications 54
commentaires, affichage 46
enregistrement lors du travail 41
enregistrement pour plus tard 41
liaison vers 135
modifications hors connexion 51
non publiés, suppression 204
orthographe, vérification 99
révision 45
suivi 44

brouillons à réviser
accès aux nouveaux brouillons 47

Brouillons et pages récentes, boîte de 
dialogue 135

C
cadres

à propos de 151, 152
enregistrement et publication 153
modification du contenu 152
sélection de la cible 152, 154

caractères spéciaux 89
caractères, codage 29, 190
catégories d'entrées de blog 71
cellules de tableau

collage 127
conflits de mise en forme 121

copie ou collage 126
espacement 134
fractionnement 129
fusion 129
marge intérieure 134
propriétés 131
raccourcis clavier, Macintosh 247, 

248
raccourcis clavier, Windows 241, 

242
sélection 123

centrer le texte 94
changement de nom

connexion à un site Web 202
connexion à un site Web ou un 

serveur de blog 202
chemin d'accès réseau 178
chercher.Voir recherche
choix

modèle 78, 80, 81, 82, 165
clés de connexion

dépannage 227, 233
envoi pour des sites CPS 197
envoi pour des sites Web 195
importation 12
sécurité 177

connexion à un site Web
Voir aussi clés de connexion

codage, caractères 29, 190
code

affichage 156
protection 224, 236

code source
affichage 156
autorisation de modifier à l'aide 

d'applications externes 224
protection 224, 236

code, fragments
insertion dans des pages Adobe 

Contribute 85
ColdFusion 224, 236
collage

cellules de tableau 127
images 104
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239

colonnes de tableau
ajout 127
conflits de mise en forme 121
largeur 134
propriétés 131, 134
raccourcis clavier, Macintosh 247, 

248
raccourcis clavier, Windows 241, 

242

redimensionnement 124
sélection 123
suppression 128
tri des données 133

commentaires
affichage 46
autorisés dans les entrées de 

blog 73
Compléments 5
comptes .Mac

création de connexions 182
configuration

dépannage 225
configuration requise 1
conflits, utilisateur 178
connexion à un blog

point d'accès 205
connexion à un serveur de blog

à l'aide de l'URL du blog 181
à propos de 175
activation 204
actualisation 182
changement de nom 202
configuration 180
dépannage 226, 227
gestion 200
modification des informations 201
pris en charge 178
sélection pour le démarrage 204
suppression 202

connexion à un site Web
à propos de 175
activation 14, 204
activation de CPS pour 183
administrateurs 12
autres adresses 176
changement de nom 202
configuration 179
dépannage 227
désactivation de CPS pour 185
gestion 200
informations, collecte 178
modification des informations 201
sélection pour le démarrage 204
suppression 202
travail hors connexion 14, 51

connexion individuelle à un serveur 
de blog

désactivation 203
connexion individuelle à un site Web

désactivation au démarrage 203
connexion, clés. Voir clés de 

connexion
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connexions
activation 14, 204
activation de CPS 183
administrateurs 12
Annuaire des utilisateurs, 

désactivation 186
changement de nom 202
configuration pour un serveur de 

blog 180
configuration pour un site 

Web 179
dépannage 227
désactivation de CPS 185
gestion 200
informations, collecte 178
modification des informations 201
suppression 202
travail hors connexion 51

connexions au démarrage
sélection de sites Web ou de 

serveurs de blog 204
connexions aux sites Web ou blogs

désactivation au démarrage 14
Console de brouillons 21, 44
contenu Adobe Acrobat Connect, 

lien vers 142
contenu de page Web

modification dans une application 
externe 52

contraste
élevé 29
images, réglage 108

Contribute CS3
intégration à Bridge CS3 16

conversion 60
documents MS Office au format 

PDF 60
copie

cellules de tableau 126
images 104
pages d'accueil 62
pages Web 60
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239

couleur
définition des propriétés d'une 

page Web 67
paramètre de contraste élevé 29
tableaux 134
texte 93

couleur d'arrière-plan
définition des propriétés d'une 

page Web 67
élevé, paramètre 29
tableau 134

CPS
activation 183
ajout d'utilisateurs 197
Annuaire des utilisateurs, 

désactivation 186
clés de connexion, envoi 197
configuration FTP ou SFTP 205
désactivation pour un site Web 185
gestion des connexions 200
modification des informations de 

connexion 201
suppression d'utilisateurs 199
suppression des connexions 202
WebDAV 205

création de connexions
comptes .Mac 182

création de pages Web
actualisation des modèles 50

création, liste à puces 95
création, liste de définitions 96
création, liste numérotée 95
Créer un nouveau rôle, boîte de 

dialogue 209
Créer une entrée, boîte de 

dialogue 138
Créer une page, boîte de dialogue 136
CSS

autorisations utilisateur 217
création de styles 91
espacement entre les 

paragraphes 224
limitation des styles 

disponibles 218, 224
propriétés de page 67
styles disponibles 87
texte, application 91

D
date

ajout à une page Web 88
publication de l'entrée de blog 65

date et heure
fixation pour des entrées de 

blog 67
définition de modèles

à l'ouverture de documents MS 
Office dans Adobe 
Contribute 82

démarrage
désactivation des connexions aux 

site Web ou au serveur de 
blog 14

démarrage d'Adobe Contribute
dépannage 225
modification du mot de passe 28

saisie d'un mot de passe 13
travail hors connexion 14, 51

démarrage lent
dépannage 226

démarrage lent, dépannage 234
dépannage

annulation de pages 231
Assistant de connexion 227
boîte de dialogue Administrer le 

site Web 233
clés de connexion 233
connexions 227
connexions réseau 226
démarrage d'Adobe 

Contribute 225
démarrage lent 226
désactivation d'un site Web 234
FTP 227, 228
installation 225
modèles 232
modification de pages Web 229
publication 231
réseau local 228
restauration d'une page Web 

supprimée 234
révision par courriel 231
rôles 227

dépannage, dossiers distants
FTP 227
réseau local 228

déplacement
images 107
vidéo 114

désactivation
accès réseau 226
Annuaire des utilisateurs 186
connexion individuelle à un 

serveur de blog 203
connexion individuelle à un site 

Web 203
connexions au site Web ou au blog 

au démarrage 14
CPS 185
réactivation d'une connexion à un 

site Web 14
restaurations 190
sites Web 234

descriptions
actifs partagés 224
images 102
obligatoire 224
raccourcis clavier, Macintosh 246
raccourcis clavier, Windows 240

développeurs 9
déverrouillage de fichiers 235
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dictionnaire, vérification 
orthographique 99

DNS, alias multiples 176
dossiers

autorisations 213
compte .Mac 183
distants, dépannage 228
fichier de paramètres partagés 207
FTP, dépannage 227
options de placement des 

fichiers 221
pages dynamiques, restriction 236

Dreamweaver, modèles
à propos 36
autorisations 219
blog, entrées 64
création de pages Web 64
dépannage 232
modification de pages 48
personnalisation 49
propriétés 48
raccourcis clavier, Macintosh 247
raccourcis clavier, Windows 241

E
Echec de la connexion, boîte de 

dialogue 226
éditeur de Contribute.

travail hors connexion 51
Éditeur, rôle 207
Edition (menu), raccourcis clavier

Macintosh 245
Windows 239

éléments de bibliothèque
Adobe Acrobat Connect, liaison 

vers 142
autorisations 222
insertion depuis les actifs 

partagés 105
éléments de la bibliothèque 

Dreamweaver
autorisations 222
insertion depuis les actifs 

partagés 105
enregistrement des brouillons

exportation de pages Web ou 
d'entrées de blog 56

lors du travail 41
pour plus tard 41
Publier en tant que nouvelle 

page 159
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239

enregistrement du logiciel 1

Enregistrer pour plus tard, 
commande 41

Enregistrer sous 159
en-têtes de tableau

ajout 134
en-têtes, application de styles 91
entrées de blog

affichage 25
existantes, publication en tant que 

nouvelles 172
mise à jour 172
navigation 23
publication de nouvelles 173
publiées récemment, affichage 25

envoi des clés de connexion
dépannage 233
pour des sites CPS 197
pour des sites Web 195
sécurité 177

envoi des clés de connexion, par 
courriel

dépannage 233
pour des sites CPS 197
pour des sites Web 195
sécurité 177

Envoyer pour la révision 42
espace

raccourcis clavier 248
raccourcis clavier, Macintosh 246, 

248
raccourcis clavier, Windows 240, 

242
espace de travail

barres d'outils 20
navigateur et éditeur 19
navigation clavier uniquement 29
panneau de navigation 21

espacement
espaces consécutifs 224
paragraphe 224
sauts de ligne 224

espaces consécutifs 224
Excel

liaison de documents à des pages 
Web 76, 79

options de placement 221, 224
ouverture de documents dans 

Adobe Contribute 77
publication de documents 164
publication du contenu du 

blog 166, 167, 173
exécution de scripts de démarrage 

dans les applications d'Adobe 
CS3

intégration d'Adobe Contribute 15

Exiger un mot de passe au démarrage 
d'Adobe Contribute 13

Explorer
accès réseau, désactivation 226
modification de pages Web et 

d'entrées de blog 39
paramètres 23
publication du contenu du 

blog 166
signets 26

exportation de pages Web ou 
d'entrées de blog 56

exportation des clés de connexion
dépannage 233
pour des sites CPS 197
pour des sites Web 195
sécurité 177

extension de fichier, par défaut 191
extraction de fichiers, annulation 235

F
Faire un don

ajout du bouton PayPal 102
FeedDemon, publication de contenu 

de blog depuis 237
FeedDemon, publication du contenu 

du blog depuis 169
fenêtres, ouverture des liens dans 144
feuilles de style

autorisations utilisateur 217
création de styles 91
disponibles 87
limitation 218, 224
propriétés de page 67
texte, application 91

feuilles de style en cascade. Voir CSS.
Fichier (menu), raccourcis clavier

Macintosh 245
Windows 239

fichier de paramètres partagés
enregistrement des 

autorisations 207
suppression 233

fichier Lisez-moi 2
Fichier sur mon poste de travail, boîte 

de dialogue 141
fichiers

affichage de pages Web 25
annulation de l’extraction 235
autorisations d'accès aux 

dossiers 213
autorisations de suppression 214
liaison vers 141
manquants, dépannage 232
options de placement 221
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publication 160
remplacement sur un site Web 161

fichiers dépendants
blogs 199
dépannage 232
options de placement 221

fichiers SWF
lecture automatique ou en 

boucle 119
fichiers verrouillés, 

déverrouillage 235
Firefox

installation des plug-ins 39
publication du contenu du 

blog 166
fixation

date et heure pour entrées de 
blog 67

Flash (SWF), fichiers
accessibilité 224
autorisations relatives aux actifs 

partagés 222
insertion 105, 111
lecture automatique ou en 

boucle 119
options de placement 221
propriétés 112

flux des travaux, présentation 11
fonction de restauration

à propos 156
utilisation 163

Format (menu), raccourcis clavier
Macintosh 246
Windows 240

Formater le tableau, boîte de 
dialogue 132

formulaires, protection 224, 236
forte accentuation, style de texte 92
Fractionner la cellule, boîte de 

dialogue 129
fragments de code

autorisations utilisateur 216
fragments de code HTML

autorisation pour l'insertion 224
insertion dans des pages Adobe 

Contribute 85
FTP

clés de connexion, envoi 177
configuration CPS 205
dépannage 227
informations de connexion 178
méthode de connexion 205
nom d'utilisateur et mot de passe, 

dépannage 228
fusion des cellules d'un tableau 129

G
gestion

connexions 200
processus de révision des 

brouillons 223
Google, fonctionnalité de recherche

ajout 53
autorisations 224

graphiques. Voir images
gras

autres balises 224
mise en forme 92
raccourcis clavier, Macintosh 246
raccourcis clavier, Windows 240

H
heure

publication de l'entrée de blog 65
Historique du brouillon 46
historique, brouillon 46
hors connexion, travail 51
HTML, balises

contenu statique dans des pages 
dynamiques 236

HTML, fragments de code
autorisations de modification 216
autorisations utilisateur 216

I
Image, bouton 103
images

 Voir aussi actifs partagés
accentuation 108
ajout aux pages Web 101, 103
alignement 107, 119
autorisations 220
barres horizontales 117
bordures 119
contraste, réglage 108
copie et collage 104
déplacement dans une page 107
descriptions, ajout 102
descriptions, obligatoire 224
fichiers de blog 199
glissement sur une page 104
luminosité, réglage 108
manquantes, dépannage 232
menu Insertion 103
modification dans une application 

externe 110
modifications dans Adobe 

Contribute 107
options de placement 221
pages d'accueil, modification 63

propriétés 106
raccourcis clavier, Macintosh 249
raccourcis clavier, Windows 242
recadrage 109
redimensionnement 109
remplissage 119
rotation 110
texte secondaire, ajout 102
texte secondaire, obligatoire 224

iMovie 112
impression

pages Web ou entrées de blog 57
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239

incorporation de PDF
redimensionnement 84

Insérer un document Microsoft 
Office, boîte de dialogue 173

Insérer un lien, boîte de dialogue
Adresse électronique 140
Brouillons et pages récentes 135
Créer une entrée 138
Créer une page 136
Fichier sur mon poste de 

travail 141
Rechercher une page Web 139

Insérer un tableau, boîte de 
dialogue 122

insertion
boutons PayPal 118
documents MS Office au format 

PDF dans Adobe Contribute 77
documents MS Office au format 

PDF dans Contribute 74
fragments de code HTML dans des 

pages Adobe Contribute 85
PDF dans des pages Adobe 

Contribute 83
Insertion (menu), raccourcis clavier

Macintosh 246
Windows 240

insertion de fichiers
d'Adobe Bridge CS3 à Adobe 

Contribute CS3 16
insertion de fragments de code 

HTML
autorisations 224

installation
dépannage 225

installation des polices 2
intégration

Adobe Bridge CS3 à Adobe 
Contribute CS3 16

intégration à Contribute CS3 16
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Internet Explorer
accès réseau, désactivation 226
modification de pages Web et 

d'entrées de blog 39
paramètres 23
publication du contenu du 

blog 166
signets 26

italiques
autres balises 224
mise en forme 92
raccourcis clavier, Macintosh 246
raccourcis clavier, Windows 240

J
JAWS pour lecteur Windows

paramètres 31
pris en charge 29

JAWS pour Windows
images 101

jeux de cadres
à propos de 151, 152
publication de pages 153

JSP, pages 224, 236
justifier le texte 94

L
langues, codage 29, 190
largeur fixe, style de texte 92
lecteur Windows Eyes

paramètres 31
pris en charge 29

lecteurs
paramètres d'accessibilité 31
pris en charge 29

lecteurs d'écran
images 101

lecture en boucle des animations 
Flash 119

liaison vers
adresses électroniques 140
ancres de section 146
brouillons ou pages récemment 

publiées 135
Contenu Adobe Acrobat 

Connect 142
entrées de blog vides 138
fichiers stockés sur un 

ordinateur 141
nouvelles pages 136
pages d'un site Web 139

liens
ancres de section, ajout 146
ancres de section, 

modification 147

aperçu dans un navigateur 149
cibles, modification 148
définition des propriétés d'une 

page Web 67
dépannage 232
documents Microsoft Word ou 

Excel liés à des pages Web 76, 79
options de placement des 

fichiers 221
pages d'accueil, modification 64
propriétés, modification 149
publication de pages Web 135, 157
rompus 157
sélection d'un cadre cible 152, 154
sélection de l'emplacement de 

chargement d'une page 144
suppléments multimédia, 

blogs 114
suppression 148
test 156
texte, modification 148
URL de rétrolien 72
URL, modification 143
vérification du 

fonctionnement 149
liens hypertextes. Voir liens
liens rompus 157
lignes de tableau

ajout 127
conflits de mise en forme 121
propriétés 131, 134
raccourcis clavier pour 

Macintosh 247
raccourcis clavier, Windows 241, 

242
redimensionnement 124
sélection 123
suppression 128

liste des entrées 25
actualisation 56

liste des entrées de blog
raccourcis clavier, Windows 241

listes
à puces 95
définitions 96
numérotées 95
propriétés 98
sous-listes 97

listes imbriquées 97
LiveDocs 2
logiciel

activation 1
enregistrement 1

logiciels, téléchargement 7

luminosité et contraste
élevé, paramètres d'accessibilité 29
images, réglage 108

M
Macintosh

raccourcis clavier 246
raccourcis clavier pour des lignes 

de tableau 247
raccourcis clavier pour les 

tableaux 248
Macintosh, raccourcis clavier

images 249
menu Affichage 246
menu Aide 247
menu Edition 245
menu Fichier 245
menu Format 246
menu Insertion 246
modèles 247

marge intérieure
cellules de tableau 134

marges, définition pour la page 
Web 67

Mes connexions
dépannage 227
utilisation 200

messagerie, liens 140
métadonnées, entrées de blog 69
Microsoft Excel

ajout de contenu à des pages 
Web 75, 78

insertion de documents au format 
PDF 81

liaison de documents à des pages 
Web 76, 79

options de placement 221, 224
ouverture de documents dans 

Adobe Contribute 77
publication de documents 164
publication du contenu du 

blog 166, 167, 173
Microsoft Internet Explorer

accès réseau, désactivation 226
modification de pages Web et 

d'entrées de blog 39
paramètres 23
publication du contenu du 

blog 166
signets 26

Microsoft Office
options de placement 221
ouverture de documents dans 

Adobe Contribute 77
publication de documents 164
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publication du contenu du 
blog 166, 167, 173

Microsoft Outlook
ouverture de documents dans 

Adobe Contribute 77
publication de documents 164
publication du contenu du 

blog 166, 167, 173
Microsoft Word

ajout de contenu à des pages 
Web 75, 78

insertion de documents au format 
PDF 81

liaison de documents à des pages 
Web 76, 79

options de placement 221, 224
ouverture de documents dans 

Adobe Contribute 77
publication de documents 164
publication du contenu du 

blog 166, 167, 173
mise à jour

entrées de blog 172
modèles 79, 81, 82, 165
pages Web 157

mise à jour des modèles 165
mise en retrait

listes 97
paragraphes 94

mise en surbrillance du texte 93
mises à jour 7
modèle

choix 78, 80, 81, 82
sélection 165
téléchargement 79, 80, 81, 82, 165

modèles
actualisation lors de la création de 

pages Web 50
autorisations 219
blog, entrées 64
création de pages Web 64
définition pour des documents MS 

Office 82
dépannage 232
modification de pages 48
pages d'accueil Web, copie 62
pages d'accueil Web, 

modification 63
personnalisation 49
propriétés 48
raccourcis clavier, Macintosh 247
raccourcis clavier, Windows 241
tableaux, formats prédéfinis 132
Web, développeurs 9
zones modifiables 36

modèles, mise à jour 80

modification 38
à partir du navigateur 39
ancres de section 147
annulation 40
annulation des modifications 54
annulation du verrouillage d'un 

fichier 235
autorisations 207, 215
barres d'outils de 20
basculement depuis le mode 

navigation 23
blog, entrées 38
boutons PayPal 119
cadres 152
code source 224, 236
conflits 178
contenu de page Web dans une 

application externe 52
dépannage 229
espace de travail 20
fichiers d'applications externes 53
flux des travaux, présentation 11
fonctionnalités 33
hors connexion 51
images 107, 110
informations de connexion 201
navigation clavier uniquement 29
orthographe, vérification 99
page créée à partir d'un modèle 48
pages à partir d'un site Web 37
pages d'accueil Web 63
pages Web et entrées de blog 34
panneau Pages 21
recherche et remplacement de 

texte 99
rétablissement 40
texte à l'aide de raccourcis clavier, 

Macintosh 248
texte à l'aide de raccourcis clavier, 

Windows 242
URL d'un lien 143
zones de modèle 36

modification de code source à l’aide 
d’applications externes

autorisations 224
Modification du mot de passe 

administrateur, boîte de 
dialogue 189

modification, méthodes
entrées de blog (pour) 67

Modifier l'ancre de section, boîte de 
dialogue 147

modules externes 5
mot de passe

FTP 228

mot de passe de démarrage
modification 28
saisie 13

mot de passe, administrateur
modification 189
redéfinition 233

mots de passe, démarrage
modification 28
saisie 13

mots, espacement 224
mots-clés et descriptions

ajout pour les pages Web 68
Movie Maker 112
Mozilla Firefox

installation des plug-ins 39
publication du contenu du 

blog 166
MS Office, documents

conversion au format PDF 74
insertion dans Adobe 

Contribute 77

N
navigateurs

cible pour les liens 144
codage 29, 190
contenu du blog, publication 166
liens, aperçu 149
modification de pages Web ou 

d'entrées de blog 39
pris en charge 39

navigation
aperçu d'une page 156
barres d'outils 20
basculement vers le mode 

modification 23
clavier uniquement 29
entrées de blog 23
espace de travail 20
flux des travaux, présentation 11
page Web non liée 25
pages Web 23
panneau Pages 21

navigation clavier uniquement 29
NetNewsWire, publication du 

contenu du blog depuis 169, 171
nom d'utilisateur

FTP, dépannage 228
non liées

non liées, affichage 25
nouveaux brouillons à réviser 47
numéros de port 177
Numérotation, boîte de dialogue 226



INDEX 259

O
Office

options de placement 221
ouverture de documents dans 

Adobe Contribute 77
publication de documents 164
publication du contenu du 

blog 166, 167, 173
orthographe, vérification

commandes 99
raccourcis clavier, Macintosh 246
raccourcis clavier, Windows 240

Outlook
ouverture de documents dans 

Adobe Contribute 77
publication de documents 164
publication du contenu du 

blog 166, 167, 173
ouverture

documents Microsoft Office dans 
Adobe Contribute 77

entrées de blog à modifier 38
page dans une nouvelle fenêtre 144
pages Web à modifier 37
pages Web et entrées de blog sans 

navigation 24
ouverture d'Adobe Contribute

dépannage 225
modification du mot de passe de 

démarrage 28
saisie d'un mot de passe de 

démarrage 13
travail hors connexion 14, 51

ouverture de documents MS Office 
dans Contribute

définition de modèles 82
ouverture de fichiers

d'Adobe Bridge CS3 à Adobe 
Contribute CS3 16

ouverture sans navigation 24

P
page Web

suppression 55
page Web ou entrée de blog

suppression 55
pages d'accueil

affichage 25
paramètres utilisateur 212, 224

pages d'accueil Web
copie 62
modification 63

pages d'index
à propos de 176
suppression de noms de fichier 192

pages dynamiques
code, protection 236
contenu statique, modification 236
scripts et formulaires, 

protection 224, 236
pages non liées

affichage 25
pages Web

accessibilité 31
accueil 62, 63
ajout à vos signets 26
annulation des modifications 54
aperçu dans un navigateur 156
applications externes, 

modification de contenu 53
autonomes, création 65
autorisations de création 219
autorisations de modification 215
contenu statique, modification 236
copie 60
création d'une page vierge 62
date, ajout 88
dynamiques 236
enregistrement des brouillons 41
exportation 56
extension de fichier, par défaut 191
flux des travaux, présentation 11
fonctionnalités 33, 59
images, insertion 101, 103
impression 57
mise à jour 157
modèles 36, 48, 64, 232
modification, dépannage 229
modifications à partir d'un 

navigateur 39
modifications hors connexion 51
mots-clés et descriptions, ajout 68
navigation 23
ouverture à des fins de 

modification 37
panneau Pages 21
propriétés 67
publication de nouvelles 157
publication en tant que 

nouvelle 159
publiées récemment, affichage 25
scripts et formulaires, 

protection 224, 236
supprimées, restauration 234
texte, ajout 88

pages Web autonomes, création 65
pages Web et entrées de blog 24

modification 34
pages. Voir pages Web

panneau Comment 21
panneau de navigation

parties de 21
redimensionnement 22

panneau Pages 21
paragraphes

alignement 94
espacement 224
listes à puces 95
listes de définitions 96
listes numérotées 95
mise en retrait 94
propriétés des listes 98
raccourcis clavier 248
raccourcis clavier pour 

Macintosh 246
raccourcis clavier, Macintosh 248
raccourcis clavier, Windows 240, 

242
sauts de ligne 94, 224

paramètre
préférences dans Contribute 27

paramètre de contraste élevé 29
paramètres par défaut. Voir  

préférences
PayPal, boutons

à propos de 102
Abonnement 102
Acheter maintenant 102
Afficher le panier 102
Ajouter au panier 102
autorisations 224
Faire un don 102
insertion d'un seul bouton 118
insertion de plusieurs 

éléments 119
modification 119

PDF 60
conversion de documents MS 

Office 60
documents Microsoft Word ou 

Excel, insertion 81
insertion dans des pages Adobe 

Contribute 83
insertion sous forme d'objet 

incorporé 77
insertion sous forme de lien 77

PDF, documents
insertion de documents MS Office 

dans Adobe Contribute 77
PDF, fichiers

options de placement 221
personnalisation des modèles 49
PHP, pages 224, 236
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placement de fichiers
d'Adobe Bridge CS3 à Adobe 

Contribute CS3 16
plug-ins

Adobe Store 7
podcasts 114
point d'accès, serveurs de blog 205
Pôle de création (Design Center) 6
Pôle de création Adobe (Adobe 

Design Center) 6
polices

ajout 90
autorisations relatives aux 

styles 217
caractères spéciaux 89
codage 29, 190
couleur 93
création de styles 91
définition des propriétés d'une 

page Web 67
espacement entre les mots 224
gras 92, 224
italiques 92, 224
limitation des styles CSS 

disponibles 218, 224
raccourcis clavier, Macintosh 246
raccourcis clavier, Windows 240
souligné 92
styles, application 91
taille, modification 89

préférences
blog, entrées 69
paramètres dans Contribute 27
rôle, paramètres de 207, 210, 212
utilisateur 224

processus de révision des brouillons
à propos 35
affichage des commentaires 46
annulation de l'envoi de pages 

Web 43
dépannage 231
envoi de pages Web par courriel 46
envoi direct de pages Web à un 

utilisateur 44
gestion 223
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239
révision des brouillons 45
suivi des brouillons 44

programme d'ajout de flux RSS, 
publication de contenu 
depuis 169

propriétés 207
animations 113
barres horizontales 117

cellules de tableau 131
contenu Flash (fichiers SWF) 112
images 106
lignes ou colonnes de tableau 131, 

134
listes 98
modèles 48
page Web 67
tableaux 130

Propriétés de l'image, boîte de 
dialogue 106

Propriétés de la barre horizontale, 
boîte de dialogue 117

Propriétés de la page 67
Propriétés du tableau, boîte de 

dialogue 130
Propriétés vidéo, boîte de 

dialogue 113
publication

à propos 155
affichage des pages Web et des 

blogs récents 25
aperçu d'une page 156
aperçu des liens 149
autorisations 207, 212, 224
contenu de blog depuis un 

agrégateur RSS 237
contenu du blog depuis Microsoft 

Office 167
contenu du blog depuis un 

navigateur 166
contenu du blog depuis un 

programme d'ajout de flux 
RSS 169

dépannage 231
documents liés 157
documents Microsoft Office 164
entrées de blog existantes en tant 

que nouvelles 172
entrées de blog, nouvelles 173
fichiers 160
flux des travaux, présentation 11
fonction de restauration 156, 163
liaison vers des pages récentes 135
mise à jour de pages Web 157
mise à jour des entrées de blog 172
mises à jour d'une page 

existante 157
nouvelles pages Web 157
page existante en tant que nouvelle 

page 159
pages de cadres 153
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239
remplacement de fichiers 161

publication d'une entrée de blog
indication des date et heure 65

publication de contenu de blog
agrégateurs RSS 237

publication de fichiers
d'Adobe Bridge CS3 à Adobe 

Contribute CS3 17
publication du contenu du blog 

depuis
Microsoft Office 167
navigateurs 166
programme d'ajout de flux RSS 169

Publier le fichier, boîte de 
dialogue 162

Publier les nouvelles entrées de blog 
liées, boîte de dialogue 172

Publier sur le site Web, boîte de 
dialogue 164

Q
Quick Time, fichiers 112, 116

R
raccourcis clavier dans l'aide 3
raccourcis clavier pour les tableaux

Macintosh 248
raccourcis clavier, Macintosh

images 249
menu Affichage 246
menu Aide 247
menu Edition 245
menu Fichier 245
menu Format 246
menu Insertion 246
modèles 247

raccourcis clavier, Windows
images 242
liste des entrées de blog 241
menu Affichage 240
menu Edition 239
menu Fichier 239
menu Format 240
menu Insertion 240
menu Tableau 241
modèles 241
modifier du texte 242
système d'aide 243
tableaux 242

raccourcis de navigation 3
recadrage des images 109
recherche

fonctionnalité Google, 
autorisations pour 224
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Google, ajout de la fonctionnalité 
de recherche dans des sites 
Web 53

texte 99
Rechercher et remplacer, 

commande 99
Rechercher la vidéo, boîte de dialogue

utilisation 119
Rechercher un fichier Flash, boîte de 

dialogue
utilisation 119

Rechercher une image, boîte de 
dialogue

utilisation 119
Rechercher une page Web, boîte de 

dialogue 139
reconnexion à un serveur de blog 182
redimensionnement

images 109, 119
incorporation de PDF 84
tableaux 124

remplacement
fichiers sur un site Web 161
texte 99

remplissage
images 119

réseau
dépannage 226, 228
travail hors connexion 14, 51

réseau local, dépannage 228
restauration d'une page Web 

supprimée 234
restauration d'une version 

précédente
à propos 156
utilisation de la fonction de 

restauration 163
Restauration, fonction

dépannage 233
Restaurer la page, boîte de 

dialogue 163
rétablissement d'une modification 40
rétablissement d'une version 

précédente
activation et désactivation de la 

fonction Restaurations 190
dépannage 233

retrait. Voir suppression
réunions, liaison vers des réunions 

Adobe Acrobat Connect 142
révision des brouillons

à propos 35
affichage des commentaires 46
annulation de l'envoi de pages 

Web 43
dépannage 231

envoi de pages vers un site Web 42
envoi de pages Web par courriel 46
envoi direct de pages Web à un 

utilisateur 44
gestion 223
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239
révision de pages Web 45
suivi 44

révision des brouillons, processus
envoi de pages vers un site Web 42

révision par courriel
affichage des commentaires 46
annulation de l'envoi de pages 

Web 43
dépannage 231
envoi de liens de pages Web 46
envoi de pages vers un site Web 42
envoi direct de pages Web à un 

utilisateur 44
gestion 223
processus 35, 36
raccourcis clavier, Macintosh 245
raccourcis clavier, Windows 239
révision de pages Web 45
suivi 44

rôles
à propos de 207
administrateur, attribution 186
administrateur, modification 189
autorisations de publication 224
création 208
dépannage 227
fichier de paramètres partagés 207
gestion des brouillons envoyés 

pour révision 223
paramètres 210
paramètres de page d'accueil 212, 

224
paramètres, généraux 207, 212, 224
suppression 235
types de 207
Voir aussi autorisations

rotation des images 110

S
sauts de ligne

ajout 94, 224
raccourcis clavier, Macintosh 246
raccourcis clavier, Windows 240

scripts de démarrage dans les 
produits d'Adobe CS3

Intégration d'Adobe Contribute 
aux applications Adobe CS3 15

scripts, protection 224, 236

sécurité
clés de connexion, envoi 177
mot de passe administrateur, 

modification 189
mot de passe de démarrage 13, 28

sélection
modèle 78, 80, 81, 82, 165

sélection de la cible
ancres de section 146
cadres 152, 154
liens 144

Sélectionner un cadre à modifier, 
boîte de dialogue 152

Sélectionner un site Web, boîte de 
dialogue 160

séparateurs de pages 117
serveur de noms de domaine, alias 

multiples 176
serveurs de blog

point d'accès 205
serveurs virtuels 177
SFTP

configuration CPS 205
dépannage 227, 228
informations de connexion 178
méthode de connexion 205

signets
affichage 26
ajout 26
suppression 27

sites Web
activation de CPS 183
administrateur, attribution du 

rôle 186, 189
ajout à vos signets 26
ajout de pages à vos signets 26
désactivation 234
désactivation de CPS 185
fichiers, publication 160
Google, ajout de la fonctionnalité 

de recherche 53, 224
liaison vers de nouvelles pages 136
liaison vers des pages 139
mise à jour de pages 157
options de placement des 

fichiers 221
ouverture de pages à des fins de 

modification 37
pages d'accueil, affichage 25
pages non liées 25
publication d'une page existante en 

tant que nouvelle 159
publication de nouvelles pages 157

souligné 92
sous-listes 97
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suivi des brouillons 44
suppléments multimédia

ajout 114
suppression 116

suppression
autorisations de suppression 214
blog, entrées 55
cellules de tableau 126
connexion à un site Web 202
fichier de paramètres partagés 233
fichiers verrouillés 235
liens 148
lignes ou colonnes de tableau 128
page Web 55
page Web ou entrée de blog 55
signets 27
suppléments multimédia 116
utilisateurs 205
utilisateurs dans un rôle 235

suppression des brouillons non 
publiés 204

Supprimer un signet, boîte de 
dialogue 27

SWF, fichiers
accessibilité 224
autorisations relatives aux actifs 

partagés 222
insertion 105, 111
options de placement 221
propriétés 112

symboles
caractères spéciaux 89
codage 29, 190

système d'aide
panneau Comment 21
raccourcis clavier, Macintosh 247
raccourcis clavier, Windows 243

système d'aide en ligne
panneau Comment 21

T
Tableau (menu), raccourcis clavier

Windows 241
tableaux

alignement 125, 134
bordures 134
conflits de mise en forme 121
couleur d'arrière-plan 134
en-têtes 134
formats prédéfinis 132
insertion 122
largeur 134
navigation clavier uniquement 30
options de tri 133

propriétés 130
propriétés du texte 134
raccourcis clavier pour 

Macintosh 248
raccourcis clavier, Windows 242
redimensionnement 124
sélection d'un tableau, d'une ligne 

ou d'une colonne 123
sélection de cellules 123
tri des données 133

tableaux, cellules
collage 127
copie ou collage 126
espacement 134
fractionnement 129
fusion 129
marge intérieure 134
propriétés 131
raccourcis clavier, Macintosh 247, 

248
raccourcis clavier, Windows 241, 

242
sélection 123

tableaux, colonnes
ajout 127
conflits de mise en forme 121
largeur 134
propriétés 131, 134
raccourcis clavier, Windows 241, 

242
redimensionnement 124
sélection 123
suppression 128
tri des données 133

tableaux, lignes
ajout 127
conflits de mise en forme 121
propriétés 131, 134
raccourcis clavier, Windows 241, 

242
redimensionnement 124
sélection 123
suppression 128

téléchargement
mises à jour, plug-ins et versions 

d'essai 7
modèle 79, 80, 81, 82, 165

texte
ajout à une page Web 88
alignement 94
autorisations de modification 224
autorisations utilisateur 217
caractères spéciaux 89
codage 29, 190
couleur, définition 93

création de styles 91
espacement des paragraphes 94
espacement entre les mots 224
espacement entre les 

paragraphes 224
gras 92, 224
italiques 92, 224
lecteurs 29, 31
lien, modification 148
limitation des styles CSS 

disponibles 218, 224
mise en forme 92
mise en retrait 94
mise en surbrillance 93
orthographe, vérification 99
pages d'accueil, modification 63
police, modification 89
polices, ajout 90
propriétés de tableau 134
raccourcis clavier, Macintosh 248
raccourcis clavier, Windows 242
recherche et remplacement 99
sauts de ligne 94, 224
souligné 92
styles, application 91

texte de remplacement
exigences en matière 

d'accessibilité 31
texte secondaire

actifs partagés, ajout à 224
ajout aux images 102
obligatoire 224

travail
hors connexion dans l'éditeur de 

Contribute 51
Travailler hors connexion 51
Trier le tableau, boîte de dialogue 133

U
URL

à propos de 178
autre 176
liens, modification 143

URL de rétrolien, entrées de blog 72
URL du blog

définition pour la connexion à un 
serveur de blog 181

utilisation pour création d'une 
connexion au serveur de 
blog 181

utilisateurs
administrateur, attribution du 

rôle 186
autorisations de publication 224
conflits 178
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CPS 197
création de rôles 208
définis 9
dépannage 227
documentation pour 4
fichier de paramètres partagés 207
flux des travaux, présentation 11
FTP, dépannage 228
gestion des brouillons envoyés 

pour révision 223
paramètres de page d'accueil 212, 

224
rôle, paramètres de 207, 210, 212, 

224
suppression d'un rôle 235
suppression d'un site CPS 199
suppression d'un site Web 205
Voir aussi autorisations

utilisation 119
boîte de dialogue Choisir un fichier 

Flash sur le site Web 119
boîte de dialogue Choisir une 

image du site Web 119
boîte de dialogue Choisir une vidéo 

sur le site Web 119
boîte de dialogue Rechercher la 

vidéo 119
boîte de dialogue Rechercher un 

fichier Flash 119
boîte de dialogue Rechercher une 

image 119

V
Vérifier l'orthographe, commande

raccourcis clavier, Macintosh 246
raccourcis clavier, Windows 240
utilisation 99

verrouillage de zones de modèle 36
version précédente, restauration

à propos 156
utilisation de la fonction de 

restauration 163
version précédente, rétablissement

activation et désactivation de la 
fonction Restaurations 190

dépannage 233
versions d'essai 7
vidéo

alignement 114
déplacement 114
fichiers de blog 114, 199
Flash, insertion 105, 111
Flash, propriétés 112
insertion 112
propriétés 113

suppléments multimédia, entrées 
de blog 114

vitesse de démarrage
dépannage 226

vitesse, dépannage 234

W
Web, développeurs 9
WebDAV

CPS 205
Windows Eyes

images 101
Windows Media, fichiers 112
Windows, raccourcis clavier

images 242
liste des entrées de blog 241
menu Affichage 240
menu Edition 239
menu Fichier 239
menu Format 240
menu Insertion 240
menu Tableau 241
modèles 241
modification 242
système d'aide 243
tableaux 242

Word
ajout de contenu à des pages 

Web 75, 78
insertion de documents au format 

PDF 81
liaison de documents à des pages 

Web 76, 79
options de placement 221, 224
ouverture de documents dans 

Adobe Contribute 77
publication de documents 164
publication du contenu du 

blog 166, 167, 173



INDEX 264


	Table des matières
	Chapitre 1 : Bienvenue dans Adobe® Contribute® CS3
	Installation
	Conditions d'utilisation
	Installation du logiciel
	Activation du logiciel
	Enregistrement
	Lisez-moi

	Aide Adobe
	Ressources de l'aide Adobe
	Utilisation de l'aide dans le produit
	Choix des documents d'aides appropriés

	Ressources
	Atelier vidéo Adobe
	Vidéos Contribute CS3
	Ressources supplémentaires
	Bridge Home
	Pôle de création Adobe (Adobe Design Center)
	Pôle de développement d'Adobe
	Assistance clientèle
	Téléchargements
	Adobe Labs
	Communautés d'utilisateurs

	Nouveautés
	Présentation du service de développement et de maintenance d'un site Web

	Chapitre 2 : Prise en main
	Flux des travaux dans Contribute
	Connexion à un site Web ou à un blog
	Connexion à un site Web
	Connexion à un blog
	Utilisation d'une clé de connexion à un site Web
	Saisie d'un mot de passe de démarrage de Contribute.

	Démarrage de Contribute sans connexion réseau
	Désactivation de votre site Web ou blog au démarrage

	Intégration de Contribute aux applications Adobe Creative Suite 3
	Exécution d'opérations Adobe Contribute dans des applications de Creative Suite 3

	Intégration d'Adobe Bridge CS3 à Adobe Contribute CS3
	Insertion de fichiers à partir d'Adobe Bridge dans Adobe Contribute
	Ouverture de fichiers depuis Adobe Bridge dans Adobe Contribute (Windows uniquement)
	Publication de fichiers d'Adobe Bridge dans Adobe Contribute (Windows uniquement)


	Chapitre 3 : Exploration de l'espace de travail de Contribute
	Espace de travail de Contribute
	Navigateur et éditeur de Contribute
	Barres d'outils de Contribute
	Panneau de navigation de Contribute

	Basculement entre les modes navigation et modification
	Accès aux pages Web et aux entrées de blog
	Ouverture des pages Web et des entrées de blog sans passer par le mode navigation
	Affichage de brouillons et de nouvelles pages ou entrées de blog
	Affichage des pages d'accueil de vos sites Web et blogs
	Affichage des pages Web et des entrées de blog publiées récemment
	Affichage des entrées de blog
	Affichage de pages et de fichiers vers lesquels vous ne pouvez pas naviguer

	Configuration de l'accès aux pages couramment utilisées
	Affichage de pages dans votre liste de signets
	Ajout d'une page à vos signets
	Suppression d'une page de vos signets

	Définition des préférences dans Contribute
	Modification ou désactivation du mot de passe de démarrage de Contribute
	Configuration du codage du navigateur
	Utilisation des fonctions d'accessibilité de Contribute
	Utilisation de lecteurs avec Contribute
	Utilisation des fonctions d'accessibilité du système d'exploitation
	Utilisation du clavier pour naviguer Contribute
	Navigation dans l'espace de travail
	Navigation dans les boîtes de dialogue
	Navigation dans les tableaux

	Création de pages Web accessibles


	Chapitre 4 : Utilisation des pages et des entrées de blog
	A propos de l'utilisation de pages Web et d'entrées de blog
	Modification de pages Web et d'entrées de blog
	Description du processus de révision des brouillons
	Description du processus de révision par courriel
	A propos des modèles

	Modification de pages Web et d'entrées de blog existantes
	Ouverture d'une page de site Web à des fins de modification
	Ouverture d'une entrée de blog à des fins de modification dans Contribute
	Ouverture d'une page stockée dans votre ordinateur à des fins de modification
	Ouverture d'une page Web ou d'une entrée de blog à des fins de modification dans un navigateur
	Navigateurs et systèmes d'exploitation pris en charge
	Informations essentielles relatives à l'utilisation de Contribute sous Windows et sur un Macintosh
	Utilisation de Contribute sur un Macintosh
	Modification d'une page Web ou d'une entrée de blog dans Contribute à partir d'un navigateur

	Annulation des erreurs

	Enregistrement des brouillons
	Enregistrement d'un brouillon en travaillant
	Enregistrement d'un brouillon

	Révision de brouillons de pages Web et de fichiers par des tiers
	Utilisation du processus de révision des brouillons
	Envoi d'un brouillon de page Web pour révision
	Envoi d'un fichier en révision à partir de votre ordinateur
	Suivi des brouillons de pages Web
	Révision d'un brouillon de page Web

	Envoi d'un brouillon de page Web pour révision par courriel
	Accès aux nouveaux brouillons de révision

	Utilisation de pages Web créées à partir de modèles Dreamweaver
	Modification d'une page Web créée à partir d'un modèle
	Utilisation de modèles de pages Web et de blogs
	Configuration des propriétés de modèle de page Web
	Personnalisation des fichiers de modèle Dreamweaver pour les blogs

	Actualisation des modèles

	Utilisation de Contribute hors connexion
	Passage du travail en ligne au travail hors connexion
	Travailler hors connexion dans l'éditeur de Contribute

	Modification du contenu d'une page Web dans un logiciel externe
	Ajout de la fonctionnalité de recherche Google à votre page Web
	Modification de la source d'une page Web dans une application externe
	Annulation d'un brouillon, d'une nouvelle page ou d'une nouvelle entrée de blog
	Suppression d'une page Web ou d'une entrée de blog
	Suppression d'une page Web
	Suppression d'une entrée de blog
	Actualisation de la liste des entrées

	Exportation d'une page Web ou d'une entrée de blog (Windows uniquement)
	Impression d'une page Web ou d'une entrée de blog

	Chapitre 5 : Ajout de pages, d'entrées de blog et de documents
	A propos de la conversion de documents au format PDF (Windows uniquement)
	Création ou copie d'une page sur un site Web
	Copie d'une page sur votre site Web
	Création d'une page Web vierge
	Copie d'une page d'accueil Web
	Modification d'une page d'accueil Web
	Création d'une page Web à partir d'un modèle

	Création d'une page Web autonome
	Création d'une entrée dans votre blog
	Création d'une entrée de blog vide
	Création d'une entrée de blog à partir d'une sélection citée
	Modification d'une entrée de blog
	Fixation de la date et de l'heure pour une entrée de blog

	Configuration des propriétés d'une page Web
	Ajout de mots-clés et d'une description à une page Web
	Configuration des préférences des entrées de blog
	Association de métadonnées à une entrée de blog
	Sélection du blog dans lequel une entrée doit être publiée
	Définition ou modification du titre d'une entrée de blog
	Ajout de balises à une entrée de blog
	Attribution de catégories à une entrée de blog
	Actualisation de la liste des catégories disponibles

	Ajout d'URL de rétrolien à une entrée de blog
	Ajout de commentaires à des entrées de blog autorisé

	Insertion de documents MS Office au format PDF dans des pages Contribute (Windows uniquement)
	Ajout de documents Microsoft Word et Excel à un site Web
	Ajout de contenu Microsoft Word ou Excel à une page (Windows uniquement)
	Insertion d'un lien pointant vers un document Microsoft Word ou Excel
	Conversion de documents au format PDF et insertion dans des brouillons (Windows uniquement)

	Ouverture de documents dans Contribute à partir d'applications Microsoft Office (Windows uniquement)
	Ouverture de documents dans Contribute à partir de Microsoft Word, Excel et du lecteur de messagerie Outlook.
	Ajout du contenu Microsoft Word, Excel ou Outlook dans une page à partir de Microsoft Office (windows uniquement)
	Insertion d'un lien pointant vers un document Microsoft Word ou Excel à partir de Microsoft Office (Windows uniquement)
	Insertion d'un document Microsoft Word ou Excel au format PDF à partir de Microsoft Office (Windows uniquement)

	Définition de modèles lors de l'ouverture de documents MS Office dans Contribute (Windows uniquement)

	Insertion de documents PDF dans des pages Contribute
	Redimensionnement de fichiers PDF incorporés insérés dans des pages Web ou des entrées de blog

	Insertion de fragments de code HTML dans des pages Contribute

	Chapitre 6 : Utilisation de texte
	A propos des styles CSS et HTML du menu Style de Contribute
	Ajout de texte à une page Web
	Ajout de la date du jour à une page
	Insertion de caractères spéciaux dans une page

	Modification de l'apparence du texte de la page
	Modification de la police et de la taille du texte
	Modification de la liste des polices

	Application de styles au texte
	Création et gestion des styles
	Modification du style du texte de la page
	Application de couleurs au texte

	Positionnement du texte dans la page
	Ajout d'espacements entre les paragraphes
	Alignement du texte
	Mise en retrait du texte

	Création de listes
	Création de listes numérotées
	Création de listes à puces
	Création de listes de définitions
	Création de sous-listes
	Définition des propriétés d'une liste

	Vérification orthographique
	Recherche et remplacement de texte

	Chapitre 7 : Utilisation d'images et d'éléments graphiques
	Insertion d'images et de boutons
	A propos de l'insertion d'images
	A propos des boutons PayPal

	Ajout d'une image à une page
	Utilisation du menu Insertion ou du bouton Image pour ajouter des images
	Glissement des images sur une page
	Copie et collage d'images

	Insertion d'actifs partagés dans une page Web
	Modification des propriétés d'une image
	Modification de la position ou de l'orientation d'une image
	Déplacement d'une image
	Alignement d'une image

	Modification d'une image dans Contribute
	Réglage de la luminosité et du contraste d'une image
	Accentuation d'une image
	Recadrage d'une image
	Redimensionnement d'une image
	Rotation d'une image

	Modification d'une image dans une application externe
	Insertion de contenu Flash dans une page Web
	Définition des propriétés des animations Flash

	Insertion d'une séquence vidéo dans une page Web
	Définition des propriétés d'une séquence vidéo

	Modification de la position ou de l'orientation d'une séquence vidéo
	Déplacement d'une séquence vidéo
	Alignement d'une séquence vidéo

	Ajout de suppléments multimédia à un blog
	Ajout de suppléments multimédia depuis votre ordinateur
	Ajout de suppléments multimédia depuis votre site Web
	Ajout de suppléments multimédia depuis Internet
	Ajout de suppléments multimédia depuis Internet (Windows Media Player sous Windows)
	Ajout de suppléments multimédia depuis Internet (QuickTime)
	Suppression des suppléments multimédia

	Ajout et suppression d'une barre horizontale
	Modification des propriétés d'une barre horizontale

	Insertion de boutons PayPal pour le commerce électronique
	Insertion d'un bouton PayPal unique
	Insertion de plusieurs boutons PayPal
	Modification d'un bouton PayPal


	Chapitre 8 : Utilisation des tableaux
	A propos des conflits de mise en forme d'un tableau
	Insertion d'un tableau dans une page
	Sélection d'éléments de tableau
	Sélection de la totalité d'un tableau, d'une ligne ou d'une colonne
	Sélection d'une cellule, d'un bloc de cellules ou de cellules non contiguës

	Redimensionnement des tableaux, lignes et colonnes
	Alignement des tableaux
	Coupe, copie et collage de cellules
	Coupe et copie de cellules d'un tableau
	Collage des cellules d'un tableau

	Ajout, suppression et fusion de lignes et de colonnes
	Ajout de lignes et de colonnes
	Suppression de lignes et de colonnes
	Fusion et fractionnement de cellules

	Modification de l'apparence d'un tableau
	Modification des propriétés d'un tableau
	Modification des propriétés des lignes ou des colonnes
	Modification des propriétés des cellules
	Utilisation d'une mise en forme de tableau prédéfinie

	Tri des données tabulaires

	Chapitre 9 : Utilisation des liens
	Création de liens texte ou image
	Création d'un lien vers un brouillon ou une page récemment publiée sur votre site Web
	Création d'un lien vers une nouvelle page
	Création d'un lien vers une nouvelle entrée de blog vide
	Création d'un lien vers une page de votre site ou d'un autre site
	Création d'un lien vers une adresse électronique
	Création d'un lien vers un fichier stocké dans votre ordinateur
	Création d'un lien vers des réunions, des formations et du contenu Adobe® Acrobat® Connect™

	Définition des options de liaison avancées
	Modification de l'URL d'un lien
	Définition d'une cible pour la page
	Création d'un lien vers un emplacement spécifique dans une page
	Ajout d'une ancre de section
	Liaison d'une ancre de section
	Modification des ancres de section


	Modification des liens
	Modification du texte et de la cible du lien
	Suppression d'un lien
	Modification des propriétés d'un lien

	Test des liens

	Chapitre 10 : Utilisation de pages contenant des cadres
	A propos des cadres
	Cadres et jeux de cadres
	A propos de la sélection d'un cadre cible

	Modification du contenu d'un cadre
	Enregistrement et publication d'une page contenant des cadres
	Définition du contenu d'un cadre comme cible

	Chapitre 11 : Publication de pages Web et d'entrées de blog
	A propos de la fonction de restauration des pages Web
	Aperçu d'une page dans le navigateur par défaut
	Publication d'une page sur votre site Web
	Publication de mises à jour d'une page existante
	Publication d'une nouvelle page sur votre site Web
	Publication d'une page existante en tant que nouvelle page

	Publication d'un fichier depuis votre ordinateur sur votre site Web
	Remplacement d'un fichier sur votre site Web
	Restauration d'une version précédente d'une page
	Publication d'un document sur votre site Web à l'aide de Microsoft Office
	Publication de contenu sur un blog
	Publication de contenu sur un blog à partir d'un navigateur
	Publication d'un contenu de blog depuis des applications Microsoft Word (Windows unqiuement)

	Publication de contenu sur un blog depuis un programme d'ajout de flux RSS
	Utilisation de Contribute avec le programme d'ajout de flux RSS
	Configuration de Contribute dans FeedDemon (Windows)
	Publication sur un blog depuis FeedDemon
	Configuration de Contribute dans NetNewsWire (Macintosh)
	Publication sur un blog depuis NetNewsWire


	Publication d'une entrée sur votre blog
	Publications de mises à jour d'une entrée de blog existante
	Publication d'une entrée de blog existante en tant que nouvelle entrée
	Publication d'une nouvelle entrée de blog vide


	Chapitre 12 : Création et gestion des connexions à un site Web et un serveur de blog
	A propos de la création d'une connexion à un site Web et de l'envoi des informations correspondantes
	Pages d'index du serveur Web
	Autres adresses du site Web
	Clés de connexion

	Préparation de la connexion à un site Web ou un blog
	Création d'une connexion à un site Web
	Création d'une connexion à un serveur de blog
	Reconnexion à un serveur de blog
	Création d'une connexion à un compte .Mac
	Sélection d'un dossier de site Web .Mac auquel se connecter

	Activation et désactivation de CPS pour un site Web
	Activation de CPS pour un site Web
	Désactivation de CPS pour un site Web
	Désactivation du service Annuaire des utilisateurs pour un site Web

	Comment devenir l'administrateur d'un site Web Contribute existant
	Configuration des paramètres d'administration de Contribute
	Modification de l'administrateur du site Web
	Modification du mot de passe de l'administrateur
	Activation et désactivation des restaurations
	Définition de nouvelles préférences de page
	Ajout de noms de fichiers de page d'index
	Suppression de noms de fichiers de page d'index
	Définition d'autres adresses de site Web
	Spécification d'une page de garde
	Activation de la compatibilité avec des versions antérieures de Contribute
	Activation ou désactivation de l'incorporation de PDF

	Envoi de clés de connexion pour des sites Web
	Envoi de clés de connexion pour des sites gérés par CPS
	Ajout d'utilisateurs aux sites Web gérés par CPS
	Suppression d'utilisateurs de sites Web gérés par CPS
	Configuration de fichiers dépendants pour les blogs
	Gestion des connexions à un site Web ou un serveur de blog
	Modification d'une connexion à un site Web ou un serveur de blog
	Changement de nom d'une connexion à un site Web ou un serveur de blog
	Suppression de connexions à un site Web ou un serveur de blog
	Désactivation de connexions à des sites Web et à des blogs
	Suppression de brouillons non publiés d'un site Web ou blog désactivé

	Activation de la connexion à un site Web ou à un serveur de blog
	Connexion aux sites Web et aux serveurs de blog au démarrage


	Chapitre 13 : Gestion des utilisateurs et des rôles
	Description des rôles
	A propos des paramètres de rôle

	Création de rôles dans Contribute
	Modification des paramètres d'un rôle
	Définition des paramètres de rôle généraux
	Définition des paramètres d'accès aux dossiers et fichiers
	Définition des paramètres d'accès aux dossiers
	Définition des paramètres de suppression de fichiers

	Définition des paramètres de modification de pages et de paragraphes
	Définition de l'option d'insertion de fragments de code HTML
	Définition des paramètres pour les styles et les polices
	Limite du nombre de styles CSS disponibles
	Définition des paramètres pour les nouvelles pages Web
	Définition des paramètres pour les nouvelles images
	Définition des paramètres de placement des fichiers
	Définition des paramètres pour les actifs partagés

	Gestion des brouillons envoyés pour la révision

	Chapitre 14 : Dépannage
	Problèmes liés à l'installation Contribute
	Problèmes liés au démarrage de Contribute
	Le démarrage est lent ou l'application semble être bloquée
	La boîte de dialogue Echec de la connexion s'affiche lorsque l'application Contribute est connectée au réseau
	Contribute ne détecte pas la déconnexion du réseau
	La boîte de dialogue Numérotation s'affiche lorsque l'application Contribute est connectée au réseau
	Contribute indique que l'utilisateur n'appartient pas à un rôle valide

	Problèmes liés à la création d'une connexion
	La boîte de dialogue Mes connexions ne s'affiche pas
	La fenêtre suivante de l'Assistant de connexion n'est pas accessible
	L'Assistant de connexion ne trouve pas le dossier distant
	La connexion LAN ne trouve pas le dossier distant
	La boîte de dialogue FTP n'accepte pas votre nom d'utilisateur et votre mot de passe

	Problèmes liés à la modification d'une page
	Le bouton Modifier la page n'est pas visible
	Le bouton de modification est désactivé
	Un message d'erreur s'affiche lors de la sélection du bouton de modification
	La sélection du bouton Modifier la page entraîne l'affichage d'une page différente

	Problèmes liés à l'annulation des pages
	Problèmes liés à l'envoi de révisions par courriel
	Problèmes liés à la publication d'une page
	Problèmes liés à la création de documents à partir de modèles
	Les modèles de pages pour les sites Web et les blogs n'apparaissent pas dans Contribute
	Des images ou d'autres éléments ne s'affichent pas sur la nouvelle page

	Problèmes d'administration de Contribute
	Le menu Administrer les sites Web est désactivé
	Vous avez oublié le mot de passe du rôle administrateur
	Contribute se bloque lors de l'envoi d'une clé de connexion
	Une page Web est supprimée accidentellement
	Les utilisateurs ne voient pas suffisamment de copies de restauration de pages
	Désactivation de sites Web pour améliorer les performances de l'application
	Vous devez supprimer un utilisateur dans un rôle
	Vous devez écraser l'extraction d'un fichier

	Utilisation de Contribute avec des pages dynamiques
	Comment empêcher les utilisateurs de modifier des pages dynamiques
	Modification du contenu statique dans les pages dynamiques

	Problèmes liés à la configuration de Contribute dans des agrégateurs RSS
	Contribute ne figure pas dans la liste des outils de publication de blog de FeedDemon


	Chapitre 15 : Raccourcis clavier pour Windows
	Menu Fichier
	Menu Edition
	Menu Affichage
	Menu Insertion
	Menu Format
	Menu Tableau
	Travailler avec des entrées de blog
	Utilisation de modèles
	Modifier du texte
	Utiliser des tableaux
	Utiliser des images
	Obtenir de l'aide

	Chapitre 16 : Raccourcis clavier pour Macintosh
	Menu Fichier
	Menu Edition
	Menu Affichage
	Menu Insertion
	Menu Format
	Menu Tableau
	Menu Aide
	Utilisation de modèles
	Modification du texte
	Utilisation des tableaux
	Utiliser des images

	Index



